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Before You Begin

1.1

1.2

About this manual

This manual explains how to install, configure, and use the following Micro Motion® Series 3000
devices:

e Model 3500 or Model 3700 transmitter
e Model 3300 or Model 3350 controller
This manual also discusses the following optional applications:
* Discrete batching
¢ Petroleum measurement (API feature)
* Custody transfer

This manual does not discuss the Series 3000 Net Oil Computer. For information on this product and
application, see the Series 3000 Net Oil Computer Manual, available on the Micro Motion web site
(www.micromotion.com).

This manual does not discuss the enhanced density application. For information on enhanced density,
see the manual entitled Enhanced Density Application: Theory, Configuration, and Use, available on
the Micro Motion web site (Www.micromotion.com).

This manual does not discuss the Marine Bunker Transfer Package. For information on this product
and application, see the manual entitled Series 3000 Transmitters: Marine Bunker Transfer Package
Supplement, available on the Micro Motion web site (www.micromotion.com).

Safety

Safety messages are provided throughout this manual to protect personnel and equipment. Read each
safety message carefully before proceeding to the next step.

A WARNING

Improper installation in a hazardous area can cause an explosion.

For information about hazardous applications, refer to Micro Motion hazardous
area installation instructions, shipped with the Series 3000 device or available from
the Micro Motion web site.
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Before You Begin

1.3

1.4

1.5

A CAUTION

Improper installation could cause measurement error or flowmeter failure.

Follow all instructions to ensure Series 3000 device will operate correctly.

European installations

This Micro Motion product complies with all applicable European directives when properly installed
in accordance with the instructions in this manual. Refer to the EC declaration of conformity for
directives that apply to this product.

The EC declaration of conformity, with all applicable European directives, and the complete ATEX

Installation Drawings and Instructions are available on the internet at www.micromeotion.com/atex
or through your local Micro Motion support center.

Environmental standards compliance

To comply with EU Battery Directive 2006/66/EC, this device has been designed for safe removal of
the batteries at end of life by a waste treatment facility.

Terminology
The following terms are used in this manual:
e Series 3000 — refers to all Model 3300, 3350, 3500, or 3700 devices.

*  MVD — Multi Variable Digital, Micro Motion’s advanced method of analyzing and reporting
process variables.

*  Application — a specific use of the flowmeter technology, and the specialized software or
hardware required for implementation. Sample applications include enhanced density,
batching, and custody transfer.

*  Platform — refers to any component that can run an application. The component may be a
transmitter or a controller (see below).

*  Sensor — provides measurement functions.

*  Core processor — refers to the component which provides memory and preprocessing
functions on process variable data received from the sensor. There are two versions: the
standard core processor and the enhanced core processor. To check your core processor type,
use the Applications List (see Section 17.5.9).

»  Transmitter — refers to the component that accepts process variable data from the core
processor, performs additional processing, and transmits the processed data to a remote device.
In this manual, the Model 3500 and Model 3700 devices are transmitters.

*  Controller — refers to the Model 3300 and Model 3350 devices. Controllers receive processed
data from a transmitter such as an IFT9701, use these data in an application that is installed on
the device, and send the results to a remote device. Controllers are not connected to a sensor or
core processor.
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Before You Begin

1.6

1.7
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Communication tools
You can communicate with a Series 3000 device using any of the following communication tools:
*  The local display

e ProLink I v2.5 and higher (ProLink II v2.9 or higher recommended), or Pocket ProLink v1.3
and higher

* 375 Field Communicator with the appropriate DD: Micro Motion 3000 Mass flo v7 DD v2 or
higher

This manual focuses on the use of the local display. Detailed menu flowcharts for the local display are
provided in Appendix F.

For information on using ProLink II or the Communicator with a Series 3000 device, see Appendix G
or Appendix H. These appendices also provide flowcharts for the most commonly used menus and
procedures.

Using this manual

If the Marine Bunker Transfer Package is installed, use the manual entitled Series 3000 Transmitters:
Marine Bunker Transfer Package Supplement as your first guide to installation, configuration, and
use.

If the Marine Bunker Transfer Package is not installed, follow the general task sequence described
below to install, configure, and use the Series 3000 device.

1. Install the Series 3000 device (Chapter 2).

2. Set up digital communications (Chapter 3).

3. Learn to use the display and menu system (Chapter 4).
4. Configure the platform (Chapters 5 through 15).

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. Perform the configuration procedures in this order:

a. Configure security and language (Chapter 5).
b. Configure system data (Chapter 6).

o

Configure inputs (Chapter 7).

o

Configure petroleum measurement parameters, if the petroleum measurement application
(API feature) is installed (see Chapter 9), or enhanced density parameters, if the enhanced
density application is installed (see the enhanced density manual, available on the Micro
Motion web site).

Note: The Series 3000 device does not support simultaneous use of the petroleum measurement
application and the enhanced density application. If you ordered either of these applications, it
should already be installed on your Series 3000 device, but not configured or enabled.

Configure discrete events (Chapter 10).
Configure the discrete batch application, if it is present (Chapter 11).
Configure outputs (Chapter 8).

e oo

Configure the process monitor (Chapter 12).

e

Configure digital communications (Chapter 13).

Configure custody transfer (Chapter 14).

—

k. Configure ticket formatting and ticket printing (Chapter 15).
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Before You Begin

Perform startup procedures (Chapter 16).
Learn to use the Series 3000 device in operation mode (Chapters 17 through 19).

Learn how to view, start and stop, and reset totalizers (Chapter 20).

® N W

Establish a meter verification baseline, and calibrate the Series 3000 device, if required
(Chapter 21).

9. Learn how to respond to alarms (Chapter 22).

1.8 Other documentation
See Table 1-1 for a list of other manuals that may be useful or required to install, configure, or operate
the Series 3000 device.
Additional documentation for Series 3000 devices
Topic Manual / QRG title Location

Device installation:
* Model 3300 panel-mount
* Model 3500 panel-mount

Model 3500 Transmitter (MVD) or
Model 3300 Peripheral: Installation
Instructions for Panel-Mount (Quick
Reference Guide)

¢ Micro Motion documentation CD
* Micro Motion web site

Device installation:
* Model 3300 rack-mount
¢ Model 3500 rack-mount

Model 3500 Transmitter (MVD) or
Model 3300 Peripheral:

Installation Instructions for Rack-Mount
(Quick Reference Guide)

¢ Micro Motion documentation CD
¢ Micro Motion web site

Device installation:
* Model 3350 field-mount
* Model 3700 field-mount

Model 3700 Transmitter (MVD) or
Model 3350 Peripheral:

Installation Instructions for Field-Mount
(Quick Reference Guide)

¢ Micro Motion documentation CD
* Micro Motion web site

Sensor installation

Varies

* Micro Motion documentation CD
* Micro Motion web site

Hazardous area installation

Varies

¢ Micro Motion documentation CD
* Micro Motion web site

Enhanced density application

Enhanced Density Application: Theory,
Configuration, and Use

¢ Micro Motion documentation CD
¢ Micro Motion web site

Marine Bunker Transfer
Package

Series 3000 Transmitters: Marine Bunker
Transfer Package Supplement

¢ Micro Motion documentation CD
* Micro Motion web site

Using ProLink Il with the
Series 3000 device

Using ProLink Il Software with Micro Motion
Transmitters

¢ ProLink Il installation media
¢ Micro Motion documentation CD
* Micro Motion web site

Micro Motion® Series 3000 MVD Transmitters and Controllers
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1.9  Micro Motion customer service
For customer service, phone the support center nearest you:
e Inthe U.S.A., phone 800-522-MASS (800-522-6277) (toll-free)
* In Canada and Latin America, phone +1 303-527-5200
e InAsia:
- InJapan, phone 3 5769-6803
- In other locations, phone +65 6777-8211 (Singapore)

o
®
=
o
=
o
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o
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o
D
Q
=1

e In Europe:
- Inthe U.K., phone 0870 240 1978 (toll-free)
- In other locations, phone +31 (0) 318 495 555 (The Netherlands)

Customers outside the U.S.A. can also email Micro Motion customer service at
flow.support@emerson.com.
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Installation

2.1 Overview

This chapter provides supplemental installation information for all Series 3000 devices.

2.2 Installation procedure
To install your Series 3000 device:
1. Obtain the appropriate Quick Reference Guide (QRG), as listed in Table 2-1.
2. Review the specifications for your device:
*  Model 3300 or Model 3500 — see Appendix A
e Model 3350 or Model 3700 — see Appendix B
3. Review the supplemental information provided in this chapter.

4. Follow the installation instructions in the QRG, making all applicable changes to your
installation procedure.

Series 3000 installation QRGs

Series 3000 device Quick Reference Guide

Model 3300 controller (panel-mount) Model 3500 Transmitter (MVD) or Model 3300 Peripheral:
Model 3500 transmitter (panel-mount) Installation Instructions for Panel-Mount

Model 3300 controller (rack-mount) Model 3500 Transmitter (MVD) or Model 3300 Peripheral:
Model 3500 transmitter (rack-mount) Installation Instructions for Rack-Mount

Model 3350 controller (field-mount) Model 3700 Transmitter (MVD) or Model 3350 Peripheral:
Model 3700 transmitter (field-mount) Installation Instructions for Field-Mount

2.3 Replacing an RFT9739 rack-mount transmitter
Micro Motion can provide a special installation kit for installing a Model 3500 transmitter in a rack as
a replacement for an RFT9739 rack-mount transmitter. Part number 3500EXTENDEDM extends the
housing of the Series 3000 device to fit an RFT9739 rack. Contact Micro Motion for information
about obtaining this kit.

Configuration and Use Manual 7
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Installation

2.4 Model 3350 or Model 3700 safety precautions

A WARNING

Explosion Hazard.

Do not open wiring compartments when an explosive gas atmosphere is
present.

Do not remove the compartment covers in an explosive atmosphere within three
minutes after power is disconnected.

A WARNING

Using a dry cloth to clean the display cover can cause static discharge,
which could result in an explosion in an explosive atmosphere.

To prevent an explosion, use a clean, damp cloth to clean the display cover in an
explosive atmosphere.

2.5 Environmental requirements
Note: This section applies to all Series 3000 devices.

In addition to the temperature requirements described in the QRG, the following environmental
requirements apply:

*  Humidity: 5 to 95% relative humidity, non-condensing at 140 °F (60 °C)
*  Vibration: Meets IEC 68.2.6, endurance sweep, 5 to 2000 Hz, 50 sweep cyclesat 1.0 g

If possible, install the Series 3000 device in a location that will prevent the heating effects of direct
exposure to sunlight.

2.6 Ingress protection for Model 3300 controller
Note: This section applies only to Model 3300 controllers.

If you are installing the Model 3300 in a panel cutout, it may be installed outdoors, if it is installed in
a panel providing a degree of ingress protection IP 65 according to EN 50529 (IEC 529).

If you are installing the Model 3300 in a rack, it should be installed in a rack providing a degree of
ingress protection NEMA 4X according to EN 50529 (IEC 529).

2.7 Frequency input cable length
Note: This section applies only to Model 3300 or Model 3350 controllers.

The maximum length of the frequency input cable has been increased. The maximum length is now
1000 feet (300 meters) of typical 18 AWG (0,80 mm?) instrumentation cable, rather than 500 feet
(150 meters) as documented in the QRGs.

8 Micro Motion® Series 3000 MVD Transmitters and Controllers
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2.8 Model 3350 or Model 3700 display cover orientation (optional)
Note: This section applies only to Model 3350 or Model 3700 devices.

If desired, you can reposition the display on the Model 3350 or Model 3700 device for easier reading
and use. You can rotate it 90°, 180°, or 270°. To do this, follow the instructions below.

1. Use a flat-head screwdriver to loosen the captive
screws that secure the display cover to the housing.

2. Use a flat-head screwdriver to loosen the captive
screws that secure the back cover to the display cover.
Take note of which screw attaches the ground wire to
the back cover.

5
®
e
o
o
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o
5

3. Pull up on the pressure relief valve while removing the
back cover. In this picture, the operator’s right hand is
touching the pressure relief valve.

4. Rotate the display cover to any desired position.

5. Without touching the circuit board, tuck the wiring out
of the way of the circuit board to prevent the wiring
from crimping, then reinstall the back cover.

Configuration and Use Manual 9
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2.9

2.10

10

6. Pull up on the pressure relief valve while pressing the
back cover into place. Be sure to attach the ground
wire to the back cover using the correct screw.
Attaching the ground wire to the wrong screw may
result in crimping of the ground wire.

7. Tuck the wiring out of the way of the connectors to
keep the wiring from crimping, then reinstall the
display cover.

Installing the remote core processor

Note: This section applies only to Model 3500 or Model 3700 devices in remote core processor with
remote transmitter installations.

For dimensions of the remote core processor, see Figure A-4 or Figure B-4.

When mounting the core processor, you can reorient it on the bracket if desired. To do this:
1. Loosen each of the four cap screws (4 mm).
2. Rotate the bracket so that the core processor is oriented as desired.
3. Tighten the cap screws, torquing to 30 to 38 in-1bs (3 to 4 N-m).

Be sure to ground the core processor according to applicable local standards, using either the internal
or external ground screw.

Sensor wiring
Note: This section applies only to Model 3500 or Model 3700 transmitters.

2.10.1  Cable types

All installation types require 4-wire cable. Micro Motion offers two types of 4-wire cable: shielded
and armored. Both types contain shield drain wires.

User-supplied 4-wire cable must meet the following requirements:
* Twisted pair construction
*  The gauge requirements as described in the installation QRG

* The applicable hazardous area requirements, if the device is installed in a hazardous area (see
the ATEX, UL, or CSA documents shipped with the transmitter or available on the Micro
Motion web site)

Micro Motion® Series 3000 MVD Transmitters and Controllers
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Remote core processor with remote transmitter installations also require 9-wire cable. Micro Motion
offers three types of 9-wire cable: jacketed, shielded, and armored. Refer to Micro Motion’s 9-Wire

Flowmeter Cable Preparation and Installation Manual for detailed descriptions of these cable types
and for assistance in selecting the appropriate cable for your installation.

2.10.2  Cable glands in remote core processor with remote transmitter installations

Depending on your transmitter model, several different cable glands may be shipped with the
transmitter and core processor. Refer to Figure 2-1 to identify the cable glands supplied by Micro
Motion. Be sure to use the appropriate cable gland for each component and location.

uibag noA alojeg

Cable glands supplied by Micro Motion

Transmitter model 3700*****B***** Transmitter model 3700*****C*****

568

5
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Cable gland
1/2°-14 NPT or M20 x1.5
used with 4-wire conduit opening

Transmitter models
° 3500**F********
Y 3500**G********
° 3700**F********
° 3700**G********

Cable gland
3/4—14 NPT
used with 9-wire conduit opening

2.11  1/0 wiring

Note: This section applies to all Series 3000 devices.

dnjag suonesiunwwo?) [eubig

2111 Terminals and terminal block locations

To locate the I/O terminal blocks on your Series 3000 platform, see Figure 2-2. To identify the I/O
terminals, see the appropriate terminal label in Figure 2-3.
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1/0 terminal locations

Model 3300 or Model 3500 Model 3300 or Model 3500 Model 3350 or Model 3700
panel-mount rack-mount field-mount

Input/output wiring terminals Input/output wiring terminals Input/output wiring terminals

1/0 terminal labels

Card for Model 3300 or Model 3500 with Label for Model 3300 or Label for Model 3350
screw-type or solder-tail terminals Model 3500 with I/0 cables or Model 3700
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Note: The terminals labeled Comm 1, Comm 2, and Comm 3 are not for I/O wiring.
These terminals are for Micro Motion internal use only.
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2.11.2  Grounding

For all Series 3000 devices, the shields from the I/O wires should be grounded at a single point.
Ground the shields at the remote device, not at the Series 3000 device.

If you are installing a Model 3300 or Model 3500 panel-mount device with I/O cables, the terminal
block ground is available for continuation of user cable shielding to I/O cable shielding. The cable
connector does not connect the I/O cable shielding to the chassis ground. See Figure 2-4.

Figure 2-4  Shield wiring for 1/0 cable to field device

Ground shields at single Terminal block / Model 3300 or Model 3500

point only (at the remote
device, not at the
Series 3000 device) /O cable

—

(3] ~ [ o]
l\ 7\ / U \ ‘/’\

~}--

7_..
Cable shields L

Chassis
Terminal marked =+ / ground
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2.11.3  Installing relays

If you will install a relay to connect the Series 3000 device’s discrete outputs to control devices, see
Appendix D for installation instructions.

Specifications for the Model 3100 relay (supplied by Micro Motion) are provided in Appendix C.

2.12  Digital communications wiring

If you will use digital communications between your Series 3000 device and a remote device (e.g., a
ticket printer, a PLC, a temperature or pressure sensor, or a PC running ProLink II), see Chapter 3 for

wiring instructions.
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Digital Communications Setup

uibag noA alojeg

3.1 About this chapter

This chapter explains how to install wiring for digital communications between the Series 3000
device and a remote device. The following are typical remote devices:

* Ticket printer
* Any PLC or control system
e PC running ProLink II

¢ 375 Field Communicator

uone|elsu|

*  Temperature or pressure sensor
e HART Tri-Loop

Note: This chapter does not discuss configuration of digital communications. To configure digital
communications, see Chapter 13.

3.2 Supported protocols

Table 3-1 describes the digital communications support provided on the Series 3000 device.
HART/Bell 202 is superimposed on the primary mA output, while all RS-485 protocols are
implemented on a dedicated terminal pair.

Series 3000 terminals, physical layers, and protocols
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Terminals Physical layer Protocol

Primary mA output terminals Bell 202 HART

RS-485 terminals RS-485 Modbus
HART
Printer

3.21 Obtaining the components

Identify and obtain the required components according to the physical layers and protocols you
will use.

3.2.2 RS-485 signal converter

RS-232 or USB conversion

If you need to convert the RS-485 signal to an RS-232 or USB signal, signal converters are available
from Micro Motion (part number PLKUSB485KIT or PLK485KIT). Contact Micro Motion for
information about ordering these converters.

Keidsig ayy Buisn
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You may also order the IC521A-F signal converter with a ticket printer. Contact Micro Motion for the
appropriate ETO (engineered-to-order) number.

Depending on your remote device, you may also need a 9-pin to 25-pin adapter.

Note: The ProLink PC Interface Adaptor (PCIA) cannot be used with the Series 3000 device. Because
the PCIA does not control the ready-to-send (RTS) line, communication between the Series 3000
device and the remote device cannot be initiated.

Other conversion

If you need to convert the RS-485 signal to another signal, you must supply the appropriate signal
converter.

3.2.3 Bell 202 signal converter

RS-232 conversion

If you need to convert the Bell 202 signal to an RS-232 signal, as used by a PC’s serial port, signal
converters are available from Micro Motion (part number PLKUSB202KIT or PLK202KIT). Contact
Micro Motion for information about ordering these converters.

You may also need a Bell 202 cable or a 9-pin to 25-pin adapter.

Other conversion

If you need to convert the Bell 202 signal to another signal, you must supply the appropriate signal
converter or HART interface.

3.3 Setting up RS-485 communications
Follow the steps below to set up RS-485 communications between the Series 3000 device and a
remote device.
1. Locate and identify the RS-485 terminals on the Series 3000 device. Refer to Table 3-2 and
Figure 2-2. Additionally, the Series 3000 device has a label or card that shows input/output
wiring terminal designations. See Figure 2-3.
Note: The terminals labeled Comm 1, Comm 2, and Comm 3 are not for I/O wiring. These terminals
are for Micro Motion internal use only.
RS-485 wiring terminals
RS-485 terminals
Model RS-485 terminals location/description A B
Model 3300 or Model 3500 with Input/output wiring terminal block a32 c32
screw-type or solder-tail connectors
Model 3300 or Model 3500 with I/0 terminal block on DIN rail 25 24
I/O cable
Model 3350 or Model 3700 Gray terminal block, non-intrinsically safe wiring 12 11
compartment

16
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2. Using twisted-pair shielded cable, and a signal converter if required, connect the remote device

to the RS-485 output terminals on the Series 3000 device. Maximum cable length between the w
Series 3000 and remote device is 4000 feet (1200 meters). g'-
e Model 3300 or Model 3500 with screw-type or solder-tail terminals: see Figure 3-1 Z
o
e Model 3300 or Model 3500 with I/O cables: see Figure 3-2 ;
«  Model 3350 or Model 3700: see Figure 3-3 S
=
3. Add resistance if required.
4. Configure RS-485 communications as described in Section 13.3.
Model 3300 or Model 3500 with RS-485 signal converter — Screw-type or solder-tail connectors
Input/output terminal block
5
o
D
For long-distance communication, or if noise from an )
external source interferes with the signal, install a 120 Q, %%mgge o
=]

Y2 watt resistor at each end of the wiring loop between the
Series 3000 device and the signal converter

RS-485to RS-232
signal converter

RS-485 A

2 s
4 a
¢ s
8 a
10 e
2 e
14
18 «
18 @
20 @
2 e
M v
20 s
2. e
N a
s & «

%l__. =\=

Serial port connection
Wire size is 24 AWG (0,25 mm?) (with 9-pin to 25-pin

adapter if necessary)

RS-485 B

=
Q
=
2
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o
3
3
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o
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o

Keidsig ayy Buisn

Configuration and Use Manual 17



Digital Communications Setup

Model 3300 or Model 3500 with RS-485 signal converter — /0 cables

Serial port connection
(with 9-pin to 25-pin
adapter if necessary)

) Wire size is 24 AWG (0,25 mm?)
Input/output terminal block RS-485 to RS-232

signal converter
|| % % Ue A A
m T e s

RS-485 A

RS-485 B

Remote
device

For long-distance communication, or if noise
from an external source interferes with the
signal, install a 120 Q, %2 watt resistor at each
end of the wiring loop between the

Series 3000 device and the signal converter

1415161718 192021222324 25 <

HOB0R00000HEH

12345678910111213/

Model 3350 or Model 3700 with RS-485 signal converter

Serial port connection
i (with 9-pin to 25-pin
Input/output terminal block adapter if necessary)

RS-485 to RS-232
signal converter
RS-485 B

% Wire size is 22 AWG (0,35 mmz)%

H e
o

v

RS-485 A
Remote
device

For long-distance communication, or if noise from an
e e external source interferes with the signal, install a 120 Q,
Y2 watt resistor at each end of the wiring loop between the
Series 3000 device and the signal converter
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3.4 Setting up Bell 202 communications

Follow the steps below to set up Bell 202 communications between the Series 3000 device and a 'y
remote device. )
)
1. Locate and identify the primary mA output terminals on the Series 3000 device. Refer to s
Table 3-3 and Figure 2-2. Additionally, the Series 3000 device has a label or card that shows ;
input/output wiring terminal designations. See Figure 2-3. e
S,
Bell 202 wiring terminals
. . Primary mA terminals
Primary mA output terminals
Model location/description + -
Model 3300 or Model 3500 with Input/output wiring terminal block c2 az
screw-type or solder-tail
connectors
Model 3300 or Model 3500 with I/0 terminal block on DIN rail 14 15
I/O cable
Model 3350 or Model 3700 Gray terminal block, non-intrinsically safe 2 1 5..
wiring compartment g
o
S
=]

2. Determine if the primary mA output will be used to report both analog (mA) process data and
HART digital data. It may already be wired for analog output.

3. Using twisted-pair shielded cable, and a signal converter if required, connect the remote device
to the Series 3000 device’s primary mA output terminals. Maximum cable length between the
Series 3000 device and the remote device is 4000 feet (1200 meters).

If the output will be used for HART digital communications only, see the following:
*  Model 3300 or Model 3500 with screw-type or solder-tail terminals: Figure 3-4
e Model 3300 or Model 3500 with 1/O cables: Figure 3-5

e Model 3350 or Model 3700: Figure 3-6

Additionally, the following wiring examples are provided:

* Using the primary mA outputs for both digital communication and analog output
(HART/analog single-loop wiring) — see Figure 3-7

*  Wiring the Series 3000 device to a HART multidrop network — see Figure 3-8
*  Wiring for pressure or external temperature compensation — see Figure 3-9
*  Wiring the Series 3000 device to a HART Tri-Loop — see Figure 3-10

e Wiring for pressure or external temperature compensation with HART Tri-Loop — see
Figure 3-11
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Note: The HART loop is not polarity-sensitive.

4. The HART interface must be connected across a resistance of 250-600 Q. Add resistance to
the connection if necessary.

5. Configure Bell 202 communications as described in Section 13.4.
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Model 3300 or Model 3500 with HART interface — Screw-type or solder-tail connectors

% Wire size is 24 AWG (0,25 mm?)

Remote
600 ©Q maximum loop resistance device

250 Q minimum loop resistance

HART interface

. : 4L

Input/output terminal block ¢ © °

\

Serial port connection
(with 9-pin to 25-pin
adapter if necessary)

2 s
4 e
6 @
s e
10 o
2 e
“ a
18 «
1 e
20 e
2 e
24 4«
28 s
3 e
N e
s B o

Model 3300 or Model 3500 with HART interface — I/0 cahles

Serial port connection
(with 9-pin to 25-pin
adapter if necessary)

) Wire size is 24 AWG (0,25 mm?)
Input/output terminal block \ HART interface

=

]

=l = . . .

mIRP= . ot

SRS

> b=l = Remote

o« S E device
~N

(=

© L)

0 E E = AANP

==

llEp=

N U

— 600 Q maximum loop resistance

250 Q minimum loop resistance
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Model 3350 or Model 3700 with HART interface

w
Serial port connection o
Wire size is 22 AWG (0,35 mm?) (with 9-pin to 25-pin [}
adapter if necessary) ®
s
c
w
HART interface &
A% %A 5
600 Q maximum loop resistance
250 Q minimum loop resistance Remote
device
\ Input/output terminal block
5
o
&
)
=,
)
=

HART/analog single-loop wiring

| W | Resistance: W

* Analog only: 820 Q maximum loop resistance o
HART device * HART only or HART/analog: HART device a
(with optional - 600 Q maximum loop resistance (with optional signal g
signal converter) - 250 Q minimum loop resistance converter) o
o
3
+ - I 3
3 HART device S
with optional signal — o
e Y]
. converter) 1 O g.
. 2 12 ®
7
e - ST 3 13 o
-~ o c
: NS B TEE 5

] ° E ] = 5 15

5 = 6 16

. = D5l =
e ~| [ g Y| 7 17
¢ of [H|w Jum| 8 18
: ==

] < E @] D c
- _ »
‘ of Dol J|— 3
e | [ < «Q
L >~ + %
=
Terminal block for Model 3300 or Terminal block for Model 3300 Terminal block for -a
Model 3500 with screw-type or or Model 3500 with IO cables Model 3350 or Model 3700 Z

solder-tail connectors
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HART multidrop wiring with SMART FAMILY™ transmitters and a configuration tool

HART-compatible 24 VDC loop power
ProLink Il v2.x, transmitters Series 3000 SMART FAMILY™ supply required for
HART Communicator, or AMS transmitters HART 4-20 mA
software passive transmitters
(with HART interffacey .~ |/ N
+ +

600 Q maximum loop resistance
250 Q minimum loop resistance

e

Note: For optimum HART communication, make
sure the output loop is single-point-grounded to
an instrument-grade ground.

Wiring for pressure or external temperature compensation

Primary mA output terminals Resistance as required for your device

\
T
-1 |+ DC power
Series 3000 supply
device Pressure or
temperature
% device —

600 Q maximum loop resistance
250 Q minimum loop resistance
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Wiring for HART Tri-Loop

w
< e
Channel 2 %
< <
2
Primary mA output terminals Channel 3 g
€« Q
\ Channel 1 =
Series 3000 | + DC power
device suppl
HART PPy
% Tri-Loop
< \
Burst input
600 Q maximum loop resistance i
250 Q minimum loop resistance =
o
=
=]

Wiring for pressure or external temperature compensation with HART Tri-Loop

Resistance as required for your device

N

AV —
- |+ DC power
supply
Pressure or
temperature —
device

Channel 2

Primary mA <
output terminals

Channel 3
< Channel 1

1=
Q
=
2
(%}
o
3
3
=
3.
)
o
=
)
S
o
»
@
o
=
o

:< DC power

Series 3000 | + supply
device

HART

%/ Tri-Loop

J_l \

Burst input

600 Q maximum loop resistance
250 © minimum loop resistance
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41 About this chapter

This chapter explains how to use the Series 3000 display and menu system. Using the display, you can
move through the menus, configure the application, monitor and control the application, and perform
maintenance and diagnostic tasks.

4.2 Startup display

When the Series 3000 device is powered on, it automatically tests its display. During display testing,
the screen darkens for approximately five seconds. After the display test is completed:

uone|elsu|

1. The Micro Motion logo is displayed for two to three seconds.
2. An application list is displayed for two to three seconds.
3. The device enters operation mode:

» If the discrete batch application is not installed, the process monitor screen is displayed, as
shown in Figure 4-1.

» If the discrete batch application is installed, the batch process screen is displayed (see
Figure 18-1).

Process Monitor screen

Alarm bar

54 DEVICE 1 —2
Mass Flow Rate

2.33

g/s

dnjas suonesiunwwo) [eubig

Mass Total
485 .88

o)
RESET EXIT

OO ©

VIEW or EXIT
button

Security

button
/
o

4. If there are any active alarms, the alarm category will be displayed in the alarm bar. To view,
acknowledge, or respond to the alarms, see Chapter 22.

c
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5
@
-
=
®
=
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4.3

Menu systems

Most Series 3000 display functions are organized into two menu systems:

* The Management menu allows you to perform configuration and maintenance tasks.

e The View menu allows you to monitor and control the process.

Figures 4-2 and 4-3 show high-level views of these menu systems. For complete menu flowcharts, see

Appendix F.

Management menu

Meter verification®

Management
|
Configuration Maintenance Security Language
System Active alarm log Security Language
Inputs Alarm history Passwords
Discrete batch™ Alarm event log Weights & Measures®
Measurements Batch inventory!"
Outputs Process inventory
Monitoring o Meter flqgg(grprlntlng(z) (1) Displayed only if discrete batch application is installed.
Digital communication éu?g tr;’;_ul (2) Available only on systems with the standard core processor.
D;Igr:gslfi)gs (3) Displayed only if custody transfer application is installed.

(4) Available only on systems with the enhanced core processor,
and only if the meter verification option was purchased.

26

View menu
View
Active alarm Preset Process Density Applications
log selections” totalizers curves® list
Process Batch Diagnostic LCD
monitoring inventory®" monitor options

(1) Displayed only if discrete batch application is installed.
(2) Displayed only if enhanced density application is installed.
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To enter the menus:

* To enter the Management menu system, press the Security button. The Security button is in 'y
the lower right corner of the display, marked with a padlock icon (see Figure 4-1). You may or )
may not be required to enter a password (see the following section). 2
o
* To enter the View menu system, press the VIEW or EXIT button (see Figure 4-1). ;
S
=
4.3.1 Accessing management functions
You can use the Security button to access management functions from any point in the Series 3000
menus. When the Security button is pressed:
e If security is disabled, the Management menu will be displayed immediately. See Figure 4-4.
By default, security is disabled.
» If security has been enabled, you will be prompted to enter a password. See Figure 4-5. There
are two passwords:
- The configuration password enables access to all functions. When it is entered, the
Management menu is displayed. Z
- The maintenance password enables access to the maintenance functions. When it is %
entered, the Maintenance menu is displayed. =
=]

Both passwords consist of a sequence of four cursor control button presses. To enter a password:
1. Press the four cursor control buttons in the correct sequence.
2. Press SEL.

To configure and enable security, see Chapter 5.

Pressing Security button from Process Monitor screen — Security disabled

DEVICE 1

Configuration

Maintenance
Security
Language

5¢ DEVICE 1 —2
Mass Flow Rate

2.33

g/s
Mass Total

485.88

dnjas suonesiunwwo) [eubig

PRINT RESET EXIT
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Pressing Security button from Process Monitor screen — Security enabled

54— DEVICE 1 —2
Mass Flow Rate

2.33

g/s

Enter Password

Mass Total

485.88

PRINT RESET EXIT HELP EXIT

Qs

4.3.2 Shortcuts

From any point in the menu system, you can:

* Return to the Management menu (if security is disabled) or the password entry screen (if
security is enabled) by pressing the Security button, as described in the previous section.

* Return to the operating screen by pressing the Security button, then pressing the EXIT button.

4.4 Using the function buttons

The buttons at the bottom of the display are the function buttons. The functions performed by the
buttons vary, depending on the screen and the current state of the application. The function currently
assigned to the button is always displayed on the screen, above the button. The buttons are sometimes
referred to as F1, F2, and F3. See Figure 4-6.

Note: The left and right cursor control buttons may also be used as function buttons. See Figure 4-6.

If a cursor is shown on the display, the action performed by the function button applies to the item
where the cursor is located. Before pressing a function button, be sure the cursor is located correctly.
See Section 4.5.
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Function bhuttons

ALARMS F3 function button

DEVICE 1

Configuration F1 function button

Maintenance
Security
Language

>

\— F3 function button

VIEW Access the View menu

EXIT Exit to previous menu or cancel a change
NO Cancel action

PREV Return to the previous screen

ABORT ¢ Abort sensor zero
¢ Abort calibration

F2 function button

HELP Show a help screen

RESUME Resume a batch that has been stopped
RESET Reset total

PRINT Print a ticket

NEXT Advance to the next screen

ACKALL Acknowledge all alarms
RESET-T Complete the current custody transfer transaction

F1 function button

START Start batch or totalizers
STOP * Stop totalizers
* Stop batch before target is achieved (batch can be resumed)
END End batch before target is achieved (batch cannot be resumed)
RESET Reset total
SEL Select the highlighted menu item
CHG Make a change to the highlighted menu item
SAVE Save a change
YES Proceed with action
ACK Acknowledge an alarm message
PRINT Print a ticket
CLEAR Reset the rollover indicator (R) for the transfer inventory

Configuration and Use Manual
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Using the Display and Menu System

4.5

4.6

30

Using the cursor control buttons

The cursor control buttons move the cursor around the display menus. In menus, the cursor is a
reverse-video highlight bar.

e Use the Up and Down buttons to locate the cursor at the menu item you want to select or
change.

*  After locating the cursor at the desired menu item, press SEL or CHG, or the Right button, to
select or change the item.

451 Selecting from a list

For enumerated lists, pressing CHG will display a separate screen from which you can choose the
desired option. From that screen:

* Press SAVE to save the change and return to the previous screen, or

*  Press EXIT or the Left button to return to the previous screen without saving.

4.5.2 Changing a variable value

If you need to change the value of a variable, the cursor appears as a line under a character in the
current value.

» If the variable has a value of Yes or No, all cursor control buttons toggle between the two
choices.

e If the variable has a numeric or character value, press the Up and Down cursor control buttons
to increase or decrease the value of the character at the cursor.

o If the variable has more than one digit or character, press the Left and Right cursor control
buttons to move the cursor to the next or previous character.

When the value is correct, press SAVE.

Press EXIT to return to the previous screen without saving.

453 Cursor control example

Figure 4-7 shows a typical configuration sequence involving both a menu item and a variable.
Pressing HELP produces a screen that has help for the item at the cursor.

45.4 Process monitor

In the process monitor, use the Left and Right cursor control buttons to scroll from one screen to the
next or previous screen. There are five screens.

*  Press the Right button to scroll to the next screen.
* Press the Left button to scroll to the previous screen.

* To assign variables to each process monitor screen, see Chapter 12.

Scientific notation

Scientific notation is used on some screens for displaying values that contain more digits than the
display can show, or that exceed the precision of the floating point data type. For example, the value
1234000.000 would be displayed as 1.234E6 or 1.234+6.
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Cursor control huttons

) w
Menu item EXIT o
°
®
Density Move cursor up/Scroll up =
Indicates items - - ¢ c
available to scroll Density Units w
g/cm3 8
Density Damping =
1.7 sec —— SELECT
Current— | 0.005000 g/cm3
selection is Slug Low Limit /
. 0.005000 g/cm3
highlighted =l Move cursor down/Scroll down
O
5
(7]
&
. Move cursor to left =
Variable o
=
S
Density i Increase value at cursor
: : or toggle YES/NO
Density Units
g/cm3
Density Damping .
1.7 sec Move cursor to right
c i | Density Cutoff |
urren 0.005000 g/cm3
selection is g Low Limit
underscored 0.005000 g/cm3

Decrease value at
SAVE HELP EXIT cursor or toggle YES/NO

>

Scroll to previous screen

% Scroll to next screen
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Process monitor

5¢ DEVICE 1 —2
Mass Flow Rate
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Mass Total
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5.1 About this chapter

This chapter explains how to configure security and select the language for the Series 3000 display.
Security and language parameters are listed in Figures 5-1 and 5-2.

Failure to perform configuration tasks in the proper sequence could result in an incomplete

. . . . . (e
configuration. See Section 1.7 for the recommended configuration sequence. )
s
=
A CAUTION 3
(7]
Changing configuration can affect device operation. 'f.._
)
Set control devices for manual operation before changing device configuration. i
Q
5
5.2 Security menu
Use the Security menu, shown in Figure 5-1, to access and configure security and passwords. The
Security menu is accessed through the Management menu, as described in Chapter 4.
To configure security for weights and measures (custody transfer) applications, see Chapter 14.
Security menu ‘g’
S
Security g
3
Q
5
S
=
| @
r—— - - - = A r = - - — — 1
Security Passwords | Weights & Measures® | [ Alarm log®® I
[ (see Chapter 14) | [ (see Chapter 14) |
S | S |
Enable security Maintenance Configuration
Write protect(" * Press 1 * Press 1
Totalizer reset!") * Press 2 * Press 2
* Press 3 * Press 3 Q
* Press 4 * Press 4 3
s
=
(1) Displayed only if the custody transfer application is not installed. 5
(2) Displayed only if the custody transfer application is installed. ‘:
(3) Displayed only if World Area is set to OIML. T
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5.3 Security
Security can be used for the following three functions:
* To control access to the Management menu
*  To write-protect the Series 3000 device configuration

e To control how process totalizers and inventories can be reset

Note: If custody transfer is implemented, the write-protection and totalizer reset control functions are
handled by the custody transfer application, and are not available here. See Chapter 14.

Note: If custody transfer (OIML) is implemented, you can also define an alarm log password to
control access to the active alarm log, the alarm event log, and alarm history. See Chapter 14.

5.3.1 Management menu access
Access to the Management menu can be controlled by two passwords:
*  The configuration password enables access to all Management menus

* The maintenance password enables access to the Maintenance portion of the Management
menu system

When the Security button is pressed (see Section 4.3.1):

* If security is enabled, you will be prompted to enter a password. Depending on the password
you enter, either the Management menu or the Maintenance menu is displayed.

» If security is disabled, the Management menu is displayed immediately.

The configured passwords are stored even if security is disabled, so you can re-enable them at any
time.

It is not possible to activate only the configuration password or only the maintenance password.
To enable security for the Management menu, set Enable Security to Enable.
To disable security for the Management menu, set Enable Security to Disable.

The passwords are a combination of four button presses, using any of the four cursor control buttons:
Up, Down, Left, and Right.

To set a password:

1. Use the menu to select the password you are defining.

2. For Press 1 through Press 4, specify which cursor control button must be pressed.
To enter a password:

1. Press the four cursor control buttons in the correct sequence.

2. Press SEL.

5.3.2 Write-protecting the device configuration

When the device is in write-protect mode, the configuration data stored in the device and core
processor cannot be changed until write-protect mode is disabled.

To enable write-protection, set Write Protect to Enable.
To disable write-protection, set Write Protect to Disable.

Note: If write-protection is enabled, process totalizers cannot be reset unless the flow rate is zero.
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2.4

5.3.3 Controlling process totalizer and process inventory reset

This feature allows you to specify the methods that can be used to reset process totalizers and process
inventories:

* No Reset — Cannot be reset using either the display or remote communications (e.g.,
ProLink II or a HART or Modbus tool).

» Display Only — Can be reset only via the display on the Series 3000 device.

* Remote Only — Can be reset only via remote communications (e.g., ProLink II or a HART or
Modbus tool).

» Display & Remote — Can be reset using any communications method.

For definitions of process totalizers, process inventories, and other totalizer types, and additional
information on managing totalizers and inventories, see Chapter 20.

Language menu

Use the Language menu, shown in Figure 5-2, to access and configure language parameters. The
Language menu is accessed through the Management menu, as described in Chapter 4.

The configured language will be used for all Series 3000 screens. The display changes immediately.

Figure 5-2  Language menu

Language

Language

Language list

Your choice of language affects the notation used for various units. If English is selected, English
notation is used. If French or German is selected, European notation is used.
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6.1 About this chapter
This chapter explains how to configure system data. System parameters are listed in Figure 6-1.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

6.2 System menu

Use the System menu, shown in Figure 6-1, to access and configure system parameters. The System
menu is accessed through the Configuration option of the Management menu. To access the
Management menu, see Chapter 4.

System menu

System
Tag Time Date Alarm severity
Hour Day Electronics alarms
Minute Month Process alarms
Second Year Sensor alarms™"
Configuration alarms

(1) Displayed only if you are configuring a Model 3500 or Model 3700 transmitter.

Configuration and Use Manual
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Configuring System Data

6.3 System parameters

System parameters are defined in Table 6-1.

System parameters

Variable Default Description

Tag® Device 1 * Enter up to 8 digits and/or characters that uniquely identify this platform
* The tag will appear on operation screens

Time Current time Enter 2 digits for hours, 2 digits for minutes, and 2 digits for seconds

Date Current date Enter 4 digits for the year, a character code for the month, and 2 digits for the
ay

Alarm severity Select alarm to be reclassified. See Section 6.3.1, below.

(1) This tag is also known as the HART tag or the software tag. It is not the HART polling address (also called the HART slave address).
To configure the HART polling address, see Section 13.4.

6.3.1 Alarm severity

Alarms are organized into four categories. Within each category, alarms are classified into three levels
of severity. The severity level controls device behavior when the alarm condition occurs. See
Table 6-2.

Alarm severity levels

Severity level Device action

Fault If this condition occurs, an alarm will be generated and all outputs go to their configured
fault levels. See Chapter 8.

Informational If this condition occurs, an alarm will be generated but output levels are not affected.

Ignore IIf tr;is condition occurs, no alarm will be generated (no entry is added to the active alarm
0g).

Some alarms can be reclassified. For example:

*  The default severity level for Alarm A020 (cal. factors missing) is Fault, but you can
reconfigure it to either Informational or Ignore.

* The default severity level for Alarm A102 (drive over-range) is Informational, but you can
reconfigure it to either Ignore or Fault.

If an alarm can be reclassified, the CHG function is assigned to the F1 button. If an alarm cannot be
reclassified, the F1 button is unassigned. The alarm listings in Section 22.7 also provide information
on which alarms can be reclassified.
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71 About this chapter

This chapter explains how to configure inputs. Inputs include all the software parameters listed in
Figures 7-1 and 7-2.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

ejeq wajisAs Burinbiyuon

7.2 Inputs menu

Use the Inputs menu, shown in Figures 7-1 and 7-2, to access and configure input parameters. The
Inputs menu is accessed through the Configuration option of the Management menu. To access the
Management menu, see Chapter 4.

You will be:
*  Configuring core processor parameters:
- Enabling or disabling core processor inputs
- Configuring process variables

- Configuring sensor calibration data

[2)
o
=]
=3
©Q
[=
=1
3
@
3
T
=
=
7]

- Configuring sensor information
- Assigning discrete inputs to actions

*  Configuring the frequency input

*  Configuring the discrete inputs
*  Configuring external inputs
e Configuring LD Optimization
Note: If you are configuring a Model 3300 or Model 3350 controller, the core processor parameters

and external inputs parameters are not displayed. To assign a discrete input to an action on these
platforms, use the frequency input menu shown in Figure 7-2.

1dV Buunbyuod
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Inputs menu - Core processor parameters

Inputs

I'__J___'I

Core processor" | Other inputs |

| SeeFigure7-2 |

L — — — — — 4
| | | | |
Enable/ Configure Sensor cal data Sensor Discrete inputs

Disable process var information

Flow variables

* Flow damping

* Flow direction

* Mass units

* Mass low flow cutoff

¢ Volume flow tg/pe

* Volume units®

* Std gas volume units®

* Std gas volume
cutoff@®

* Std gas density®

* Vol low flow cutoff®

 Special mass units

» Special volume units®

* Special gas std units®

Density
* Density units

T-Series Setup

* Density damping
* Density cutoff

¢ Slug low limit
* Slug high limit
¢ Slug duration

¢ Sensor model no.
¢ Sensor serial no.
¢ Sensor material

* Sensor flange

¢ Sensor liner

Yes
* FCF
*FTG
* FFQ
* D1

Temperature

* Temperature units
* Temperature damping

* D2
* D3
*D4
*K1
s K2

e K3

e K4

*FD

DT

* DTG

* DFQ1
*DFQ2

* Temp. slope

* Temp. offset
¢ Mass factor

* Density factor
¢ Volume factor

No

* Flow cal

* D1

D2

* K1

K2

*FD

* Dens temp coeff
* Temp. cal factor
* Mass factor

* Density factor

* Volume factor

o Start zero

* Reset mass total

* Reset volume total

* Reset API cor vol tot®
* Reset ED std vol tot®

* Reset ED net mass to®
* Reset ED net vol tot®

* Reset all totals

* Start/stop all totals

* Start meter verify™”

LD Optimization

(1) Displayed only if you are configuring a Model 3500 or Model 3700 transmitter.
(2) Displayed only if Volume Flow Type = Liquid Volume.

(3) Displayed only if Volume Flow Type = Gas Standard Volume.

(4) Displayed only on systems with the enhanced core processor.

(5) Displayed only if petroleum measurement application is installed.

(6) Displayed only if enhanced density application is installed.

(7) Displayed only if Smart Meter Verification is installed.
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Figure 7-2

Inputs menu - Frequency input, discrete input, external inputs

Inputs

s (R

| Core processor inputs |
[ See Figure 7-1 |

Frequency input

Flow rate units

Scaling method

Reset all totals™"

Start/Stop all totals'”

Discrete input 1
Discrete input 2

Frequency=flow Pulses/unit Units/pulse None
* Frequency * Pulses/unit * Units/pulse

* Flow * K-factor » K-factor

* K-factor

Discrete inputs

Discrete input1 | 2

External inputs®

Polling variable 1| 2

Polarity * Polling control

* Polling variable

* External tag

* Pressure compensation®

* Pressure units®

* Flow factor®

« Density factor®

« Cal pressure®

* External temperature
compensation®
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(1) Displayed only if you are configuring a Model 3300 or Model 3350 controller.
(2) Displayed only if you are configuring a Model 3500 or Model 3700 transmitter.
(3) Displayed only if Polling Variable is set to Pressure.

(4) Displayed only if Polling Variable is set to Temperature.

1.3 Configuring the core processor parameters
Core processor parameters include:
*  Core processor inputs
*  Process variables
* Sensor calibration data

¢ Sensor information
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7.3.1 Enabling and disabling core processor inputs

Core processor inputs are enabled by default. By disabling the core processor, you disable all core
processor input signals and alarms. Disabling them might be desirable while you are connecting the
sensor, or if you are using only the frequency input to measure flow.

Table 7-1 describes the core processor input options.

Enabling or disabling inputs and alarms

Variable Default Description

Enable core processor Yes If set to No:

* The platform will not use input signals from the sensor to measure flow,
density, or temperature.

* The platform will not produce the following alarms: warming up, cal in
progress, drive overrange, temperature overrange, temperature failure,
sensor failure, transmitter failure, density overrange, density failure, mass
flow overrange, volume overrange, calibration failure, calibration complete,
calibration aborted, RTD failure, charize required, slug flow, slug timeout™.

(1) For more information about alarms, see Chapter 22.

7.3.2 Configuring process variables

Process variables include mass flow, volume flow, density, and temperature. For each process
variable, several parameters can be configured.

Mass flow and volume flow parameters

Mass flow and volume flow parameters are listed and defined in Table 7-2. Note that you can
configure the transmitter to measure either liquid volume flow or gas standard volume flow,
depending on the setting of Volume Flow Type.

Details about the Flow Direction parameter are provided in Table 7-3. Units for mass flow and
volume flow parameters are listed in Tables 7-4 through 7-6. Special units for mass and volume are
defined and described in the section entitled Special units later in this chapter.

Flow parameters

Variable Default Description

Flow damping 0.8 sec * Damping filters out noise or the effects of rapid changes in the flow rate
without affecting measurement accuracy. See the section entitled Damping

later in this chapter. For gas applications, Micro Motion recommends a
minimum flow damping value of 2.56 seconds. Range is 0.0-51.2 seconds.
* Milliamp outputs have an additional damping parameter. See Section 8.4.4.

Flow direction Forward * Controls how flow through the sensor will affect outputs and totalizers.

* For the effect of flow direction on milliamp outputs, see Figure 7-3 if the 4 mA
value of the milliamp output is set to 0, and see Figure 7-4 if the 4 mA value
of the milliamp output is set to a negative value. For a discussion of these
figures, see the examples following the figures. For information on setting the
4 mA value, see Section 8.4.4.

¢ For the effect of flow direction on frequency outputs, totalizers, and flow
values reported via digital communication, see Table 7-3.

Mass units a/s ¢ Select the desired unit of mass flow. See Table 7-4.
* Mass flow outputs and displays will indicate mass flow in the selected unit.
The mass totalizer and inventory will use the corresponding mass unit.

Mass low flow cutoff 0.00000 g/s * Enter the mass flow rate below which mass flow outputs and displays will
indicate zero flow. See the section entitled Cutoffs later in this chapter.
* Milliamp outputs have an additional cutoff parameter. See Section 8.4.4.
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Flow parameters continued

Variable Default Description

Volume flow type Liquid * Select the desired volume flow type.
- If you select Liquid, only liquid volume units are available for measurement
- If you select Gas, only gas standard volume units are available for
measurement. See the section entitled Gas standard volume flow and
standard density.
* If you are using the enhanced density application or the petroleum
measurement application, select Liquid.

Volume units /s * Select the desired unit of liquid volume flow. See Table 7-5. The liquid
volume totalizer and inventory will use the corresponding volume unit.

abenbue @ Ayinoas Bunbyuosn

Volume low flow 0.00000 I/'s ¢ Enter the liquid volume flow rate below which volume flow outputs and
cutoff® displays will indicate zero flow. See the section entitled Cutoffs later in this
chapter.
¢ Milliamp outputs have an additional cutoff parameter. See Section 8.4.4.
Standard gas volume SCFM * Select the desired unit of gas standard volume flow. See Table 7-6. The gas
units® standard totalizer and inventory will use the corresponding volume unit.

Standard gas volume 0.0000 SCFM ¢ Enter the volume flow rate below which volume flow outputs and displays will
cutoff®@® indicate zero flow. See the section entitled Cutoffs later in this chapter.
* Milliamp outputs have an additional cutoff parameter. See Section 8.4.4.

Standard gas density® 0.10000 g/cm® e Enter the standard density of the gas you are measuring. See the section
entitled Gas standard volume flow and standard density

(1) Displayed only if Volume Flow Type = Liquid.
(2) Displayed only if Volume Flow Type = Gas Standard.
(3) Available only on systems with the enhanced core processor.
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Effect of flow direction on milliamp outputs: 4 mA value =0

20 20 20
- = = 0
> =) =] o
8 12 8 12 8 12 3
> > =} —_
o o o «Q
< < < s
€ 4 E 4 E 4 5
Q@
X 0 X X 0 X X 0 X 3
o c
___________ N At RN At RN =
Reverse Forward Reverse Forward Reverse Forward
flow(" flow® flow™ flow® flow(" flow®
Zero flow Zero flow Zero flow
Flow direction parameter: Flow direction parameter: Flow direction parameter:
e Forward only * Reverse only e Absolute value
* Negate/Forward only * Bidirectional
* Negate/Bidirectional
Milliamp output configuration: (1) Process fluid flowing in opposite direction from flow direction arrow on sensor.
e 20 mA value = x (2) Process fluid flowing in same direction as flow direction arrow on sensor.

e 4mAvalue=0
To set the 4 mA and 20 mA values, see
Section 8.4.4.
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Effect of flow direction on milliamp outputs: 4 mA value < 0

20 20 20 v
4 —— | |
'5‘ > > | |
2 12 £ 12 £ 12 [ - |
> o) ° |
o I | I
< < < I | I
g g
€ 4 4 4 ' [ !
| | |
=
Reverse Forward Reverse Forward Reverse Forward
flow™ flow® flow™ flow® flow™ flow®
Zero flow Zero flow Zero flow
Flow direction parameter: Flow direction parameter: Flow direction parameter:
e Forward only * Reverse only e Absolute value
* Negate/Forward only * Bidirectional
e Negate/Bidirectional
Milliamp output configuration: (1) Process fluid flowing in opposite direction from flow direction arrow on sensor.
e 20 mA value = x (2) Process fluid flowing in same direction as flow direction arrow on sensor.
* 4 mA value = —x
e x<0
To set the 4 mA and 20 mA values, see
Section 8.4.4.
Example 1 Configuration:

e Flow direction = Forward only
e  mA output: 4 mA =0 g/s; 20 mA =100 g/s
(See the first graph in Figure 7-3.)

As a result:

e Under conditions of reverse flow or zero flow, the mA output is
4 mA.

* Under conditions of forward flow, up to a flow rate of 100 g/s, the
mA output varies between 4 mA and 20 mA in proportion to (the
absolute value of) the flow rate.

¢ Under conditions of forward flow, if (the absolute value of) the flow
rate equals or exceeds 100 g/s, the mA output will be proportional
to the flow rate up to 20.5 mA, and will be level at 20.5 mA at
higher flow rates.
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Example 2 Configuration:
* Flow direction = Reverse only
e mA output: 4 mA =0 g/s; 20 mA = 100 g/s
(See the second graph in Figure 7-3.)

As a result:

¢ Under conditions of forward flow or zero flow, the mA output is
4 mA.

e Under conditions of reverse flow, up to a flow rate of 100 g/s, the
mA output varies between 4 mA and 20 mA in proportion to the
absolute value of the flow rate.
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¢ Under conditions of reverse flow, if the absolute value of the flow
rate equals or exceeds 100 g/s, the mA output will be proportional
to the absolute value of the flow rate up to 20.5 mA, and will be
level at 20.5 mA at higher absolute values.

Example 3 Configuration:
*  Flow direction = Forward only
¢ mA output: 4 mA =-100 g/s; 20 mA = 100 g/s
(See the first graph in Figure 7-4.)
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As a result:
¢ Under conditions of zero flow, the mA output is 12 mA.
¢ Under conditions of forward flow:

- Up to a flow rate of 100 g/s, the mA output varies between
12 mA and 20 mA in proportion to (the absolute value of) the
flow rate.

- If (the absolute value of) the flow rate equals or exceeds
100 g/s, the mA output is proportional to the flow rate up to
20.5 mA, and will be level at 20.5 mA at higher flow rates.

¢ Under conditions of reverse flow:
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- Up to a flow rate of 100 g/s, the mA output varies between
4 mA and 12 mA in inverse proportion to the absolute value of
the flow rate.

- Ifthe absolute value of the flow rate equals or exceeds 100 g/s,
the mA output is inversely proportional to the flow rate down to
3.8 mA, and will be level at 3.8 mA at higher absolute values.
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Effect of flow direction on frequency outputs, discrete outputs, totalizers, and
digital communications

Forward flow("

Frequency Flow values via
Flow direction value outputs Discrete outputs® Flow totals digital comm.
Forward only Increase OFF Increase Positive
Reverse only OHz OFF No change Positive
Bidirectional Increase OFF Increase Positive
Absolute value Increase OFF Increase Positive®
Negate/Forward only Zero® ON No change Negative
Negate/Bidirectional Increase ON Decrease Negative

Zero flow

Frequency Flow values via
Flow direction value output Discrete outputs Flow totals digital comm.
All OHz OFF No change 0

Reverse flow

Frequency Flow values via
Flow direction value outputs Flow totals digital comm.
Forward only 0 Hz ON No change Negative
Reverse only Increase ON Increase Negative
Bidirectional Increase ON Decrease Negative
Absolute value Increase OFF Increase Positive®
Negate/Forward only Increase OFF Increase Positive
Negate/Bidirectional Increase OFF Increase Positive

(1) Process fluid flowing in same direction as flow direction arrow on sensor.

(2) Applies only if the discrete output has been configured to indicate flow direction. See Section 8.3.2.
(3) Refer to the digital communications status bits for an indication of whether flow is positive or negative.

(4) Process fluid flowing in opposite direction from flow direction arrow on sensor.
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Mass flow units

Unit Software label
Grams per second g/s
Grams per minute g/min
Grams per hour g/hr
Kilograms per second kag/s
Kilograms per minute kg/min
Kilograms per hour kg/hr
Kilograms per day kg/day
Metric tons (1000 kg) per minute t/min
Metric tons (1000 kg) per hour t/hr
Metric tons (1000 kg) per day t/day
Pounds per second Ib/s
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Mass flow units continued

Unit Software label
Pounds per minute Ib/min

Pounds per hour Ib/hr

Pounds per day Ib/day

Short tons (2000 Ib) per minute STon/min

Short tons (2000 Ib) per hour STon/hr

Short tons (2000 Ib) per day STon/day

Long tons (2240 Ib) per hour LTon/hr

Long tons (2240 Ib) per day LTon/day
Special unit (see the following section entitled Special units) Special

Volume flow units - Liquid

Unit Software label
Cubic feet per second cuft/s
Cubic feet per minute cuft/min
Cubic feet per hour cuft/hr
Cubic feet per day cuft/day
Cubic meters per second cum/s
Cubic meters per minute cum/min
Cubic meters per hour cum/hr
Cubic meters per day cum/day
U.S. gallons per second Usgps
U.S. gallons per minute Usgpm
U.S. gallons per hour Usgph
U.S. gallons per day Usgpd
Million U.S. gallons per day MilGal/day
Liters per second I/s

Liters per minute I/min
Liters per hour I/hr
Million liters per day MilL/day
Imperial gallons per second UKgps
Imperial gallons per minute UKgpm
Imperial gallons per hour UKgph
Imperial gallons per day UKgpd
Barrels® per second bbl/s
Barrels" per minute bbl/min
Barrels" per hour bbl/hr
Barrels" per day bbl/day
Beer barrels® per second b bbl/s
Beer barrels® per minute b bbl/min

Configuration and Use Manual
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Volume flow units — Liquid continued

Unit Software label
Beer barrels® per hour b bbl/h
Beer barrels® per day b bbl/d
Special unit (see the following section entitled Special units) Special

(1) Unit based on oil barrels (42 U.S. gallons).
(2) Unit based on beer barrels (31 U.S. gallons).

Volume flow units — Gas standard

Unit Software label
Standard liters per second Sl/s
Standard liters per minute SI/min
Standard liters per hour Sl/h
Standard liters per day Si/d
Normal cubic meters per second Nm3/s
Normal cubic meters per minute Nm3/min
Normal cubic meters per hour Nm3/h
Normal cubic meters per day Nm3/d
Standard cubic feet per second SCFS
Standard cubic feet per minute SCFM
Standard cubic feet per hour SCFH
Standard cubic feet per day SCFD
Standard cubic meters per second Sm3/s
Standard cubic meters per minute Sm3/min
Standard cubic meters per hour Sm3/h
Standard cubic meters per day Sm3/d
Special unit (see the following section entitled Special units) Special

Gas standard volume flow and standard density

If you set Volume Flow Type to Gas Standard Volume, you must enter the standard density of the gas
you are going to measure (i.e., the density of the gas at reference conditions):

e If you know the standard density, you can enter that value in the Standard Gas Density field.
For optimal measurement accuracy, be sure the standard density you enter is correct and fluid

composition is stable.

* If you do not know the standard density of the gas, and you can connect to the Series 3000

device using ProLink II, you can use the Gas Wizard.

To use the Gas Wizard:
1. Click ProLink > Configure > Flow.
2. Click Gas Wizard.
3. If your gas is listed in the Choose Gas list:
a. Select the Choose Gas radio button.

b. Select your gas.
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4. If your gas is not listed, you must describe its properties.
a. Select the Enter Other Gas Property radio button.

b. Select the method that you will use to describe its properties: Molecular Weight, Specific
Gravity Compared to Air, or Density.

c. Provide the required information. Note that if you selected Density, you must enter the
value in the configured density units and you must provide the temperature and pressure at
which the density value was determined, using the configured temperature and pressure
units.

5. Click Next.

6. Verify the reference temperature and reference pressure. If these are not appropriate for your
application, click Change Reference Conditions and enter new values for reference
temperature and reference pressure.
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7. Click Next. The calculated standard density value is displayed.

e If the value is correct, click Finish. The value will be written to transmitter
configuration.

» If the value is not correct, click Back and modify input values as required.

Note: The Gas Wizard displays density, temperature, and pressure in the configured units. If required,
you can configure the transmitter to use different units.
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Special units

If you need to use a non-standard unit of measure, you can create one special measurement unit for
mass flow, one special measurement unit for liquid volume flow, and one special measurement unit
for standard gas volume flow.

Note: If you create a special measurement unit for liquid volume flow and another for gas standard
volume flow, the Series 3000 will store both definitions. However, only one is available at a time.

Special measurement units consist of:
*  Base unit — a combination of:

- Base mass or base volume unit — a measurement unit that the transmitter already
recognizes (e.g., kg, m’)

- Base time unit — a unit of time that the transmitter already recognizes (e.g., seconds, days)
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*  Conversion factor — the number by which the base unit will be divided to convert to the special
unit

*  Special unit — a non-standard volume flow or mass flow unit of measure that you want to be
reported by the transmitter

These terms are related by the following formula:
x[BaseUnit(s)] = y[SpecialUnit(s)]

x[BaseUnit(s)]

ionFactor =
ConversionFactor y[SpecialUnit(s)]
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To create a special unit, you must:

1. Identify the simplest base volume or mass and base time units for your special mass flow or
volume flow unit. For example, to create the special volume flow unit pints per minute, the
simplest base units are gallons per minute:

Base volume unit: gallon

Base time unit: minute

2. Calculate the conversion factor using the formula below:

1 (gallon per minute)

8 (pints per minute)

= 0.125 (conversion factor)

Note: 1 gallon/minute = 8 pints/minute.

3. Name the new special mass flow or volume flow measurement unit and its corresponding
totalizer measurement unit:

Special volume flow measurement unit name: Pint/min

Volume totalizer measurement unit name: Pints

Special unit parameters are listed and defined in Table 7-7.

Special unit parameters

Variable Default Description

Base mass unit g Enter the base unit to be used for the special unit for mass flow.

Base mass time Sec Enter the base time unit to be used for the special unit for mass flow.

Mass flow 1.0000 Enter the conversion factor that will be used to calculate the special unit for mass

conversion factor flow.

Mass flow text NONE Enter the name to be used for the special unit for mass flow. The name can contain
up to 8 characters.

Mass total text NONE Enter the name to be used for the mass totalizer. The name can contain up to 8
characters.

Base volume unit | Enter the base unit to be used for the special unit for liquid volume flow.

Base volume time Sec Enter the base time unit to be used for the special unit for liquid volume flow.

Volume flow 1.0000 Enter the conversion factor that will be used to calculate the special unit for liquid

conversion factor volume flow.

Volume flow text  NONE Enter the name to be used for the special unit for liquid volume flow. The name can
contain up to 8 characters.

Volume total text NONE Enter the name to be used for the special unit for the liquid volume totalizer. The
name can contain up to 8 characters.

Base gas volume SCF Enter the base unit to be used for the special unit for gas standard volume flow.

unit

Base gas volume  Min Enter the base time unit to be used for the special unit for gas standard volume flow.

time

Gas volume flow  1.0000 Enter the conversion factor that will be used to calculate the special unit for gas

conversion factor standard volume flow.

Gas volume flow  NONE Enter the name to be used for the special unit for gas standard volume flow. The

text name can contain up to 8 characters.

Gas volume total NONE Enter the name to be used for the special unit for the gas standard volume totalizer.

text

The name can contain up to 8 characters.
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Density parameters

Density parameters are listed and defined in Table 7-8. Density units are listed in Table 7-9.

Density parameters

Variable Default Description

Density units g/cm?® * Select the desired unit of density. See Table 7-9.

* Density outputs and displays will indicate density in the selected unit.

Density damping 1.6 sec * Damping filters out noise or the effects of rapid changes in density without
affecting measurement accuracy. See the section entitled Damping later in this
chapter. Range is 0.0-51.2 seconds.

* Milliamp outputs have an additional damping parameter. See Section 8.4.4.

Density cutoff 0.2 g/cm® * Enter the density value below which density outputs and displays will indicate zero
density. See the section entitled Cutoffs later in this chapter.

Slug low limit 0.000000 * Enter the desired low limit, in g/cm?®, for the process density. Range is

g/cm?® 0.0-10.0 g/cm®.
* The entered value is the density below which a slug flow alarm will be generated.
* For more information about slug flow, see Slug flow alarms in Section 22.7.3.
Slug high limit 5.000000 * Enter the desired high limit, in g/cm?, for the process density. Range is
g/cm?® 0.0-10.0 g/cm?.
* The entered value is the density above which a slug flow alarm will be generated.
* For more information about slug flow, see Slug flow alarms in Section 22.7.3.
Slug duration 0.0 sec * Enter the number of seconds for which flow outputs will hold their last measured

flow rate while density is outside the range specified by the slug low limit and slug
high limit. Range is 0.0-60.0 seconds.

* If a value of 0.0 is entered, flow outputs will go to the level that indicates zero flow
as soon as slug flow is detected.

* For more information about slug duration, see Slug flow alarms in Section 22.7.3.

Density units

Unit Software label
Specific gravity unit SGU (not temperature corrected)
Grams per cubic centimeter g/cm3

Kilograms per cubic meter kg/m3

Pounds per U.S. gallon Ib/gal

Pounds per cubic foot Ib/cuft

Grams per milliliter g/mL

Kilograms per liter kg/L

Grams per liter g/L

Pounds per cubic inch Ib/Culn

Short ton per cubic yard STon/CuYd
Degrees API deg API

Configuration and Use Manual
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Temperature parameters

Temperature parameters are listed and defined in Table 7-10.

Temperature parameters

Variable Default Description

Temperature units degC ¢ Select °Celsius, °Fahrenheit, °Rankine, or °Kelvin.

* Temperature outputs and displays will indicate temperature in the selected
unit.

Temperature damping 4.8 sec * Damping filters out noise or the effects of rapid changes in temperature
without affecting measurement accuracy. See the section entitled Damping
later in this chapter. Range is 0.0-38.4 seconds.

* Milliamp outputs have an additional damping parameter. See Section 8.4.4.
Damping
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A damping value is a period of time, in seconds, over which the process variable value will change to
reflect 63% of the change in the actual process. Damping helps the transmitter smooth out small,
rapid measurement fluctuations:

A high damping value makes the output appear to be smoother because the output must change
slowly.

A low damping value makes the output appear to be more erratic because the output changes
more quickly.

You can change the damping values for flow (mass and volume), density, and temperature.

When configuring damping values, note the following:

Be sure

Liquid volume flow is derived from mass and density measurements; therefore, any damping
applied to mass flow and density will affect liquid volume measurement.

Gas standard volume flow is derived from mass flow measurement, but not from density
measurement. Therefore, only damping applied to mass flow will affect gas standard volume
measurement.

You can also configure damping specifically for the milliamp outputs (see Section 8.4.4). If
damping is configured for flow, density, or temperature, the same process variable is assigned
to a milliamp output, and added damping is also configured for the milliamp output, the effect
of damping the process variable is calculated first, and the added damping calculation is
applied to the result of that calculation.

to set damping values accordingly.

When you specify a new damping value, it is automatically rounded down to the nearest valid
damping value. Flow, density, and temperature have different valid damping values.

Valid damping values are listed in Table 7-11.

Valid damping values

Process variable Valid damping values
Flow (mass and volume) 0,.2,.4,8,..512
Density 0,.2,.4,.8,..512

Temperature 0,.6,12,24,48,..384
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Cutoffs

Cutoffs are user-defined values below which the transmitter reports a value of zero for the specified
process variable. Cutoffs can be set for mass flow, volume flow, or density.

When setting cutoffs, keep the following points in mind:

e The mass flow cutoff is not applied to the volume flow calculation. Even if the mass flow
drops below the cutoff, and therefore the mass flow indicators go to zero, the volume flow rate
will be calculated from the actual mass flow process variable.

* The density cutoff is applied to the volume flow calculation. Accordingly, if the density drops
below its configured cutoff value, the volume flow rate will go to zero.
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* Both mA outputs have cutoffs (see Section 8.4.4). If the mA outputs are configured for mass or
volume flow, and these cutoffs are set to a greater value than the mass and volume cutoffs, the
flow indicators will go to zero when the mA cutoff is reached. If the mA cutoffs are set to a
lower value than the mass or volume cutoff, the flow indicator will go to zero when the mass or
volume cutoff is reached.

Be sure to set cutoff values accordingly.

71.3.3 Sensor calibration data
Note: This section is not applicable to the Model 3300 or Model 3350 controller.
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Sensor calibration data describe the sensor’s sensitivity to flow, density, and temperature. The term
“characterization” is frequently used to refer to the process of configuring the transmitter with this
information. The characterization procedure depends on whether or not the transmitter is currently
attached to a sensor, and if it is, the sensor type: T-Series or Other.

e If a sensor is currently attached, the transmitter will automatically display the appropriate
calibration parameters for the sensor type.

* If no sensor is currently attached, you must select T-Series Setup and specify:
- Yes —if you want to configure T-Series calibration factors
- No —if you want to configure calibration factors for any other sensor

See Figure 7-1 for a list of the sensor calibration parameters required for your sensor.

Preconfigured calibration data

If the core processor and sensor in your Series 3000 system were ordered together, then the flowmeter
has already been characterized. You need to characterize the flowmeter only if the core processor and
sensor are being paired together for the first time.

2]
o
=]
=3
©Q
[=
=1
3
@
3
T
=
=
7]

Calibration data on sensor tags

The characterization parameters are provided on the sensor tag. The format of the sensor tag varies
depending on your sensor’s date of purchase. See Figures 7-5 and 7-6 for illustrations of newer and
older sensor tags.

Note: On some sensors, the Temperature Coefficient (DT) is shown as TC.
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Sample calibration tags — T-Series sensors

Newer tag Older tag
( h e A
MODEL T100T628SCAZEZZZZ S/N 1234567890 MODEL T100T628SCAZEZZZZ S/N 1234567890
FLOW FCF XXXX.XX.XX FLOW FCF X.XXXX FT X. XX
FTG X.XX FFQ X . XX FTG X.XX FFQ XXX
DENS D1 X .XXXXX K1 XXXXX XXX DENS D1 X.XXXXX K1 XXXXX . XXX
D2 X.XXXXX K2 XXXXX . XXX D2 X.XXXXX K2 XXXXX . XXX
DT X.XX FD XX . XX DT X.XX FD XX . XX
DTG X.XX DFQ1 XX.XX DFQ2 X.XX DTG X.XX DFQ1 XX. XX DFQ2 X.XX
TEMP RANGE —-XXX TO XXX C TEMP RANGE -XXX TO XXX C
TUBE*  CONNxx  CASE=x TUBE*  CONNxx  CASEx
XXXX XXXXX XXXX XXXXXX XXXX XXXXX XXXX XXXXXX
\_ *x MAXIMUM PRESSURE RATING AT 25°C, ACCORDING TO ANSI/ASME B16.5, OR MFR'S RATING Y, \_ *#+ WAXIWM PRESSLRE RATING AT 25°C, ACCORDING TO ANSI/ASME B16.5, OR MFR'S RATING )

Sample calibration tags — All sensors except T-Series

Newer tag Older tag
- ~ . N
'\SA%EI)EL Sensor S/N
FLOW CALx 19.0005.13 Meter Type
DENS CALx 12502142824 .44 Meter Factor
D1 0.0010 K1 12502.000 Flow Cal Factor 19.0005.13
D2 0.9980 K2 14282.000 Dens Cal Factor 12500142864 .44
TC4.44000 FD 310 Cal Factor Ref to 0°C
TEMP RANGE TO C TEMP oC
TUBE**  CONNx** CASE %% TUBE % CONN ¥ %
«AX. PRESSURE RATING AT 25°C, ACCORDING TO ASWE B31
”&lill Tmnm%c ABWINCTD 1.3 « HAX. PRESSURE RATING AT 25°C, ACCORDING TOANS\/ASME B1550R MFR’S RATING.

Km MAXINUM PRESSURE RATING AT 25C. ACCORDING TO Abqsmsv: B16.5 OR MFR'S RATING

Density calibration factors
If your sensor tag does not show a D1 or D2 value:

¢ For DI, enter the Dens A or D1 value from the calibration certificate. This value is the
line-condition density of the low-density calibration fluid. Micro Motion uses air.

¢ For D2, enter the Dens B or D2 value from the calibration certificate. This value is the
line-condition density of the high-density calibration fluid. Micro Motion uses water.

If your sensor tag does not show a K1 or K2 value:

* For K1, enter the first 5 digits of the density calibration factor. In the sample tag in Figure 7-6,
this value is shown as 12500.

* For K2, enter the second 5 digits of the density calibration factor. In the sample tag in
Figure 7-6, this value is shown as 14286.

If your sensor does not show an FD value, contact Micro Motion customer service.

If your sensor tag does not show a DT or TC value, enter the last 3 digits of the density calibration
factor. In the sample tag in Figure 7-6, this value is shown as 4.44.
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Flow calibration values

Two separate values are used to describe flow calibration: a 6-character FCF value and a 4-character
FT value. Both values contain decimal points. During characterization, these are entered as a single
10-character string that includes two decimal points.

To obtain the required value:

*  For older T-Series sensors, concatenate the FCF value and the FT value from the sensor tag, as
shown below.

Flow FCF X.XXXX FT X.XX

*  For newer T-Series sensors, the 10-character string is represented on the sensor tag as the FCF
value. The value should be entered exactly as shown, including the decimal points. No
concatenation is required.
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» For all other sensors, the 10-character string is represented on the sensor tag as the Flow Cal
value. The value should be entered exactly as shown, including the decimal points. No
concatenation is required.

Other calibration values

Temperature calibration factors are described in Table 7-12.
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Meter factors allow you to modify the transmitter’s output so that it matches an external measurement
standard. See Chapter 21 for more information.

All other values are configured exactly as they are shown on the sensor tag. Note the following:

* D3 and D4 density factors are used only if a D3 or D4 density calibration has been performed
in the field (see Section 21.5).

* K3 and K4 factors represent the calibration values at D3 and D4 respectively, and are
configured only when the D3 and D4 density factors are configured.

0
o
Temperature calibration values 2
E
Variable 5
(=]
T-Series sensors  Other sensors Default Description ]
c
Temperature slope Temp cal 1.000000 e This value represents the temperature slope. The default 7]
(first 7 characters) value is used for most applications. If you perform a
temperature calibration, this value is updated
automatically.
* To perform a temperature calibration, see Section 21.6.
Contact Micro Motion customer service before performing
a temperature calibration.
Temperature offset Temp cal 0.000000 e+ This value represents the temperature offset. The default
(last 6 characters) value is used for most applications. If you perform a

temperature calibration, this value is updated
automatically.

* To perform a temperature calibration, see Section 21.6.
Contact Micro Motion customer service before performing
a temperature calibration.
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LD Optimization is a special compensation that is specifically for hydrocarbon liquids. LD
Optimization should not be used with any other process fluids. LD Optimization is available only with
certain large sensor sizes. If your sensor can benefit from LD Optimization, the enable/disable option
will appear in ProLink II or on the display.

A CAUTION

If you send the transmitter to a calibration facility to perform a water
calibration, either during startup or any time thereafter, LD Optimization
must be disabled. When you have completed the calibration, re-enable LD
Optimization.

7.3.4 Sensor information

Sensor information includes parameters that serve as references without affecting calibration
parameters, totalizers, or outputs. These parameters are informational and not required.

Sensor information parameters are listed and defined in Table 7-13.

Sensor information parameters

Variable Default Description

Sensor model no. Uninitialized Automatically set based on calibration data, and cannot be changed.
Sensor serial no. 0 Enter the serial number that is on the sensor serial number tag.
Sensor material Unknown Select the appropriate sensor flow tube material.

Sensor flange Unknown Select the appropriate flange.

Sensor liner None Select the appropriate liner material for the sensor flow tubes.
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7.3.5 Discrete inputs

Note: Be sure to distinguish these discrete input parameters from the discrete input parameters
described in Section 7.5, which are used to describe the discrete input signal.

The discrete input parameters allow you to specify a transmitter action that will occur when:

* AnON signal is received from a discrete input (see Section 7.5 for information on configuring
the discrete input signal)

* A discrete event occurs (see Chapter 10 for information on configuring discrete events)

You can assign one or more actions to a single discrete input or discrete event. All assigned actions
will be performed. Actions and assignments for discrete inputs and discrete events are listed and
defined in Table 7-14.

Note: If you are configuring a Model 3300 or Model 3350 controller, refer to Section 7.4 to assign an
action to a discrete input.

Note: To assign a batch control function to a discrete input or a discrete event, see Chapter 11. To
assign a print function to a discrete input or discrete event, see Chapter 15.
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Discrete input actions and assignments

Action Default Assignment Description

Start zero None None Starts the sensor zero process. See Section 16.3.
Discrete input 1
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Reset mass total None Discrete input 2 Resets the value of the mass totalizer to zero.
Reset volume total None Discrete event 1 Resets the value of the liquid volume totalizer to zero.
Discrete event 2 -
Reset GStd vol total None Discrete event 3 Resets the value of the gas standard volume totalizer
Discrete event 4 to zero.
Reset API corrected None Discrete event 5 Resets the value of the API corrected volume totalizer
volume total™ to zero.
Reset ED standard None Resets the value of the ED standard volume totalizer
volume total® to zero.
Reset ED net mass None Resets the value of the ED net mass totalizer to zero.
total®
Reset ED net volume None Resets the value of the ED net volume totalizer to g
total® zero. 2
Reset all totals None Resets the value of all totalizers to zero. s
=]
Start/stop all totals None * |f totalizers are stopped, starts all totalizers. «Q
* |f totalizers are started, stops all totalizers. -‘<:
Start meter verify® None « Starts a Smart Meter Verification test. See g
Section 21.2.1.
S
(1) Displayed only if petroleum measurement application is installed. &

(2) Displayed only if enhawnced density application is installed.
(3) Displayed only on systems with Smart Meter Verification.

1.4 Configuring the frequency input

Frequency input parameters define how the frequency input is used to represent process data.
Frequency input parameters are listed and defined in Table 7-15.

0

. o

Frequency input parameters 4

«Q

[=

Variable Default Description 5
(=]

Flow rate units kg/min Select the desired unit of mass flow or volume flow. See Table 7-4. 5
T

Scaling method Frequency = flow * Select frequency = flow, pulses/unit, or units/pulse. E’

* The frequency input has a range of 0 to 20,000 Hz.

Frequency 1000.000 Hz If Frequency = flow is selected as the scaling method, enter the frequency (or
pulse rate), in Hz, that represents the configured flow rate.

Flow 999.9999 kg/min If Frequency = flow is selected as the scaling method, enter the flow rate that is
represented by the configured frequency.

Pulses 60.00 pulses If Pulses/unit is selected as the scaling method, enter the number of input
pulses that represents one mass or volume unit.

Units 0.0167 kg If Units/pulse is selected as the scaling method, enter the number of mass or
volume units that is represented by one input pulse.

K-factor 1.0000 * The K-factor is used for proving a Model 3300 or Model 3350 controller, for

which meter factors are not available. To calculate the K-factor, see the
following example. The resulting value must be between 0.0001 and 2.0000.

* The entered value serves as a scaling factor for flow rate outputs and
displays.

1dV Buunbyuod
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Frequency input parameters continued

Variable Default Description

Reset all totals! None Specify the discrete input or discrete event that will trigger this action.
Start/Stop all None Specify the discrete input or discrete event that will trigger this action.
totals!"

(1) Displayed only if you are configuring a Model 3300 or Model 3350 controller.

Example A Model 3300 controller indicates a flow rate of 5483 grams per
minute. Calibration of the reference flow element reveals that the actual
flow rate is 5482 grams per minute.

Use the following formula to calculate the K-factor:

Reference flow rate
Indicated flow rate

K-factor =

5482 g/min _ 0.9998

K-factor = =——=<——
5483 g/min

Enter a K-factor of 0.9998.

For more assistance on configuring the frequency input parameters, see the information provided for
configuring the frequency output parameters, in Section 8.5.

1.5 Configuring the discrete inputs

Note: Be sure to distinguish these discrete input parameters from the discrete input parameters
described in Section 7.3.5, which are used to assign actions to discrete inputs and discrete events.

These parameters allow you to describe the signal used by the discrete inputs. You can configure each
discrete input separately. Discrete input options are listed and defined in Table 7-16. See

Section 7.3.5, Section 11.7, and Chapter 15 for a discussion of the different actions that can be
triggered by a discrete input.

Discrete input parameters

Polarity Default Description
Active low Active low * The input is considered active when the input level is between 0.0 and 0.8 V.
* The input is considered inactive when the input level is between 3.0 and
30.0V.
Active high * The input is considered active when the input level is between 3.0 and
30.0V.
* The input is considered inactive when the input level is between 0.0 and
0.8 V.
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7.6 Configuring the external inputs

External input parameters are used to configure polling. Polling is used to retrieve temperature or
pressure data from an external device over a HART/Bell 202 connection. You may poll for either
temperature or pressure, or both.

Note: Pressure compensation and external temperature are optional. Configure pressure
compensation only if your sensor is subject to pressure effect and if the operating pressure is
significantly different from calibration pressure. External temperature compensation is used to
provide an external temperature value for the petroleum measurement application or the enhanced
density application. If you have core processor v2.1 or earlier, the external temperature data is used
for all calculations that require temperature values. If you have core processor v2.2 or later, the
external temperature data is used only for calculation of the derived variable in enhanced density
applications or the CTL (Correction for Temperature on volume of Liquids) value in petroleum
measurement applications. To determine your core processor version, use the Applications List from
the View menu (see Section 17.5.9).

abenbue @ Ayinoas Bunbyuosn

(%)
o
Note: If you poll for temperature or pressure, ensure that the external measurement device is accurate =L
and reliable. ‘g
. . . 5
To set up polling, you must configure the external input parameters and you must also ensure that the ‘3’
primary milliamp output has been wired for HART protocol (see Section 3.4). The external input S
parameters are listed and defined in Table 7-17. Fan"
s
External input parameters =
Variable Default Description
Polling control Do not poll You can configure polling control for an external temperature device, an

external pressure device, or both:

* Do not poll — polling will not occur.

* Poll as primary — The Series 3000 device will poll the external HART device
as a primary master. Choose this option if the external device will probably
be accessed by another device acting as a secondary master (e.g., a HART

Communicator). g)
¢ Poll as secondary — The Series 3000 device will poll the external HART 3
device as a secondary master. Choose this option if the external device will Q
probably be accessed by another device acting as a primary master. g
If polling both a temperature device and a pressure device, you must configure a
the same polling control method for both. In other words, you cannot poll one =
external device as a primary master and the other external device as a ©
secondary master. However, you can disable polling for one device, then poll %
the other device as either a primary or secondary master.
Polling variable None Select the process data to be polled through this polling variable:
* Temperature
* Pressure
*None
External tag NONE Enter the HART tag of the external device to be polled for temperature or
pressure.
Pressure Disable ¢ Select Enable to enable pressure compensation.
compensationt™ * Select Disable to disable pressure compensation.
Pressure units PSI Select the pressure unit that is used by the remote device that you are polling

for pressure.

Flow factor” 0.0000 % per PSI  The percent change in the flow rate per PSI. Not all sensors or applications
require a pressure correction factor for flow. For the value to be used, see the
product data sheet for your sensor, then reverse the sign of the value listed for
pressure effect for flow (e.qg., if the pressure effect is 0.000004 % per PSI,
enter a pressure correction factor of —0.000004 % per PSI).

1dV Buunbyuod
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External input parameters continued

Variable

Default

Description

Density factor"

0.0000 g/cm3 per
PSI

The change in fluid density per PSI. Not all sensors or applications require a
pressure correction factor for density. For the value to be used, see the product
data sheet for your sensor, then reverse the sign of the value listed for
pressure effect for density (e.g., if the pressure effect is 0.000004 % per PSI,
enter a pressure correction factor of —0.000004 % per PSI).

Calibration 0.0000 PSI The pressure at which the flowmeter was calibrated (which therefore defines

pressure'” the pressure at which there will be no effect on the calibration factor). Refer to
the calibration document shipped with your sensor. If the data is unavailable,
use 20 psi.

External Disable ¢ Select Enable to enable external temperature compensation.

temperature * Select Disable to disable external temperature compensation.

compensation®

(1) Displayed only if Polling Variable is set to Pressure.
(2) Displayed only if Polling Variable is set to Temperature.
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8.1

8.2

About this chapter

This chapter explains how to configure outputs. Outputs include all the software parameters listed in
Figure 8-1.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

Outputs menu

Use the Outputs menu, shown in Figure 8-1, to access and configure output parameters. The Outputs
menu is accessed through the Configuration option of the Management menu. To access the
Management menu, see Chapter 4. You will be configuring:

* Discrete outputs
e Milliamp (mA) outputs

* Frequency output

Configuration and Use Manual 61
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62

Outputs menu

Outputs

Discrete outputs

Milliamp outputs

Frequency output

Discrete output

-
N
w

Milliamp output 1 2

Polarity
* Active high
* Active low

Assignment

¢ Discrete input 1

* Discrete input 2

* Discrete event 1

* Discrete event 2

* Discrete event 3

¢ Discrete event 4

* Discrete event 5

* Flow switch

* Flow direction

e Cal in progress

* Fault condition

* Batch timeout

» Batch in progress'"
* Batch end warn®"

* Batch overrun®

* Batch pump

* Batch primary valve”
* Batch secondary valve"®
* Printer job status®
* Display error®

* None

Fault indication
Flow switch source®
Flow switch setpoint®

Switch hysteresis®

Fault indication

¢ Condition

e Setting

¢ L ast measured value timeout

Variable assignment

* Mass flow rate

* Temperature

* Density

* Line (gross) volume flow rate®

* API: Temp corrected density®

¢ API: Temp corrected (standard)
volume flow®

* API: Batch weighted average
density®

* API: Batch weighted average
temperature®

* ED: Density at reference”

* ED: Density (fixed SGU)™

« ED: Standard volume flow rate”

* ED: Net mass flow rate”

* ED: Net volume flow rate”

* ED: Concentration”

* Drive gain

 External pressure

* External temperature

* Gas standard volume flow rate®

* Frequency input flow rate

Calibration span
*20 mA

*4 mA

* Low flow cutoff

* Damping seconds

* 4.0 mA minimum®

* 20.0 mA maximum®
* Minimum span®

Flow source

* Mass flow rate

* Line (gross) volume flow rate®

* Gas standard volume flow rate®

¢ API: Temp corrected (standard)
volume flow®

* ED: Standard volume flow rate®

* ED: Net mass flow rate®”

* ED: Net volume flow rate

* Frequency input flow rate

Scaling method

* Frequency = flow
* Pulses/unit

e Units/pulse

Frequency®
Flow(?
Pulses/unit""
Units/pulse?
Max. pulse width

Power
* Active
* Passive

Polarity
e Active high
* Active low

Fault indication
* Downscale

* Upscale

e Internal zero

* None

Fault frequency®
Last measured value timeout

(1) Displayed only if discrete batch application is installed. May also require corresponding batch control function enabled.
(2) Displayed only if No. of Stages is set to 2.
(3) Displayed only if custody transfer application is installed and World Area is set to OIML
(4) Displayed only if Flow Switch is selected.

(5) Displayed only if Volume Flow Type is set to Liquid.

(6) Displayed only if petroleum measurement application is installed.
(7) Displayed only if enhanced density application is installed.

(8) Displayed only if Volume Flow Type is set to Gas Standard.

(9) Read-only; calculated by transmitter according to sensor model.
(10) Displayed only if Frequency = Flow is selected.

(11) Displayed only if Pulses/unit is selected.

(12) Displayed only if Units/pulse is selected.

(13) Displayed only if Fault Indication is set to Upscale.
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8.3

Configuring the discrete outputs

You can configure one, two, or three discrete outputs. For each discrete output, you will configure:
* Polarity
*  Assignment
*  Fault indication

Discrete outputs can be connected to factory-supplied or user-supplied relays. For relay installation
instructions, see Appendix D. For specifications of the Model 3100 relay supplied by Micro Motion,
see Appendix C.

8.3.1 Polarity

The discrete outputs generate two voltage levels to represent ON or OFF states. The voltage levels
depend on the output’s polarity, as shown in Table 8-1. Figure 8-2 shows a diagram of a typical
discrete output circuit.

Table 8-1 Discrete output polarity

Polarity Description

Active high * The circuit provides a pull-up to 24 V when asserted (when condition tied

to DO is true).
* The circuit provides 0 V when not asserted (when condition tied to the DO
is false).

Active low * The circuit provides 0 V when asserted (when condition tied to DO is

true).
* The circuit provides a pull-up to 24 V when not asserted (when condition
tied to the DO is false).

Figure 8-2  Discrete output circuit

+24 V (Nom)
§ 3.2 kQ
N
| Out+
'_
D—{ —<
'_
| Out—
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8.3.2 Source variable assignment

The ON/OFF states of the discrete output are controlled by the discrete input, discrete event, or
process condition assigned to the discrete output as a source variable. See Table §-2.

When the discrete batch application is installed, one or more of the discrete outputs must be used to
control the pump, primary valve, or secondary valve. See the following section entitled Discrete batch

requirements.

A CAUTION

If “batch in progress” is assigned to a discrete output, connecting the output
to a system pump can cause batch overrun or a deadhead pump.

To avoid batch overrun or a deadhead pump, do not connect a discrete output to a
pump if “batch in progress” is assigned to the output.

Discrete output source variables

Source variable Default

Description

None None

Discrete input 1

Discrete input 2

Discrete event 1

Discrete event 2

Discrete event 3

Discrete event 4

Discrete event 5

Flow switch

Flow direction

Calibration in progress

Fault condition

Batch timeout

Batch in progress

Batch end warn

Batch overrun

Batch pump

Batch primary valve

The discrete output is inactive.

The discrete output will be controlled by discrete input 1.

The discrete output will be controlled by discrete input 2.

The discrete output will be controlled by discrete event 1.

The discrete output will be controlled by discrete event 2.

The discrete output will be controlled by discrete event 3.

The discrete output will be controlled by discrete event 4.

The discrete output will be controlled by discrete event 5.

The discrete output will be controlled by the occurrence of a flow switch.
See the section entitled Flow switch later in this chapter.

The discrete output will be controlled by the flow direction.

The discrete output ON state will indicate calibration in progress.

The discrete output will indicate any condition that produces a fault alarm.
For information about fault alarms, see Section 22.6.

At start of batch or at any time before batch completion, the discrete output will
be active if no flow has been measured for the amount of time configured for
time out.

The discrete output will indicate the batch is in progress.

* “Batch in progress” is a status indicator only.

* Because “batch in progress” remains active until the batch is completed or
ended, using “batch in progress” to control a pump can cause batch overrun
or a deadhead pump.

The discrete output will indicate when the batch total has exceeded the
percent of target or quantity subtracted from target that is configured for batch
end warn.

The discrete output will indicate when the batch total has exceeded the
amount configured for batch overrun.

The discrete output will control the system pump. The pump remains on while
the primary or secondary valve is open.

The discrete output will control the primary valve.
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Discrete output source variables continued

o
Source variable Default Description 5..
Batch secondary valve The discrete output will control the secondary valve. ‘_g‘
Printer job status!” If Printer Type is set to FDW, the discrete output will be activated if either of the a
following is true: m
* The last ticket print request failed. o
* Flow rate is not zero. o
If Printer Type is set to Epson, the discrete output will be activated if either of
the following is true:
* The printer is out of paper.
* Flow rate is not zero.
Printer job status is not supported for other printer types.
Display error The discrete output will indicate when a display error has occurred (custody
transfer only).
(1) Displayed only if custody transfer application is installed and World Area is set to OIML.
o
. o
Flow switch %
Flow switch is used to indicate that the flow rate of the flow switch source (e.g., mass flow, liquid S
. ; 5
volume flow) has dropped below the flow switch setpoint. @
w
The flow switch source specifies the flow variable that will be monitored. Any flow variable, g-
5

including gas standard volume flow and petroleum measurement or enhanced density flow variables,
can be assigned as the flow switch source.

The flow switch has a user-configurable hysteresis. Hysteresis defines a range around the setpoint
within which the flow switch will not change. The default hysteresis value is 5%. The valid range is
0.1% to 10%. At startup, the flow switch is OFF.

For example, if the flow switch setpoint is 100 g/sec and the first reading is below 95 g/sec, the flow
switch turns ON and will stay ON until the flow rate rises above 105 g/sec. At this point it turns OFF,
and will stay off until the flow rate drops below 95 g/sec.

Note: It is possible to assign flow switch to more than one discrete output, but they will all use the

same setpoint and hysteresis.

Discrete batch requirements

If discrete batching is enabled, there are specific requirements for discrete output assignment:
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e If 1-stage operation is specified, one discrete output must be assigned to either Batch Pump or
Primary Valve.

» If 2-stage operation is specified:

- One discrete output must be assigned to Primary Valve.
- One discrete output must be assigned to Secondary Valve.

- One discrete output may optionally be assigned to Batch Pump.

8.3.3 Fault indication

The Fault Indication parameter specifies the state of the discrete output if a fault occurs. Options for
Fault Indication are shown in Table 8-4.
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Discrete output fault indication and values

Discrete output state

Condition Polarity = Active High Polarity = Active Low
Upscale e Fault: DO is ON (site-specific voltage) e Fault: DO is OFF (0 V)
* No fault: DO is controlled by its assignment ¢ No fault: DO is controlled by its assignment
Downscale e Fault: DO is OFF (0 V) e Fault: DO is ON (site-specific voltage)
* No fault: DO is controlled by its assignment ¢ No fault: DO is controlled by its assignment
None DO is controlled by its assignment
Note: The Fault Indication parameter is designed to put the discrete output in a safe state during a
fault condition, and not to indicate that a fault condition is present. If you want to use the discrete
output to indicate faults, assign Fault Condition to the discrete output as described in Section 8.3.2,
and set Fault Indication to None. If you do this, the logical state of the discrete output will be ON
whenever a fault condition is active, and OFF otherwise.
8.4 Configuring the milliamp outputs

66

Configuring milliamp outputs includes the following procedures:
*  Specifying the milliamp output to be configured
*  Configuring fault indication
* Assigning a process variable to the output

*  Configuring the calibration span

8.4.1 Milliamp output
Select Milliamp Output 1 or Milliamp Output 2.

8.4.2 Fault indication

To configure fault indication, you must specify:
e Condition
*  Setting (only if Condition is set to Upscale or Downscale)
e Last Measured Value Timeout

The Condition parameter specifies the fault indication, or the state of the milliamp output if a fault
occurs. Options for Condition are shown in Table 8-4.

A CAUTION

Using Internal zero or None may hamper identification of fault outputs.

To make sure fault outputs can be identified, select Downscale or Upscale.

If Upscale or Downscale is specified, you must also configure the fault indication Setting. Setting
ranges and defaults are shown in Table 8-4.
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By default, the Series 3000 device immediately reports a fault when a fault is encountered. You can
delay reporting faults by changing the fault timeout. Last Measured Value Timeout specifies the time,
in seconds, that the milliamp output will report its last valid measurement after a fault condition has
been detected. After the timeout has expired, the milliamp output will report its configured fault

condition.

Fault indication parameters for milliamp outputs

Parameter Default

Description

Setting

Condition / Upscale Downscale

Condition / Downscale

Condition / Internal
zero

Condition / None

¢ |f Condition is set to Upscale, and a fault
condition occurs, the milliamp output will
transmit this level of current.

Range: 21.0 to 24.0 mA
Default: 22.0 mA

¢ [f Condition is set to Downscale, and a fault
condition occurs, the milliamp output will
transmit this level of current.

Range: 1.0 to 3.6 mA
Default: 2.0 mA

* Goes to the mA value that represents a value of
0.0 for the process variable.

* An apparent value of 0.0 for the process
variable could indicate a fault.

Not applicable

¢ The milliamp output never indicates a fault
condition.

* The milliamp output always transmits process
variable data.

Not applicable

Last measured value 0 sec
timeout

e Enter the value, in seconds, that the
Series 3000 device will continue to report its last
valid measurement after a fault condition has
been detected. Range is 0.0-60.0 seconds.?®

Not applicable

(1) The Setting parameter is displayed only if Condition is set to Upscale or Downscale.
(2) This parameter can also be set in the frequency output menu. Only one value is stored. If you change the fault timeout in the mA output
menu, the value displayed in the frequency output menu is changed, and vice versa.

8.4.3 Process variable

For the selected milliamp output, select a process variable. The milliamp output level will vary
according to the value of this process variable, within the limits defined by the calibration span
parameters (see the following section).

A CAUTION

Changing the process variable assignment without verifying the milliamp
output range can produce process error.

When the process variable assignment is changed, the milliamp output range
parameters will be changed automatically. The new output range may or may not
be appropriate for the process. To avoid causing process error, always verify the
milliamp output range parameters (LRV and URV) after changing the process
variable assignment. See Section 8.4.4.

8.4.4 Calibration span

Calibration span defines the range, scale, and related parameters for the milliamp output. See

Table 8-5.

Configuration and Use Manual
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Calibration span variables

Variable Default

Description

20 mA Sensor limit for selected

process variable

4 mA

(Upper range value, or URV) Enter the value the output will
represent at 20.0 mA. See the section entitled LRV and URV.

(Lower range value, or LRV) Enter the value the output will represent
at 4.0 mA. See the section entitled LRV and URV.

Low flow cutoff® 0.0 for all flow variables

¢ |f a flow variable is assigned to the output, the low flow cutoff is the
flow rate below which the output will indicate zero flow.

¢ If the value entered here is less than the value configured for mass
or volume low flow cutoff, this value will have no effect. See the
section entitled Multiple cutoffs.

Damping 0 sec
seconds®

* Select the amount of added damping for the milliamp output.

* Damping is added to damping that has been configured for flow,
density, or temperature. See the section entitled Multiple damping
parameters.

4.0 mA minimum  Not applicable

(read-only)

20.0 mA
maximum

Minimum span

The lowest value that can be represented by the output, as
determined by sensor limit.

The highest value that can be represented by the output, as
determined by sensor limit.

The smallest allowable difference between the value represented at
4.0 mA and the value represented at 20.0 mA, as determined by
sensor limit.

(1) Formost applications, the Low Flow Cutoff default value is used. Contact Micro Motion customer service before changing the Low

Flow Cutoff parameter.

(2) For most applications, the Damping Seconds default value is used. Contact Micro Motion customer service before changing the

68

Damping Seconds parameter.

LRV and URV

Each process variable that can be assigned to a milliamp output has its own 20 mA and 4 mA value
(URV and LRV). If you assign a different process variable to a milliamp output, the corresponding
LRV and URYV are loaded and used. Default LRV and URYV settings are listed in Table 8-6.

Default LRV and URV

Process variable LRV URV

All mass flow variables —200.000 g/s 200.000 g/s
All liquid volume flow variables —-0.200 I/'s 0.200 I/s

All density variables 0.000 g/cm?® 10.000 g/cm?®
All temperature variables —240.000 °C 450.000 °C
Drive gain 0.000% 100.000%
Gas standard volume flow -423.78 SCFM 423.78 SCFM
External temperature —240.000 °C 450.000 °C
External pressure 0.000 bar 100.000 bar
Enhanced density concentration 0% 100%
Enhanced density Baume 0 10

Enhanced density specific gravity 0 10
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Note: Beginning with rev7.0 of the transmitter software, if the LRV and URV are changed from the

defaults, and the milliamp output source is later changed, the LRV and URV will not be reset to their Qo
default values. For example, if mass flow is assigned to the milliamp output, and the LRV and URV for £
mass flow are changed, then density is assigned to the milliamp output, and finally mass flow is ‘_g‘
reassigned to the milliamp output, the LRV and URV for mass flow are reset to the configured values. g'
In earlier versions of the transmitter software, the LRV and URV were reset to factory default values. m
o
=]
Multiple cutoffs o
Cutoffs can be configured for the mA output and also for the mass flow and volume flow process
variables. If mass flow or volume flow has been assigned to an mA output, a non-zero value is
configured for the flow cutoff (see Section 7.3), and the mA output’s Low Flow Cutoff is also
configured, the cutoff occurs at the highest setting, as shown in the following examples.
Example Configuration:
¢ Primary mA output: Mass flow o
o
¢ Frequency output: Mass flow 3,
*  AO cutoff for primary mA output: 10 g/sec E_
e Mass flow cutoff: 15 g/sec a
w
o
As a result, if the mass flow rate drops below 15 g/sec, all outputs c;_a'

representing mass flow will report zero flow.

Example Configuration:
¢ Primary mA output: Mass flow
¢ Frequency output: Mass flow
*  AO cutoff for primary mA output: 15 g/sec
e Mass flow cutoff: 10 g/sec

As a result:
* If the mass flow rate drops below 15 g/sec but not below 10 g/sec:
- The primary mA output will report zero flow.
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- The frequency output will report nonzero flow.

e If the mass flow rate drops below 10 g/sec, both outputs will report
zero flow.

See Section 7.3 for information on the mass flow, volume flow, and density cutoffs.

Multiple damping parameters

Damping can be configured for the mA output and also for the mass flow, volume flow, density, and
temperature process variables. If damping has been configured for the process variable assigned to an
mA output (see Section 7.3), and a non-zero value is configured for Damping Seconds for the same
mA output, the effect of damping the process variable is calculated first, and the Damping Seconds
calculation is applied to the result of that calculation. See the following example.
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Example

Configuration:

As a result:

Flow damping: 1

Primary mA output: Mass flow

Frequency output: Mass flow

Primary milliamp output damping seconds: 2

A change in mass flow will be reflected in the primary mA output
over a time period that is greater than 3 seconds. The exact time
period is calculated by the Series 3000 device according to internal
algorithms which are not configurable.

The frequency output level changes over a 1-second time period
(the Flow Damping value). It is not affected by the Damping
Seconds parameter.

8.5 Configuring the frequency output

Table 8-7 lists and defines the parameters that can be set for the frequency output.

A CAUTION

Using Internal zero or None may hamper identification of fault outputs.

To make sure fault outputs can be identified, select Downscale or Upscale.

Frequency output variables

Variable

Default

Description

Flow source

Mass flow rate

Specifies the process variable that the frequency output will represent.

Select one of the following:

* Frequency input flow rate

* Mass flow rate

* Volume flow rate (liquid)™

* Gas standard volume flow rate

* API corr volume flow (available only if petroleum measurement
application is installed)

* Std vol flow (available only if enhanced density application is installed
and configured to indicate standard volume flow)

* Net mass flow (available only if enhanced density application is installed
and configured to indicate net mass flow)

* Net vol flow (available only if enhanced density application is installed
and configured to indicate net volume flow)

The output received at the external device can be totalized or used to

control the process.

Scaling method

Frequency = flow

Select Frequency = flow, Pulses/unit, or Units/pulse.

Frequency® 1000.000 Hz * Enter the value, in Hz, that will represent the value configured for Flow.
To calculate the Frequency value, see Section 8.5.1.
* The frequency output has a range of 0 to 10,000 Hz.

Flow® 16666.6699 g/sec Enter the maximum flow rate that is appropriate to your application. See

Section 8.5.1.

Pulses/unit®

0.0600

Enter the number of output pulses that will represent one mass or volume
unit.
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Frequency output variables continued

Variable Default Description

Units/pulse®® 16.6700 g Enter the number of mass or volume units that will be represented by one
output pulse.

Maximum pulse 277 ms * The pulse width can be configured for output frequencies below 500 Hz.
width * Enter the desired pulse width in milliseconds: minimum value is 0.5 ms,
maximum value is 277.2352 ms.
¢ For more information, see Section 8.5.2.

sjuang Bunnbiuon

Power Active Select Active or Passive operation for the frequency output.
*Voltage is 24 VDC nominal for active operation, 30 VDC applied
maximum for passive operation.
* Sourcing current is 10 mA at 3 VDC for active operation.
* Sinking current is 500 mA for active or passive operation.

Polarity Active high Specifies how the frequency output will represent an active state.
* Active high — The active state is represented by the frequency output’s
high value.
* Active low — The active state is represented by the frequency output’s low
value.

Fault indication Downscale * Downscale: Output goes to 0 Hz.

* Upscale: Output goes to configured Fault frequency value.

¢ Internal zero:
- Output goes to 0 Hz.
- An apparent no-flow condition could indicate a fault.

*None:
- The frequency output never indicates a fault condition.
- The frequency output always transmits process variable data.

yoreqg bunbyuosn

Fault frequency 15000.000 * Enter the value, in Hz, that will be transmitted during fault conditions if
the fault indicator is set to Upscale. Minimum value is 10.000, maximum
value is 15000.000.

Last measured value 0 sec ¢ Enter the value, in seconds, that the Series 3000 device will continue to
timeout report its last valid measurement after a fault condition has been
detected.®

(1) Either liquid or gas standard volume flow rate is available, depending on the setting of Volume Flow Type (see Section 7.3.2).

(2) Displayed only if Scaling Method is set to Frequency = Flow.

(3) Displayed only if Scaling Method is set to Pulses/unit.

(4) Displayed only if Scaling Method is set to Units/pulse.

(5) This parameter can also be set in the milliamp output menu. Only one value is stored. If you change the fault timeout in the milliamp
output menu, the value displayed in the frequency output menu is changed, and vice versa.

o
o
=
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Q
o
c
=
©
c
=
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8.5.1 Frequency = flow

If you specify Frequency = Flow, you must also specify Frequency and Flow. Flow is defined as the
maximum flowrate appropriate to your application. Frequency can then be calculated using the
following formula:

Frequency = EI_?—W x N

Jojiuopy ssado.id Burnbyuosn
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where:
*  Flow = maximum appropriate flowrate (Flow in configuration)
* T =factor to convert selected flow time base to seconds
* N =number of pulses per flow unit, as configured in the receiving device
The resulting Frequency value must be within the range of the frequency output (0 to 10,000 Hz).

» If the Frequency value is less than 1 Hz, reconfigure the receiving device for a higher
pulses/unit setting.

e If the Frequency value is greater than 10,000 Hz, reconfigure the receiving device for a lower
pulses/unit setting.

Example Maximum appropriate flowrate (Flow) is 2000 Ibs/min.
Receiving device is configured for 10 pulses/pound.

Solution:
Frequency = FI%V x N
Frequency = % x 10

Frequency = 333.33

Series 3000 device configuration:
*  Frequency = 333.33
*  Flow = 2000

8.5.2 Maximum pulse width

The frequency output maximum pulse width defines the maximum duration of the “active” portion of
the wave that the Series 3000 device sends to the frequency receiving device. The active portion may
be the high voltage or 0.0 V, depending on the polarity setting, as shown in Figure 8-3.

Pulse width
Pulse width
Polarity = Active High \
1 / ™~
<+“—> <+—>
Pulse width
Polarity = Active Low
<+“—> <+“—>
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Maximum Pulse Width can be set to 0, or to values between 0.5 and 277.2352 milliseconds. The

user-entered value is adjusted automatically to the nearest valid value. If Maximum Pulse Width is set o
to 0, the output will have a 50% duty cycle, independent of the output frequency. A 50% duty cycle is 2
illustrated in Figure 8-4. ‘g
3
50% duty cycle %‘
=

If Maximum Pulse Width is set to a non-zero value, the duty cycle is controlled by the crossover

frequency:

* At frequencies below the crossover frequency, the duty cycle is determined by the pulse width 9
and the frequency. “5_;.,
* At frequencies above the crossover frequency, the output changes to a 50% duty cycle. s
=]
The crossover frequency is calculated as follows: ‘;
g
=2

1
2 x max pulse width

Crossover frequency =

You can change the setting for Maximum Pulse Width so that the Series 3000 device will output a
pulse width appropriate to your receiving device:

* High-frequency counters such as frequency-to-voltage converters, frequency-to-current
converters, and Micro Motion peripherals usually require approximately a 50% duty cycle.

* Electromechanical counters and PLCs that have low-scan cycle rates generally use an input
with a fixed non-zero state duration and a varying zero state duration. Most low-frequency
counters have a specified requirement for Maximum Pulse Width.

Note: For typical applications, the default pulse width is used.

Example The frequency output is wired to a PLC with a specified pulse width
requirement of 50 ms. The crossover frequency is 10 Hz.

0o
=]
=
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c
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=
Q
o
c
=
©
c
=
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Solution:
e Set Maximum Pulse Width to 50 ms.

¢ For frequencies less than 10 Hz, the frequency output will have a
50 msec ON state, and the OFF state will be adjusted as required.
For frequencies higher than 10 Hz, the frequency output will be a
square wave with a 50% duty cycle.

Note: If you are using the Freq = Flow output scale method, and you set Maximum Pulse Width to a
non-zero value, Micro Motion recommends setting the frequency factor to a value below 200 Hz. See
Section 8.5.1. If you are using the Pulses/unit or Units/pulse output scale method, Maximum Pulse
Width must be set to a value that allows crossover to occur.
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Application

abenbue @ Ayinoas Bunbyuo)

9.1 About this chapter

This chapter explains how to configure the petroleum measurement application (API feature). The

petroleum measurement parameters include all the software parameters listed in Figure 9-1. g
Note: The petroleum measurement application is an optional feature of the Series 3000 platform, and Q@
may not be installed on your equipment. To verify that it is installed, use the View menu to list all =
installed applications (see Section 17.5). Z,
Failure to perform configuration tasks in the proper sequence could result in an incomplete %
configuration. See Section 1.7 for the recommended configuration sequence. %
Q
)
A CAUTION
Changing configuration can affect device operation.
Set control devices for manual operation before changing device configuration.
9.2 APl menu Q
=]
Use the API menu, shown in Figure 9-1, to access and configure petroleum measurement parameters. =
The API menu is a submenu of the Measurements menu, which is accessed through the Configuration §
option of the Management menu. To access the Management menu, see Chapter 4. @
3
=
APl menu @
Measurements
r__J___'IF____J_ _____ A
| Discrete events I Density functions I API
I See Chapter 10 [ | Seeenhanced density manual
L - e e — = d L e e e e e e = = . o)
o
3
g
* Table type s
* User defined TEC™ 5
» Temperature units® ‘;
(1) Displayed only if Table Type is set to 6C, 24C, or 54C. * Density units® e
(2) Read-only. * Reference temperature® =
(3) Read-only unless Table Type is set to 53x or 54x.
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9.3

9.4

About petroleum measurement

The petroleum measurement application enables Correction of Temperature on volume of Liquids, or
CTL. In other words, some applications that measure liquid volume flow or liquid density are
particularly sensitive to temperature factors, and must comply with American Petroleum Institute
(API) standards for measurement.

The petroleum measurement parameters determine the values that will be used in API-related
calculations. The petroleum measurement parameters are available only if the petroleum measurement
application is installed on your Series 3000 device.

9.3.1 Definitions
The following terms and definitions are used in this chapter:
e API - American Petroleum Institute

* CTL - Correction for Temperature on volume of Liquids. The CTL value is used to calculate
the VCF value

* TEC - Thermal Expansion Coefficient

e VCF - Volume Correction Factor. The correction factor to be applied to volume process
variables. VCF can be calculated after CTL is derived

9.3.2 CTL derivation methods
There are two derivation methods for CTL:
e  Method 1 is based on observed density and observed temperature.

* Method 2 is based on a user-supplied reference density (or thermal expansion coefficient, in
some cases) and observed temperature.

The choice of reference table determines the derivation method to be used, as discussed in
Section 9.4.1.

Configuring petroleum measurement parameters

The petroleum measurement parameters are listed and defined in Table 9-1.

Petroleum measurement parameters

Variable Description

Table type Select the table that matches your requirements. See Section 9.4.1.

User defined TEC"  Thermal expansion coefficient. Enter value to be used in CTL calculation.

Temperature units®  Read-only. Displays the unit used for reference temperature in the reference table.

Density units Read-only. Displays the unit used for reference density in the reference table.
Reference Read-only unless Table type is set to 53x or 54x. If configurable:
temperature * Specify the reference temperature to be used in CTL calculation.

* Enter reference temperature in °C.

(1) Displayed only if Table Type is set to 6C, 24C, or 54C.
(2) In most cases, the temperature unit used by the API reference table should also be the temperature unit configured for the device to
use in general processing. To configure the temperature unit, see Section 7.3.
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9.4.1 Reference tahles

Reference tables are organized by reference temperature, CTL derivation method, liquid type, and
density unit. The table selected here controls all the remaining options.

e Reference temperature:

- If you specify a 5x, 6x, 23x, or 24x table, the default reference temperature is 60 °F, and
cannot be changed.

- If you specify a 53x or 54x table, the default reference temperature is 15 °C. However, you
can change the reference temperature, as recommended in some locations (for example, to
14.0 or 14.5 °C).

¢ CTL derivation method:

- If you specify an odd-numbered table (5, 23, or 53), CTL will be derived using Method 1
(described in Section 9.3.2).

abenbue @ Ayinoas Bunbyuosn

- If you specify an even-numbered table (6, 24, or 54), CTL will be derived using Method 2 9
(described in Section 9.3.2). =
@
* Theletters A, B, C, or D that are used to terminate table names define the type of liquid that the 5
table is designed for: a
. . .. »
- A tables are used with generalized crude and JP4 applications. b
- Btables are used with generalized products. ‘3"
- Ctables are used with liquids with a constant base density or known thermal expansion E
coefficient. =
- D tables are used with lubricating oils.
» Different tables use different density units:
- Degrees API
- Relative density (SG)
- Base density (kg/m?) o
Table 9-2 summarizes these options. S_
S
f=
=
3
API reference temperature tables ‘;
°
CTL Density unit and range %
derivation
Table method Base temperature Degrees API Base density Relative density
5A Method 1 60 °F, non-configurable 0to 100
5B Method 1 60 °F, non-configurable 0to 85
5D Method 1 60 °F, non-configurable -10 to +40
23A Method 1 60 °F, non-configurable 0.6110 to 1.0760
23B Method 1 60 °F, non-configurable 0.6535 to 1.0760
23D Method 1 60 °F, non-configurable 0.8520 to 1.1640
53A Method 1 15 °C, configurable 610 to 1075 kg/m?® o
53B Method 1 15 °C, configurable 653 to 1075 kg/m?® S
53D Method 1 15 °C, configurable 825 to 1164 kg/m® cé'
Reference temperature Supports é'
6C Method 2 60 °F, non-configurable 60 °F Degrees API >
24C Method 2 60 °F, non-configurable 60 °F Relative density 2
54C Method 2 15 °C, configurable 15°C Base density in kg/m®
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9.4.2 Temperature data

For the temperature value to be used in CTL calculation, you can use the temperature data from the
sensor, or you can poll an external temperature device:
L]

To use temperature data from the sensor, no action is required.

* To poll an external temperature device, configure polling for temperature as described in

Section 7.6. When polling is enabled, the Series 3000 device will automatically use the
external temperature value for CTL calculation.
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10.1

10.2

10.3

About this chapter

This chapter explains how to configure discrete events. Discrete events include all the software
parameters listed in Figure 10-1.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

Discrete events menu

Use the Discrete Events menu, shown in Figure 10-1, to access and configure discrete event
parameters. The Discrete Events menu is a submenu of the Measurements menu, which is accessed
through the Configuration option of the Management menu. To access the Management menu, see
Chapter 4.

About discrete events

A discrete event occurs if the real-time value of a user-specified process variable varies beyond a
user-specified value.

Discrete events are used to perform specific actions on the Series 3000 platform. For example, the
discrete event can be defined to activate a discrete output if the flow rate is outside a specified range.

Note: In rev7.0 of the Series 3000 firmware, discrete events are available on all Series 3000 devices.
In previous firmware versions, discrete events were available only on the Model 3500 and Model 3700
transmitters; they were not available on the Model 3300 and Model 3350 controllers.
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Discrete events menu

Measurements

e d I

Discrete events | Density functions [ API |

| Seeenhanced density manual | | See Chapter 9 I

Discrete event1 | 2

Event type

e HI

*LO

* IN HI/LO

* OUT HI/LO

Process variable
HI PV value®"
LO PV value®

(1) If Event Type is HI, IN HI/LO, or OUT HI/LO.
(2) If Event Type is LO, IN HI/LO, or OUT HI/LO.

10.4 Discrete event configuration procedure

You can configure 1 to 5 discrete events, as described in the following steps.

Discrete event
Select Discrete event 1 - 5.

Event type

For the selected discrete event, select one of the event types defined in Table 10-1.

Description

Event types
Variable Default
HI HI
LO
IN HI/LO
OUT HI/LO

Discrete event will occur if the assigned variable is greater than the high value.”

Discrete event will occur if the assigned variable is less than the low value.”

Discrete event will occur if the assigned variable is greater than the low value and less than
the high value."

Discrete event will occur if the assigned variable is less than the low value or greater than the
high value.™

(1) A discrete event does not occur if the assigned variable is equal to the high or low value.

Process variable

For the selected discrete event, select a process variable.
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High and low values

For the process variable assigned to the selected discrete event, configure a high value, a low value, or
high and low values, as required by the event type. Enter values in the unit that is configured for the
selected process variable. See Table 10-2 for definitions and descriptions.

Values are exclusive. For example, if the event type is HI, and the HI PV value is set to 100 Ib/min:

e If the flow rate equals 100 Ib/min, the discrete event does not occur.
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e If the flow rate exceeds 100 Ib/min, the discrete event occurs.

High and low values of process variables

Variable Description

HI PV value * |f event type is HI or OUT HI/LO, enter the value above which the discrete event will occur.
* If event type is IN HI/LO, enter the value below which the discrete event will occur.
¢ |f event type is OUT HI/LO or IN HI/LO, you must also enter a LO PV value.

LO PV value ¢ If event type is LO or OUT HI/LO, enter the value below which the discrete event will occur. (2]
¢ If event type is IN HI/LO, enter the value above which the discrete event will occur. e
e If event type is OUT HI/LO or IN HI/LO, you must also enter a HI PV value. =
c
=
- - m
Discrete event actions g
To assign an action to a discrete event: S
* To assign flowmeter zero, see Section 7.3.5.
» To assign a totalizer control action, see Section 7.3.5.
* To assign a batch control function, see Section 11.7.
* To assign a discrete output, see Section 8.3.2.
* To assign a print function, see Chapter 15.
* To assign a meter verification test, see Section 7.3.5. o
If the enhanced density application is installed, you may also assign the “next curve” function. S..
If more than one action is assigned to a single discrete event, all assigned actions are performed when ‘_E‘
the discrete event occurs. g'
o
=
Example Configure discrete event 1 so it will stop all totalizers when the mass 'g_
P flow rate in forward or backward direction is less than 2 Ib/min. @

1. Select Ib/min as the mass flow unit. See Section 7.3.2.

2. Configure the flow direction parameter for absolute value. See
Section 7.3.2.

3. Configure discrete event 1 so the event type is LO and the process
variable is mass flow.

4. Enter a value of 2 for the LO PV value.
5. Exit the Measurements menu.

6. Using the Inputs/Core Processor parameters/Discrete Inputs
menu, assign Start/stop all totals to discrete event 1. See
Section 7.3.5.
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111

11.2

About this chapter

This chapter explains how to configure the discrete batch application. The discrete batch application
includes all the software parameters listed in Figure 11-1.

Note: Information on formatting and printing batch tickets is provided in Chapter 15.
Note: Information on operating the discrete batch application is provided in Chapter 18.

Note: The discrete batch application is an optional feature of the Series 3000 platform, and may not
be installed on your equipment. To verify that it is installed, use the View menu to list all installed
applications (see Section 17.5).

Note: If the discrete batch application will be used with custody transfer, review the information in
Chapters 14, 15, and 19 before configuring the discrete batch application.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation, including batching.

Changes made to discrete batch configuration while a batch is running do not take
effect until the batch is ended. Changes made to other configuration parameters
may affect batching. To ensure correct batching, do not make any configuration
changes while a batch is in progress.

Discrete batch menu

Use the Discrete Batch menu, shown in Figure 11-1, to access and configure batch parameters. The
Discrete Batch menu is accessed through the Configuration option of the Management menu. To
access the Management menu, see Chapter 4.

Configuration and Use Manual
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Discrete batch menu

Discrete batch

Flow source Control options Configure presets Discrete inputs
4 |5 |6
None Enable batch End
Frequency input Time out Preset1 |2 | 3 Inhibit batch
Mass No. of stages Inhibit totalizer
Volume® No. of decimals Reset
Gas standard volume® Reset on start Resume
ED std vol Count up Start
ED net mass® Enable end warning Stop
ED net vol® Enable AOC Increment preset
API temp. corr vol® Enable overrun Enable preset Inhibit flow
Lockout target Name
Maximum target® Density curve®
Ignore source alarms Open primary®
Alarm timeout®” Open secondary®
Configure presets by Close primary® * None
End warning'® « Discrete input 1
Target * Discrete input 2
Overrun™ * Discrete event 1
* Discrete event 2
* Discrete event 3
(1) Displayed only if Volume Flow Type is set to Liquid (see Section 7.3.2). * Discrete event 4
(2) Displayed only if Volume Flow Type is set to Gas Standard (see Section 7.3.2). * Discrete event 5
(3) Ifenhanced density application is installed and configured, and the derived variable

is mass-based.

(4) Ifenhanced density application is installed and configured, and the derived variable
is volume-based.

(5) If petroleum measurement application is installed.

(6) If Lockout Target is set to No.

(7) If Ignore Source Alarms is set to Yes.

(8) If enhanced density application is installed and configured.

(9) If No. of Stages is set to 2.

(10) If Enable End Warning is set to Yes.

(11) If Enable Overrun is set to Yes.

11.3  Batching configuration overview
To configure batching, the following general steps are required:
1. From the Discrete Batch menu:
Configure flow source.

a
b. Configure control options.

o

Configure one or more presets (optional).

o

Configure batch control methods, if desired.
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2. From the Discrete Outputs menu, configuring the required discrete outputs:

* For 1-stage operation, you must configure one discrete output. This output must control
either the pump or the primary valve, as appropriate to your application. This discrete
output is required.

* For 2-stage operation, you must configure two or three discrete outputs:

- One to control the primary valve (required)

- One to control the secondary valve (required)

- One to control the pump (optional; only if required by your installation)

You must configure the discrete outputs that are listed as required, whether or not your
installation requires them (for example, you may start and stop the pump manually). You will
not be able to start a batch until the required discrete outputs have been configured. See
Section 8.3 for information on configuring the discrete outputs.

3. If you enabled the Batch AOC control option, you should perform batch AOC (automatic
overshoot compensation) calibration. Batch AOC is used to minimize the amount of overshoot
per batch. See Section 18.6 for information on performing batch AOC calibration.

4. You may optionally configure the batch ticket and ticket printing. See Chapter 15 for
information on configuring tickets and ticket printing.

11.4 Flow source

The flow source specifies the flow variable that will be used for batch measurement. Select one of the
flow sources defined in Table 11-1.

Note: If the discrete batch application will be used for custody transfer measurement, ensure that the
transfer variable is configured as the batch flow source. See Chapter 14 for more information.

Flow sources

Flow Source Default

Description

None None

Frequency input

Mass

Volume®"

Gas standard
volume®

ED std vol flow®

¢ Batch controller is disabled.
* START button will not appear on display.

* Frequency input from a Micro Motion IFT9701 or RFT9739 transmitter
¢ Frequency input from a pulse output device

Mass flow rate from Model 3500 or Model 3700 transmitter

Liquid volume flow rate from Model 3500 or Model 3700 transmitter

Gas standard volume flow rate from Model 3500 or Model 3700 transmitter

e Standard volume flow rate at reference temperature

* Standard volume flow is available only if the enhanced density application software
is installed and configured to indicate standard volume flow. See the enhanced
density manual.

Configuration and Use Manual
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Flow sources continued

Flow Source

Default

Description

ED net mass flow®

ED net vol flow®

API temperature-
corrected volume
flow™

* Net mass flow rate

* Net mass flow is available only if the enhanced density application software is
installed and configured to indicate net mass flow. See the enhanced density
manual.

* Net volume flow rate at reference temperature

*Net volume flow is available only if the enhanced density application software is
installed and configured to indicate net volume flow. See the enhanced density
manual.

* Volume flow adjusted by the calculated volume correction factor
* Available only if the petroleum measurement application is installed. See
Chapter 9.

(1) Displayed only if Volume Flow Type is set to Liquid. See Section 7.3.2.

(2) Displayed only if Volume Flow Type is set to Gas Standard. See Section 7.3.2.
(3) Displayed only if the enhanced density application is installed.

(4) Displayed only if the petroleum measurement application is installed.

11.5 Control options

Select one of the control options defined in Table 11-2.

Note: Control options apply to all batch presets.

Control options

Setting Default Description

Enable batch Yes * Select Yes to enable the discrete batch application.

* Select No to disable the discrete batch application. The operation mode will
default to the process monitor.

* If the custody transfer application is installed, with either World Area set to
NTEP or World Area set to OIML with batching approved (see Chapter 14),
Enable Batch is set to Yes and cannot be changed.

Time out 10.0 sec * The Time Out period specifies how long the batch controller will wait before
posting an alarm if flow stops or the batch totalizer or batch flow is inhibited
while a batch is running.

* Enter a value of 0.0 to 300.0.
¢ Time Out is disabled if set to 0.0 seconds.
* A discrete output can be configured to activate if the Time Out period expires.
See Section 8.3.2.
No. of stages 1 Enter a value of 1 for 1-stage batch control, or 2 for 2-stage batch control. See
the discussion in Section 11.5.1.

No. of decimals 1 ¢ Enter a value of 0 to 5.

* This value specifies the number of digits to the right of the decimal point on the
operation screen.

Reset on start No ¢ If set to Yes, the batch totalizer resets when the operator starts the batch.

* If set to No, the operator must press RESET before starting a new batch

* Reset and Start can be assigned to discrete inputs or discrete events. See
Section 11.7.

* If the custody transfer application is installed, Reset on Start is set to No and
cannot be changed if either of the following is true: World Area is set to NTEP,
or World Area is set to OIML and the discrete batch application is approved.
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Control options continued

Setting Default

Description

Count up Yes

* |f set to Yes, the total displayed on screen increases from zero to the target
value.

* |f set to No, the total displayed on screen decreases from the target value to
zero

* The setting of the Count Up control option affects only the quantity displayed
on screen. It does not affect configuration of presets.

« If the custody transfer application is installed, with either World Area set to
NTEP or World Area set to OIML with batching approved (see Chapter 14),
Count Up is set to Yes and cannot be changed.

Enable end No
warning

* Select Yes to enable the end warning.

*When End Warning is enabled and an end warning value has been entered for
the selected preset, a discrete output can be configured to indicate the end
warning.

* End Warning is a status indicator only, and does not affect valve operation.

* End Warning will remain active until batch completion.

Enable AOC Yes

* Select Yes to enable Automatic Overshoot Compensation (AOC).

* When batch AOC is enabled and batch AOC calibration has been performed,
the batch controller compensates for the time required to close the valve.

¢ If Enable AOC is set to Yes, batch AOC calibration is required to provide data
for the compensation process. To perform batch AOC calibration, see
Section 18.6.

Enable overrun No

* Select Yes to enable overrun indication.

*When Overrun is enabled and an overrun value has been entered for the
selected preset, the batch controller produces an overrun alarm when the
batch total exceeds the target by more than the programmed overrun amount.

* Overrun can be assigned to a discrete output. See Section 8.3.2.

Lockout target No

e If set to Yes, the current target cannot be changed from the batch operation
screen.

¢ If set to No, the batch target can be changed from the batch operation screen
when a batch is not running.

Maximum target 1.0000E9 kg

If Lockout Target is set to No, enter the maximum target that the operator will be
allowed to set in the batch operation mode.

Ignore source No
alarms

A source alarm is any fault-level alarm. If Ignore Source Alarms:

¢ |s set to Yes, the batch will not stop for the duration of the alarm timeout.
¢ |s set to No, the batch is stopped as soon as the alarm condition occurs.

If the custody transfer application is installed, with either World Area set to

NTEP or World Area set to OIML with batching approved (see Chapter 14),
Ignore Source Alarms is set to No and cannot be changed.

Alarm timeout 1 minute

This parameter is applicable only if Ignore source alarms is set to Yes.

¢ Enter the number of minutes, from 1 to 20, for which source alarms will be
ignored.

« If the alarm condition is present when the alarm timeout expires, the current
batch is stopped.

Configure presets % of target
by

Select % of Target or Quantity.

¢ If set to % of Target, Open Primary, Open Secondary, Close Primary, and End
Warning values are each configured as a percent of target. See Example 2 in
Section 11.6.1.

* If set to Quantity, Open Primary and Open Secondary are each configured as
a quantity at which the valve should open; Close Primary and End Warning
values are each configured as a quantity that is subtracted from the target.
See Example 1 in Section 11.6.1.

* To configure Open Primary, Open Secondary, Close Primary, and End
Warning values, see Section 11.6.
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Configuring the Discrete Batch Application

11.5.1 One-stage versus two-stage batching

If No. of Stages is set to 1, a single pump or valve is used to control the batch. (You can assign both a
pump and a valve if desired, although only one is necessary.) When the batch is started, the pump
starts or the valve opens; at the configured target, the pump stops or the valve closes. Open Primary,
Open Secondary, and Close Primary values are not required when configuring the preset (see

Section 11.6).

If No. of Stages is set to 2, two valves are used to control the batch, and the following requirements
apply when configuring the preset:

* Both Open Primary and Open Secondary must be configured.
»  Either Open Primary or Open Secondary must be set to 0. Both may be set to 0 if desired.

*  Close Primary must be configured.

11.6  Configure presets

You can configure up to six batch presets. Preset 1 cannot be disabled, but you can change its
configuration.

Table 11-3 defines the options for configuring presets. To configure a preset, first select the preset to
be configured, then define its parameters.

Presets
Setting Default Description
Enable preset ¢ Yes for preset 1 ¢ |f set to Yes, the batch preset can be selected in the View menu. See

*No for presets 2—6 Section 17.5.3.
¢ |f set to No, the batch preset is disabled and cannot be selected.
* Preset 1 cannot be disabled.

Name *Preset 1 * Enter the name that will appear on operation screens and in preset selection
*Preset 2 menus.
*Preset 3 * A maximum of 22 characters can be entered. Only 21 characters are
*Preset 4 displayed. You can use the left and right cursor control buttons to scroll
*Preset 5 through and view the entire name.
*Preset 6

Density curves  None * |f a derived variable is selected as the flow source, you can select a density

curve that will apply to this preset. See the enhanced density manual.
* The batch total will be based on the density curve for that variable.

Open primary™  0.00% of target or * Enter the quantity or the percent of the target at which the primary valve will
0.0 kg quantity open. See the examples later in this section.
e Either Open Primary or Open Secondary must be set to 0. If one of these
parameters is set to a non-zero value, the other is set to 0 automatically.
* To enable 2-stage batch control, see Section 11.5.
* Before a batch can be started, the primary valve must be assigned to a
discrete output. See Section 8.3.2.

Open 0.00% of target or * Enter the quantity or the percent of the target at which the secondary valve
secondary” 0.0 kg quantity will open. See the examples later in this section.
* Either Open Primary or Open Secondary must be set to 0. If one of these
parameters is set to a non-zero value, the other is set to 0 automatically.
* To enable 2-stage batch control, see Section 11.5.
* Before a batch can be started, the secondary valve must be assigned to a
discrete output. See Section 8.3.2.

Close primary™  80.00% of target or * Enter the quantity subtracted from the target, or the percent of the target, at
0.0 kg quantity which the primary valve will close. See the examples later in this section.
* The secondary valve always closes when the target is achieved.
* To enable 2-stage batch control, see Section 11.5.
* Before a batch can be started, the primary valve must be assigned to a
discrete output. See Section 8.3.2.
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Presets continued

Setting Default Description
End warning®  80.00% of target or * If End Warning is enabled as a control option, enter the quantity subtracted
0.0 kg quantity from the target, or the percent of the target, at which the end warning will

occur. See the examples later in this section.
* End Warning can be assigned to a discrete output. See Section 8.3.2.
* To enable the end warning, see Section 11.5.

Target® 0.0 kg Enter the total at which the batch will be completed.

Overrun® 0.0 kg * |f Overrun is enabled as a control option, enter the amount over the target
value at which batch overrun will be indicated. For example, if the target is
250 kilograms and overrun should be indicated at 280 kilograms, enter 30.
* Overrun can be assigned to a discrete output. See Section 8.3.2.
¢ To enable overrun indication, see Section 11.5

(1) This parameter is displayed only if No. of Stages was set to 2.

(2) This parameter is displayed only if Enable End Warning was set to Yes.

(3) A non-zero value must be configured for Target before a batch can be started.
(4) This parameter is displayed only if Enable Overrun was set to Yes.

11.6.1 Batch preset examples

The following examples describe the batch processing sequence for two different batch preset
configurations.

Note: For a detailed presentation of batch processing sequences, including how the STOP and
RESUME functions affect processing, see Section 18.4.

Example 1 Configure presets by quantity under the following conditions:
e The target is 200 kilograms

* The primary valve opens at the start of the batch and closes when
180 kilograms have been delivered

* The secondary valve opens when 100 kilograms have been
delivered

¢ The end warning occurs when 160 kilograms have been delivered
Close Primary = 200 kilograms — 180 kilograms = 20
Open Secondary = 100 kilograms

End Warning = 200 kilograms - 160 kilograms = 40
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Configuring the Discrete Batch Application

Example 2 Configure presets by percent of target under the following conditions:
* The target is 200 kilograms

¢ The primary valve opens at the start of the batch and closes when
180 kilograms have been delivered

e The secondary valve opens when 100 kilograms have been
delivered

* The end warning occurs when 160 kilograms have been delivered

: 180 kilograms
Close P - 180 kilograms _ ; g
08€ FTIMAY = 560 kilograms

Since 0.90 equals 90%, enter a Close Primary value of 90.

Open Secondary = 100 kilograms _ 0.50

200 kilograms

Since 0.50 equals 50%, enter an Open Secondary value of 50.

End Warning = 160 kilograms _ 0.80

200 kilograms

Since 0.80 equals 80%, enter an End Warning value of 80.

11.7  Batch control methods
Batch control functions can be performed in four ways:
* By using the function buttons on the display (see Section 18.3)
* By assigning a discrete input to a batch control function
* By assigning a discrete event to a batch control function
* By using digital communications (e.g., ProLink II)

Table 11-4 lists the batch control functions, and Table 11-5 describes how the batch responds to
changes in discrete inputs or discrete events. To assign a discrete input or discrete event to perform a
batch control function:

1. Select the batch control function to be performed.

2. Specify the discrete input or discrete event that will perform the batch control function.
Note: For a detailed description of the batch control functions in operation, see Chapter 18.

Note: You can assign one or more actions to a single discrete input or discrete event. All assigned
actions that are compatible with the current batch state will be performed, and all others, except for
print commands, will be discarded. To assign flowmeter zero or a totalizer control function to a
discrete input, discrete event, or batch event, see Section 7.3.5. To assign a print function to a discrete
input or discrete event, see Chapter 15.
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Batch control assignments

Default
Function assignment Assignment options ON state actions
End None Specify the discrete input or ¢ Ends the batch.

Inhibit batch

Inhibit
totalizer

Reset"

Resume

Start

Stop

Increment
preset

Inhibit flow

discrete event that will
perform the batch control
function:

*None

¢ Discrete input 1

¢ Discrete input 2

¢ Discrete event 1

¢ Discrete event 2

¢ Discrete event 3

¢ Discrete event 4

¢ Discrete event 5

* The batch cannot be resumed.
* The batch totalizer must be reset for the next batch."

* Batch cannot be started.
¢ Inhibit Batch is used for temporary lockout.

¢ Delivers the batch but does not totalize.
* While totalizing is inhibited, flow measurement
continues but batch total is not incremented.

* Resets batch total to zero.

¢ Batch reset cannot be performed while a batch is
running or while a batch is stopped. Before a batch can
be reset, the batch target must be reached or the batch
must be ended.

* Resumes a batch that has been stopped.
¢ Counting resumes from the total at which the batch was
stopped.

» Starts the batch by opening the flow control valve(s)
and starting the pump.

* Stops the batch.

* The batch can be resumed.

« |f Lockout Target is disabled as a control option, the
operator can change the target before resuming.

*To enable or disable Lockout Target, see Section 11.5.

¢ Selects next configured and enabled preset (as listed in
the preset menus) for use in the next batch.

* Delivers the batch but does not totalize.
* Used to allow the batch to end while flow is present.

(1) The batch controller can be configured to reset automatically on start. To configure Reset on Start, see Section 11.5.

Discrete event/discrete input states and batch control functions

Batch control function

Discrete event/discrete input Result

End

Turns ON

Stops current batch; batch cannot be restarted.

Turns OFF No action taken.
Inhibit batch While ON Batch cannot be started. If start is attempted,
“Start Not Okay” alarm is posted.
While OFF Batch can be started.
Turns OFF No action taken.

Any change of state

Does not affect batch in progress.

Configuration and Use Manual

91

sjuang Bunnbiuon

0
o
3
=
Q
[=
=t
3
@
o)
)
=
o
>

sinding BurinBiyuon

Jojuopy ssado.id Burnbyuosn



Configuring the Discrete Batch Application

Discrete event/discrete input states and batch control functions continued

Batch control function Discrete event/discrete input Result

Inhibit totalizer

Turns ON Batch totalizer stops incrementing.

¢ |f the Time Out batch control option is set to
0, no time out alarm will be posted.

* If the Time Out batch control option is set to a
non-zero value, a time out alarm will be
posted if the time out period expires before
batch totalizing resumes.

While ON Batch totalizer does not increment.
Turns OFF Resumes incrementing.
While OFF Batch totalizer increments if flow is detected,
whether or not a batch is running.
Reset Turns ON Batch total reset to 0.
Turns OFF No action taken.
Resume Turns ON Resumes current batch.
Turns OFF No action taken.
Start Turns ON Begins new batch.
Turns OFF No action taken.
Stop Turns ON Pauses current batch. Batch can be resumed.
Turns OFF No action taken.
Increment preset Turns ON Sets the batcher to use the next enabled preset

for the next batch.
Works only if a batch is not running.

Turns OFF No action taken.
Inhibit flow Turns ON Batch totalizer stops incrementing.
While ON Batch totalizer does not increment. The batch

in progress remains active, and will end when
the batch time out is reached or when an END
command is received.

Turns OFF Resumes incrementing.

While OFF Batch totalizer increments.

(1) Does not work during AOC calibration.

11.71

Special cases in batch control

There are two common situations in batch control that may require special configuration:

92

Cleaning/purging the sensor tubes

In normal processing, the batch totalizer increments whenever flow through the sensor tubes is
detected. If you will want to run fluid through the tubes without incrementing the totalizer,
assign a discrete input to the Inhibit Totalizer function.

Ending the batch while flow is present

In normal processing, you cannot end a batch while flow is present. If you may need to end a
batch while flow is present, assign a discrete input to the Inhibit Flow function.
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12.1  About this chapter
This chapter explains how to configure the process monitor. Parameters are listed in Figure 12-1.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

(2}
o
A CAUTION e
‘é-
Changing configuration can affect device operation. =
@
Set control devices for manual operation before changing device configuration. o
)
12.2  Monitoring menu
Use the Monitoring menu, shown in Figure 12-1, to access and configure process monitor parameters.
The Monitoring menu is accessed through the Configuration option of the Management menu. To
access the Management menu, see Chapter 4.
Monitoring menu
(%)
-]
=]
Monitoring =
=
=
@
o
=
2
Screens Variables Update period 73
Screen 1, variable 1 ... Variable list

Screen 2, variable 1 ...
Screen 3, variable 1 ...
Screen 4, variable 1 ...
Screen 5, variable 1 ...

ADRPADD

. (1) Displayed only if the custody
Number of decimals
W&M aporoval® transfer application is installed and
Label PP World Area is set to OIML.

O
o
=
=h
«Q
[=
=
3
«©«
)
=
o
(2]
(13
(7
(72}
=
o
=]
=
o
=
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12.3 Process monitor screens

The Process Monitor Screens menu allows you to specify the process variable that will appear on the
display. You can configure five screens, displaying O to 4 variables on each screen. Font size is

adjusted according to the number of variables configured for display.

See Table 12-1.

Note: For information about using the process monitor, see Chapter 17.

Process monitor screen parameters

Variable

Default

Description

Screen 1, Variable 1

Mass flow rate

Select the process variable that will appear on screen 1, line 1.

Screen 1, Variable 2

Mass total

Select the process variable that will appear on screen 1, line 2.

Screen 1, Variable 3

None

Select the process variable that will appear on screen 1, line 3.

Screen 1, Variable 4

None

Select the process variable that will appear on screen 1, line 4.

Screen 2, Variable 1

Volume flow rate

Select the process variable that will appear on screen 2, line 1.

Screen 2, Variable 2

Volume total

Select the process variable that will appear on screen 2, line 2.

Screen 2, Variable 3

None

Select the process variable that will appear on screen 2, line 3.

Screen 2, Variable 4

None

Select the process variable that will appear on screen 2, line 4.

Screen 3, Variable 1

Density

Select the process variable that will appear on screen 3, line 1.

Screen 3, Variable 2

Temperature

Select the process variable that will appear on screen 3, line 2.

Screen 3, Variable 3

None

Select the process variable that will appear on screen 3, line 3.

Screen 3, Variable 4

None

Select the process variable that will appear on screen 3, line 4.

Screen 4, Variable 1

Density

Select the process variable that will appear on screen 4, line 1.

Screen 4, Variable 2

Mass flow rate

Select the process variable that will appear on screen 4, line 2.

Screen 4, Variable 3

None

Select the process variable that will appear on screen 4, line 3.

Screen 4, Variable 4

None

Select the process variable that will appear on screen 4, line 4.

Screen 5, Variable 1

Mass flow rate

Select the process variable that will appear on screen 5, line 1.

Screen 5, Variable 2

Volume flow rate

Select the process variable that will appear on screen 5, line 2.

Screen 5, Variable 3

Density

Select the process variable that will appear on screen 5, line 3.

Screen 5, Variable 4

Temperature

Select the process variable that will appear on screen 5, line 4.

12.4 Process monitor variahles

The Process Monitor Variables menu allows you to control the following:

* The precision of the process variable values shown on the display. This does not affect the

precision used in internal processing or communicated via digital communications.

* The label to be used for process totalizer and process inventory values on the display.

* The display of the transfer variable (custody transfer applications only).

To change the precision of a process variable:

1. Select it from the list.

2. Specity the number of decimals that will be displayed. The valid range is O to 5.

94
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12.5

To change the label used for a process totalizer or process inventory value:
1. Select the process totalizer or process inventory from the list.

2. Enter the label to be used. This label will be used on the display and printed on process
monitor tickets.

Additionally, if the custody transfer application is installed and World Area is set to OIML, this menu
allows you to specify one or more process variables to be marked with asterisks on the transfer ticket
and, optionally, the process monitor. This is typically done to identify the process variable used for
legal compliance (the transfer variable).

To do this:
1. Select the process variable from the list.

2. Set W&M Approval to Approved or Not Approved, as desired.

Note: For more information, see Section 14.5.

Update period

The update period controls how often the display is refreshed with current data. The default value is
200 msec. The range is 100 to 10,000 msec. The Update Period value applies to all process variables
on the display.

Note: Update Period does not affect the values reported by outputs or digital communications.
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13.1  About this chapter

This chapter explains how to configure digital communications. Only communication parameters are
discussed here; for ticket formatting and printing information, see Chapter 15.

Note: To install wiring for digital communications, see Chapter 3.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

Jaysuea] Apoisn) Buunbiyuon

13.2 Digital communication menu

Use the Digital Communication menu, shown in Figures 13-1 through 13-3, to access and configure
digital communications parameters. The RS-485 menu displayed depends on several factors:

*  Which protocol is configured

(@)
TR o
*  Whether or not the custody transfer application is installed El
@
» If the custody transfer application is installed, whether World Area is set to OIML or NTEP s
3
The Digital Communication menu is accessed through the Configuration option of the Management “_’|
menu. To access the Management menu, see Chapter 4. You will be configuring: =)
(1]
*  RS-485 parameters )
e Bell 202 parameters
e Device parameters
Note: Before you can use digital communications, the appropriate wiring must be installed. See
Chapter 3.
Note: Although the Digital Communication menu is used to configure ticket formatting and printing,
these topics are not discussed in this chapter. For information on ticket formatting and printing, see
Chapter 15.
@
o
3
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S
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Digital communication menu — RS-485 (Protocol = HART, Modbus RTU, or Modbus ASCII)

Digital comm

Configure RS-485

Protocol Configure protocol Discrete inputs®
* HART * Baud rate * Transfer reset screen
* Modbus RTU * Parity * Transfer scr to reset
* Modbus ASCII * Data bits
e Printer * Stop bits

* Polling address”

* Byte order®

(1) If HART protocol is configured for RS-485, Polling Address in RS-485 menu and Polling Address in Bell 202 menu are
duplicates. See Section 13.3.1.

(2) Displayed only if Protocol is set to Modbus RTU or Modbus ASCII.

(3) Displayed only if custody transfer application is installed, World Area is set to OIML, and Protocol is not set to Printer.
For more information, see Section 14.5, Step 6.

Digital communication menu — RS-485 (Protocol = Printer)

Digital comm

Configure RS-485

Protocol Configure printer Format W&M ticket® Discrete inputs Printer test
* HART * Printer selection
* Modbus RTU * Pre header codes!" See Chapter 15 See Chapter 15
* Modbus ASCII * Header line 1-2
* Printer * Footer
* Post footer codes!"
* Baud rate
* Parity
* Data bits
¢ Stop bits

¢ Chars per second
* Print buf size
: Ilzlmesbper Ptaglf s (1) Not displayed if custody transfer application is installed.
. Aﬂtrg perirnct)(z’ Ickets (2) Displayed only if discrete batch application is installed.
« Disable paper (3) Not displayed if World Area is set to OIML.

check® (4) Displayed only if custody transfer application is installed.
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Digital communication menu — Bell 202 and Device setup

Digital comm
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Configure Bell-202 Device setup
Polling address” Fault setting
e Upscale
Loop current mode * Downscale
* Enable * Zero
* Disable * NAN
e Zero flow
Burst mode * None o)
* Enable e
* Disable Description =h
User message =
Burst command HART QV =
* Primary variable HART device ID ‘3
* PV & pct range Transmitter serial no. o)
* Dyn vars & pct range e
* Transmitter vars o
o
Burst variable 1® ':
Burst variable 2 T
Burst variable 3® 3
Burst variable 4® g..
W

(1) If HART protocol is configured for RS-485, Polling Address in RS-485 menu and Polling Address in Bell 202 menu are
duplicates. See Section 13.3.1.
(2) Displayed only if Burst Command is set to Transmitter Vars.

13.3  Configuring RS-485 parameters

o
o
RS-485 parameters specify how the Series 3000 device will communicate via the RS-485 terminals. 2
(To set up RS-485 communications, see Section 3.3.) ‘:_c::
The RS-485 terminals can be configured for HART, Modbus RTU, Modbus ASCII protocol, or printer a
protocol. Different protocol parameters are displayed according to your choice of protocol. ;','
Ey
@
13.3.1 Configuring HART, Modbus RTU, or Modbus ASCII protocol
Parameters used to configure HART, Modbus RTU, and Modbus ASCII protocols are listed and
defined in Table 13-1.
Note: If HART is configured, the Polling Address is used for both HART/RS-485 and HART/Bell 202
communications (see the following section). All other parameters specified here apply only to
HART/RS-485 communications (via the RS-485 terminals). They do not apply to HART/Bell 202
communications (via the primary mA output terminals).
L
o
3
[=
S
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HART, Modbus RTU, and Modbus ASCII parameters

Variable Default Description
Baud rate 9600 baud Select the baud rate to be used with the remote device.
Parity Odd Select None, Odd, or Even as required by the remote device.
Data bits 8 bits This parameter is read-only:
*HART and Modbus RTU - 8
* Modbus ASCII -7
Stop bits 1 bit Enter 1 or 2 stop bits as required by the remote device. If HART is the
configured protocol, Stop bits must be set to 1.
Polling address 0 (HART) Enter the polling address to be assigned to the Series 3000 device.
1 (Modbus) ¢ |[f Modbus/RS-485 protocol is configured, enter a Modbus polling address.
Valid Modbus polling addresses are in the following ranges: 1-15, 32—-47,
64-79, 96-110.

* If HART/RS-485 protocol is configured, enter a HART polling address. See the
discussion in the following section. Valid HART polling addresses are in the
range 0—-15. If the HART polling address is set to any value other than 0, the
primary mA output is fixed at 4 mA, and will not report process variable data or
fault conditions.

Byte order 3—4-1-2 (Modbus RTU or Modbus ASCII only) Specifies the floating point byte order for

Modbus communications. Select one of the following:
*1-2-3-4
*3-4-1-2
*2-1-4-3
*4-3-2—1

Polling address

Two polling addresses are stored on the Series 3000 device: a Modbus polling address and a HART
polling address.

The Modbus polling address can be configured only in the RS-485 menu, and is used for all
Modbus communications.

The HART polling address can be configured either in the RS-485 menu (if HART protocol is
specified) or in the Bell 202 menu. Because only one value can be stored, if Polling Address is
set in both menus, the most recent address will be used for HART communication over both
the RS-485 terminals and the primary mA/HART terminals.

Communicating with a remote device

After RS-485 communications have been set up (both wiring and configuration), there are two
communication methods available:

Service port mode
RS-485 mode

Note: Service port connections use standard settings and do not require transmitter configuration.
Therefore, they are easy and convenient. However, the standard settings and the address may not be
compatible with your network, and the service port cannot be used when the custody transfer
application is installed and the transmitter is secured.

Immediately after the Series 3000 device is powered up, the RS-485 terminals are available in service
port mode for 10 seconds. To connect during this period, configure your remote device as described in
Table 13-2. If a service port connection is made, the terminals will remain in service port mode.
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¢)

o

3

Connection parameters for service port mode ‘g

=

Connection parameter Value %
Protocol Modbus RTU %
Baud rate 38400 o
o)

Stop bits 1 3
Parity none 5
Address/Tag 111 g
COM port COM port assigned to PC serial port %

If no connection is made during the 10-second period, the terminals are automatically reset to RS-485
mode and will remain in that mode. To connect, set the connection parameters to the values
configured in your Series 3000 device.

To switch from service port mode to RS-485 mode or vice versa, you must power down the device,
then power it up and connect in the desired mode.

If the custody transfer application is installed:

» Service port connections are available only if the custody transfer security switch is OFF
(unsecured).

* If the terminals are in service port mode and the custody transfer security switch is then turned
ON (secured), the terminals are reset to RS-485 mode. If there is a current service port
connection, it is broken. To reconnect in service port mode, you must turn off the security
switch and perform a power cycle as described above.
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13.3.2  Configuring printer protocol

Printer protocol parameters are used to:

* Configure communications with a printer. o
=]
e Test the printer setup. é"
*  Format ticket headers and footers. For more information, see Chapter 15. §'
*  Specify screens to print via a discrete input or discrete event. For more information, see c:,|
Chapter 15. 3
)
Configuring printer communications
The parameters used to configure printer communications are listed and defined in Table 13-3. These
parameters control printer communications for all tickets. To access these parameters, refer to
Figure 13-1.
Printer communications parameters
Variable Default Description
Printer selection  Generic Specify the type of printer to be used.
The Terminal option is used to specify a dumb terminal or a terminal emulation @
o
program. 3
FDW refers to FernDruckWerk, a printer interface device. .g
Baud rate 9600 baud Select the baud rate to be used to communicate with the printer.
Parity Odd Select None, Odd, or Even as required by the printer.
Data bits 8 bits Select 7 or 8 as required by the printer.
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Printer communications parameters continued

Stop bits 1 bit Enter 1 or 2 stop bits as required by the printer.
Chars per Variable Enter the number of characters per second to be sent to the printer. The range
second is 1-1000.

The default value for the generic printer is very low, resulting in very slow
printing. Micro Motion recommends checking this parameter and setting it
appropriately for the printer being used.

Print buf size Variable Enter the size of the print buffer, in characters. The range is 32-32768.
The default value for the generic printer is very low, resulting in very slow
printing. Micro Motion recommends checking this parameter and setting it
appropriately for the printer being used.

Lines per page 25 This parameter is read-only, and shown only for user reference. If you are
printing more than 25 lines of data, you will need to insert multiple tickets or use
a roll of paper.

Disable paper Yes Valid only for the Epson ticket printer.
check If it is enabled, and an out-of-paper condition is detected:
« |f the custody transfer application is installed and World Area is set to OIML, a
print failure message is shown on the Series 3000 display for five seconds.
¢ In all other cases, an A130 alarm is posted. The alarm is cleared when the
out-of-paper condition is removed.

Printer test

After configuring the printer, select Printer Test to perform a printer test. A standard test page should
be produced at the printer. When the printer test is complete, the display reads “Print Test Complete.”

If printing does not occur:
*  Check RS-485 output wiring. See Section 3.3.

* Make sure printer configuration settings are compatible with the selected printer. See the
instructions for the selected printer.

13.4  Configuring Bell 202 parameters

The Bell 202 parameters are used to configure HART communications over the Bell 202 physical
layer. (To set up Bell 202 communications, see Section 3.4.)

When using HART/Bell 202 communications, baud rate, stop bits, parity, and data bits have standard
values and cannot be changed. Parameters that can be set for Bell 202 communications are listed and
defined in Table 13-4.

Bell 202 parameters

Variable Default Description

Polling address” 0 Enter the HART polling address to be assigned to the Series 3000 device. Valid
HART polling addresses are in the range 0-15.

Loop current Disable * Select Enable to enable Loop Current Mode.

mode® * Select Disable to disable Loop Current Mode.

Burst mode® Disable * Select Enable to enable burst mode.

¢ Select Disable to disable burst mode.
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Bell 202 parameters continued

Variable Default Description
Burst command  Transmitter vars Specify the type of information that will be broadcast via burst mode. Select
from:

* Primary variable — The Series 3000 device repeats the primary variable
(PV)¥, in measurement units, in each burst (e.g., 14.0 g/s, 13.5 g/s, 12.0 g/s).

* PV & pct range — The device sends the PV’s percent of range and the PV’s
actual mA level in each burst (e.g., 25%, 11.0 mA).

¢ Dyn vars & Pct range — The device sends PV, SV, TV, and quaternary variable
(QV) values in measurement units and the PV’s actual milliamp reading in
each burst (e.g., 50 Ib/min, 23 °C, 50 Ib/min, 0.0023 g/cm?, 11.8 mA).

e Transmitter vars — In each burst, the device sends the four process variables
configured for burst variables 1-4.

Burst variable 1® Mass flow rate ¢ Specifies the process variable to be broadcast in position 1.
¢ Select the desired process variable from the list.

Burst variable 2® Temperature ¢ Specifies the process variable to be broadcast in position 2.
¢ Select the desired process variable from the list.

Burst variable 3® Density ¢ Specifies the process variable to be broadcast in position 3.
¢ Select the desired process variable from the list.

Burst variable 4® Mass total ¢ Specifies the process variable to be broadcast in position 4.
¢ Select the desired process variable from the list.

(1) If HART protocol is configured for RS-485, Polling Address in RS-485 menu and Polling Address in Bell 202 menu are duplicates.
See Section 13.3.1.

(2) See Section 13.4.1.

(3) See Section 13.4.2.

(4) The primary variable (PV) is the process variable reported via the primary mA output (MAO1). The secondary variable (SV) is the
process variable reported via the secondary mA output (MAO?2). The tertiary variable (TV) is the process variable reported via the
frequency output. The quaternary variable (QV) is accessible via HART, and can be assigned through the Device Setup menu. See
Section 13.5.

(5) This parameter appears only if Transmitter Vars is specified for Burst Command.

13.4.1 Loop current mode
Loop current mode is used to fix or unfix the mA output:

* If Loop Current Mode is disabled, the mA output is fixed at 4 mA, and therefore cannot be
used to report process data.

* If Loop Current Mode is enabled, the mA output will report process data as configured.

13.4.2 Burst mode

Burst mode (or HART burst mode) is a specialized mode of communication during which the
Series 3000 device regularly broadcasts process variable data over the primary mA output, using
HART protocol. The Burst Command parameter allows you to specify the content and format of the
process variable data.

Burst mode is ordinarily disabled, and should be enabled only if another device on the network
requires HART burst mode communication.
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Configuring Digital Communications

13.4.3  Communicating with a remote device

After Bell 202 communications have been set up (both wiring and configuration), you can connect to
the Series 3000 device using the parameters described in Table 13-5.

Connection parameters for Bell 202 communications

Connection parameter Value

Protocol HART

Baud rate 1200

Stop bits 1

Parity Odd

Address/Tag As configured in the Series 3000 device
COM port COM port assigned to PC serial port

13.5 Configuring device parameters

The device parameters are used to describe the device and manage digital communication fault
indication. Table 13-6 lists and defines the device parameters.

Device parameters

Variable Default Description

Fault setting None The method used to indicate a fault alarm via digital communication. This
setting also applies to digital communication from the core processor.
Options are as follows:

* Upscale — Process variables indicate the value is greater than the upper
sensor limit. Totalizers stop.

* Downscale — Process variables indicate the value is less than the lower
sensor limit. Totalizers stop.

* Zero — Flow rates, density, and temperature go to their internal zero
value.

*NAN (Not A Number) — Process variables report IEEE NAN. Totalizers
stop.

* Zero flow — Flow rates go to their internal zero value; other process
variables are not affected. Totalizers do not stop.

*None — Process variables reported as measured. Totalizers do not stop.

For all options, Modbus scaled integers report Max Int + 1.

Description Device-dependent® Any user-supplied description. This parameter is not required. The
description may contain up to 16 characters.

User message Device-dependent® Any user-supplied message. This parameter is not required. The
description may contain up to 32 characters.

HART QV Volume flow rate The process variable to be assigned to the quaternary variable (QV). See
the definition of Burst Command in Table 13-4.

HART device ID 0 The HART device ID can be set only once, and is usually set at the factory
to the device serial number. If the HART device ID has not been set, its
value is 0.

Transmitterserial 0 The serial number of the Series 3000 device. This parameter is not

number required.

(1) May be set at the service center to the service center name and the year, month, and day the unit was processed.
(2) May be set at the service center to the service center name and the order ID.
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14.2

About this chapter

This chapter explains how to configure the custody transfer application.

Note: The custody transfer is also known as the weights and measures application. The custody
transfer application is an optional feature of the Series 3000 device, and may not be installed on your
equipment. To verify that it is installed, use the View menu to list all installed applications (see
Section 17.5).

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

About custody transfer

The custody transfer application is designed to allow compliance with weights and measures
requirements. While the Series 3000 device is “secured,” all device data can be viewed, but critical
device configuration and operation functions (e.g., starting and stopping totalizers) cannot be accessed
manually. Operational functions are performed automatically by the device according to existing
configuration. To perform these functions manually, the device must be “unsecured.”

In addition:
* A hardware switch and a weights and measures seal are used for physical security.

* A security breach alarm is posted if the hardware switch is toggled or the core processor is
replaced.

* For some ticket types, if the ticket is printed while a security breach alarm is active, or while a
batch is in progress, a note is added to the ticket.

For a more detailed description of device behavior when the device is “secured” or “unsecured,” see
Chapter 19.
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Configuring Custody Transfer

14.3 Configuration options

The custody transfer application is designed to comply with three different sets of requirements, as
defined by two different regulatory agencies. Before configuring the custody transfer application,
review the descriptions below and follow the configuration instructions for the custody transfer
system that applies to you.

* National Type Evaluation Program (NTEP) — Custody transfer (NTEP) may be used on all
Series 3000 devices.

Custody transfer (NTEP) requires the discrete batch application. Only batches, as managed by
the discrete batch application, can be used for custody transfer measurement. Accordingly, the
process variable used for batch measurement (the batch flow source) serves as the transfer
variable (the process variable used for legal compliance), and the transaction is measured and
managed by the discrete batch application. See Table 14-1.

To configure custody transfer (NTEP), follow the instructions in Section 14.4.
Note: In previous versions of the Series 3000 software, this configuration type was called World Wide.

*  Organisation Internationale de Métrologie Légale (OIML) — Custody transfer (OIML) and
custody transfer (OIML/batch) can be used only on Model 3500 or Model 3700 transmitters;
they are not supported on Model 3300 or Model 3350 controllers.

- In custody transfer (OIML) installations, the discrete batch application is not approved for
custody transfer use, and the transfer is used to define the custody transfer transaction.

- In custody transfer (OIML/batch) installations, the discrete batch application must be
approved for custody transfer use, and either the transfer or the batch may be used to
define the custody transfer transaction.

The enhanced density and petroleum measurement applications may or may not be approved
for custody transfer use. The options for transfer variable, transaction measurement, and
transaction management are described in Table 14-1.

To configure custody transfer (OIML) or custody transfer (OIML/batch), follow the
instructions in Section 14.5.

Note: If you are using the custody transfer (OIML) configuration (i.e., the discrete batch application
is not approved), you can still install and use the discrete batch application to run batches that are not
custody transfer transactions.

Note: In previous versions of the Series 3000 software, the discrete batch application was not
approved for OIML compliance. The custody transfer (OIML) configuration is equivalent to the
configuration previously known as custody transfer (Europe). The custody transfer (OIML/batch)
configuration is new with transmitter software rev7.0.
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Transaction measurement and management

Custody Discrete
transfer batch
type application Method Transfer variable Transaction management Legal receipt
NTEP Required Batch * Batch total * Measured by batch total e Batch (NTEP)
* Ended by: ticket
- Batch (NTEP) ticket printing,
manual or automatic
- Batch reset function
(manual)
OIML Not installed, Transfer * Mass total * Measured by transfer total ¢ Transfer (OIML)
or installed ¢ Volume total ¢ Ended manually by: ticket
but not * API corrected - Transfer (OIML) ticket * Transfer log
approved volume total® printing
*ED net mass total? - Transfer reset function
OIML/batch Installed and  Batch * Batch total * Measured by batch total * Batch (OIML)
approved * Ended by: ticket
- Batch (OIML) ticket printing
(manual or automatic)
- Batch reset function
(manual)
Transfer * Mass total * Measured by transfer total * Transfer (OIML)

¢ VVolume total
¢ API corrected
volume total™

* ED net mass total®

* Ended manually by:
- Transfer (OIML) ticket
printing
- Transfer reset function

ticket
* Transfer log

(1) If approved.

14.4

Configuring custody transfer (NTEP)

To configure custody transfer (NTEP):
1. Referring to Figure 14-1, set World Area to NTEP.

2. Ensure that the Series 3000 system, including the discrete batch application, is completely
configured and tested. Verify that the discrete batch flow source has been set to the process
variable to be used for custody transfer measurement (the transfer variable). Only the
following process variables are valid:

- Mass flow

- Volume flow (liquid)

- QGas standard volume flow

- Frequency input

3. If you are using a Model 3500 or Model 3700 transmitter, perform a sensor zero. See
Section 16.3.

N ok

Configure ticket format and ticket printing as described in Section 15.5.

Referring to Section 13.3, use the Digital Communication menu and set Protocol to Printer.

Select Configure Printer and configure printer communications (see Section 13.3.2).

Set the security switch on your Series 3000 device. The security switch is a hardware switch.

Security does not take effect until the security switch is ON. Detailed instructions for the
different Series 3000 devices are provided in Section 14.6.

8. Contact an authorized agent for installation of the Weights and Measures seal. Detailed
instructions for the different Series 3000 devices are provided in Section 14.7.
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Configuring Custody Transfer

Security menu for custody transfer (NTEP)

Security

Weights & Measures

World area
* NTEP
* OIML

i o
Switch status (1) Read-only.

14.5 Configuring custody transfer (OIML) and custody transfer (OIML/batch)
To configure custody transfer (OIML) or custody transfer (OIML/batch):
1. Referring to Figure 14-2:
a. Set World Area to OIML.
Set Discrete Batch (if displayed) as desired:

* Approved: The discrete batch application can be used for transaction measurement
and management.

* Not Approved: The discrete batch application cannot be used for transaction
measurement and management.

c. Set APl or Enhanced Density (if displayed) as desired:

* Approved: API or enhanced density process variables can be used as the transfer
variable.

* Not Approved: API or enhanced density process variables cannot be used as the
transfer variable.

2. Ensure that the Series 3000 system, including all special applications (discrete batch,
petroleum measurement, enhanced density), is completely configured and tested. Verify the
following:

¢ Volume Flow Type is set to Liquid. Gas standard volume flow cannot be used for OIML
custody transfer.

* If you will use the discrete batch application for transaction measurement, verify that the
discrete batch flow source has been set to the process variable to be used for custody
transfer measurement (the transfer variable). Only the following process variables are
valid:

- Mass flow
- Volume flow (liquid)

- API corrected volume flow (if the petroleum measurement application was approved
in the previous step)

- ED net mass flow (if the enhanced density application was approved in the previous
step)

3. Perform a sensor zero. See Section 16.3.
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4. If desired, you can mark the transfer variable with asterisks that will appear on the transfer
(OIML) ticket and in the transfer log, and optionally, the process monitor. To do this, refer to
Figure 12-1 and:

a. Select the transfer variable and set W&M Approval to Approved. Data for this process
variable will be marked with asterisks on the transfer (OIML) ticket and in the transfer log,
and optionally on the process monitor (see Step 5).

b. For all other process variables, set W&M Approval to Not Approved.

Note: The default setting is Not Approved. It is possible to set more than one process variable to
Approved. If you do this, all approved variables will be marked with asterisks.

suonesunwwo) |eybig burinbiyuon

Note: Approved variables are never marked with asterisks on batch (OIML) tickets.
Note: See Section 19.5.5 for a discussion of the transfer log.

5. If desired, you can specify that all process variables configured as approved in Step 4 will be
marked with asterisks on the process monitor (if the process variables are configured for
display; see Section 12.3). To do this, refer to Figure 14-2 and set Process Monitoring as
desired:

* Approved: Data for all process variables configured as approved in Step 4a will be
marked with asterisks on the process monitor (if the process variables are configured for
display; see Section 12.3).

* Not Approved: No data will be marked with asterisks on the process monitor.
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6. Determine how you will end the transaction, and perform required configuration. Typically,
printing a transfer (OIML) ticket or batch (OIML) ticket ends the transaction. However, if
printing is not available, you can end a custody transfer (OIML) transaction by using the
transfer reset function, and you can end a custody transfer (OIML/batch) transaction by
resetting the batch.

e If you will print transfer (OIML) or batch (OIML) tickets:
a. Referring to Figure 13-2, set Protocol to Printer.

(@)
o
b. Select Configure Printer and configure printer communications (see Section 13.3.2). 2
@
c. Configure ticket format and ticket printing as described in Section 15.6. s
3
* If you will use the transfer reset function via the RESET-T button, refer to Figure 13-1 and “_’|
set Protocol to any value other than Printer. The RESET-T button will now be available =)
from the Transfer Totalizer screen on the View menu. ﬁ-
* If you will use the transfer reset function via discrete input 1 or discrete input 2:
a. Referring to Figure 13-1, set Protocol to any value other than Printer.
Select Discrete Inputs.
c. Select Transfer Reset Screen, then specify the discrete input to be used to complete
the transfer.
d. Select Transfer Scr to Reset and specify the data to be added to the transfer log when
the specified discrete input is activated.
Note: These menu options are similar to the Transfer Print Screen and Transfer Screens To Print
menu options described in Section 15.6.2, except that if the discrete input is configured here, no 5
attempt will be made to print a ticket when the discrete input is activated, and the other menu allows _g'

you to print a ticket containing only inventory data. The discrete input and transfer screens specified
here are reflected in the corresponding menu options, and vice versa.
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Note: If a single discrete input is assigned to print both a transfer (OIML) ticket and a standard or
batch ticket, only the transfer (OIML) ticket will be printed. With the exception of ticket printing and
transfer reset, you can assign one or more actions to a single discrete input. All applicable assigned

actions will be performed. Other discrete input actions and assignments are listed and defined in
Table 7-14.

* If you will use the batch reset function, you can press the RESET button from the batch
process screen, or you can assign the batch reset function to a discrete input or discrete
event (see Section 11.7).

7. If desired, you can define an alarm log password that will be required for the user to access the
active alarm log, the alarm history, and the event log. To do this, refer to Figure 14-2 and:

a. Define the four button-presses that will be used for the alarm log password.

b. Enable the alarm log password.

Note: Once enabled, the alarm log password will be required to re-enter this menu and change or
disable the alarm log password.

8. [Measuring Instruments Directive (MID) compliance] Read and document the Field
Verification Zero (FVZ) value. To read FVZ, you must configure the process monitor to
display it. See Section 12.3.

Note: This is required only for systems that include a transmitter. If your custody transfer application
is running on a Model 3300 or Model 3350 controller, you do not have an FVZ value.

9. (Gas applications in Germany) Read and document the checksum values for the transmitter
and core processor firmware in your flowmeter.

Note: The checksum values may also be useful for MID test reports.

10. Set the security switch on your Series 3000 device. The security switch is a hardware switch.
Security does not take effect until the security switch is ON. Detailed instructions for the
different Series 3000 devices are provided in Section 14.6.

11. Contact an authorized agent for installation of the Weights and Measures seal. Detailed
instructions for the different Series 3000 devices are provided in Section 14.7.
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14.6

Security menu for custody transfer (OIML) and custody transfer (OIML/batch)

Security

Weights & Measures Alarm log
World area Enable alarm log password
* NTEP
* OIML Alarm log password
Process monitoring
Discrete batch"
API® . (1) Displayed only if discrete batch application is installed.
Enhanced density® @ (2) Displayed only if petroleum measurement application is installed.
Transmitter Chegl)(sum (3) Displayed only if enhanced density application is installed.
Core checksum 4) Read-onl
Switch status® (4) Read-only.

Setting the security switch

Security for custody transfer will not take effect until the security switch has been set to ON. The
security switch is a hardware switch.

Note: Current status of the security switch can be viewed using the display, but the display cannot be
used to change the security switch setting.

This step provides instructions for:
¢ Panel-mount devices (Model 3300 or Model 3500)
¢ Rack-mount devices (Model 3300 or Model 3500)
¢ Field-mount devices (Model 3350 or Model 3700)

Follow the instructions for your device.

14.6.1  Panel-mount devices
To set the security switch on a Model 3300 or Model 3500 mounted in a panel:

1. Power down the device.

Note: If you set the security switch on a panel-mount device while power is on, communications
alarms may be produced.

2. Loosen the captive screws in the bracket that holds the screw-type wiring connectors or I/O
cables in place on the back panel of the Series 3000 device.

3. Pull the bracket away from the back panel.

4. The security switch is located on the back panel. To secure the device, set the switch so the
toggle is downward. See Figure 14-3.

5. Plug the bracketed wiring connectors or I/O cables onto the terminal strips in the back panel.
6. Tighten the captive screws to secure the bracket to the back panel.

7. Restore power to the device.
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14.6.2

Security switch on panel-mount Model 3300 or Model 3500

Custody transfer tab
Seal wire will be installed by weights and
measures inspector (see Section 14.7)

Security switch
Security is enabled when toggle is downward

Rack-mount devices

To set the security switch on a Model 3300 or Model 3500 mounted in a rack:

1.

2
3.
4

Loosen the captive screws that secure the front panel of the Series 3000 device to the rack.

. Slide the platform out of the rack.

Remove the protective mask (see Figure 14-4).

. The security switch is located on the back panel of the platform. To secure the device, set the

switch so the toggle is downward. See Figure 14-4.

5. Reinstall the protective mask.

6. Install a weights and measures seal (see Section 14.7) through the custody transfer tab shown

in Figure 14-4. This installation must be performed by a weights and measures inspector.

7. Align the platform with the guide rails in the rack.

8. Slide the platform into the rack. Make sure the pins on the back panel make contact with the

10.
11.

wiring connectors.

(Optional) Replace the top two or bottom two screws in the front panel of the platform with the
supplied lockout screws. See Figure 14-5.

Make sure all four front-panel screws are tightly secured to the guide rails in the rack.

(Optional) Install a weights and measures seal through the holes in the front panel. See
Figure 14-5.
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Security switch on rack-mount Model 3300 or Model 3500

Custody transfer tab
Seal wire will be installed by weights and

Protective mask measures inspector (see Section 14.7)
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14.6.3  Field-mount devices
A WARNING
Explosion hazard.

In an explosive atmosphere, do not remove the circuit board compartment
cover within 2 minutes after power has been disconnected. wn
)
Figure 14-6 identifies the circuit board compartment. _g'
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A CAUTION

Improper handling of device components can damage the Series 3000
device.

If a breaker bar or other tool is used for loosening the cover of the circuit board
compartment:

* Apply steady pressure to avoid chipping the paint. Chipped paint can result in
corrosion of the housing. If the paint is chipped, repaint the housing.

* Do not apply excessive torque. Excessive torque can damage the pipeline or the
platform.

To set the security switch on the Model 3350 or Model 3700:
1. Unscrew the circuit board compartment cover.

2. The security switch is located on the panel inside the circuit board compartment. To secure the
device, set the switch so the toggle is toward the mounting bracket for the Series 3000 device.
See Figure 14-6.

3. Reinstall the cover. Tighten the cover to 12 ft-1b (16 N-m) torque.

Security switch on Model 3350 or Model 3700

Circuit board compartment

Do not open within 2 minutes
after power has been
disconnected

Custody transfer hasp and tab (x4)
Seal wire will be installed by weights and
measures inspector (see Section 14.7)

Security switch

Security is enabled

when toggle is toward mounting
bracket
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14.7 Installing the weights and measures seal

The weights and measures seal must be installed and secured by a weights and measures inspector or
authorized third party.

On a panel-mount Model 3300 or Model 3500, the inspector runs the wire seal through the
custody transfer tab, as shown in Figure 14-3.

On a rack-mount Model 3300 or Model 3500, two locations are provided for the weights and
measures seal:

- Required: The inspector must run a wire seal through the custody transfer tab, as shown in
Figure 14-4.

- Optional: The inspector may run a wire seal through the holes in the lockout screws on the
front panel of the platform, as shown in Figure 14-5.

On a field-mount Model 3350 or Model 3700, a hasp on the housing is located beside the
circuit board compartment cover. The cover has four tabs. The inspector runs the wire seal
through the hole in the hasp and the hole in the nearest tab, as shown in Figure 14-6.
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15.1

15.2

About this chapter

This chapter explains how to format and print tickets. To print tickets, digital communication to a
printer must be configured. See Section 13.3.2.

Failure to perform configuration tasks in the proper sequence could result in an incomplete
configuration. See Section 1.7 for the recommended configuration sequence.

A CAUTION

Changing configuration can affect device operation.

Set control devices for manual operation before changing device configuration.

Ticket overview

There are five ticket types. Different ticket types are available, depending on the discrete batch
application and the custody transfer application (see Table 15-1). Contents of each ticket type are
listed in Table 15-2.

You can format each ticket type separately. For some ticket types, you can specify that certain types of
content will be included or excluded, and you can configure the tickets to print automatically, e.g., at

certain points in a discrete batch, or when an event occurs. You can also print tickets manually at
certain times, using either the PRINT button on the display or a discrete input.

Format only the ticket types that you will use. Formatting of each ticket type is described in Sections

15.3 through 15.6.
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Ticket Formatting and Printing

Ticket availability

Tickets available

Batch Transfer Batch
Special applications Standard Batch® (NTEP)? (OIML) (OIML)®
None v
Discrete batch application v v
Custody transfer application (NTEP) v /@
(Requires discrete batch application)
Custody transfer application (OIML) v /0 @
(Discrete batch application not installed, or installed
but not approved)
Custody transfer application (OIML/batch) v @ @

(Requires discrete batch application installed and

approved)

(1) Refers to batch tickets when (a) the custody transfer application is not installed, or (b) the custody transfer application is installed,
World Area is set to OIML, and the discrete batch application is not approved for custody transfer.

(2) Refers to batch tickets when the custody transfer application is installed and World Area is set to NTEP.

(3) Refers to batch tickets when the custody transfer application is installed, World Area is set to OIML, and the discrete batch
application is approved for custody transfer.

(4) Legal receipt.
(5) Not a legal receipt.

(6) Available only if the discrete batch application is installed.

Ticket contents

Ticket contents

Ticket type Header lines (standard) Ticket contents (conditional)
Standard 1and?2 * Depends on ticket (e.g., ¢ “*Approved Measurement*” banner
3and 4" process monitor data, alarm
log, etc.)
Batch 1and 2 * Batch date and time *“Not A Legal Receipt” banner®

* Batch data
* Print timestamp

Batch (NTEP) 1and2
3and 4

¢ Batch date and time
e Batch data
e Batch BOL number

¢ “Duplicate Receipt” banner
* “Security Breach” banner
*“Not A Legal Receipt’ banner

Transfer (OIML) 1and2

* Transfer date and time ¢ “Not Complete” banner with current flow rate

3and 4 * Transfer data data
e Transfer BOL number ¢ “Complete” banner
* “Alarm occurred during the Transfer’ banner®
Batch (OIML) 1and2 * Batch date and time * “Duplicate Receipt” banner
3and 4 e Batch data * “Security Breach” banner

e Batch BOL number *“Not A Legal Receipt’ banner

(1) Audit event log tickets only. Lines 3 and 4 are formatted and printed as configured for transfer tickets.
(2) Appears only when the custody transfer application is installed, World Area is set to OIML, and the discrete batch application is not

approved for custody transfer.

(3) Alarm may or may not have been a security breach.
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15.3  Standard tickets
This section describes the formatting and printing of standard tickets.
15.3.1 Formatting
To format standard tickets:
1. In the Digital Communication menu, select Configure RS-485 and set Protocol to Printer.
The menu shown in Figure 15-1 is displayed.
Select Configure printer.
Set parameters as desired. See Table 15-3.
Note: Other parameters in this menu are defined in Table 13-3.
Note: The Header Line 1, Header Line 2, and Footer parameters are shared with all ticket types. Any
formatting defined for standard tickets is applied to all tickets.
Note: Because the audit trail is a custody transfer feature and requires the custody transfer
application, audit event log tickets include the Header Line 3 and Header Line 4 parameters
configured for transfer tickets (see Section 15.6.1 or Section 15.5.1). In all other respects, audit event
log tickets are standard tickets.
Ticket configuration menu — Standard tickets
Digital comm
Configure RS-485
Protocol Configure printer Discrete inputs Printer test
* HART ¢ Printer selection * Print screen
* Modbus RTU * Pre header codes!" * Screens to print
* Modbus ASCII ¢ Header line 1-2 ¢ Print process monitor
* Printer * Footer
* Post footer codes!”
* Baud rate
* Parity
* Data bits
* Stop bits

* Chars per second
* Print buf size
e Lines per page \ (1) Not displayed if custody transfer application is installed.
* Number O(fz)“CketS( ) (2) Displayed only if discrete batch application is installed,
* Auto print @ and applies only to batch tickets.
* Disable paper check . . .

(3) Not displayed if custody transfer World Area is set to
OIML.
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Ticket Formatting and Printing

Ticket parameters for standard tickets

Variable Default Description
Pre header codes None Printer control codes. Enter any control codes required by your
Post footer codes printer, e.g., form feed.
Header line 1 Text Blank (no text) Enter the text for this line of the header or for the footer.
Header line 2 You may enter up to 22 characters. Scroll as required to view all
Footer characters.

Line feeds 1 line Enter 1, 2, or 3. This parameter controls the space between the

current line and the following line.

Font size Normal height Select normal height or double height.®

(1) ASCII non-printable control codes are represented by a two-character sequence in hexadecimal format; e.g., the linefeed character
is “OA" (zero, A). Leading or trailing spaces are ignored, but spaces must not be inserted between hex codes.

(2) Not all printers are capable of double height. If double height is configured but the printer cannot print double height, normal height
will be used.
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15.3.2  Printing

You can print standard tickets manually, via the display, or via a discrete input. You can also specify
that tickets will be printed automatically if a discrete event occurs. You may use as many of these
methods as desired.

Display
To print standard tickets from the display, use the PRINT button. The PRINT button appears whenever
the print function is available. For example, you can print:

*  The current process monitor screen

e All configured process monitor screens

e All configuration data

*  The active alarm log, alarm history, or alarm event log

If the Series 3000 device is connected to a standard core processor, you can specify whether or not
process monitor tickets will include the average, maximum, and minimum values for process
variables, when appropriate. To do this, use the Print Process Monitor option described in the
following section.

Discrete input or discrete event

You can configure the Series 3000 device so that a standard ticket is printed whenever a discrete input
is activated or a discrete event occurs. This ticket can include one or several screens; all assigned
screens will be printed. To do this:

1. From the Digital Communication menu (see Figure 15-1), select Configure RS-485, then
select Discrete Inputs.

2. Using the Print screen option, select the discrete input or discrete event to which you will
assign screens.

3. Using the Screens to print option, specify the screens that will be printed when the specified
discrete input is activated or the discrete event occurs. You may specify as many screens as
desired.

4. (Standard core processor only) If you specified a process monitor screen, use the Print
Process Monitor option to control whether or not the ticket will include the average,
maximum, and minimum values for process variables, when appropriate (With Stats or
Without Stats).
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15.4

Note: You can assign one or more actions to a single discrete input or discrete event. Other discrete
input and discrete event actions and assignments are listed and defined in Table 7-14. Note that if you
assign ticket printing to a discrete input or a discrete event, all standard, batch, batch (NTEP), and
batch (OIML) tickets will be printed, but if a transfer (OIML) ticket is assigned with other ticket types,
only the transfer (OIML) ticket will be printed. If required, assign the transfer (OIML) ticket to one
discrete input and assign all other tickets to the second discrete input.

Batch tickets

This section describes the formatting and printing of batch tickets.

15.4.1 Formatting
To format batch tickets:

1. In the Digital Communication menu, select Configure RS-485 and set Protocol to Printer.
The menu shown in Figure 15-2 is displayed.

Select Configure Printer.

Set parameters as desired. See Table 15-4.
Note: Other parameters in this menu are defined in Table 13-3.

Note: The Header Line 1, Header Line 2, and Footer parameters are shared with all ticket types. Any
formatting defined for batch tickets is applied to all tickets.

Ticket configuration menu — Batch tickets

Digital comm

Configure RS-485

Protocol Configure printer Discrete inputs Printer test
* HART
* Modbus RTU * Printer selection * Print screen
* Modbus ASCII * Pre header codes ¢ Screens to print
* Printer * Header line 1 -2 * Print process monitor
* Footer
* Post footer codes
* Baud rate
* Parity
* Data bits
* Stop bits

* Chars per second
* Print buf size

* Lines per page ) ) o
o Number of tickets (1) Not displayed if custody transfer application is installed
* Auto print and World Area is set to OIML.

* Disable paper check!"
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Ticket Formatting and Printing

Ticket parameters for batch tickets

Variable

Default

Description

Pre header codes
Post footer codes

None

Printer control codes. Enter any control codes required by your
printer, e.g., form feed.

Header line 1 Text Blank (no text) Enter the text for this line of the header or for the footer.
Header line 2 You may enter up to 22 characters. Scroll as required to view all
Footer characters.

Line feeds 1 line Enter 1, 2, or 3. This parameter controls the space between the

current line and the following line.

Font size Normal height Select normal height or double height.
Number of 1 The number of batch tickets to be printed by the Auto Print
tickets function (if Auto Print is enabled) or by a manual print request.
Auto print No * Select Yes if you want batch tickets to be printed automatically at

the end of each batch. Tickets will be printed only if the target
has been reached and flow is stopped.

* Select No if you do not want tickets to be printed automatically at
the end of each batch.

(1) Not all printers are capable of double height. If double height is configured but the printer cannot print double height, normal height

will be used.

15.4.2  Printing

Batch tickets can be printed in several ways:

* Automatically, when the batch ends or when a discrete event occurs

e Manually, using the display or a discrete input

Note: Information in this section applies only to batch tickets that are not used as custody transfer
tickets. For information on printing batch tickets used as custody transfer tickets, see Section 15.5.2
for batch (NTEP) tickets, or Section 15.6.2 for batch (OIML) tickets.

Auto print

To print batch tickets automatically when the batch target is reached, configure the Auto Print and
Number of Tickets parameters as required (see Table 15-4).

Display

To print batch tickets from the display, use the PRINT button. The PRINT button appears only when
the batch is ended; it does not appear when the batch is stopped.

Discrete input or discrete event

You can configure the Series 3000 device so that a batch ticket is printed whenever a discrete input is
activated or a discrete event occurs. This ticket can include one or several screens in addition to the
batch screen; all assigned screens will be printed. To do this:

1. From the Digital Communication menu (see Figure 15-1), select Configure RS-485, then
select Discrete Inputs.

2. Using the Print Screen option, select the discrete input or discrete event to which you will
assign screens.

3. Using the Screens to Print option, specify the screens that will be printed when the specified
discrete input is activated or the discrete event occurs. You may specify as many screens as

desired.
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15.5

If the print request occurs:
*  When flow is not present (the batch is stopped or ended), the batch ticket is printed.

*  When flow is present, the request is queued until flow stops, and the batch ticket is printed at
that time.

Note: You can assign one or more actions to a single discrete input or discrete event. Other discrete
input and discrete event actions and assignments are listed and defined in Table 7-14. Note that if you
assign ticket printing to a discrete input or a discrete event, all standard, batch, batch (NTEP), and
batch (OIML) tickets will be printed, but if a transfer (OIML) ticket is assigned with other ticket types,
only the transfer (OIML) ticket will be printed. If required, assign the transfer (OIML) ticket to one
discrete input and assign all other tickets to the second discrete input.

Multiple tickets
If multiple tickets are printed:
*  With one print request, all tickets are identical.

e With multiple print requests, each ticket contains the timestamp and batch data that was
current when the ticket was printed.

Batch (NTEP) tickets

This section describes the formatting and printing of transfer tickets when the custody transfer
application is configured for World Area = NTEP.

15.5.1 Formatting

The batch (NTEP) ticket is basically a batch ticket, with a few additional options. To format batch
(NTEP) tickets:

1. Format a batch ticket as described in Section 15.4.1.

2. In the Digital Communication menu, select Configure RS-485, then select Format W&M
Ticket. The menu shown in Figure 15-3 is displayed.

3. Set parameters as desired. See Table 15-5.
Note: Other parameters in this menu are defined in Table 13-3.

Note: The Pre Header, Post Footer, Header Line 1, Header Line 2, and Footer parameters are shared
with all ticket types. Any formatting defined for batch (NTEP) tickets is applied to all tickets.
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Ticket Formatting and Printing

Ticket configuration menu — Batch (NTEP) tickets

Digital comm

Configure RS-485

Protocol Configure printer Format W&M ticket Discrete inputs Printer test
* HART
* Modbus RTU * Printer selection * Header line 1 — 4 * Print screen
* Modbus ASCII * Pre header codes * Footer * Screens to print
* Printer * Header line 1 -2 e Batch start no. (BOL) * Print process monitor

* Footer

* Post footer codes

* Baud rate

* Parity

* Data bits

* Stop bits

* Chars per.second (1) Does not apply to batch (NTEP) tickets. Only one batch

* Print buf size NTEP) tick b nted . heth inted

« Lines per page ( ) ticket can be printed at a time, whether printe

o Number of tickets™ automatically or manually.

* Auto print

* Disable paper check

Ticket parameters — Batch (NTEP) tickets
Variable Default Description
Header line 1 Text Blank (no text) Enter the text for this line of the header or for the footer.
Header line 2 You may enter up to 22 characters. A maximum of 21 characters
Header line 3 are displayed. Scroll as required to view all characters.
Header line 4 - - -
Line feeds 1 line Enter 1, 2, or 3. This parameter controls the space between the
Footer . S
current line and the following line.
Font size Normal height Select normal height or double height.”
Batch start no. 0 Starting ticket number for batch bills of lading (BOL).
(BOL)
(1) Not all printers are capable of double height. If double height is configured but the printer cannot print double height, normal height

will be used.
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15.5.2  Printing

Batch (NTEP) tickets can be printed in several ways:
* Automatically, when the batch ends or when a discrete event occurs
e Manually, using the display or a discrete input

Only one batch (NTEP) ticket can be printed at a time; the Number of Tickets parameter is not
applied.

The custody transfer transaction ends when the first batch (NTEP) ticket is printed for the current
batch. This is true even when the batch is ended, the target is increased, and the batch is then resumed.
In this case, all tickets will contain identical custody transfer data, even though the batch data may
have changed.
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15.6

Auto print

To print a batch (NTEP) ticket automatically when the batch target is reached, set the Auto Print
parameter for batch tickets to Yes (see Table 15-4).

Display

To print a batch (NTEP) ticket from the display, use the PRINT button on the batch process screen.
The PRINT button appears only when the batch is ended; it does not appear when the batch is stopped.

Discrete input or discrete event

You can configure the Series 3000 device to print a batch (NTEP) ticket when a discrete input is
activated or a discrete event occurs. This ticket can include one or several screens in addition to the
batch (NTEP) ticket; all assigned screens will be printed. To do this:

1. From the Digital Communication menu (see Figure 15-1), select Configure RS-485, then
select Discrete Inputs.

2. Using the Print Screen option, select the discrete input or discrete event to which you will
assign screens.

3. Using the Screens to Print option, specify the screens that will be printed when the specified
discrete input is activated or the discrete event occurs. You may specify as many screens as
desired.

If the print request occurs:
*  When flow is not present (the batch is stopped or ended), the batch (NTEP) ticket is printed.

*  When flow is present, the request is queued until flow stops, and the batch (NTEP) ticket is
printed at that time.

Note: You can assign one or more actions to a single discrete input or discrete event. Other discrete
input and discrete event actions and assignments are listed and defined in Table 7-14.

Additional tickets

Before the batch reset is performed, additional batch (NTEP) tickets for the current transaction can be
printed manually, by using the PRINT button or by activating a discrete input that has been configured
to print a batch (NTEP) ticket. The batch (NTEP) tickets will contain identical custody transfer data,
and all tickets except the first, will include the “Duplicate receipt” banner.

Transfer (OIML) tickets

This section describes the formatting and printing of transfer tickets when the custody transfer
application is configured for World Area = OIML and the discrete batch application is not used to
manage the custody transfer transaction.

15.6.1 Formatting
To format transfer (OIML) tickets:

1. In the Digital Communication menu, select Configure RS-485 and set Protocol to Printer.
The menu shown in Figure 15-4 is displayed.

2. Select Format W&M Ticket.

3. Set parameters as desired. See Table 15-6.
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Ticket Formatting and Printing

Note: The Pre Header, Post Footer, Header Line 1, Header Line 2, and Footer parameters are shared
with all ticket types. Any formatting defined for transfer (OIML) tickets is applied to all tickets.

Note: Other parameters in this menu are defined in Table 13-3.

Note: In previous versions of the custody transfer application, a Transfer Total Format parameter was

displayed. This has been replaced by the W&M Approval option (see Section 14.5, Step 4).

Ticket configuration menu - Transfer (OIML) tickets

Digital comm

Configure RS-485

Protocol Configure printer Format W&M ticket Discrete inputs Printer test
« HART
* Modbus RTU * Printer selection Header line 1 -4 * Transfer print screen®
* Modbus ASCII * Pre header codes * Transfer screens to
* Printer * Header line 1 -2 Transfer ticket print®
* Footer * Transfer start (BOL) * Print screen®
* Post footer codes * Transfer print * Screens to print®
* Baud rate conditions * Print process monitor
* Parity * Transfer form feed
* Data bits * Alarm occurred
e Stop bits * Number of transfer
e Chars per second tickets
* Print buf size
* Lines per page Footer
» Number of tickets!"
* Auto print®
(1) Not applicable to transfer (OIML) tickets.
(2) Used to print transfer (OIML) tickets.
(3) Used to print other ticket types.
Ticket parameters — Transfer (OIML) tickets
Variable Default Description
Pre header codes None Printer control codes. Enter any control codes required by your

Post footer codes printer, e.g., form feed.

Enter the text for this line of the header or for the footer.
You may enter up to 22 characters. Scroll as required to view

Header line 1 Text
Header line 2

Blank (no text)

Header line 3 all characters.
Header line 4 Line feeds 1 line Enter 1, 2, or 3. This parameter controls the space between the
Footer h Lo
current line and the following line.
Font size Normal height Select normal height or double height.”
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Ticket parameters — Transfer (OIML) tickets continued

Variable Default Description
Transfer Transfer start 0 Starting ticket number for transfer bills of lading (BOL).
ticket (BOL) Changing the start number resets the transfer log. If the start

number is changed after transfers have been completed, all
data in the transfer log is lost.

Transfer print With flow * No Flow — Tickets cannot be printed if there is any flow
conditions through the sensor. If a ticket is printed under conditions of
no flow, and the ticket includes a transfer total, the transfer is
completed, and the flow rate and the banner “Complete” are
printed on the ticket.
* With Flow — Tickets may be printed while flow is occurring.

- If a ticket is printed while flow is occurring, the flow rate and
the banner “Not complete” are printed on the ticket, and the
transfer continues.

- If a ticket is printed under conditions of no flow and the ticket
includes a transfer total, the transfer is completed, and the
flow rate and the banner “Complete” are printed on the
ticket.

- If a ticket is printed under conditions of no flow and the ticket
does not include a transfer total, the flow rate is printed on
the ticket and the transfer is not completed.

suonesunwwo) |eybig burinbiyuon

Transfer form feed No *No — A form feed will not be issued automatically after a ticket
has been printed.
*Yes — A form feed will be issued automatically after a ticket
has been printed.
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Alarm occurred No ¢ No — Tickets will not include the banner “Alarm occurred
during the transfer” if an alarm occurs during transfer
processing.

*Yes — Tickets will include the banner “Alarm occurred during
the transfer” if an alarm occurs during transfer processing.

Number of 1 The number of transfer (OIML) tickets to be printed when a
transfer tickets print request is received. The range is 1 to 3.?)

(1) Not all printers are capable of double height. If double height is configured but the printer cannot print double height, normal height
will be used.

(2) Each print request (depending on flow and ticket contents) completes a transaction. If duplicate tickets are required for each
transaction, you must specify the required number here; there is no other way to print duplicate tickets. All tickets for the same
transfer are identical; they do not contain the “Duplicate receipt” banner.
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15.6.2  Printing

Transfer (OIML) tickets must be printed manually, using either the PRINT button on the display or a
discrete input configured to print a transfer (OIML) ticket.

The results of the print request depend on the flow at the time of the print request and the Transfer
Print Conditions parameter, and the contents of the ticket, as shown in Table 15-7.

dnueis
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Results of print request for transfer (OIML) tickets

Flow at time of Ticket contains  Transfer Print
print request? transfer total? Conditions Result

Flow present N/A With Flow * “Not Complete” banner and flow rate printed on ticket

* Current transfer totals are printed on ticket, but not
marked with asterisks even if the process variables
are approved

e Transfer continues

N/A No Flow * Ticket not printed
* Transfer continues

No flow

Yes N/A ¢ “Complete” banner printed on ticket
* Transfer total printed on ticket
* Approved process variables marked with asterisks
* Custody transfer transaction completed automatically
 Transfer data written to transfer log
* Transfer BOL number incremented
* Next custody transfer transaction started

No N/A * “Not Complete” banner and flow rate printed on ticket
* Transfer continues

128

Display
Note: This function is not available if flow is present and Transfer Print Conditions is set to No Flow.

To print a transfer (OIML) ticket from the display:
1. From the View menu, select Transfer Totalizer.
2. Select the type of ticket you want to print.
3. Press the PRINT button.

Discrete input

You can configure a discrete input to print a transfer (OIML) ticket.

Note: You can assign one or more actions to a single discrete input. Other discrete input actions and
assignments are listed and defined in Table 7-14. Note that if you assign ticket printing to a discrete
input, all standard, batch, and batch (OIML) tickets can be printed from one discrete input, but if a
transfer (OIML) ticket is assigned with other ticket types, only the transfer (OIML) ticket will be
printed. If required, assign the transfer (OIML) ticket to one discrete input and assign all other tickets
to the second discrete input.

To do this:

1. From the Digital Communication menu (see Figure 15-4), select Configure RS-485, then
select Discrete Inputs.

2. Use the Transfer Print Screen option to select the discrete input to which you will assign the
transfer (OIML) ticket.

3. Use the Transfer Screen to Print option to specify the set of data that will be printed when the
specified discrete input is activated.

* If Transfer Totals, Transfer & Inventory, API Transfer & Inventory or ED Transfer &
Inventory is selected, printing this ticket under conditions of no flow will cause the
transfer to be completed and transfer data to be recorded in the transfer log.

» IfInventory is selected, printing this ticket will not cause the transfer to be completed and
no data will be recorded in the transfer log.
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15.7

Note: The Transfer Print Screen and Transfer Screens to Print options are similar to the Transfer
Reset Screen and Transfer Scr To Reset menu options described in Section 14.5, Step 6, except that
this menu includes the Inventory option, and if the discrete input is configured here, a ticket will be
printed when the discrete input is activated. The discrete input and transfer screens specified here are
reflected in the corresponding reset menu options, and vice versa.

Multiple tickets

If multiple tickets are required, set Number of Transfer Tickets to the required number. Because a
transfer (OIML) print request may complete the current transfer and begin a new one, you cannot use
multiple print requests to print duplicate tickets. All tickets for the same OIML transfer are identical;
they do not contain the “Duplicate receipt” banner.

Batch (OIML) tickets

This section describes the formatting and printing of transfer tickets when the custody transfer
application is configured for World Area = OIML and the discrete batch application is used to manage
the custody transfer transaction.

15.7.1 Formatting
To format batch (OIML) tickets:

1. In the Digital Communication menu, select Configure RS-485 and set Protocol to Printer.
The menu shown in Figure 15-4 is displayed.

2. Select Format W&M Ticket.
3. Set parameters as desired. See Table 15-6.
Note: The Pre Header, Post Footer, Header Line 1, Header Line 2, and Footer parameters are shared

with all ticket types. Any formatting defined for transfer (OIML) or batch (OIML) tickets is applied to
all tickets.

Note: Other parameters in this menu are defined in Table 13-3.

Note: In previous versions of the custody transfer application, a Transfer Total Format parameter was
displayed. This has been replaced by the W&M Approval option in the Configuration > Monitoring
menu (see Section 14.5, Step 4).
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Ticket configuration menu — Batch (OIML) tickets

Digital comm

Configure RS-485

Protocol

* HART

* Modbus RTU
e Modbus ASCII
e Printer

Configure printer

e Printer selection

* Pre header codes
e Header line 1 — 2
¢ Footer

* Post footer codes
* Baud rate

* Parity

¢ Data bits

e Stop bits

Format W&M ticket
Header line 1 — 4
Transfer ticket®
Footer

Batch start no. (BOL)

Discrete inputs

« Transfer print screen®

* Transfer screens to
print®

* Print screen

* Screens to print

* Print process monitor

Printer test

e Chars per second
* Print buf size

* Lines per page

» Number of tickets(”

(1) Applies only to batch tickets. Not applicable to batch (OIML) tickets.
(2) Not applicable to batch (OIML) tickets.

Ticket parameters — Batch (OIML) tickets

Variable

Default

Description

Pre header codes
Post footer codes

None

Printer control codes. Enter any control codes required by your

printer, e.g., form feed.

Header line 1 Text

Blank (no text)

Enter the text for this line of the header or for the footer.

Header line 2 You may enter up to 22 characters. Scroll as required to view
Header line 3 all characters.
Header line 4 Line feeds 1 line Enter 1, 2, or 3. This parameter controls the space between the
Footer ; Lo
current line and the following line.

Font size Normal height Select normal height or double height.”
Transfer Not applicable to batch (OIML) tickets.
ticket
Batch start Starting ticket number for batch bills of lading (BOL).
number
(BOL)

(1) Not all printers are capable of double height. If double height is configured but the printer cannot print double height, normal height

will be used.
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15.7.2  Printing
Batch (OIML) tickets can be printed in several ways:
* Automatically, when the batch ends
e  Manually, using the display or a discrete input

Only one batch (OIML) ticket can be printed at a time; the Number of Tickets parameter is not
applied.

The custody transfer transaction ends when the first batch (OIML) ticket is printed for the current
batch. This is true even when the batch is ended, the target is increased, and the batch is then resumed.
In this case, all tickets will contain identical custody transfer data, even though the batch data may
have changed.
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Auto print

To print a batch (OIML) ticket automatically when the batch target is reached, set the Auto Print
parameter for batch tickets to Yes (see Table 15-8).

Display

To print a batch (OIML) ticket from the display, use the PRINT button on the batch process screen.
The PRINT button appears only when the batch is ended; it does not appear when the batch is stopped.

Discrete input or discrete event

You can configure the Series 3000 device to print a batch (OIML) ticket when a discrete input is
activated or a discrete event occurs. This ticket can include one or several screens in addition to the
batch (OIML) ticket; all assigned screens will be printed.
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Note: You can assign one or more actions to a single discrete input or discrete event. Other discrete
input and discrete event actions and assignments are listed and defined in Table 7-14. Note that if you
assign ticket printing to a discrete input or a discrete event, all standard and batch (OIML) tickets can
be printed from one discrete input or discrete event, but if a transfer (OIML) ticket is assigned with
other ticket types, only the transfer (OIML) ticket will be printed. If required, assign the transfer
(OIML) ticket to one discrete input and assign all other tickets to the second discrete input.

To do this:

1. From the Digital Communication menu (see Figure 15-4), select Configure RS-485, then
select Discrete Inputs.
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2. Use the Print Screen option to select the discrete input to which you will assign the batch
(OIML) ticket.

3. Use the Screens to Print option to specify that a batch ticket will be printed. Printing this
ticket will always complete the transfer.

Multiple tickets

If multiple tickets are required, use the PRINT button or the discrete input to print additional tickets
before the batch is reset. One ticket will be printed for each print request. The additional tickets will
contain the “Duplicate receipt” banner.

dnueis
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16.1  About this chapter

This chapter explains the procedures that are required for initial startup of the Series 3000 device.
After initial startup, these procedures may be performed as required for troubleshooting or
maintenance.

The following procedures are discussed:
e Applying power to the flowmeter
* Sensor zero
e Testing the inputs and outputs
e Milliamp output trim

Note: If you are using a Model 3300 or Model 3350 controller, the sensor zero procedure is not
applicable to your device. Perform the other procedures as applicable.
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16.2  Applying power

Before you apply power to the Series 3000 device, close and tighten all housing covers.

A WARNING

Operating the Series 3000 device without covers in place creates electrical
hazards that can cause death, injury, or property damage.

Make sure safety barrier partition and covers for the field-wiring, circuit board
compartments, electronics module, and housing are all in place before applying
power to the Series 3000 device.

s)a)o11 Bunbyuosn

Turn on the electrical power at the power supply. The flowmeter automatically tests its display.
During display testing, the screen darkens for approximately five seconds. After the display test is
completed:

1. The Micro Motion logo is displayed for two to three seconds.
2. An application list is displayed for two to three seconds.
3. The device enters operation mode:

» If the discrete batch application is not installed, the process monitor screen is displayed, as
shown in Figure 17-1.

» If the discrete batch application is installed, the batch process screen is displayed (see
Figure 18-1).
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4. If there are any active alarms, the alarm category will be displayed in the alarm bar. To view,
acknowledge, or respond to the alarms, see Chapter 22.

Note: Series 3000 transmitters are ready to begin measurement approximately one minute after
power-up (time varies with models). However, approximately ten minutes are required for the
electronics to warm up to equilibrium. During this ten-minute period, the transmitter may exhibit
minor instability or inaccuracy.

16.2.1 Communication methods after power-up
After power-up:
e Communication via the display is available as soon as the display is visible.

* If you are using the Communicator, or ProLink II with HART/Bell 202, you can establish
communication with the Series 3000 device immediately after power-up, using the primary
mA output terminals. See Appendix G for more information on using ProLink II and
Appendix H for more information on using the Communicator.

e If you are using ProLink II via the RS-485 physical layer, the RS-485 terminals are available
to establish a connection in service port mode for 10 seconds immediately after power-up. If
no service port connection is made during this period, the terminals are automatically reset to
the configured RS-485/Modbus communication parameters. Be sure to set the ProLink II
connection parameters appropriately.

Sensor zero
Note: This section is not applicable to Model 3300 or Model 3350 controllers.

Zeroing the flowmeter establishes the flowmeter’s point of reference when there is no flow. The meter
was zeroed at the factory, and should not require a field zero. However, you may wish to perform a
field zero to meet local requirements or to confirm the factory zero.

When you zero the flowmeter, you may need to adjust the zero time parameter. Zero time is the
amount of time the transmitter takes to determine its zero-flow reference point. The default zero time
is 20 seconds.

* A long zero time may produce a more accurate zero reference but is more likely to result in a
zero failure. This is due to the increased possibility of noisy flow, which causes incorrect
calibration.

* A short zero time is less likely to result in a zero failure but may produce a less accurate zero
reference.

For most applications, the default zero time is appropriate.

Note: Do not zero the flowmeter if a fault alarm is active. Correct the problem, then zero the
flowmeter. You may zero the flowmeter if a low-severity alarm is active. See Section 22.6 for
information on viewing transmitter status and alarms.
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16.3.1  Zero failure and restoring zero values
If the zero procedure fails, see Section 16.3.4 for troubleshooting information.
Additionally, if you have the enhanced core processor:

*  You can restore the factory zero. This procedure returns the zero value to the value obtained at
the factory, if the factory configuration has been saved on the transmitter.

* If you are using ProLink II to zero the flowmeter, you can also restore the prior zero
immediately after zeroing (e.g., an “undo” function), as long as you have not closed the
Calibration window or disconnected from the transmitter. Once you have closed the
Calibration window or disconnected from the transmitter, you can no longer restore the prior
Zero.
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16.3.2  Preparing for sensor zero calibration
To prepare the flowmeter for sensor zero:
1. Install the sensor according to the appropriate sensor instruction manual.
2. Apply power to the Series 3000 system, then allow it to warm up for at least 30 minutes.

3. Run the process fluid to be measured through the sensor until the sensor temperature
approximates the normal process operating temperature.

4. Close the shutoff valve downstream from the sensor.

5. Fill the sensor completely with process fluid under normal process conditions of temperature,
density, pressure, etc., and ensure zero flow through the sensor.
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6. Make sure flow through the sensor is completely stopped.

A CAUTION

If fluid is flowing through the sensor, the sensor zero calibration may be
inaccurate, resulting in inaccurate process measurement.

To improve the sensor zero calibration and measurement accuracy, ensure that
process flow through the sensor has completely stopped.
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16.3.3  Performing the sensor zero calibration
To perform the sensor zero:

1. From the Calibration menu (see Figure 16-1), select Sensor Zero. The Calibration menu is
accessed through the Maintenance option of the Management menu.

2. Check the setting for Zero Time, and change it if desired.

3. Note the value displayed for Mass Flow Rate. If it is non-zero, recheck sensor preparation
(see Section 16.3.2).

4. Select Calibrate Zero, then press SEL. During sensor zero:
* A Calibration In Progress alarm is generated.
e The time remaining counts down to zero seconds.

* The Calibrate Zero screen displays an “In Progress” status, and the zero offset in
microseconds.
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5. When the calibration is complete:
* Inthe active alarm log, the alarm changes from “active” to “inactive but unacknowledged.”
» If the calibration succeeded, a “Success” status is displayed.
» If the calibration failed, a “Failed” status is displayed.

6. Press EXIT to return to the Sensor Zero screen.

(Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the
display, acknowledge the alarm using the procedures described in Chapter 22.
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Calibration menu

Calibration

T
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Sensor zero mA output trim | Batch AOC® | Density curve trim® |
| (seeChapter18) (see the enhanced density
L 3 | manual)
| | L o e o e — — — |
Zero time Milliamp output 1 2
Mass flow rate™

Calibrate zero [
Restore factory zero®
View current data Trim 4.0 mA

* Enter mA reading

* mA output reads

¢ Does mA out match?

Trim 20.0 mA

* Enter mA reading

* mA output reads

* Does mA out match?

s
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Flowing density
¢ Actual density
¢ Calibrate density

| Density I | Temperature | | Meter verification |
| (seeChapter21) | | (seeChapter21) | (see Chapter 21) |
L — — — — — 4 L — — _ — — 1 L — — — - — _ 4
I 1 T
Low density Low temperature Uncertainty limit
* Density * Low temp. value Counter
* D1 * Calibrate temp. Start meter verify
¢ Calibrate density o)
High temperature e
High density * High temp. value =h
* Density * Calibrate temp. ‘E
e D2 g.
¢ Calibrate density View current data Q@
-
=
X
()
)

Density D3 (T-Series)
* Density
* D3
* Calibrate density
(1) Read-only; displayed for reference only.
Density D4 (T-Series) (2) Displayed only if you are using the enhanced core processor and the
: BinSIty factory configuration has been saved.
« Calibrate density (3) Displayed only if the discrete batch application is installed.

(4) Displayed only if the enhanced density application is installed.

View current data

Configuration and Use Manual 137



Startup Procedures

16.3.4  Diagnosing sensor zero failure

If the Calibrate Zero screen reads “Calibration Failure,” the sensor zero calibration was not
successfully completed. “Calibration Failure” could indicate:

*  Flow of fluid during the sensor zero calibration
* Partially empty flow tubes
* An improperly mounted sensor
To clear a sensor zero failure:
*  Press EXIT to exit the Calibrate Zero screen, then re-zero after correcting the problem, or
*  Abort the sensor zero procedure by cycling power to the platform

» If appropriate, restore the factory zero or prior zero (see Section 16.3.1)

16.4 Testing the inputs and outputs

The Diagnostics menu is used to test the inputs and outputs. Figure 16-2 shows the Diagnostics menu.
The Diagnostics menu is accessed through the Maintenance option of the Management menu.

Using the Diagnostics menu, you can:
* Read the states of discrete inputs
* Read the pressure and temperature values as received from external devices
* Read the value of the frequency input

» Set a specific value for discrete outputs, mA outputs, and the frequency output

Diagnostics menu

Diagnostics
Read external inputs Simulate outputs

Discrete input 1 Discrete outputs
Discrete input 2 * Discrete output 1
Frequency input * Discrete output 2
External pressure!" * Discrete output 3
External temperature®

Milliamp outputs

* Milliamp output 1
(1) Displayed only if polling for pressure has been configured. * Milliamp output 2
(2) Displayed only if polling for temperature has been configured.

Frequency output

Note: The Diagnostics menu is not the same as the diagnostic monitor. The diagnostic monitor,
accessed through the View menu, allows you to read the values for tube frequency, left pickoff, right

pickoff, drive gain, and live zero. The diagnostic monitor and its use are described in Chapter 17 and
Chapter 22.
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16.4.1 Reading and testing the discrete inputs

Refer to Figure 16-2 to access and read the current states of Discrete Input 1 and 2. States are shown
as:

¢ Yes (ON)
¢ No (OFF)

To test the discrete inputs, toggle the remote input device and verify that the appropriate value is
received by the Series 3000 device.
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16.4.2 Reading and testing the frequency input

If the Series 3000 device has been wired for a frequency input, refer to Figure 16-2 to access and read
the output level of the frequency input. The frequency is displayed in Hz.

To test the frequency input, check the frequency at the remote input device and verify that the
appropriate value is received by the Series 3000 device.

16.4.3  Reading and testing the pressure and external temperature

If polling for pressure or external temperature has been configured, refer to Figure 16-2 to access and
read the pressure and temperature values being received by the Series 3000.

To test the pressure and temperature input, use a reference device and verify that the appropriate value
is received by the Series 3000 device.
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16.4.4  Setting and testing outputs

The software enables you to set the states of discrete outputs or the values of milliamp outputs or the
frequency output.

A CAUTION

Performing output tests while control devices are set for automatic control
will result in measurement error.

To avoid measurement error, set control devices for manual operation before
performing output tests.
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Discrete outputs
Refer to Figure 16-2 to access and set the current states of discrete outputs.
1. Select the discrete output to be set.

2. The default setting is Unfixed. Reset the output to ON or OFF. The outputs associated with ON
and OFF depends on the output’s polarity, as shown in Table 8-1. (For information on setting
the discrete output polarity, see Section 8.3.1.)

3. Press SAVE to set the state of the selected discrete output.
4. Check the receiving device to ensure that the correct level is being received.

5. Reset the discrete output to Unfixed, or exit to the Simulate Outputs screen. The discrete
output is released and is again controlled by the application.
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Milliamp outputs
Refer to Figure 16-2 to access and set the output levels of milliamp outputs.
1. Select the milliamp output to be set.
2. Use the cursor control buttons to change the output value.
3. Press SAVE to set the output level.
4. Check the receiving device to ensure that the correct output level is being received.

When you exit to the Simulate Outputs screen, the milliamp output is released and is again controlled
by the application.

If the difference between the output level sent by the Series 3000 device and the output level received
by the receiving device is not acceptable for your application, perform a milliamp output trim. See
Section 16.5.

Frequency output
Refer to Figure 16-2 to access and set the output levels of the frequency output.
1. Select the frequency output.
2. Use the cursor control buttons to change the output value.
3. Press SAVE to set the value.
4. Check the receiving device to ensure that the correct output level is being received.

When you exit to the Simulate Outputs screen, the frequency output is released and is again controlled
by the application.

Milliamp output trim

A milliamp output trim creates a common measurement range between the Series 3000 device and the
device that receives the mA output. For instance, a Series 3000 device might send a 4 mA signal that
the receiving device reports incorrectly as 3.8 mA. If the Series 3000 device output is trimmed
correctly, it will send a signal appropriately compensated to ensure that the receiving device actually
indicates a 4 mA signal.

You must trim the outputs at both the 4 mA and 20 mA points to ensure appropriate compensation
across the entire range of outputs.

To perform a milliamp output trim:

1. Connect a digital multimeter (DMM) or other reference device to the primary or secondary
milliamp wiring terminals. Ensure that the reference device is connected in series. Table 16-1
lists the terminals to which the reference device should be connected.

2. Ensure that the reference device is set to read milliamps.
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Milliamp output wiring terminals

Terminal number

Model 3300 or Model 3500 Model 3300 or
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Terminal with screw-type or solder-tail Model 3500 with Model 3350 or
designation Polarity terminals I/O cables Model 3700
4—-20 mA primary + c2 1 2
- a2 2 1
4-20 mA secondary + c4 14 4
- a4 15 3
Terminal block location Farthest right block on back panel  Attached to DIN ralil Gray terminal block
3. From the Maintenance menu, select Calibration (see Figure 16-1).
4. Select mA Output Trim.
5. Select Milliamp Output 1 or Milliamp Output 2.
6. Select the output level to be trimmed:

e To trim at 4 mA, select Trim 4.0 mA
e To trim at 20 mA, select Trim 20.0 mA

7. Press CHG, enter the amount of current indicated by the reference device, then press SAVE.
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8. Compare the output level that is indicated by the reference device to the output level that
appears in the display.

» If the output level that appears in the display matches the output level that is indicated by
the reference device, press YES.

» If the output level that appears in the display does not match the output level that is
indicated by the reference device, press NO, then repeat Steps 7 and 8.

Note: Any trimming performed on the output should not exceed 200 microamps. If more trimming is
required, contact Micro Motion customer support.

Note: If you are trimming the primary mA output, and you are performing a trim using a HART
connection to the Series 3000 device, the HART signal will affect the reading. Disconnect the HART
connection before reading the output, then reconnect and resume the trim after taking the reading.
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17.2

17.3

About this chapter
This chapter explains how to use the Series 3000 device in operation mode.
There are two different operation modes:

*  The process monitor is the default operation mode unless the discrete batch application is
present. Process monitor mode is described in Section 17.4.

* Batch mode, which is the default operation mode if the discrete batch application is installed.
Batch mode is described in Chapter 18.

Both modes will operate differently if the custody transfer application is installed and security is
enabled. See Chapter 19.

To determine what applications or special options have been installed, use the applications list in the
View menu (see Section 17.5.9).

Startup and display test

At startup, the Series 3000 device automatically tests its display. During display testing, the screen
darkens for approximately five seconds. After the display test is completed:

1. The Micro Motion logo is displayed for two to three seconds.
2. An application list is displayed for two to three seconds.
3. The device enters operation mode:

» If the discrete batch application is not installed, the process monitor screen is displayed, as
shown in Figure 17-1.

» If the discrete batch application is installed, the batch process screen is displayed (see
Figure 18-1).

4. If there are any active alarms, the alarm category will be displayed in the alarm bar. To view,
acknowledge, or respond to the alarms, see Section 22.6.

Initial startup

For Series 3000 transmitters, a sensor zero may be performed at initial startup. Sensor zero establishes
flowmeter response to zero flow and sets a baseline for flow measurement.

Once the sensor zero is set, it remains part of the transmitter nonvolatile memory, and will not be
affected by a power failure, brownout, or power cycle.

See Section 16.3 for instructions on performing a sensor zero.
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A CAUTION

Failure to perform a sensor zero calibration at initial startup could cause the
flowmeter to produce inaccurate signals.

To avoid inaccurate measurements, perform a sensor zero before putting the
flowmeter into operation.

17.4 Process monitor operation mode

The process monitor, shown in Figure 17-1, is the default operation mode unless the discrete batch
application is present.

* To scroll through the process monitor, press the left or right cursor control button. The number
beside each arrow on the top line indicates the screen that will be displayed if the left or right
cursor control button is pressed. If no display variables are configured for a particular screen,
that screen is skipped.

» If atotal appears on the screen, you can press RESET to reset it to 0. Pressing RESET will
reset only the totals on the screen that is displayed.

* Press PRINT to print a ticket that includes values of process variables on the screen that is
displayed.

You can configure the process variables that will be displayed on each of the five screens of the
process monitor. To configure the process monitor, see Chapter 12.

If the discrete batch application is installed, you can monitor process variables by using the Process
Monitor option from the View menu (see Section 17.5).

Series 3000 display in process monitor mode

5« DEVICE 1 —2
Mass Flow Rate

Backlit 2 . 33

Cursor control

display
buttons
g/s
Mass Total
485 .88
g
PRINT RESET EXIT VIEW or EXIT
button

Security button

>

Function buttons
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17.5 Using the View menu

When you press VIEW at the operation screen, the View menu is displayed (see Figure 17-2). o
T
This menu varies according to the installed applications. Your menu may be different. %
Note: See Chapter 19 for a discussion of the View menu if the custody transfer application is installed S
and World Area is set to OIML. s
Q
Figure 17-3 shows the functions performed by the function buttons and cursor control buttons in the ®
View menu.
View menu
View menu
O
S
(1}
S
Active alarm log Process Preset Batch inventory" Process totalizers §
monitoring selections!" =
3
(1]
1
w
Preset 1 Preset inventory 1 Process g-
Preset 2 Preset inventory 2 * Mass total >
Preset 3 Preset inventory 3 * Volume total
Preset 4 Preset inventory 4 * API ref vol total®
Preset 5 Preset inventory 5 * ED ref vol total®
Preset 6 Preset inventory 6 * ED net mass total
« ED net vol total®

* Frequency input total

Inventory

* Mass inventory

* Volume inventory

* API ref vol inventory®
Diagnostic monitor Density curves® LCD options Applications list * ED ref vol inventory®

* ED net mass inventory®
* ED net vol inventory®

* Freq input inventory

Tube frequency Density curve 1 Contrast

Left pickoff Density curve 2 LCD backlight
Right pickoff Density curve 3

Drive gain Density curve 4

Live zero Density curve 5
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Density curve 6

(1) If batch application is installed and configured.

(2) If enhanced density application software is installed and configured, and density curves have not been assigned to batch presets.
(3) If petroleum measurement application is installed and configured.

(4) If enhanced density application software is installed and configured.
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Working with the View menu

EXIT

ALARMS

Move cursor upward
VIEW MENU

—

Process Monitoring
Preset Selections
Batch Inventory
Process Totalizers
Diagnostic Monitor

___ SELECT

Density Curves
LCD Options
Applications List

HELP EXIT Move cursor downward

SEL
CHG

SAVE
STOP

START

RESET
PRINT

Select highlighted option

Make a change to the HELP
highlighted option RESET
Save a change

Pause counting of all
totalizers except batch

Resume counting of all
totalizers except batch

Reset totalizer
Print a ticket

Show a help screen

EXIT Return to operation screen

17.5.1 Active alarm log

The platform performs self-diagnostics during operation. If the platform detects certain events or
conditions, an alarm message appears in the highlight bar at the top of the screen and an item is added
to the active alarm log.

The active alarm log lists:
e All alarms that are active (the condition that caused the alarm is active)

e All alarms that have not been acknowledged (even if the condition causing the alarm is no
longer active)

The alarm will be listed in the active alarm log and displayed in the highlight bar until the alarm has
been acknowledged.

The active alarm log is organized in either of two ways:

e If accessed via the View menu, as shown in Figure 17-2, only alarm categories containing
active or unacknowledged alarms are listed. Alarm categories are listed in order of priority
(Electronics, Sensor, Process, Configuration). To view individual alarms, place the cursor on
an alarm category and press HELP.

* Ifaccessed via the Maintenance menu, individual alarms are listed in numerical order by alarm
number (alarm numbers are documented in Section 22.7).

For information about acknowledging alarms or responding to alarm messages, see Section 22.6.
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17.5.2  Process monitoring

This selection displays the process monitor, as described in Section 17.4. The display is identical to
the display shown in Figure 17-1.

If you enter the process monitor from the View menu, then press EXIT, you are returned to the View
menu.
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17.5.3 Preset selections

The Preset Selections option allows you to specify which of the existing presets will be used to
control batching. Only presets that have been enabled are listed here.

The discrete batch application can be set up with as many as six different batch presets. Each preset
has its own target. A preset may also have a descriptive name, which will appear on the selection
menu.

For more information on batch presets and how to configure them, see Section 11.6.

Note: If a density curve has been assigned to the selected preset, batch totals will be based on the
derived variable that was selected during configuration of the density application. See the enhanced
density manual.

17.5.4  Batch inventory

This option displays the current inventory totals for all enabled presets.
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For more information on batch presets and how to configure them, see Section 11.6. For more
information on batch inventories and how to reset them, see Section 18.3.

17.5.5 Process totalizers and inventories

The View menu allows you to view, start, stop, and reset process totalizers, and view process
inventories.

To view or manage process totalizers:
1. From the View menu, select Process Totalizers.

2. Select Process. Current values for the first four totalizers are displayed. Scroll down as
required to view additional totalizers.

3. To start or stop all totalizers, press the left function button (labeled START or STOP).

4. To reset a specific totalizer:
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a. Highlight the totalizer to be reset.
b. Press the RESET button.
To view a process inventory:
1. From the View menu, select Process Totalizers.
2. Select Inventory.

3. Scroll down the list as required to view the desired value.

Note: Inventories cannot be reset from the View menu. To reset an inventory, you must use the
Maintenance menu. See Section 20.5.
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17.5.6  Diagnostic monitor

The Diagnostic Monitor shows real-time values for sensor flow tube frequency, left and right pickoffs,
drive gain, and live zero.

Drive gain, pickoff levels, and sensor flow tube frequency values are useful for troubleshooting fault
alarms. For information about troubleshooting fault alarms, see Chapter 22.

Live zero is useful for monitoring the flow rate when it drops below the mass low flow cutoff. To
configure the mass low flow cutoff, see Section 7.3.2.

Note: The diagnostic monitor is not the same as the Diagnostics menu. The Diagnostics menu,
accessed through the Maintenance option of the Management menu, allows you to read the values of
external inputs and simulate output levels for outputs. The Diagnostics menu and its use are described
in Chapter 16.

17.5.7  LCD options

The LCD Options allow you to adjust the contrast, or to enable screen backlighting.
1. Select LCD Options from the View menu.
2. Select Contrast to adjust the screen contrast.
3. Select LCD Backlight to turn screen backlighting on or off.

17.5.8  Density curves

The Density Curves menu item is available only if the enhanced density application is installed and
one or more density curves has been configured. This screen lists all density curves that have been
configured. The active density curve is highlighted.

* If no density curve has been assigned to a batch preset, you can use this menu to change the
active density curve. To do this, highlight the desired curve in the list and press SEL.

» If a density curve has been assigned to a batch preset, that curve is active and you cannot
change the active density curve from this menu.

17.5.9  Applications list

The Applications List shows the software version of the Series 3000 device and the core processor (if
applicable) and all applications that are installed. Refer to this screen for the software revision number
to report problems.
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18.1

18.2

About this chapter

This chapter explains how to use the discrete batch control application and how to perform batch
AOQOC (automatic overshoot compensation).

Note: Before you can use the discrete batch application, it must be configured. For information on
configuring the discrete batch application, see Chapter 11.

Note: For information on formatting and printing batch tickets, see Chapter 15.

About discrete batching

Discrete batching is used to start flow, then stop flow automatically when the target amount of process
fluid has flowed through the sensor. During a batch, flow may be stopped and resumed. A batch may
also be ended before the target is reached.

The normal batching sequence is as follows:

1. Select a batch preset (see Section 17.5.3). The batch preset determines the target, how end
warnings and overruns will be handled, and, for 2-stage batching only, the point at which the
primary and secondary valves will be opened and the point at which the primary valve will be
closed.

2. Start the batch. The operator can start the batch manually, using the START button on the batch
process screen, or a discrete input or discrete event can be configured to start the batch (see
Section 11.7). Before a batch can be started, the previous batch must be ended and the totals
must be reset.

Note: Reset may be automatic (Reset on Start is enabled; see Section 11.5) or manual via the RESET
button or an assigned discrete input (see Section 11.7).

3. In normal operation, the flowmeter will stop the batch automatically when the configured
target is reached.

The operator can halt the batch manually, using the STOP or END buttons on the batch process
screen. The STOP and END functions can also be assigned to a discrete input or discrete event
(see Section 11.7).

» If the batch is stopped, the current batch totals are retained, and pressing the RESUME
button will restart the batch from the current totals. The RESUME function can also be
assigned to a discrete input or discrete event (see Section 11.7).

» If the batch is ended, it cannot be restarted (with one exception: by increasing the batch
target to a value that is greater than the current batch total).

Table 18-1 describes batch events and how the batch function buttons operate under different batch
conditions.

For examples of batch processing, including the effects of STOP and RESUME, see Section 18.4.

For a discussion of batch control functions, see Section 11.7.
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Operation Mode — Batch

Batch events

Event Description

Batch in progress e Batch is in progress.
* Batch in progress remains active until the batch completes or is ended. If the batch is
stopped, batch in progress remains active.

Primary valve open/close, * If control options are configured for Reset on Start, pressing START resets the batch
1-stage batch total to zero, starts the pump or opens the valve, and starts the batch.
* If control options are not configured for Reset on Start, pressing START starts the
pump or opens the valve to start the batch.
* The pump stops or the valve closes automatically when the target is reached.

Primary valve open/close, * If control options are configured for Reset on Start and the preset is configured so
2-stage batch Open Primary is 0% of target, or Quantity is set to 0, pressing START resets the
batch total to zero, opens the primary valve, and starts the batch.
* If control options are not configured for Reset on Start and the preset is configured so
Open Primary is 0% of target, or Quantity is set to 0, pressing START opens the
primary valve and starts the batch.
¢ If the preset is configured so Open Primary is a value other than 0% of target, or a
quantity other than 0, the valve opens when the batch total achieves the Open
Primary value.
* The primary valve closes when the batch total achieves the Close Primary value.

Secondary valve open/close, * If control options are configured for Reset on Start and the preset is configured so
2-stage batch Open Secondary is 0% of target, or Quantity is set to 0, pressing START resets the
batch total, opens the secondary valve, and starts the batch.
* If control options are not configured for Reset on Start and the preset is configured so
Open Secondary is 0% of target, or Quantity is set to 0, pressing START opens the
secondary valve and starts the batch.
* If the preset is configured so Open Secondary is a value other than 0% of target, or a
quantity other than 0, the secondary valve opens when the batch total achieves the
Open Secondary value.
* The secondary valve closes when the target is achieved.

End warning * If End Warning was enabled during configuration, the batch controller produces an
alarm when the batch total achieves the programmed end warning value.
* The end warning remains active until batch completion.

Overrun ¢ |f Overrun was enabled during configuration, the batch controller produces an alarm
when the batch total exceeds the target by the programmed amount or percent of
target.

* Overrun remains active until flow stops.

Batch pump * The system pump is operating.
* The pump remains on while the primary or secondary valve is open.

18.3  Batch process screen
Figure 18-1 shows the Series 3000 display in batch operation mode, ready to start a batch.

The display shows that there have been zero kilograms of actual delivery in this batch. When flow
starts, the display is continuously updated to show the actual amount that has been delivered.

The display can be set up to show either the amount that has been delivered (Count Up) or the amount
remaining to be delivered (Count Down). To configure Count Up or Count Down, see Section 11.5.
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Series 3000 display in batch mode
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Note: If the petroleum measurement application or the enhanced density application is installed
and the batch controller is measuring standard volume, net volume, or net mass, actual and
target values indicate net totals rather than gross totals.

18.3.1  Function buttons
In Figure 18-2, the display shows that the batch target is 12.3 kg.

*  When you press START, the discrete outputs assigned to the pump and valve are activated, and
flow starts.

*  When the target amount has passed through the flowmeter, the discrete outputs assigned to the
pump and valve are deactivated, and flow stops.

The labels on the three function buttons are changed during the batch run to show the actions you can
perform at each point.

To start the batch, press the button on the left, labeled START. Figure 18-2 shows what happens.
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Using batch function buttons

F-----------.
DEVICE 1 DEVICE 1
Preset 1 Preset 1
Actual Actual
T t kg Target kg
arge
g 12.3 12.3
START HELP VIEW STOP HELP VIEW

©

Display shows actual quantity

Functions of these updated continuously

buttons change

Figure 18-3 indicates the actions that are performed by the function buttons during batch operation.

Function huttons in batch mode

F.....................‘

DEVICE 1
Preset 1

Actual
0.0
kg

12.3

Target

START  HELP VIEW

>

o
N

VIEW Access the View menu
ACK Acknowledge an alarm

HELP Show a help screen
RESUME Resume a batch that has been stopped
PRINT Print a ticket

START Start the batch

STOP » Stop the batch before the target is achieved
¢ Batch can be resumed

END * End the batch before the target is achieved
e Batch cannot be resumed

RESET Reset the batch total to zero
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18.4

18.3.2 Cursor control huttons

The Lockout Target parameter can be set to allow the operator to change the target directly from the
batch operation screen when the batch is not running (Lockout Target set to No). To enable target
adjustment, see Section 11.5.

In Figure 18-4, the line beneath the farthest right digit of the target is the editing cursor. If Lockout
Target is set to No, the cursor appears on the screen whenever the batch is not running. Whenever the
cursor appears on the screen, you can use the cursor control buttons to change the target.

Figure 18-4 shows how the cursor control buttons work when the editing cursor is displayed.

Adjusting the batch target

Moves cursor left

Increases value at cursor

—
/

DEVICE 1
Preset 1

Actual

Moves cursor right

==
START HELP VIEW \ Decreases value at cursor

Cursor

Note: If the petroleum measurement application or the enhanced density application is
installed and the batch controller is measuring standard volume, net volume, or net mass,
the actual and target values indicate net totals rather than gross totals.

Batch processing sequences

The following sequences (Figures 18-5 and 18-6) show the opening and closing of the primary and
secondary valves, under normal processing and when STOP / RESUME is performed at different
points during the batch.

Note: Because the pump is on whenever a valve is open, it is not shown in these sequences.

For a description of two specific sequences, see the examples following the figures.
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Batch processing sequences: 2-stage batching, Open Primary at 0%

Normal operation

0% m% n

Valve behavior with STOP/RESUME at x%

x% before secondary open - — —

0% X% m% mM+x% n% 100%
X% after secondary open,when  _ _ __| _ _ __ _ - —
m+x% <n% e aaaa b e e e e e e e e e
| I | |
0% m% X%  M+x% n% 100%
x% after secondary open, when - — | — — — — — - —_—
m+x%>n% e e e e e e e e ke e e
| I | |
0% m% X% n% M+x% 100%
x% after primary close === - — —|— — — — — —
| | [ |
0% m% n% X% M+x% 100%
Configured values Legend
* Open Primary: 0% e Primaryvalve - — — — -
* Open Secondary: m% e Secondary valve ----------
e Close Primary: n% * Flow ——

154 Micro Motion® Series 3000 MVD Transmitters and Controllers



Operation Mode - Batch

Figure 18-6 Batch processing sequences: 2-stage batching, Open Secondary at 0%

Normal operation

Valve behavior with STOP/RESUME at x%

x% before primary open

0% X% Mm% m+x% n% 100%
x% after primary open, when — — - —
m+x% <n% e e e eeea|eeeeee el e e e e e e e
I I I I
0% m% X% mM+x% n% 100%
x% after primary open, when L _ __ _ _ _
m+X% >nN% e e e e eee e e e b e e e e e
I I I I
0% m% X% n% m+Xx% 100%
X% after primary close | _ _
I I [ I
0% m% N% X% M+x% 100%
Configured values Legend

* Open Primary: m%
* Open Secondary: 0%
* Close Primary: n%

e Primaryvalve - — — — -
e Secondaryvalve ----------
* Flow
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Example 1 Batch control configuration:

* No. of Stages =2

e Configure Presets By = % of Target

Preset configuration:

e Target =100 liters

¢ Open Primary = 0%

* m (Open Secondary) = 30%

¢ n (Close Primary) = 70%

Operator actions:

¢ None (see the first sequence in Figure 18-5)

As a result:

e At the beginning of the batch run, the primary valve opens and flow
starts.

¢ When the flowmeter has measured 30 liters, the secondary valve
opens.

¢  When the flowmeter has measured 70 liters, the primary valve
closes.

¢ When the flowmeter has measured 100 liters, the secondary valve
closes.

Example 2 Batch control configuration:

* No. of Stages =2

e Configure Presets By = % of Target
Preset configuration:

e Target =100 liters

¢ Open Primary = 0%

* m (Open Secondary) = 30%

¢ n (Close Primary) = 70%

Operator actions:

¢ STOP/RESUME occurred after 20 liters had been measured (20%
of target; x = 20%) (see the second sequence in Figure 18-5)

As a result:

e At the beginning of the batch run, the primary valve opens and flow
starts.

¢ When the flowmeter has measured 50 liters (30 + 20, or m + x), the
secondary valve opens.

¢ When the flowmeter has measured 70 liters, the primary valve
closes.

¢ When the flowmeter has measured 100 liters, the secondary valve
closes.
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18.5

18.6

Special cases in batch processing

This section describes two common situations in batch processing that may require special attention
from the operator.

18.5.1  Cleaning/purging the tubes

In normal processing, the batch totalizer increments whenever flow is detected. To run fluid through
the tubes without incrementing the batch totalizer:

1. Ensure that the Inhibit Totalizer batch control function has been assigned to a discrete input, as
described in Section 11.7.

2. Activate the discrete input or discrete event.
3. Run fluid through the tubes as desired.

4. When you are ready to resume totalizing, deactivate the discrete input.

18.5.2  Ending a batch while flow is present
In general, to end a batch:

* Automatically, the target must be reached and flow must be stopped.

e Manually, the batch must be stopped (paused) and flow must be stopped.
To end a batch while flow is present:

1. Ensure that the Inhibit Flow batch control function has been assigned to a discrete input, as
described in Section 11.7.

2. When the batch total reaches the target, activate the discrete input so that the batch can end
normally.

Batch AOC calibration

Batch AOC (Automatic Overshoot Compensation) keeps the actual quantity delivered as close as
possible to the batch target, by minimizing the amount of overshoot.

If batch AOC is enabled (see Section 11.5), batch AOC calibration is required to provide data for the
compensation process. Thereafter, batch AOC calibration is recommended:

*  Whenever consistent overshooting or undershooting of the target occurs

e If equipment (valve or pump) is changed
Note: If batch AOC is not enabled, you cannot perform batch AOC calibration.
To perform batch AOC calibration:

1. From the Maintenance menu, select Calibration (see Figure 4-2).

2. Select Batch AOC.

3. Select Start Calibration.

4. Press EXIT repeatedly to return to the operation screen.

5. Run 2 to 10 batches.
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Operation Mode — Batch

6. When overshoot has been adequately minimized:
a. From the Maintenance menu, select Calibration.
b. Select Batch AOC.

7. Select Save Calibration.

8. Press SEL.
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19.1

19.2

19.3

About this chapter

This chapter explains how to use and manage the custody transfer application. The following topics
are discussed:

* Identifying a security breach — see Section 19.2

¢ General differences between secured versus unsecured states — see Section 19.3

* Using custody batch (NTEP) — see Section 19.4

*  Using custody transfer (OIML) and custody transfer (OIML/batch) — see Section 19.5
* Clearing a security breach — see Section 19.6

* Reconfiguring the Series 3000 device — see Section 19.7

e Audit trail — see Section 19.8

The custody transfer application must be configured for the system that will be used. See Chapter 14
for information on configuring the custody transfer application.

Identifying a security breach

It is useful to distinguish between data security and legal security. Data security is present if the
custody transfer switch is in the ON position and there is no “Security Breach” banner on the
Series 3000 display. However, legal security requires data security plus an intact weights and
measures seal.

For custody transfer use, legal security is required. Therefore, a security breach is present if either of
the following is true:

*  Visual inspection shows that the weights and measures seal is broken or missing.

* The Series 3000 device has detected a security breach and posted the “Security Breach”
banner on the display.

Note: The “Security breach” and “Not a legal receipt” banners will also be printed on batch (NTEP)
tickets or batch (OIML) tickets, but not on transfer (OIML) tickets.

If a security breach is present, security cannot be guaranteed, and Series 3000 data cannot be used to
meet weights and measures requirements. To clear a security breach, see Section 19.6.

Secured versus unsecured

In general, when the Series 3000 device is secured, the operator can run a batch and view process
data, but cannot change device configuration. When the device is unsecured, configuration changes
are permitted but other device behavior changes to indicate the unsecured status.

Table 19-1 provides a detailed list of changes to specific features or functions when the custody
transfer application is installed and the Series 3000 device is either secured or unsecured.
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Operation Mode — Custody Transfer

Series 3000 behavior and available functions

Custody transfer (OIML) and

Custody transfer (NTEP) custody transfer (OIML/batch)

Function Secured Unsecured Secured Unsecured
Batch processing

Batch reset Y Y Y Y

Batch start, stop, resume Y Y Y Y

Batch BOL number N Y N Y

changed manually

Different batch preset Y Y Y Y

selected
Transfer BOL number changed N/A N/A N Y

manually

Time of day Can be changed by Y Can be changed by Y
one hour in either one hour in either
direction. Cannotbe direction. Cannot be
changed in the changed in the
same direction same direction
twice consecutively. twice consecutively.

External pressure and

temperature data

Updated via polling Y Y Y Y
Updated by Modbus or N Y N Y
HART host

Calibration

Zero N Y N Y
Density N Y N Y
Temperature N Y N Y
Meter verification
Original version N Y N Y
Smart Meter Verification
*Outputs set to Continue Y Y Y Y
Measuring
¢ Outputs set to Fault Y Y Y Y
¢ Qutputs set to Hold Last N Y N Y

Value

160

Micro Motion® Series 3000 MVD Transmitters and Controllers



Operation Mode — Custody Transfer

Series 3000 hehavior and available functions continued

Custody transfer (NTEP)

Custody transfer (OIML) and
custody transfer (OIML/batch)

Function Secured Unsecured Secured Unsecured
Outputs
mA output behavior Normal If reporting flow Normal Perform configured
rate, show zero flow fault action
Otherwise, normal
mA output trim N Y N Y
mA output loop test N Y N Y
Frequency output behavior Normal Inactive (produces  Normal Perform configured
no pulses) even fault action
under fault
conditions
Frequency output loop test N N N Y
Discrete output behavior Normal Normal Normal Perform configured
fault action
Discrete output loop test N Y N Y
Service port connections N Y N Y

If device is secured
while service port
connectionis active,
terminals are reset
to RS-485 mode
and connection is
broken.

If device is secured
while service port
connectionis active,
terminals are reset
to RS-485 mode
and connection is
broken.
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Series 3000 hehavior and available functions continued

Function

Custody transfer (NTEP)

Custody transfer (OIML) and
custody transfer (OIML/batch)

Secured

Unsecured

Secured

Unsecured

Process variables

All flow rates

Reported normally

Reported as zero

Reported normally

Reported normally

Density and temperature

Reported normally

Reported normally

Reported normally

Reported normally

Process totalizers

Increment normally

Cannot be stopped

Cannot be reset

unless flowrate is

zero. If any one is

reset:

¢ All others are
reset
automatically

* A test of the
display is
performed
automatically

Stopped

If any one is reset:

¢ All others are
reset
automatically

¢ A test of the
display is
performed
automatically

Replaced by
transfer totalizers
Transfer totalizers
Increment normally

Replaced by
transfer totalizers
Transfer totalizers
stopped

Process inventories

Increment normally
Cannot be stopped
Cannot be reset

Stopped
Cannot be reset

Increment normally
Cannot be stopped
Cannot be reset

Stopped
Cannot be reset

Transfer totalizers N/A N/A Rollover indicator: Rollover indicator
e Cannotbecleared can be cleared
manually
¢ Cleared
automatically
upon starting new
transfer
Transfer inventories N/A N/A Rollover indicator Rollover indicator
cannot be cleared can be cleared
Simulation mode N Y N Y
Alarm menu Normal Normal Alarm log password  Alarm log password

required (if enabled)

required (if enabled)
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19.4

Custody transfer (NTEP)

This section provides information on the BOL number, the custody transfer transaction, tickets and
ticket printing, and general use of the Series 3000 device when World Area is set to NTEP.

19.41 BOL number

In custody transfer (NTEP) applications, there is one bill of lading (BOL) number. The BOL number
is used to identify both the custody transfer transaction and the batch. The default BOL start number
is 0, and the BOL number is incremented automatically when the discrete batch is reset. To change or
reset the BOL start number manually, see Section 15.5.1.

Note: The BOL number rolls over to 0 after 99,999,999 batches.

You cannot change the BOL start number while the device is secured. In most cases, the BOL start
number is set during initial configuration and is not changed thereafter. To determine the current BOL
number, check the most recent batch (NTEP) ticket.

19.4.2  Executing a custody transfer (NTEP) transaction

Custody transfer (NTEP) is used with the discrete batch application. To execute a custody transfer
(NTEP) transaction:

1. Reset the batch. Because Reset on Start is disabled, you must reset the batch manually. At this
point, the batch BOL number is incremented, the batch total is reset, and the custody transfer
transaction begins.

2. Run the batch. The discrete batch application will automatically stop flow when the target is
reached, but you may increase the target and resume flow if desired.

3. When the desired quantity has been delivered, as measured by the discrete batch application,
stop flow and end the batch.

4. End the transaction by printing a batch (NTEP) ticket. The custody transfer transaction ends
when the first batch (NTEP) ticket is printed. You can print the ticket manually or
automatically, at the end of a batch. You cannot print the ticket while the batch is stopped.

See the following section for information on ticket printing.

19.4.3  Batch (NTEP) tickets and ticket printing

The batch (NTEP) ticket is very similar to the batch ticket but contains some additional data. The
batch (NTEP) ticket serves as the legal receipt. To print a batch (NTEP) ticket, see Section 15.5.2 for
instructions for both automatic and manual printing, and for printing additional tickets.

Note the following:
* A batch (NTEP) ticket cannot be printed until flow stops.

e If a batch (NTEP) ticket is printed, and the batch target is then increased and the batch is
resumed, the custody transfer data will not change even though the batch data changes. All
additional batch (NTEP) tickets printed during this batch will contain the original custody
transfer data and the “Duplicate receipt” banner.

*  For printer type Epson TMU295, an out-of-paper alarm can be generated, depending on the
setting of the Disable Paper Check parameter (see Table 13-3). No other forms of print failure
are detected.
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19.5

164

19.4.4  General use of Series 3000 device

This section describes the effect of custody transfer (NTEP) on specific Series 3000 device functions.
Information in this section supplements the information in Table 19-1.

19.4.5 Inventories

Process inventory values may become too large to display on screen. If this happens, the decimal
point is shifted to the right, and eventually the screen display may be converted to scientific notation.

Note: Precision may be lost only in the displayed value. No precision is lost in the value stored in the
device.

Note: For definitions of process totalizers, process inventories, transfer totalizers, and transfer
inventories, see Section 20.2.

Audit trail

The audit trail function (see Section 19.8) is active, whether the device is currently secured or
unsecured.

Custody transfer (OIML) and custody transfer (OIML/batch)

This section provides information on BOL numbers, the custody transfer transaction, tickets and
ticket printing, the transfer log, and general use of the Series 3000 device when World Area is set to
OIML.

19.5.1 BOL numbers

For custody transfer (OIML), the transfer BOL number is used to identify the custody transfer
transaction. The default transfer BOL start number is 0, and the transfer BOL number is incremented
automatically when the custody transfer is completed. The BOL start number is never reset
automatically. To change or reset the transfer BOL start number manually, see Section 15.6.1.

Note: If the transfer BOL start number is changed or reset, the transfer log is reset and all transfer
data is lost. See Section 19.5.5.

For custody transfer (OIML/batch), the batch BOL number is used to identify the custody transfer
transaction. The default batch BOL start number is 0, and the batch BOL number is incremented
automatically when the batch is reset. The batch BOL start number is never reset automatically. To
change or reset the batch BOL start number manually, see Section 15.6.1.

You cannot change either BOL start number while the device is secured. In most cases, the BOL start
numbers are set during initial configuration and are not changed thereafter. To determine the current
BOL number, check the most recent transfer (OIML) or batch (OIML) ticket. For transfer (OIML),
you can also check the transfer log (see Section 19.5.5).

19.5.2  Executing a custody transfer (OIML) transaction
To execute a custody transfer (OIML) transaction:
1. Start flow.
2. Stop flow when the desired quantity has been delivered.
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3. End the transaction, either by printing a transfer (OIML) ticket or by using the transfer reset
function.

* To end a transaction via ticket printing, print a transfer (OIML) ticket that contains the
transfer total (see Section 19.5.4).

* To end a transaction via the transfer reset function, perform one of the following:
- Press the RESET-T button.
- Activate a discrete input that is configured for transfer completion (see Section 14.5,
Step 6).
Note: During the transfer reset function, the Series 3000 display is temporarily blank.

When the transfer is completed, transfer data is written to the transfer log, the transfer BOL
number is incremented by 1, all totalizers except the batch totalizer are reset automatically, and
the next custody transfer transaction begins immediately.

Note: Inventories are not reset automatically when a transfer is completed.

Note the following:

» Tickets are optional. If you do not print a ticket, the transfer log is used for legal compliance,
and the transfer reset function is used to end the transaction and begin a new one.

o If flow is present:
- You cannot end the transaction.
- The transfer reset function is disabled.

- You may or may not be able to print a ticket. If you can, ticket contents will include the
flow rate and a “Not Complete” banner. See Section 19.5.4.

* A custody transfer (OIML) transaction can be executed and completed whether the device is
secured or unsecured.

19.5.3  Executing a custody transfer (OIML/batch) transaction
To execute a custody transfer (OIML/batch) transaction:

1. Reset the batch. Because Reset on Start is disabled, you must reset the batch manually. At this
point, the batch BOL number is incremented, the batch total is reset, and the custody transfer
transaction begins.

2. Run the batch. The discrete batch application will automatically stop flow when the target is
reached, but you may increase the target and resume flow if desired.

3. When the desired quantity has been delivered and flow is stopped, end the batch.
4. End the transaction by printing a batch (OIML) ticket (see Section 19.5.4).
Note the following:

* Ending a batch does not automatically end the transaction. The transaction ends when the first
batch (OIML) ticket is printed or when the batch is reset.

» If flow is present, you cannot end the transaction.
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19.5.4  Transfer (OIML) and batch (OIML) tickets and ticket printing

Printing methods, conditions, and ticket contents for transfer (OIML) and batch (OIML) tickets are
described in Table 19-2.

Transfer (OIML) and batch (OIML) ticket printing methods, conditions, and contents

Transfer (OIML) tickets Batch (OIML) tickets
Printing method * Manual, from PRINT button or discrete input ¢ Manual, from PRINT button or discrete input
* See Section 15.6.2 ¢ Automatic, via Auto Print parameter or

discrete event
¢ See Section 15.7.2

Approved process Marked with asterisks Not marked with asterisks
variables
Printing when flow is ~ May or may not be permitted, depending on Not permitted
present Transfer Print Conditions parameter (see
Table 15-7)
Security breach No security breach banner Security breach banner printed on ticket

Alarm banner may or may not be included,
depending on Alarms Occurred parameter
(see Table 15-6)

Print failure See the section entitled Print failure See the section entitled Print failure
Print job status See the section entitled Print job status See the section entitled Print job status
Print failure

166

If a print failure occurs:
*  For printer type FDW and transfer (OIML) tickets, the following warning message is
displayed for five seconds after the first failure:

Ticket Print Failure
Printer off-line and/or out of paper

If ticket printing fails a second time, the transfer is automatically completed and the following
warning message is displayed:

Ticket Print Failure

Manually record the transfer data from the Transfer Log

The display then shows the transfer log entry for the just completed transfer.

*  For printer type FDW and batch (OIML) tickets, the following warning message is displayed
for five seconds after the first failure:
Ticket Print Failure
Printer off-line and/or out of paper
If the second print attempt succeeds, the ticket will include the “Duplicate receipt” banner,
with other data (e.g., batch totals and timestamp) based on the first print attempt.

If ticket printing fails a second time, the failure message is repeated, the batch total is reset,
and the batch BOL is incremented.

*  For printer type Epson TMU295, when the printer is connected through an RS-485 converter,
the out-of-paper condition is handled via the warning message described above. Other types of
print failure cannot be detected.

*  For other printer types, two-way communication is not supported. No forms of print failure are
detected.
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Print job status

For some printer types, a discrete output can be configured to indicate that the ticket could not be o
printed (see Section 8.3.2), for one of these two reasons: ?g
o
* The last ticket print request failed. =
=
* The flow rate is not zero. =
If either of these situations occurs, the discrete output is activated. &
19.5.5 Transfer log
Note: The transfer log is used only for transfer (OIML) transactions. The transfer log does not
contain entries for batch (NTEP) or batch (OIML) transactions.
Whenever a transfer is completed, transfer data is added to the transfer log. The entry may contain the
transfer totals, or the transfer totals and inventories, and the transfer variable may be marked with o
asterisks, depending on configuration (see Section 14.5). An example transfer log entry is shown in 3
. =
Figure 19-1. =
o
If a ticket is printed but the transfer is not completed, no data is added to the transfer log. ;
You may view data from the transfer log for the 20 most recent transfers. To do this: %
1. Select Transfer Log from the View menu. l.'ln
2. Use the Select BOL to View option to specify the transfer you want to view. Log data for the :"':_,'

selected transfer is displayed automatically.

Example transfer log entry

Transfer Log

M. RESET

5-MAR-2007 19:19:02
Transfer (BOL) :

1 Complete

Mass Transfer

* 100.000 kg *
Volume Transfer
10000.000 1

EXIT
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Note: If the Transfer Start (BOL) parameter is changed, the transfer log is reset and all transfer data
is lost.

Note: It is not possible to print the transfer log or retrieve it via digital communications.
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19.5.6  General use of Series 3000 device

This section describes the effect of custody transfer (OIML) and custody transfer (OIML/batch) on
specific Series 3000 device functions. Information in this section supplements the information in
Table 19-1.

Process monitor

Depending on configuration, the transfer variable may be marked with asterisks on the process
monitor (see Section 14.5, Step 5).

Alarm log password

If the alarm log password has been enabled (see Section 14.5, Step 7), operators will be prompted for
the alarm log password when they attempt to access the active alarm log, the alarm history, or the
event log.

View menu

The View menu changes as follows:
* Transfer Totalizer replaces Process Totalizers.
* Transfer Log is added.

See Figure 19-2.

View menu - Custody transfer (OIML) and custody transfer (OIML/batch)

View
Active alarm Preset Transfer Diagnostic LCD
log selections" totalizer® monitor options
Process Batch Transfer Density Applications
monitoring inventory® log curves® list

(1) Displayed only if discrete batch application is installed.
(2) Buttons on Transfer Totalizer screen depend on configured Protocol.
(3) Displayed only if enhanced density application is installed.
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If you select Transfer Totalizer:

*  You can view current transfer, inventory, or transfer and inventory values for the current o
transfer. ?g
o
* If Protocol is set to Printer, a PRINT button is displayed when the print function is available =
(i.e., if Transfer Print Conditions is set to With Flow, or if Transfer Print Conditions is set to ;
No Flow and there is no flow through the sensor). You can print current transfer, inventory, or o
transfer and inventory values for the current transfer. If you print a ticket that contains a ®
transfer value, under conditions of zero flow, the current custody transfer transaction is
completed and a new one is started (see Section 19.5.3).
» If Protocol is not set to Printer, the RESET-T button is displayed. This button can be used to
complete the current custody transfer transaction and start a new one (see Section 19.5.3).
To view data for a different transfer:
1. Select Transfer Log from the View menu.
. . . . . o
2. Use the Select BOL to View option to specify the transfer you want to view. You can view 3
data for the 20 most recent transfers. Log data for the selected transfer is displayed 8
automatically. e
g
Totalizers and inventories 2
I
Note: For definitions of process totalizers, process inventories, transfer totalizers, and transfer @
inventories, see Section 20.2. c;_f

Whether the Series 3000 device is secured or unsecured:
* The process totalizers are not available. They are replaced by the transfer totalizers.
¢ Process inventories cannot be reset.

The maximum value for transfer totalizers and inventories is 999999999. They are not displayed in
scientific notation. If the maximum value is reached, they roll over to 0 and the character R (rollover
indicator) is added to the data line on transfer screens. The R may or may not be displayed on the
process monitor or printed on process monitor tickets, depending on approval of the process monitor:

» If the process monitor is approved (see Section 14.5), the R is displayed on the process
monitor and printed on process monitor tickets.

e If the process monitor is not approved, the R is not displayed on the process monitor and not
printed on process monitor tickets.

The R is cleared automatically from transfer totalizer values when a new custody transfer transaction
is started. The R is not cleared automatically from transfer inventory values. To clear the R from
transfer inventory values:
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1. Select Transfer Totalizer from the View menu.

2. Select Inventory.

3. Select the inventory whose display indicator you want to clear.
4. Press the CLEAR button (see Figure 4-6).

Note: This action clears only the rollover indicator, and does not affect the transfer inventory value.
To clear the R, the Series 3000 device must be unsecured.

Audit trail

The audit trail function (see Section 19.8) is active, whether the Series 3000 device is currently
secured or unsecured.
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19.6

Cause

Clearing a security breach

The method used to clear a security breach depends on the cause of the breach. See Table 19-3.

Security breach causes and clearing methods

Clearing method

Security switch set to OFF Set security switch to ON.

Core processor replaced, or disconnected and reconnected * Set security switch to OFF and back to ON.

¢ |f AO09 and A026 alarms are present on Model 3300
or Model 3500 panel-mount devices, see
Section 22.9.

19.7

19.8

170

Note: Clearing the security breach on the Series 3000 device does not establish legal security (see
Section 19.2). To establish legal security, an authorized installation of the weights and measures seal
must be performed (see Section 14.7).

Reconfiguring the Series 3000 device

If you need to reconfigure the Series 3000 device:
1. Break the weights and measures seal.
2. Set the security switch to OFF (see Section 14.6).
3. Perform required configuration changes.
4. Set the security switch to ON (see Section 14.6).
5

. If desired, acknowledge the security breach alarm (see Section 22.6). This step is not required;
the Series 3000 device will operate normally with an unacknowledged alarm.

6. Perform an authorized installation of the weights and measures seal (see Section 14.7).

Audit trail

The audit trail feature is used to track any changes made to Series 3000 parameters while the device is
unsecured.

The audit trail is organized into events. The Series 3000 device assigns a number to each event, and
stores the events in numerical order. An event includes all parameter changes made between the time
secure mode is exited and the time secure mode is reentered. For example:

* Secure mode is exited, no parameter changes are made, and secure mode is entered — no event
is logged in the audit trail.

* Secure mode is exited, one parameter change is made, and secure mode is entered — one event
is logged in the audit trail.

*  Secure mode is exited, several parameter changes are made on one day, and several more are
made on the following day, then secure mode is entered — one event is logged in the audit trail.

The audit trail is accessed from the Maintenance menu. See Figure 19-3.
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Figure 19-3  Audit trail menu

Maintenance

Audit trail

Current event number
View event
Date search

19.8.1  Using the audit trail

The Current Event Number item on the Audit Trail menu displays the event number of the most
recent event.

The View Event item is used to locate the event to be viewed.

To locate an event for viewing, use one of the following methods:

e  Manual
a. Highlight View Event.
b. Press CHG.
c. Use the cursor buttons to move to the event number.
d. Press SAVE. °
e. Press EXIT. E:
* Date search %‘
a. Highlight Date Search. %
b. Press SEL. &
c. Set Day, Month, and Year to the date on which you want to start your search. é)
d. Press SAVE. §
e. Press EXIT. :
To view an event: g
1. Use View Event as required to locate the event. g

Press VIEW.
If more than one event is listed, scroll through the list and highlight the event you want to view.
Press SEL.

Scroll through the list of parameter changes, using the cursor buttons or the PGDN and PGUP
buttons.

A
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20.1  About this chapter

This chapter explains how to monitor, start, stop, and reset totalizers and inventories.

Note: Totalizers and inventories operate differently if the custody transfer application is installed. See
Chapter 19 for more information.

20.2  Overview
There are several totalizer types:

*  Process totalizers track the total quantity of a process variable, and can be viewed, stopped,
started, and reset during normal use (i.e., from the process monitor or the View menu). Process
totalizers include:

- Mass total

yoleg — apo\ uonesado

- Volume total

- API reference volume total

- ED (enhanced density) reference volume total
- ED net mass total

- ED net volume total

- Frequency input total

*  Process inventories track the total quantity of a process variable. They can be viewed from the
process monitor or from the View or the Maintenance menu, but can be reset only from the
Maintenance menu. They are typically used to track the total quantity of a process variable
across multiple resets of the process totalizer. Process inventories include:

- Mass inventory

- Volume inventory

Jaysuel] Apoisny — apoyy uonesado

- API reference volume inventory
- ED reference volume inventory
- ED net mass inventory

- ED net volume inventory

- Frequency input inventory

*  Batch inventories track the total quantity of a process variable across batches. There is one
batch inventory for each batch preset. Batch inventories are available only if the discrete batch
application is installed and configured. The View menu allows you to view batch inventory
values for only the batch presets that are enabled. The Maintenance menu allows you to view
and reset batch inventory values for all six batch presets, whether or not they are defined or
enabled.
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In addition, if the custody transfer application is installed and World Area is set to OIML, the process
totalizers and inventories are replaced by the following:

»  Transfer totalizers — track the total quantity of the transfer variable measured by a single
custody transfer transaction. They are automatically reset when the custody transfer
transaction ends.

»  Transfer inventories — track the total quantity of the transfer variable measured across custody
transfer transactions. They cannot be reset.

For more information on transfer totalizers and transfer inventories, see Section 19.5.6.

Note: The transmitter can store totalizer and inventory values up to 2%. Values larger than this cause
the internal totalizer to go into overflow.

20.3 Totalizer management
The method used to manage totalizers depends on the totalizer type and the function to be performed.
See Table 20-1.
Totalizers appear on the process monitor only if the process monitor has been configured to display
them (see Section 12.3). The user-specified label will be used (see Section 12.4). For information on
using the process monitor to reset totalizers, see Section 17.4.
Refer to Chapter 4 for information on accessing the View menu and the Maintenance menu.
Totalizer management
Totalizer type Process monitor View menu Maintenance menu
Process totalizer View current value, reset”  View current value, start, Not accessible
stop, reset"
Process inventory View current value View current value View current value, reset!"
Batch inventory N/A View current value for View current value, reset
enabled batch presets for all six batch presets

(1) Reset is available only if enabled via the display. See Section 5.3.3.

174
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Figure 20-1 View menu - Totalizer management

View

Process totalizers

Batch inventory®

* API ref vol total™

* ED ref vol total®

* ED net mass total®
« ED net vol total®

* Frequency input total

* API ref vol inventory"

* ED ref vol inventory®

* ED net mass inventory®
* ED net vol inventory®

* Frequency input inventory

Process Inventory * Preset 1
* Preset 2
* Preset 3
* Preset 4
* Preset 5
* Mass total * Mass inventory * Preset 6
* Volume total * Volume inventory

(1) Displayed only if the petroleum measurement application is installed.
(2) Displayed only if the enhanced density application is installed.
(3) Displayed only if the discrete batch application is installed. Only enabled presets are listed.

Figure 20-2 Maintenance menu - Totalizer management

Maintenance

Batch inventory™"

* Preset 1
* Preset 2
* Preset 3
* Preset 4
* Preset 5
* Preset 6

Process inventory

* Mass inventory

¢ Volume inventory

* API ref vol inventory®

* ED ref vol inventory®
 ED net mass inventory®
 ED net vol inventory®

* Freq input inventory

(1) Displayed only if the discrete batch application is installed.
(2) Displayed only if the petroleum measurement application is installed.
(3) Displayed only if the enhanced density application is installed.
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20.4

20.5

20.6

176

Process totalizers
Use the View menu to:
*  View the current value of a process totalizer
»  Start or stop all process totalizers and inventories simultaneously
* Reset a process totalizer
From the View menu:
Select Process Totalizers.
Select Process. All process totalizers are displayed. Scroll down the list as required.
To start all totalizers and inventories, press START.

To stop all totalizers and inventories, press STOP.

A

To reset a totalizer, highlight the desired totalizer and press RESET.

Note: The RESET button is available only if resetting totalizers via the display has been enabled. See
Section 5.3.3.

Note: If write-protection has been enabled (see Section 5.3.2), process totalizers cannot be reset
unless the flow rate is zero.

Process inventories

Use the Maintenance menu to:
*  View the current value of a process inventory
¢ Reset a process inventory

From the Maintenance menu:

1. Select Process Inventory. All process inventories are displayed. Scroll down the list as
required.

2. To reset a process inventory, highlight the desired process inventory and press RESET.

Note: The RESET button is available only if resetting totalizers via the display has been enabled. See
Section 5.3.3.

You can also use the View menu to view the current value of a process inventory. From the View
menu:

1. Select Process Totalizers.
2. Select Inventory.

3. Select the desired process inventory. Its current value is displayed on screen.

Batch inventories

Use the Maintenance menu to:
* View the current value of a batch inventory
* Reset a batch inventory

From the Maintenance menu:

1. Select Batch Inventory. Values for all batch presets are displayed. Scroll down the list as
required.

2. To reset a batch inventory, highlight the desired batch preset and press RESET.
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You can also use the View menu to view the current value of a batch inventory. From the View menu:
1. Select Batch Inventory. Values are listed only for presets that have been enabled.

2. Scroll down the list as required.
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21.1  Overview

This chapter describes the following procedures:
e Meter verification — see Section 21.3
e Meter validation and adjusting meter factors — see Section 21.4
* Density calibration — see Section 21.5
e Temperature calibration — see Section 21.6

This chapter provides basic information and procedural flowcharts for each step. For more details
about how to perform each procedure, see the flowcharts for your Series 3000 device and
communication tool, provided in the appendices to this manual.

Notes: All ProLink Il or Communicator procedures provided in this section assume that your
computer is already connected to the Series 3000 device and you have established communication,
and that you are complying with all applicable safety requirements.

Bunooyssjqnoa] pue sansoubeiq

21.2  Meter verification, meter validation, and calibration
There are three procedures:

*  Meter verification — establishing confidence in the sensor’s performance by analyzing
secondary variables that are highly correlated with flow and density calibration factors

*  Meter validation — confirming performance by comparing the sensor’s measurements to a
primary standard

*  Calibration — establishing the relationship between a process variable (flow, density, or
temperature) and the signal produced by the sensor

These three procedures are discussed and compared in Sections 21.2.1 through 21.2.4. Before
performing any of these procedures, review these sections to ensure that you will be performing the
appropriate procedure for your purposes.

00S€/00EE 19POIN — SuonednIdads

00.€/0SEE 19POIN — suonedldads

Configuration and Use Manual 179



Measurement Performance

21.2.1 Meter verification

Meter verification applies only to the Model 3500 and Model 3700 transmitters. To use meter
verification, the transmitter must be connected to an enhanced core processor and the meter
verification option must have been ordered.

Meter verification evaluates the structural integrity of the sensor tubes by comparing current tube
stiffness to the stiffness measured at the factory. Stiffness is defined as the load per unit deflection, or
force divided by displacement. Because a change in structural integrity changes the sensor’s response
to mass and density, this value can be used as an indicator of measurement performance. Changes in
tube stiffness are typically caused by erosion, corrosion, or tube damage.

Note: Micro Motion recommends that you perform meter verification on a regular basis.

There are two versions of the meter verification application: the original version and Micro Motion
Smart Meter Verification. Table 21-1 lists requirements for the original version and Smart Meter
Verification. Table 21-2 provides a comparison of the two versions.

Note: If you are running an older version of ProLink Il or the Communicator device description, you
will not be able to access the additional features in Smart Meter Verification. If you are running an
updated version of ProLink Il or the Communicator with the original version of meter verification, the
meter verification procedures will be slightly different from the procedures shown here.

Version requirements for meter verification application

Meter verification application

Requirement type Original version Smart Meter Verification

Transmitter v7.0 v8.0 and later

Enhanced core processor'” v3.0 v3.6 and later

ProLink Il requirements v2.5 v2.9

HART DD requirements 375 Field Communicator device rev 7, 375 Field Communicator device rev 8,
DD rev 1 DD rev 1

(1) The standard core processor does not support meter verification.

Comparison of meter verification features and functions: original version vs. Smart Meter
Verification

Meter verification application

Feature or function Original version Smart Meter Verification

Process interruption No need to halt flow No need to halt flow

Measurement interruption Three minutes. Outputs go to: User option:
e Last Measured Value * Continue Measurement. Measurement is
* Configured Fault Value not interrupted. Test requires
approximately 90 seconds.
¢ Last Measured Value. Outputs fixed and
measurement interrupted for
approximately 140 seconds.
* Configured Fault Value. Outputs fixed
and measurement interrupted for
approximately 140 seconds.

Result storage Test results stored only for tests run with ~ Twenty most recent results stored on the
ProLink Il, and stored on the PC transmitter, independent of tool used to
perform the procedure. For tests run with
ProLink I, additional result data stored on
PC.
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Comparison of meter verification features and functions: original version vs. Smart Meter
Verification continued

Feature or function

Meter verification application

Original version

Smart Meter Verification

Result data on display

Pass/Fail/Abort for current test

For all results stored on transmitter:

¢ Pass/Fail/Abort

¢ Abort code (if relevant)

» Stiffness of the right and left pickoffs

Result data with Communicator

Pass/Caution/Abort for current test

For all results stored on transmitter:

* Pass/Caution/Abort

* Abort code (if relevant)

* Stiffness of the right and left pickoffs
e Comparison table for stored results
* Comparison plot for stored results

Result data with ProLink Il

For all results stored on PC:

* Pass/Fail/Abort

* Abort code (if relevant)

» Stiffness of the right and left pickoffs
* Test execution metadata

e Comparison graphs

* Test reports

¢ Data export and manipulation

For all results stored on transmitter:

* Pass/Fail/Abort

* Abort code (if relevant)

« Stiffness of the right and left pickoffs
* Test execution metadata

e Comparison graphs

* Test reports

¢ Data export and manipulation

capabilities capabilities
Startup methods Manual Manual
Scheduler
Event

Discrete input

21.2.2

Meter validation and meter factors

Meter validation can be used with all Series 3000 systems (both transmitters and controllers). There
are no special requirements.

Meter validation compares a measurement value reported by the Series 3000 device with an external
measurement standard. Meter validation requires one data point.

Note: For meter validation to be useful, the external measurement standard must be more accurate
than the sensor. See the sensor’s product data sheet for its accuracy specification.

If the Series 3000 device’s mass flow, volume flow, or density measurement is significantly different
from the external measurement standard, you may want to adjust the corresponding meter factor. A
meter factor is the value by which the Series 3000 device multiplies the process variable value. The
default meter factors are 1.0, resulting in no difference between the data retrieved from the sensor and
the data reported externally.

Meter factors are typically used for proving the flowmeter against a weights and measures standard.
You may need to calculate and adjust meter factors periodically to comply with regulations.

21.2.3

Calibration

Calibration applies only to the Model 3500 and Model 3700 transmitters. There are no special

requirements.
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The flowmeter measures process variables based on fixed points of reference. Calibration adjusts
those points of reference. Three types of calibration can be performed:

e Zero (see Section 16.3)
* Density calibration
* Temperature calibration

Density and temperature calibration require two data points (low and high) and an external
measurement for each. Calibration produces a change in the offset and/or the slope of the line that
represents the relationship between process density and the reported density value, or the relationship
between process temperature and the reported temperature value.

Note: For density or temperature calibration to be useful, the external measurements must be
accurate.

Transmitters are calibrated at the factory, and normally do not need to be calibrated in the field.
Calibrate the flowmeter only if you must do so to meet regulatory requirements. Contact Micro
Motion before calibrating your flowmeter.

Micro Motion recommends using meter validation and meter factors, rather than calibration, to prove
the meter against a regulatory standard or to correct measurement error.

21.2.4  Comparison and recommendations

When choosing among meter verification, meter validation, and calibration, consider the following
factors:

*  Process and measurement interruption

- Smart Meter Verification provides an option that allows process measurement to continue
during the test.

- The original version of meter verification requires approximately three minutes to
perform. During these three minutes, flow can continue (provided sufficient stability is
maintained); however, measurement is halted.

- Meter validation for density does not interrupt the process or process measurement.
However, meter validation for mass flow or volume flow requires process down-time for
the length of the test.

- Calibration requires process down-time. In addition, density and temperature calibration
require replacing the process fluid with low-density and high density fluids, or with
low-temperature and high-temperature fluids.

* External measurement requirements
- Neither version of meter verification requires external measurements.
- Zero calibration does not require external measurements.

- Density calibration, temperature calibration, and meter validation require external
measurements. For good results, the external measurement must be highly accurate.
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21.3

e  Measurement adjustment

- Meter verification is an indicator of sensor condition, but does not change flowmeter
internal measurement in any way.

- Meter validation does not change flowmeter internal measurement in any way. If you
decide to adjust a meter factor as a result of a meter validation procedure, only the reported
measurement is changed — the base measurement is not changed. You can always reverse
the change by returning the meter factor to its previous value.

- Calibration changes the transmitter’s interpretation of process data, and accordingly
changes the base measurement. If you perform a zero calibration, you can restore the
factory zero at a later time. You cannot return to the previous zero (if different from the
factory zero), density calibration values, or temperature calibration values unless you have
manually recorded them.

Micro Motion recommends obtaining the meter verification option and performing meter verification
on a regular basis.

Performing meter verification

Note: To use meter verification, the transmitter must be paired with an enhanced core processor, and
the meter verification option must be purchased for the transmitter.

21.3.1 Preparing for the meter verification test

Process fluid and process conditions

The meter verification test can be performed on any process fluid. It is not necessary to match factory
conditions.

During the test, process conditions must be stable. To maximize stability:
* Maintain a constant temperature and pressure.
e Avoid changes to fluid composition (e.g., two-phase flow, settling, etc.).
*  Maintain a constant flow. For higher test certainty, reduce or stop flow.

If stability varies outside test limits, the meter verification procedure will be aborted. Verify the
stability of the process and retry the test.

Transmitter configuration

Meter verification is not affected by any parameters configured for flow, density, or temperature. It is
not necessary to change the transmitter configuration.

Control loops and process measurement

If the transmitter outputs will be set to Last Measured Value or Fault during the test, the outputs will
be fixed for two minutes (Smart Meter Verification) or three minutes (original version). Disable all
control loops for the duration of the test, and ensure that any data reported during this period is
handled appropriately.
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Specification uncertainty limit

The specification uncertainty limit defines the acceptable degree of variation from factory results,
expressed as a percentage. Variation inside the limit is reported as Pass. Variation outside the limit is
reported as Fail or Caution.

* In Smart Meter Verification, the specification uncertainty limit is set at the factory and cannot
be configured.

* In the original version of meter verification, the specification uncertainty limit is configurable.
However, Micro Motion suggests using the default value. Contact Micro Motion Customer
Service before changing the specification uncertainty limit.

21.3.2  Running the meter verification test, original version
To run a meter verification test:

e With ProLink II, see Figure 21-1

*  With the display, see Figure 21-2

Note: If you start a meter verification test from ProLink I, the transmitter display shows the following
message:

SENSOR
VERFY/x%
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Figure 21-1 Meter verification test, original version — ProLink Il
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(1) If the graph was viewed at the beginning of the procedure,
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Meter verification test, original version — Display

Maintenance Menu >
Meter Verification >

v

‘ Set Uncertainty Limit(" ‘

'

‘ Start Meter Verify ‘

‘ Set output behavior ‘

'

(1) Enter the uncertainty limit as a decimal value,
e.g., 0.0400 (4%).

‘ Proceed? ‘
Yes
‘ Progress ......... X%
‘ PASS ‘ ‘ FAIL ‘ ‘ ABORT ‘

21.3.3  Running Smart Meter Verification
To run a Smart Meter Verification test:

*  With ProLink II, see Figure 21-3.

*  With the display, see Figure 21-4.

e  With the Communicator, see Figure 21-5.

Note: If the custody transfer application is installed and the transmitter is secured, you can run a
Smart Meter Verification test with outputs set to Continue Measuring or Fault. Last Measured Value is
not available. See Section 19.3 for detailed information.

Note: If you start a Smart Meter Verification test from ProLink Il or the Communicator, and the
outputs are set to Last Measured Value or Fault, the transmitter display shows the following message:

SENSOR
VERFY/x%
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Smart Meter Verification test — ProLink Il

Tools >
Meter Verification >
Run Meter Verification
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Bunooyssjqnoa] pue sansoubeiq

y
A

00S€/00EE 19POIN — SuonednIdads

Test result chart
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Smart Meter Verification test — Display

— Continue Measuiring

Maintenance Menu >
Meter Verification >

!

Start Meter Verify

Set output behavior

Output

: Hold last value =~ ——
setting

Fault

!

Proceed?
Yes
v
Progress ......... x%
|
v v v
PASS FAIL ABORT
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Smart Meter Verification test — Communicator
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21.3.4 Reading and interpreting meter verification test results

Pass/Fail/Abort

When the test is completed, the result will be reported as Pass, Fail, or Abort:

*  Pass— The test result is within the specification uncertainty limit. In other words, the stiffness
of the left and right pickoffs match the factory values plus or minus the specification
uncertainty limit. If transmitter zero and configuration match factory values, the sensor will
meet factory specifications for flow and density measurement. It is expected that meters will

pass meter verification every time the test is run.

*  Fail/Caution — The test result is not within the specification uncertainty limit. Micro Motion
recommends that you immediately repeat the meter verification test. If you were using Smart
Meter Verification, with outputs set to Continue Measurement, change the setting to Last

Measured Value or Fault.

- If the meter passes the second test, the first Fail/Caution result can be ignored.

- If the meter fails the second test, the flow tubes may be damaged. Use your process
knowledge to determine the possibilities for damage and the appropriate actions for each.
These actions might include removing the meter from service and physically inspecting
the tubes. At minimum, you should perform a flow validation and a density calibration.

e Abort — A problem occurred with the meter verification test (e.g., process instability). Abort
codes are listed and defined in Table 21-3, and suggested actions are provided for each code.

Meter verification abort codes

Abort code Description Suggested action

1 User-initiated abort None required. Wait for 15 seconds before
starting another test.

3 Frequency drift Ensure that temperature, flow, and density are
stable, and rerun the test.

5 High drive gain Ensure that flow is stable, minimize entrained
gas, and rerun the test.

8 Unstable flow Review the suggestions for stable flow in
Section 21.3.1 and rerun the test.

13 No factory reference data for meter verification Contact Micro Motion customer service and

test performed on air

provide the abort code.

14 No factory reference data for meter verification
test performed on water

Contact Micro Motion customer service and
provide the abort code.

15 No configuration data for meter verification Contact Micro Motion customer service and
provide the abort code.
Other General abort. Repeat the test. If the test aborts again, contact

Micro Motion customer service and provide the
abort code.
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Detailed test data with ProLink Il

For each test, the following data is stored on the transmitter:
¢ Powered-on hours at the time of the test (Smart Meter Verification)
e Test result

»  Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

* Abort code, if applicable
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ProLink II stores additional descriptive information for each test in a database on the local PC,
including:

e Timestamp from the PC clock

*  Current flowmeter identification data

e Current flow and density configuration parameters
*  Current zero values

e Current process values for mass flow rate, volume flow rate, density, temperature, and external
pressure

* (Optional) User-entered customer and test descriptions

If you are using Smart Meter Verification and you run a meter verification test from ProLink II,
ProLink II first checks for new test results on the transmitter and synchronizes the local database if
required. During this step, ProLink II displays the following message:

Bunooyssjqnoa] pue sansoubeiq

Synchronizing x out of y
Please wait

Note: If you request an action while synchronization is in process, ProLink Il displays a message
asking whether or not you want to complete synchronization. If you choose No, the ProLink I1
database may not include the latest test results from the transmitter.

Test results are available at the end of each test, in the following forms:
* A test result chart (see Figure 21-6).

*  Atest report that includes the descriptive information for the current test, the test result chart,
and background information about meter verification. You can export this report to an HTML
file or print it to the default printer.

Note: To view the chart and the report for previous tests without running a test, click View Previous
Test Results and Print Report from the first meter verification panel. See Figure 21-3. Test reports are
available only for tests initiated from ProLink II.
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Test result chart

Structural Integrity Meter Yerification - Test Hesults

Last Meter Verification Fesult
IVM teter PASSED Yerfication. Meter meets factory specifications.

Structural Integrity Normalized Stiffness
Transmitter Model: 2700C, Transmitter Serial No.: 0, Sensor Model: TOTS, Sensor Serial No.: 0

i Device Initiated Inlet Stiffness [ Device Initiated Outlet Stiffness & Prolink Initiated Inlet Stiffness
B Prolink Initiated (wtlet Stiffness

4 Uppergpe¢ Umit ~ - -~~~ -~~~ "~~~ ~"~"“~"“""~""°""""7"""°"°7"°7"°7/"°7""°" """ "~~~ o,ooT,TooTooToooToomommTTTT
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Meter Verification Run Counter
Rl v
Right click on the graph to interact with it Click '< Back' to collect data again. Export Data to C5Y File |
Click Nest to generate and print repart.

< Back I Mext » I Cancel Help

The test result chart shows the results for all tests in the ProLink II database, plotted against the
specification uncertainty limit. The inlet stiffness and the outlet stiffness are plotted separately. This
helps to distinguish between local and uniform changes to the sensor tubes.

This chart supports trend analysis, which can be helpful in detecting meter problems before they
become severe.
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Note the following:

e The test result chart may not show all test results, and test counters may not be continuous.
ProLink II stores information about all tests initiated from ProLink II and all tests available on
the transmitter when the test database is synchronized. However, the transmitter stores only the
twenty most recent test results. To ensure a complete result set, always use ProLink II to
initiate the tests, or synchronize the ProLink II database before overwriting occurs.

* The chart uses different symbols to differentiate between tests initiated from ProLink II and
tests initiated using a different tool. A test report is available only for tests that were initiated
from ProLink II.

*  You can double-click the chart to manipulate the presentation in a variety of ways (change
titles, change fonts, colors, borders and gridlines, etc.), and to export the data to additional
formats (including “to printer”).
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*  You can export this chart to a CSV file for use in external applications.

Detailed test data with the display

Note: Requires Smart Meter Verification. No detailed test data is available with the original version
of the meter verification application.

For each Smart Meter Verification test, the following data is stored on the transmitter:
* Powered-on hours at the time of the test

e Test result

Bunooyssjqnoa] pue sansoubeiq

»  Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

e Abort code, if applicable

To view this data, see Figure 21-7.

Meter verification test data — Display

Maintenance Menu >
Meter Verification >

!

Read Results

Select Test Number
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Detailed test data with the Communicator

Note: Requires Smart Meter Verification. No detailed test data is available with the original version
of the meter verification application.

For each Smart Meter Verification test, the following data is stored on the transmitter:

¢ Powered-on hours at the time of the test

e Test result

»  Stiffness of the left and right pickoffs, shown as percentage variation from the factory value. If
the test aborted, O is stored for these values.

*  Abort code, if applicable

The Communicator also provides a trend function that allows you to compare the results of the 20
tests, viewed as either a table or a graph.

To view this data, see Figure 21-8.

Meter verification test data — Communicator

Online >

1 Overview >
3 Shortcuts >
6 Meter Verification

194

»

Online >
3 Service Tools >
4 Maintenance >
1 Routine Maintenance >
3 Meter Verification

w

v

1 Run Meter Verification
2 View Test Results
3 Schedule Meter Verification

|
2
v

1 Run Counter

2 Running Hours

3 Test Result

4 Abort Code

5 LPO Stiffness

5 RPO Stiffness

7 Show Results Table
8 Show Results Plot

Test Result #x

Run Counter
Running Hours
Test Result
Abort Code
LPO Stiffness
RPO Stiffness

To previous test:
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21.3.5  Setting up automatic or remote execution of the meter verification test

Note: Requires Smart Meter Verification. Scheduling is not available with the original version of the
meter verification application.

There are three ways to execute a Smart Meter Verification test automatically:
* Define it as an event action

* Set up a one-time automatic execution
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* Set up a recurring execution

In addition, if your transmitter has a discrete input, you can configure the discrete input to initiate a
Smart Meter Verification test remotely.

In all cases, the test will be performed with outputs set to Continue Measuring.

You can use these methods in any combination. For example, you can specify that a Smart Meter
Verification test will be executed three hours from now, every 24 hours starting now, every time a
specific discrete event occurs, and every time the discrete input is activated.

* To define meter verification as an event action, see Figure 10.4.
* To define meter verification as a discrete input action, see Section 7.3.5.

e To set up a one-time automatic execution, set up a recurring execution, view the number of
hours until the next scheduled test, or delete a schedule:

- With ProLink II, click Tools > Meter Verification > Schedule Meter Verification.
- With the display, see Figure 21-9.
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- With the Communicator, see Figure 21-10
Note the following:

» If you are setting up a one-time automatic execution, specify the start time as a number of
hours from the present time. For example, if the present time is 2:00 and you specify 3.5 hours,
the test will be initiated at 5:30.

* If you are setting up a recurring execution, specify the number of hours to elapse between
executions. The first test will be initiated when the specified number of hours has elapsed, and
testing will be repeated at the same interval until the schedule is deleted. For example, if the
present time is 2:00 and you specify 2 hours, the first test will be initiated at 4:00, the next at
6:00, and so on.

* To turn off automatic execution from the display, set the appropriate value (Next Run or
Recurring Time) to 0 hours.
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Smart Meter Verification scheduler — Display

Maintenance Menu >
Meter Verification >

v

Schedule Meter Verify

Time Remaining

Next Run

Recurring Time

Smart Meter Verification scheduler — Communicator

Online > Online >
1 Overview > 3 Service Tools >
3 Shortcuts > 4 Maintenance >
6 Meter Verification 1 Routine Maintenance >
3 Meter Verification
6 ¢ 3

1 Run Meter Verification
2 View Test Results
3 Schedule Meter Verification

:
v

1 Next Run

2 Set Hrs Until Next Run
3 Set Recurring Hours
4 Turn Off Schedule

21.4  Performing meter validation

To perform meter validation, measure a sample of the process fluid and compare the measurement
with the flowmeter’s reported value.

Use the following formula to calculate a meter factor:

ExternalStandard
ActualTransmitterMeasurement

NewMeterFactor = ConfiguredMeterFactor x

Valid values for meter factors range from 0.8 to 1.2. If the calculated meter factor exceeds these
limits, contact Micro Motion customer service.

To enter the new meter factor, use the Inputs menu (see Figure 7-1).
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Example The flowmeter is installed and proved for the first time. The flowmeter
mass measurement is 250.27 |b; the reference device measurement is
250 Ib. A mass flow meter factor is determined as follows:

250

25027 - 09989

MassFlowMeterFactor = 1 x

The first mass flow meter factor is 0.9989.
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One year later, the flowmeter is proved again. The flowmeter mass
measurement is 250.07 Ib; the reference device measurement is
250.25 Ib. A new mass flow meter factor is determined as follows:

250.25

MassFlowMeterFactor = 0.9989 x 550.07

= 0.9996

The new mass flow meter factor is 0.9996.

21.5 Performing density calibration
Density calibration includes the following calibration points:
* All sensors:
- DI calibration (low-density)
- D2 calibration (high-density)

» T-Series sensors only:
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- D3 calibration (optional)
- D4 calibration (optional)

For T-Series sensors, the optional D3 and D4 calibrations could improve the accuracy of the density
measurement. If you choose to perform the D3 and D4 calibration:

* Do not perform the D1 or D2 calibration.
e Perform D3 calibration if you have one calibrated fluid.

e Perform both D3 and D4 calibrations if you have two calibrated fluids (other than air and
water).

The calibrations that you choose must be performed without interruption, in the order listed here.
Note: Before performing the calibration, record your current calibration parameters. If you are using

ProLink 11, you can do this by saving the current configuration to a file on the PC. If the calibration
fails, restore the known values.
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21.5.1 Preparing for density calibration

Before beginning density calibration, review the requirements in this section.

Sensor requirements

During density calibration, the sensor must be completely filled with the calibration fluid, and flow
through the sensor must be at the lowest rate allowed by your application. This is usually
accomplished by closing the shutoff valve downstream from the sensor, then filling the sensor with
the appropriate fluid.
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Density calibration fluids

D1 and D2 density calibration require a D1 (low-density) fluid and a D2 (high-density) fluid. You
may use air and water. If you are calibrating a T-Series sensor, the D1 fluid must be air and the D2

fluid must be water.

A CAUTION

For T-Series sensors, the D1 calibration must be performed on air and the D2
calibration must be performed on water.

For D3 density calibration, the D3 fluid must meet the following requirements:
e Minimum density of 0.6 g/cm’

»  Minimum difference of 0.1 g/cm® between the density of the D3 fluid and the density of water.
The density of the D3 fluid may be either greater or less than the density of water

For D4 density calibration, the D4 fluid must meet the following requirements:
e Minimum density of 0.6 g/cm’

e Minimum difference of 0.1 g/cm’ between the density of the D4 fluid and the density of the
D3 fluid. The density of the D4 fluid must be greater than the density of the D3 fluid

e Minimum difference of 0.1 g/cm’ between the density of the D4 fluid and the density of water.
The density of the D4 fluid may be either greater or less than the density of water

During the calibration, you must enter the density of the calibration fluid. For convenience, Tables
21-4 and 21-5 provide the density of air and water at different environmental conditions.

Density of air

Pressure Temperature in °C and °F

in millibar

(inches of 10 °C 15 °C 20°C 25°C 30°C 35°C 40 °C 45 °C 50 °C
mercury) 50 °F 59 °F 68 °F 77 °F 86 °F 95 °F 104°F 113°F 122°F
850 (25.14) .0010 .0010 .0010 .0010 .0010 .0010 .0009 .0009 .0009
900 (26.62) .0011 .0011 .0011 .0010 .0010 .0010 .0010 .0010 .0009
950 (28.10) .0012 .0011 .0011 .0011 .0011 .0011 .0010 .0010 .0010
1000 (29.57) .0012 .0012 .0012 .0012 .0011 .0011 .0011 .0011 .0011
1050 (31.06) .0013 .0013 .0012 .0012 .0012 .0012 .0012 .0011 .0011
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Density of water ?

(7]

c

Temperature Temperature g

°C °F Density in g/cm? °C °F Density in g/cm? f_:':

0 32 0.99987 21 69.8 0.99802 4

1 33.8 0.99993 22 71.6 0.99780 ol

2 35.6 0.99997 23 73.4 0.99756 3

3 37.4 0.99999 24 75.2 0.99732 2

4 39.2 1.00000 25 77 0.99707 e
5 M 0.99999 26 78.8 0.99681
6 42.8 0.99997 27 80.6 0.99654
7 44.6 0.99993 28 82.4 0.99626
8 46.4 0.99988 29 84.2 0.99597
9 48.2 0.99981 30 86 0.99567

10 50 0.99973 o

11 51.8 0.99963 31 87.8 0.99537 =

12 53.6 0.99952 32 89.6 0.99505 3

13 55.4 0.99940 33 91.4 0.99473 @

14 57.2 0.99927 34 93.2 0.99440 s

15 59 0.99913 35 95 0.99406 5

16 60.8 0.99897 36 96.8 0.99371 =

17 62.6 0.99880 37 98.6 0.99336 -

18 64.4 0.99862 38 100.4 0.99229 )

19 66.2 0.99843 &

20 68 0.99823 2

=2

o

]

21.5.2  Density calibration procedures a

To perform the low-density calibration:
1. Fill the sensor with a low-density fluid, such as air.

2. If possible, shut off the flow. Otherwise, pump the fluid through the sensor at the lowest flow
rate allowed by the process.

3. Use any established method to derive an accurate density, in g/cm?, for the fluid at line
conditions. If air is the low-density calibration fluid, a value from Table 21-4 can be used for
the density.

Press the Security button on the display.
From the Maintenance menu, select Calibration.

Select Density.

N o s

Select Low Density.

00S€E/00€EE [9POIN — suonesyldoads

a. Set the D1 value to the line-condition density in grams per cubic centimeter.
b. Select Calibrate Density, then press SEL. A “Calibration In Progress” alarm is generated.
8. When the calibration is complete:
* Inthe active alarm log, the alarm changes from “active” to “inactive but unacknowledged.”
» If the calibration succeeded, a “Success” status is displayed.
» If the calibration failed, a “Failed” status is displayed.
9. Press EXIT to return to the Density menu.

10. (Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the
display, acknowledge the alarm using the procedures described in Chapter 22.

To perform the high-density calibration:

1. Fill the sensor with a high-density fluid, such as water.
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If possible, shut off the flow. Otherwise, pump the fluid through the sensor at the lowest flow
rate allowed by the process.

To ensure stable density, make sure the fluid in the flow tubes remains completely free of gas
bubbles during the calibration.

Use any established method to derive an accurate density, in g/cm’, for the fluid at line
conditions. If water is the high-density calibration fluid, a value from Table 21-5 can be used
for the density.

From the Density menu, select High Density.

a. Set the D2 value to the line-condition density in grams per cubic centimeter.

b. Select Calibrate Density, then press SEL. A “Calibration In Progress” alarm is generated.
When the calibration is complete:

* Inthe active alarm log, the alarm changes from *“active” to “inactive but unacknowledged.”
» If the calibration succeeded, a “Success” status is displayed.

e If the calibration failed, a “Failed” status is displayed.

7. Press EXIT to return to the Density menu.

8. (Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the

display, acknowledge the alarm using the procedures described in Chapter 22.

To perform the D3 calibration (T-Series sensors only):

1.
2.

Fill the sensor completely with a fluid of known density.

If possible, shut off the flow. Otherwise, pump the fluid through the sensor at the lowest flow
rate allowed by the process.

To ensure stable density, make sure the fluid in the flow tubes remains completely free of gas
bubbles during the calibration.

Use any established method to derive an accurate density, in g/cm®, for the fluid at line
conditions.

From the Density menu, select Density D3.

a. Set the D3 value to the line-condition density in grams per cubic centimeter.

b. Select Calibrate Density, then press SEL. A “Calibration In Progress” alarm is generated.
When the calibration is complete:

* In the active alarm log, the alarm changes from “active” to “inactive but unacknowledged.”
» If the calibration succeeded, a “Success” status is displayed.

» If the calibration failed, a “Failed” status is displayed.

Press EXIT to return to the Density menu.

8. (Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the

display, acknowledge the alarm using the procedures described in Chapter 22.

To perform the D4 calibration (T-Series sensors only):

1.
2.

Fill the sensor completely with a fluid of known density.

If possible, shut off the flow. Otherwise, pump the fluid through the sensor at the lowest flow
rate allowed by the process.

To ensure stable density, make sure the fluid in the flow tubes remains completely free of gas
bubbles during the calibration.
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4. Use any established method to derive an accurate density, in g/cm’, for the fluid at line
conditions.

5. From the Density menu, select Density D4.
a. Set the D4 value to the line-condition density in grams per cubic centimeter.
b. Select Calibrate Density, then press SEL. A “Calibration In Progress” alarm is generated.

6. When the calibration is complete:
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* Inthe active alarm log, the alarm changes from “active” to “inactive but unacknowledged.”

e If the calibration succeeded, a “Success” status is displayed.

o If the calibration failed, a “Failed” status is displayed.
7. Press EXIT to return to the Density menu.

(Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the
display, acknowledge the alarm using the procedures described in Chapter 22.

21.6  Performing temperature calibration

Temperature calibration is a two-part procedure: temperature offset calibration and temperature slope
calibration. The entire procedure must be completed without interruption.

Temperature calibration requires reading and entering temperature values in degrees Celsius.
Although it is not required, it may be useful to configure the temperature unit for degrees Celsius. See
Section 7.3.2 for information on configuring the temperature unit.

Bunooysajqnoa] pue sansoubeiq

To perform the temperature offset calibration:
1. Fill the sensor with process fluid at the lowest temperature measured during the application.
2. Wait approximately 30 minutes for the flow tube temperature to stabilize.

3. Use a highly accurate thermometer, temperature sensor, RTD, or other device to measure the
temperature of the process fluid.

From the Maintenance menu, select Calibration.
Select Temperature.
Select Low Temperature.

N e

At the Low Temperature menu:

a. Set the Low Temperature Value to the temperature that was measured in Step 3, in
degrees Celsius, then press SAVE.

00S€/00EE 19POIN — SuonednIdads

b. Select Calibrate Temp, then press SEL.
8. During calibration, an alarm message is generated.
9. When the calibration is complete:
* Inthe active alarm log, the alarm changes from “active” to “inactive but unacknowledged.”
e If the calibration succeeded, a “Success” status is displayed.
e If the calibration failed, a “Failed” status is displayed.
10. Press EXIT to return to the Temperature menu.

11. (Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the
display, acknowledge the alarm using the procedures described in Chapter 22.

To perform the temperature slope calibration:

1. Fill the sensor with process fluid at the highest temperature measured during the application.

00.€/0SEE 19POIN — suonedldads
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. Wait approximately 30 minutes for the flow tube temperature to stabilize.

3. Use the same reference device as the one that was used during the temperature offset

calibration to measure the temperature of the process fluid.

4. From the Temperature menu, select High Temperature.

. At the High Temperature menu:

a. Set the High Temperature Value to the temperature that was measured in Step 3, in
degrees Celsius, then press SAVE.

b. Select Calibrate Temp, then press SEL.

6. During calibration, an alarm message is generated.

. When the calibration is complete:

* Inthe active alarm log, the alarm changes from “active” to “inactive but unacknowledged.”
o If the calibration succeeded, a “Success” status is displayed.

» If the calibration failed, a “Failed” status is displayed.

8. Press EXIT to return to the Temperature menu.

(Optional) To clear the alarm from the active alarm log and the alarm bar at the top of the
display, acknowledge the alarm using the procedures described in Chapter 22.

Micro Motion® Series 3000 MVD Transmitters and Controllers
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22.1  About this chapter
This chapter explains how to use the diagnostic software to troubleshoot alarm conditions. Diagnostic
software includes:
*  Meter fingerprinting
* Sensor simulation mode
e The active alarm log
e  Alarm messages
e The diagnostic monitor
This chapter also provides additional information on troubleshooting.
22.2 Checking process variables
Micro Motion suggests that you make a record of basic process variables under normal operating
conditions. This will help you recognize when the process variables are unusually high or low. The
meter fingerprinting feature (see Section 22.3) may be used to record the current levels of twelve
process variables, and to view the recorded levels of these process variables at three other points of
transmitter operation.
For troubleshooting, check the process variables under both normal flow and tubes-full no-flow
conditions. Except for flow rate, you should see little or no change between flow and no-flow
conditions. if you see a significant difference, record the values and contact Micro Motion customer
service for assistance.
Unusual values for process variables may indicate a variety of different problems. Table 22-1 lists
several possible problems and remedies.
Process variables problems and possible remedies
Symptom Cause Possible remedy
Steady non-zero flow rate under Misaligned piping (especially in new Correct the piping.
no-flow conditions installations)
Open or leaking valve. Check or correct the valve mechanism.
Bad sensor zero Rezero the flowmeter. See
Section 16.3.
Inappropriate measurement unit Check configuration. See
Section 22.13.
Cutoff set too low Check configuration. See Section 7.3.2.
Bad flow calibration factor Verify characterization. See

Section 22.16.
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Process variables problems and possible remedies continued

Symptom

Cause

Possible remedy

Erratic non-zero flow rate under
no-flow conditions

RF interference

Check environment for RF interference.
See Section 22.11.5.

Wiring problem

Verify all sensor-to-transmitter wiring
and ensure the wires are making good
contact.

Incorrectly grounded 9-wire cable
(remote core processor with remote
transmitter installations)

Verify 9-wire cable installation.

Vibration in pipeline at rate close to
sensor tube frequency

Check environment and remove source
of vibration.

Improper sensor grounding (T-Series
sensors only)

Verify that the sensor is grounded to
earth ground.

Leaking valve or seal

Check pipeline.

Inappropriate measurement unit

Check configuration. See
Section 22.13.

Inappropriate damping value

Check configuration. See Section 7.3.2.

Slug flow

See Slug flow alarms in Section 22.7.3.

Plugged flow tube

Check drive gain and tube frequency.
Purge the flow tubes or replace the
Sensor.

Moisture in sensor junction box

Open junction box and allow it to dry.
Do not use contact cleaner. When
closing, ensure integrity of gaskets and
O-rings, and grease all O-rings.

Mounting stress on sensor

Check sensor mounting. Ensure:

* Sensor is not being used to support
pipe.

* Sensor is not being used to correct
pipe misalignment.

* Sensor is not too heavy for pipe.

Sensor cross-talk

Check environment for sensor with
similar (+ 0.5 Hz) tube frequency.

Incorrect sensor orientation

Sensor orientation must be appropriate
to process fluid. See the installation
manual for your sensor.

Erratic non-zero flow rate when flow

is steady

Output wiring problem

Verify wiring between Series 3000
device and receiving device. See the
transmitter installation instructions.

Problem with receiving device

Test with another receiving device.

Inappropriate measurement unit

Check configuration. See
Section 22.13.

Inappropriate damping value

Check configuration. See Section 7.3.2.

Excessive or erratic drive gain

See Section 22.18.3 and
Section 22.18.4.

Slug flow

See Slug flow alarms in Section 22.7.3.

Plugged flow tube

Check drive gain and tube frequency.
Purge the flow tubes or replace the
sensor.

Wiring problem

Verify all sensor-to-transmitter wiring
and ensure the wires are making good
contact.

204
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Process variables problems and possible remedies continued

Symptom

Cause

Possible remedy

Inaccurate flow rate or batch total

Bad flow calibration factor

Verify characterization. See
Section 7.3.3.

Inappropriate measurement unit

Check configuration. See
Section 22.13.

Bad sensor zero

Rezero the meter. See Section 16.3.

Bad density calibration factors

Verify characterization. See
Section 7.3.3.

Bad flowmeter grounding

See Section 22.11.3.

Slug flow

See Slug flow alarms in Section 22.7.3.

Problem with receiving device

See Section 22.11.6.

Wiring problem

Verify all sensor-to-transmitter wiring
and ensure the wires are making good
contact.

Inaccurate density reading

Problem with process fluid

Use standard procedures to check
quality of process fluid.

Bad density calibration factors

Verify characterization. See
Section 7.3.3.

Wiring problem

Verify all sensor-to-transmitter wiring
and ensure the wires are making good
contact.

Bad flowmeter grounding

See Section 22.11.3.

Slug flow

See Slug flow alarms in Section 22.7.3.

Sensor cross-talk

Check environment for sensor with
similar (0.5 Hz) tube frequency.

Plugged flow tube Check drive gain and tube frequency.
Purge the flow tubes or replace the
sensor.
Temperature reading significantly RTD failure Check for alarm conditions and follow

different from process temperature

troubleshooting procedure for indicated
alarm.

Verify polling configuration and disable
polling for temperature if appropriate.
See Section 7.6.

Problem with sensor wiring

Check wiring to sensor. See
Section 22.11.2.

Incorrect calibration factor

Verify that the temperature calibration
factor is set correctly. See
Section 22.17.

Temperature reading slightly different
from process temperature

Temperature calibration required

Perform temperature calibration. See
Section 21.6.

Loose connections in sensor wiring

Check wiring to sensor. See
Section 22.11.2.

Corrosion in flow tube

Purge the flow tubes.

Unusually high density reading

Plugged, partially filled, or coated flow
tube

Check drive gain and tube frequency.
See Section 22.18.
Purge the flow tubes.

Incorrect K2 value

Verify characterization. See
Section 22.16.
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Diagnostics and Troubleshooting

Process variables problems and possible remedies continued

Symptom

Cause

Possible remedy

Unusually low density reading

Slug flow

See Section 22.7.3.

Incorrect K2 value

Verify characterization. See
Section 22.16.

Sensor erosion

Contact Micro Motion.

Unusually high tube frequency

Sensor erosion

Contact Micro Motion.

Reversed drive coil leads (remote core
processor with remote transmitter

installations)

Verify drive coil leads

Unusually low tube frequency

tube

Plugged, partially filled, or coated flow

Check drive gain and tube frequency.
See Section 22.18.
Purge the flow tubes.

Unusually low pickoff voltages

Several possible causes

See Section 22.18.5.

Unusually high drive gain

Several possible causes

See Section 22.18.3.

22.3

Fingerprint time

Meter fingerprinting

Note: Meter fingerprinting is available only on systems with the standard core processor.

The meter fingerprinting feature provides snapshots, or “fingerprints,” of twelve process variables, at
four different points of transmitter operation. See Table 22-2.

Meter fingerprinting data

Description

Process variables recorded

Current Present-time values

Factory Values at time transmitter left factory
Installation Values at time of first sensor zero
Last zero Values at time of most recent sensor

zero

* Mass flow rate
¢ \Volume flow rate

* Density
e Temperature

* Case temperature

* Mech zero

* Tube frequency

* Drive gain

* Left pickoff

* Right pickoff

* Core processor temperature
* Core processor input voltage

206

For each process variable, the following values are recorded:
¢ For Mech Zero:

5-minute running average

5-minute running standard deviation

*  For all other process variables:

Instantaneous value

5-minute running average

5-minute running standard deviation
Recorded minimum

Recorded maximum

To access meter fingerprint data, use the Maintenance menu as shown in Figure 22-1. The transmitter
will report the data in either SI units or English units, as configured from the Units menu item. The
display is updated continuously.

Micro Motion® Series 3000 MVD Transmitters and Controllers
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When the cursor is positioned on Current, you can use the RESET button to set a new start time for
the recorded minimum and maximum values.

When the cursor is positioned on Factory, you can use the SAVE button to overwrite the data in the
factory fingerprint with the current fingerprint data.

Note: Due to the continuous updating, the meter fingerprinting feature can have a negative effect on
other sensor-transmitter communications. Do not open the meter fingerprinting window unless you
plan to use it, and be sure to close it when you no longer need it.

99UBWLIOLDd JUSWAINSES

Meter fingerprinting menu

Maintenance

Meter Fingerprinting

Units Current Factory Installation Last zero
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SI
English

* Mass flow rate

* Volume flow rate
¢ Density

* Temperature

* Case temperature
e Live zero

* Tube frequency

* Drive gain

o Left pickoff

* Right pickoff

* Board temperature
* Input voltage

22.4 Sensor simulation mode

00SE/00€E€E I9POIN — suonedylvads

Note: Sensor simulation mode is available only on systems with the enhanced core processor.

Sensor simulation allows you to simulate process data for mass flow, temperature, and density. Sensor
simulation mode has several uses:

e It can help determine if a problem is located in the transmitter or elsewhere in the system. For
example, signal oscillation or noise is a common occurrence. The source could be the PLC, the
meter, improper grounding, or a number of other factors. By using sensor simulation to output
a flat signal, you can determine the point at which the noise is introduced.

e It can be used to analyze system response or to tune the loop.

00.€/0SEE I9POIN — suonedldads
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If sensor simulation mode is active, the specified simulated values are substituted for process data
from the sensor. Therefore, sensor simulation will affect, for example:

*  All mass flow, temperature, or density values shown on the display or reported via outputs or
digital communications

e The mass total and mass inventory values

*  All volume calculations and data, including reported values, volume totals, and volume
inventories

Accordingly, do not enable simulation when your process cannot tolerate these effects, and be sure to
disable simulation when you have finished testing.

Note: Unlike actual mass flow and density values, the simulated values are not
temperature-compensated.

Note: Simulation does not change any diagnostic values.

Sensor simulation mode is available via ProLink II (see Figure G-3) or the Communicator (see
Figure H-7). To set up sensor simulation, follow the steps below:

1. Enable simulation mode.
2. For mass flow:
a. Specify the type of simulation you want: fixed value, triangular wave, or sine wave.
b. Enter the required values.
» If you specified fixed value simulation, enter a fixed value.

* If you specified triangular wave or sine wave simulation, enter a minimum amplitude,
maximum amplitude, and period.

3. Repeat Step 2 for temperature and density.

To use sensor simulation mode for problem location, enable simulation mode and check the signal at
various points between the transmitter and the receiving device.

22.5 Updates, upgrades, and master resets

Micro Motion recommends that you document or save device configuration information before
updating or upgrading the software in your Series 3000 device or before performing a master reset.

You can document the configuration manually. Alternatively, if you have ProLink II, you can save the
configuration data to a file on the PC.

22.6  Alarm types and handling

The Series 3000 device performs self-diagnostics during operation. If the device detects certain events
or conditions, an alarm message appears in the highlight bar at the top of the screen, and an alarm is
written to the active alarm log.

22.6.1  Alarm severity

Alarms are classified into three levels of severity. The severity level controls device behavior when the
alarm condition occurs. See Table 22-3.
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Alarm severity levels and fault reporting

Series 3000 device action if condition occurs

“Alarm active” Alarm shown “Alarm active” record Fault indication
Severity level status bit set? on display? written to history? activated?®
Fault Yes Yes Yes Yes
Informational Yes Yes Yes No
Ignore Yes No No No

(1) For some alarms, fault indication (setting outputs to configured fault levels) will not occur until the fault timeout expired. For other
alarms, fault indication begins as soon as the fault condition is recognized. Tables 22-4 through 22-6 include information on which
alarms are affected by the fault timeout. To configure fault timeout, see Chapter 8.

Some alarms can be reclassified. For example:

e The default severity level for Alarm A020 (calibration factors unentered) is Fault, but you can
reconfigure it to either Informational or Ignore.

*  The default severity level for Alarm A102 (drive over-range) is Informational, but you can
reconfigure it to either Ignore or Fault.

For information on which alarms can be reclassified, see Section 22.7. For information on how to
reclassify alarms, see Section 6.3.1.

22.6.2 Fault timeout

By default, the Series 3000 device immediately sets outputs to their configured fault levels when a
fault is encountered. For specific faults, you can delay this action by changing the fault timeout to a
non-zero value (see Chapter 8). If fault timeout is configured:

e During the fault timeout period, the device continues to report its last valid measurement.

e The fault timeout applies only to the mA output, frequency output, and discrete output. Fault
indication via digital communications is unaffected.

The fault timeout is not applicable to all faults. See Section 22.7 for information about which faults
are affected.

22.6.3  Alarm categories

Alarms are organized into four alarm categories, in the following order of priority:
* Electronics
e Sensor (Model 3500 and Model 3700 transmitters only)
* Process

* Configuration

22.6.4  Alarm occurrences and logs
Information about alarm occurrences is maintained and displayed in three different ways:
* Active alarm log (see Figure 22-2) — Lists:
- All alarms that are active (the condition that caused the alarm is active)

- All alarms that have not been acknowledged (even if the condition causing the alarm is no
longer active)

Configuration and Use Manual 209
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The active alarm log provides help for each alarm listed (see Section 22.6.5), and also allows

you to acknowledge alarms.

When the active alarm log is

It is cleared and regenerated with every Series 3000 power cycle.

viewed through the View menu, only categories containing active

alarms are listed; individual alarms are not listed. When the active alarm log is viewed through
the Maintenance menu, individual alarms are listed.

Alarm history (see Figure 22-3) — Lists all alarms that have occurred, with a count of the
number of times a particular alarm has occurred, and the timestamp of the last time the alarm

was posted and cleared. It is

not cleared when a Series 3000 power cycle occurs. You cannot

acknowledge alarms or access the help system from alarm history. Alarm history is accessible

from the Maintenance menu

Alarm event log (see Figure

22-4) — Lists the 50 most recent alarm post or alarm clear events.

It is not cleared when a Series 3000 power cycle occurs. You cannot acknowledge alarms or

access the help system from
Maintenance menu.

Example alarm log

ACK

Example alarm history

Al

Cnt
Post
Clr

Active Alarm Log

23-JUN-03 10:02
Density Out-of-Range

23-JUN-03 10:02
Xmtr Initializing

23-JUN-03 10:02
Power Reset

23-JUN-03 10:02

Cnt 25
Post 23-JUN-03 14:56
Clr 23-JUN-03 14:56

Freg. Output Fixed

the alarm event log. The alarm event log is accessible from the

HELP EXIT

©

arm History

1
13-JUN-03 9:39
13-JUN-03 9:39

EXIT

Qs
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Example alarm event log

Alarm Event Log

Meter Verify Hold LMV

Clr: 15-JAN-07 16:53

Sensor Failure
Clr: 15-JAN-07 16:51

99UBWLIOLDd JUSWAINSES

Sensor Failure
Post: 15-JAN-07 16:50

EXIT

Oz

Active alarm log
To access the active alarm log from the View menu:
1. At the operation screen, press EXIT or VIEW.
2. Highlight Active Alarm Log.
3. To acknowledge all alarms, press the ACKALL button.
4

=
D
Q
=]
o
@
o
o
o
o
5
2
-]
5
o
c
=3
®
o
>
o
o
=
5
@

. To acknowledge all alarms in an alarm category:

a. Select Active Alarm Log.

b. Use the cursor keys to highlight the alarm category.
c. Press the ACK button.
Note: You cannot view and acknowledge individual alarms from the View menu.
To access the active alarm log from the Maintenance menu:
1. At the operation screen, press the Security button.
2. Select Maintenance.
3. Highlight Active Alarm Log.
4. To acknowledge all alarms, press the ACKALL button.
5

. To acknowledge a single alarm:

00S€/00EE I9POIN — SuonedyIdads

a. Select Active Alarm Log.
b. Use the cursor keys to highlight the alarm.
c. Press the ACK button.

22.6.5  Help system
Help is provided for each alarm. The help system can be accessed from several locations:

*  From the list of alarm categories in the active alarm log. If multiple alarms are posted in the
active alarm log, press PGDN to view help for all alarms in the selected category.

e From the list of individual alarms in the active alarm log
*  Wherever the HELP button appears
To view help from a list, highlight a list entry and press the HELP button.

00.€/0SEE I9POIN — suonedydads
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The help system will display up to five screens of information. On these screens:
e The alarm number is displayed.
*  An explanation of the alarm is provided.
e Instructions for correcting the alarm condition may be provided.

» If the help occupies more than one screen, use the PGDN (page down) or PGUP (page up)
buttons to view all the help text.

Example alarm help

ALARMS

Density Out-of-Range

™~ [A8] The density
reading is outside
the sensor limits. If
the Sensor Failure
(A3) alarm is also
present, solve the
Sensor Failure first.
Verify all density

PGDN EXIT

Alarm number

T~

Qs

22.7 Alarm listings by category

This section lists all alarms in the four alarm categories (Electronics, Sensor, Process, and
Configuration), and provides information on alarm severity level, user configuration, fault timeout
behavior, and suggested user actions.

22.71 Electronics alarms

Table 22-4 lists all alarms in the Electronics category, with descriptions, suggested user actions, and
related information.

Electronics alarms

Alarm severity

Affected
Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions
A001 CP EEPROM Uncorrectable Fault No No Cycle power to the
Failure checksum flowmeter.
mismateh. The flowmeter might need
service. Contact Micro
Motion customer service.
A002 CP RAM Failure A RAM location  Fault No No Cycle power to the
in the core flowmeter.
processor cannot

The flowmeter might need
service. Contact Micro
Motion customer service.

be written to.
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Electronics alarms continued

Alarm severity

Affected
Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions
A009 Xmtr Initializing Device is Fault Yes No No action required unless
performing alarm does not clear. If alarm
self-calibration does not clear:
after power-up. * Check wiring to sensor.
* Check power supply wiring.
* Make sure that the sensor
is completely full or
completely empty.
* Verify sensor configuration.
See Section 7.3.3.
e |[f AO26 alarm is present,
check core processor
address. See Section 19.6.
A014 Transmitter Error  Transmitter Fault No No Cycle power to the
failure for any of flowmeter.
several reasons. .
Perform sensor coil and
resistance tests. See
Section 22.20.
The flowmeter might need
service. Contact Micro
Motion customer service.
A018 EEPROM (3000) Uncorrectable Fault No No Cycle power to the
checksum flowmeter.
mismatch. The flowmeter might need
service. Contact Micro
Motion customer service.
A019 RAM Failure A RAM location Fault No No Cycle power to the
in the transmitter flowmeter.
fannot be written The flowmeter might need
0. . .
service. Contact Micro
Motion customer service.
A022" CP Config Failure Uncorrectable Fault No No Cycle power to the
checksum flowmeter.
mismatch. The flowmeter might need
service. Contact Micro
Motion customer service.
A023" CP Totals Failure Uncorrectable Fault No No Cycle power to the
checksum flowmeter.
mismatch. The flowmeter might need
service. Contact Micro
Motion customer service.
A024" CP Program Uncorrectable Fault No No Cycle power to the
Failure checksum flowmeter.
mismatch. The flowmeter might need
service. Contact Micro
Motion customer service.
A025M" CP Boot Program  Uncorrectable Fault No No Cycle power to the
Fault checksum flowmeter.
mismatch.

The flowmeter might need
service. Contact Micro
Motion customer service.

Configuration and Use Manual
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Electronics alarms continued

Alarm severity

Affected
Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions
A026 Xmtr Comm Communication  Fault No No If the custody transfer
Problem errors between application is installed, the
transmitter and core processor may have
core processor. been disconnected or
replaced. See Section 22.9.
Check wiring between
transmitter and core
processor (remote core
processor with remote
transmitter installations).
Check for noise in wiring or
transmitter environment.
Check the core processor
LED. See Section 22.19.1.
Check that the core
processor is receiving power.
See Section 22.11.1.
Perform the core processor
resistance test. See
Section 22.19.2.
A028 Xmtr Write Error  Attempt to write  Fault No No Cycle power to the
to the core flowmeter.
processor has The flowmeter might need
failed. . .
service. Contact Micro
Motion customer service.
A031@ Low Power The core Fault No No Check the power supply and
processor is not all power wiring.
receiving enough
power.
A103™ Data Loss Core processor Info Yes No Cycle power to the
Possible unable to store flowmeter.
totalizer values View th " i
on last power iew the entire current
d configuration to determine
own.
what data were lost.
Configure any settings with
missing or incorrect data.
The flowmeter might need
service. Contact Micro
Motion customer service.
A107 Power Reset Transmitter has  Info Yes No No action required.
been restarted.
A1120 Upgrade Transmitter Info Yes No Upgrade software. Contact
Software software is Micro Motion customer
downlevel from service. Note that the device
core processor is still functional.
software.
A129 PPI Display Error  (Custody transfer Info Yes No Cycle power to the

only) Readback
function from
transmitter
display indicates
error or failure.

flowmeter. If the problem
persists, contact Micro
Motion customer service.

214
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Electronics alarms continued

Alarm severity

Affected
Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions
A130 Printer Out of (Custody transfer Ignore Yes No Add paper to the printer.
Paper only) The ticket
printer is out of
paper.
A134 PPl Memory Memory or Info Yes No Cycle power to the
Error checksum error flowmeter. If the problem
in transmitter persists, contact Micro
display. Motion customer service.
A135 PPl Comm Error  Internal Info Yes No Cycle power to the
communication flowmeter. If the problem
error with persists, contact Micro
transmitter Motion customer service.
display.

(1) Applies only to systems with the standard core processor.
(2) Applies only to systems with the enhanced core processor.
(3) Applies only to systems with transmitter software earlier than rev7.0.

22.7.2 Sensor alarms

Table 22-5 lists all alarms in the Sensor category, with descriptions, suggested user actions, and
related information.

Sensor alarms

Alarm severity

Affected
Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions
A003 Sensor Failure No tube vibration Fault Yes Yes Check the test points. See
detected at the Section 22.18.

sensor. -
Check the sensor coils. See

Section 22.20.

Check wiring to sensor. See
Section 22.11.2.

Check for slug flow. See
Section 22.7.3.

Check sensor tubes.

Configuration and Use Manual 215
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Sensor alarms continued

Alarm severity
Affected

Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions

A004 Temp. The measured Fault No Yes Check wiring to sensor. See
Out-of-Range temperature is Section 22.11.2.
outside the
sensor limits.

Verify sensor configuration.
See Section 7.3.3.

Check the test points. See
Section 22.18.

Check the sensor coils and
RTD. See Section 22.20.

Verify that process
temperature is within range
of sensor and transmitter.

Contact Micro Motion
customer service.

A016 Sensor RTD Error Sensor RTD has  Fault Yes Yes Check wiring to sensor. See
failed. Section 22.11.2.

Make sure the appropriate
sensor type is configured.
See Section 7.3.3.

Check the test points. See
Section 22.18.

Check the sensor coils. See
Section 22.20.

Contact Micro Motion
customer service.

A017 Meter RTD Error  Meter RTD has Fault Yes Yes Check wiring to sensor. See
failed. Section 22.11.2.

Make sure the appropriate
sensor type is configured.
See Section 7.3.3.

Contact Micro Motion
customer service.

22.7.3 Process alarms

Table 22-6 lists all alarms in the Process category, with descriptions, suggested user actions, and
related information. More information on specific process alarms is provided later in this section.
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Process alarms

Maintenance
menu listing

Alarm
number

Alarm severity

Description Default config?

Affected
User by fault
timeout

User actions

AQ005 Mass Flow
Overrange

Mass flow value  Fault Yes Yes
is outside sensor
limits.

Check the test points. See
Section 22.18.

Check the sensor coils. See
Section 22.20.

Verify process.

Make sure that the
appropriate measurement
unit is configured. See
Section 22.13.

Verify 4 mA and 20 mA
values. See Section 22.14.

Verify calibration factors in
transmitter configuration.
See Section 22.17.

Re-zero the transmitter.

A008 Density
Out-of-Range

Density value is  Fault Yes Yes
outside sensor
limits.

Check the test points. See
Section 22.18.

If accompanied by an A003
alarm, check the sensor
coils. See Section 22.20.

Verify process. Check for air
in the flow tubes, tubes not
filled, foreign material in
tubes, or coating in tubes.

Verify calibration factors in
transmitter configuration.
See Section 22.17.

Perform density calibration.
See Section 21.5.

A010 Calibration
Failure

Calibration Fault No No
procedure failed

for any of a

variety of

reasons.

Ensure that there is no flow
through the sensor. Check
for pipe stress at sensor.
Then retry. See Calibration
alarms.

Cycle power to the
flowmeter, then retry. See
Calibration alarms.

AO011 Cal Fail - Too Low

Calibration Fault Yes No
procedure failed

due to reverse

flow through the

sensor.

Ensure that there is no flow
through the sensor. Check
for pipe stress at sensor.
Then retry. See Calibration
alarms.

Cycle power to the
flowmeter, then retry. See
Calibration alarms.
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Process alarms continued

Alarm severity

Affected

Alarm Maintenance User by fault

number menu listing Description Default config? timeout User actions

A012 Cal Fail - Too Calibration Fault Yes No Ensure that there is no flow

High procedure failed through the sensor. Check
due to flow for pipe stress at sensor.
through the Then retry. See Calibration
sensor. alarms.

Cycle power to the
flowmeter, then retry. See
Calibration alarms.

A013 Cal Fail - Too Calibration Fault Yes No Ensure that there is no flow

Noisy procedure failed through the sensor. Check
due to flow for electromechanical noise.
through the Sources of noise include:
sensor. * Mechanical pumps

¢ Pipe stress at sensor

* Electrical interference

¢ Vibration effects from
nearby machinery

Then retry. See Calibration

alarms.

Cycle power to the

flowmeter, then retry. See

Calibration alarms.

A033" Tube Not Full No signal from Fault Yes Yes Verify process. Check for air
LPO or RPO, in the flow tubes, tubes not
suggesting that filled, foreign material in
sensor tubes are tubes, or coating in tubes.
not vibrating.

A100 mA 1 Saturated Process variable Info Yes® No See Output saturation
assigned to alarms.
primary mA
output is outside
configured limits.

A102 Drive Overrange  No tube vibration Info Yes No Ensure that sensor tubes are
or erratic tube unobstructed. Purge tubes if
vibration. necessary.

Ensure sensor is full of
process fluid.

Ensure sensor is free to
vibrate.

Verify sensor configuration.
See Section 7.3.3.

Ensure that flow rate is within
sensor limits.

A105 Slug Flow Slug flow Info Yes No See Slug flow alarms.
detected in
process.

A110 Freq. Out Process variable Info Yes® No See Output saturation

Saturated assigned to alarms.
frequency output
is outside
configured scale
limits.

218
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Process alarms continued §
(7}
Alarm severity 5
Affected 3
Alarm Maintenance User by fault e
number menu listing Description Default config? timeout User actions 3
o
A113 mA 2 Saturated ~ Process variable Info Yes® No See Output saturation 3
assigned to alarms. 3
secondary mA 8
output is outside 2
configured limits.
A115 External Input HART polling Info Yes No Ensure that external device
Error connection to is available:
external device * Verify device operation.
has failed. * Verify wiring.
Verify polling configuration. g
See Section 7.6. Q
A116 API: Temp Process Info Yes No Verify process. ,8,
Overrange ':)euTSpi)géature Verify API reference table @
APl-defined and temperature 8
i i o
extrapolation cS:onil_gurgtldcf)n. See -
limits. ection 9.4 )
A117 API: Dens Process density  Info Yes No Verify process. %
i (2]
Overrange outside Verify API reference table =
API-defined ; h ! o
: and density configuration. <]
extrapolation X =3
o See Section 9.4. =
limits. Q@
A121 ED: Extrap. Fall Enhanced Info Yes No Verify process temperature.
density Verif densit
calculations are erify process denstty.
outside the Verify enhanced density (7}
configured data configuration. See the 5
range. enhanced density manual. =
A124 Freq. Input Frequency input  Info Yes No Reconfigure frequency §
Saturated from external scaling on input device. o
device is too . @
high. Recpnflgure frgquency |
scaling on Series 3000 =
platform. See Section 7.4. =
A125 Batcher Timeout  No flow detected Info Yes No See Batch alarms. %
during configured 8
timeout period. (<3
W
A126 Batcher Overrun  The batcher has  Info Yes No See Output saturation 2
o

overrun the
configured target.

alarms.

(1) Applies only to systems with the enhanced core processor.
(2) Can be set to either Info or Ignore, but cannot be set to Fault.

Slug flow alarms

Slugs — for example, gas in a liquid process or liquid in a gas process — occasionally appear in some
applications. The presence of slugs can significantly affect the process density reading. Slug-flow
limits and duration can help the transmitter suppress extreme changes in reading.

Note: Default slug-flow limits are 0.0 and 5.0 g/cm’. Raising the low slug-flow limit or lowering the
high slug-flow limit will increase the possibility of slug flow conditions.
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If slug limits have been configured, and slug flow occurs:
* A sslug flow alarm is generated.

*  All outputs that are configured to represent flow rate hold their last “pre-slug” value for the
configured slug-flow duration.

If the slug flow condition clears before the slug-flow duration expires:
*  Outputs that represent flow rate revert to reporting actual flow.

* The slug flow alarm is deactivated, but remains in the active alarm log until it is
acknowledged.

If the slug flow condition does not clear before the slug-flow duration expires, outputs that represent
flow rate report a flow rate of zero.

If slug time is configured for 0.0 seconds, outputs that represent flow rate will report zero flow as
soon as slug flow is detected.

If slug flow occurs:
e Check process for cavitation, flashing, or leaks.
e Change the sensor orientation.
*  Monitor density.
» If desired, enter new slug flow limits (see Section 7.3.2).

e If desired, increase slug duration (see Section 7.3.2).

Output saturation alarms

If an output variable exceeds the upper range limit or goes below the lower range limit, the
Series 3000 device produces an output saturation alarm. The alarm can mean:

* The output variable is outside appropriate limits for the process.
*  The unit of flow needs to be changed.
* Sensor flow tubes are not filled with process fluid.
* Sensor flow tubes are plugged.
If an output saturation alarm occurs:
*  Bring flow rate within sensor limit.
*  Check the measurement unit. You may be able to use a smaller or larger unit.
e Check the sensor:
- Ensure that flow tubes are full.
- Purge flow tubes.
*  For the mA outputs, change the 20 mA and 4 mA values (see Section 8.4.4).

* For the frequency output, change frequency and flow values, pulses/unit, or units/pulse (see
Section 8.5).

Batch alarms

If the batch controller is operating, the Series 3000 device produces batch alarms. Table 22-7
summarizes batch alarms and lists corrective actions.
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Using batch alarms

Alarm message

Cause

Action

Time Out

No flow was detected for the number of
seconds configured for time out

» Check valves, piping, and pumps for proper operation

* Check flow source configuration.

* Increase number of seconds for time out. See
Section 11.5.

¢ After cause has been diagnosed, press END to end
batch or RESUME to resume batch.

¢ |f you are using a Model 3300 or Model 3350, verify
that the controller is receiving frequency input from the
remote transmitter.

Overrun

* Batch total has exceeded target
¢ Batch has not ended
* Flow is still being measured

* End batch if required.

* Check wiring for discrete output indicating overrun.

* Check device connected to discrete output indicating
overrun.

¢ Enable batch AOC. See Section 11.5.

* Increase quantity configured for overrun.

* Verify that low-flow cutoff is correctly configured for
process conditions.

* Re-zero flowmeter.

¢ After cause has been diagnosed, press RESET or
START to start new batch.

Start Without Reset

Operator attempted to start batch
without pressing RESET

* Press RESET, then press START or
* Set Reset on start option to Yes. See Section 11.5.

Start Not OK

Enable batch control option is set to
No

Set Enable batch control option to Yes. See Section 11.5.

Batch flow source is not configured

Configure batch flow source. See Section 11.4.

Control functions have not been
assigned to discrete outputs

Assign control functions such as primary valve,
secondary valve, or pump to discrete outputs. See
Section 8.3.2).

An alarm is active

Clear all alarm messages. See Section 22.6.

Discrete input is configured to inhibit
batch

Shut off discrete input.

Target value is zero

Change target value. See Section 11.6.

If enhanced density is enabled and an
enhanced density variable has been
configured as the batch flow source, a
valid enhanced density curve has not
been assigned to the current preset

Configure batch preset for a valid enhanced density
curve. See Section 11.6.

Output is fixed, calibration is in
progress, or slug flow has occurred

Correct the condition and retry.

Calibration alarms

If a calibration procedure fails:

1. Ensure that there is no flow through the sensor.

. Eliminate mechanical noise, if possible.

2
3. Ensure the interior of the sensor junction box (if present in your installation) is dry.
4

. Retry the calibration procedure.
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22.7.4

Configuration alarms

Table 22-8 lists all alarms in the Configuration category, with descriptions, suggested user actions,
and related information.

Using configuration alarms

Alarm severity

Affected

Alarm Maintenance User by fault

number menu listing Description Default config? timeout User actions

A006 Characterize Master reset has  Fault Yes No Enter required values. See

Meter been performed. Section 7.3.3.
Required
calibration values
are missing.
A020 Cal. Factors Master reset has  Fault Yes No Enter required values. See
Missing been performed. Section 7.3.3.
Required
calibration values
are missing.
A021 Sensor Type K1 value missing Fault No No Verify characterization
Incorrect or incorrect, or parameters. See
RTD data from Section 7.3.3.
sensor is
incorrect.

A027 Security Breach ~ (Custody transfer Fault No No Weights and Measures
only) Device has security seal has been
been tampered broken. Alarm can be
with. cleared by user, but

authorized procedure is
required to reestablish
security. Ensure that the
security switch is set to the
ON position. Contact Micro
Motion.

A032"®  Meter Verify Fault Meter verification ~Fault No No Allow the procedure to
in progress, with complete. If desired, abort
outputs set to the procedure and restart
fault. with outputs set to last

measured value.

A032® Outputs Fixed Meter verification  Varies® Allow the procedure to
in progress, with complete.
outputs set to If desired, abort the
Fault or Last procedure and restart with
Measured Value. outputs set to Continue

Measurement.
A034® Meter Verify The test ran to Info Yes No Rerun the test. If the test fails
Failed completion but again, see Section 21.3.4.
the results were
not within limits.
A035® Meter Verify The testdid not  Info Yes No If desired, read the abort
Aborted run to code, see Section 21.3.4,

completion.

and perform the appropriate
action.
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Using configuration alarms continued

Alarm severity

Affected

Alarm Maintenance User by fault

number menu listing Description Default config? timeout User actions

A101 mA 1 Fixed Primary mA Info Yes® No Change Loop Current Mode
output is parameter. See
transmitting fixed Section 22.11.7.
output level. Exit from mA output trim.

See Section 16.5.

Exit from mA output
simulation. See

Section 16.4.4.

Check to see if the output
has been fixed via digital
communication.

A104 Cal in Progress Transmitter Info Yes® No No action required.
currently
performing flow
or density
calibration.

A106 Burst Enabled Transmitter Info Yes® No No action required.
configured for
burst mode.

A111 Freq. Output Frequency output  Info Yes® No Exit from frequency output

Fixed is transmitting simulation. See
fixed output level. Section 16.4.2.

A114 mA 2 Fixed Secondary mA Info Yes® No Exit from mA output trim.
output is See Section 16.5.
transmitting fixed -
output level. Exnt from mA output

simulation. See

Section 16.4.4.

Check to see if the output
has been fixed via digital
communication.

A118 DO 1 Fixed Discrete output 1 Info Yes® No Unfix discrete output 1. See
transmitting fixed Section 16.4.1.
output.

A119 DO 2 Fixed Discrete output 2 Info Yes® No Unfix discrete output 2. See
transmitting fixed Section 16.4.1.
output.

A120 ED: Curve Fit Fail Configured Info No No Verify enhanced density
values for density configuration. See the
curves do not enhanced density manual.
meet accuracy
requirements.

A122 DO 3 Fixed Discrete output 3  Info Yes® No Unfix discrete output 3.
transmitting fixed SeeSection 16.4.1.
output.

A127 Batcher Needs Tried to start a Info Yes No See Section 22.7.3.

Reset batch without
resetting
previous batch.
A128 Batcher Cannot Transmitter Info Yes No See Section 22.7.3.
Start cannot start a
batch.
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Using configuration alarms continued

Alarm severity

Affected
Alarm Maintenance User by fault
number menu listing Description Default config? timeout User actions
A131M@  Meter Verify Hold Meter verification Info Yes No Allow the procedure to
LMV in progress, with complete. If desired, abort
outputs set to last the procedure and restart
measured value. with outputs set to fault.
A131@ Meter Verify Meter verification  Info Yes No Allow the procedure to
Progress in progress, with complete.
outputs set to
continue
reporting process
data.
A1320 Simulation Mode  Simulation mode Info Yes® No Disable simulation mode.
is active. See Section 22.4.

(1) Applies only to systems with the enhanced core processor.

(2) Applies only to systems with the original version of the meter verification application.

(3) Applies only to systems with Smart Meter Verification.

(4) If outputs are set to Last Measured Value, severity is Info. If outputs are set to Fault, severity is Fault.
(5) Can be set to either Info or Ignore, but cannot be set to Fault.

22.8

22.9

224

Restoring a working configuration

At times it may be easier to start from a known working configuration than to troubleshoot the
existing configuration. To do this, you can:

* Restore a configuration file saved via ProLink II, if one is available. See Figure G-1.

» Restore the factory configuration, as stored in the Series 3000 device (no external
configuration file is required). To do this:

- Using ProLink II, see Figure G-2. ProLink II v2.6 or higher is required.
- Using the Communicator, see Figure H-3.

Both of these actions will overwrite the existing configuration. Ensure that the existing configuration
is appropriately documented or saved.

A009/A026 alarms on Model 3300 or Model 3500 panel-mount

On Model 3300 or Model 3500 panel-mount devices rev6.1 or lower, when the custody transfer
application is installed, AOO9 and A026 alarms may be generated if the position of the security switch
is changed while the device is powered.

Note: These alarms occur because to change the position of the security switch, you must remove the
connector wiring bracket, which means that power to the core processor will be interrupted.

To clear these alarms, you must change the core processor address manually to the default value of 1
while the transmitter is unsecured. Then, when the transmitter is secured, the core processor address
will automatically be changed to the unique address used for secure processing.

To change the core processor address manually:

1. Disconnect the RS-485 wires from the RS-485 terminals on the Series 3000 device (see
Figure 2-3).

2. Connect ProLink II to the RS-485 wires, or to the RS-485 terminals on the core processor,
using Modbus RTU (8-bit) protocol and any values for baud rate, parity, and stop bit.
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3. Poll to make a connection to the core processor.

4. When the core processor is found, click ProLink > Configuration > Device and set the

Modbus address to 1.
5. Click Apply.
6. Disconnect ProLink II.

7. Reconnect the RS-485 wiring between the Series 3000 device and the core processor.

To avoid this problem, always power down the transmitter before removing the connector wiring

bracket.

Note: Do not confuse the Modbus address of the core processor with the Modbus address of the

transmitter. The Modbus address of the core processor is accessible only when you connect directly to

the core processor.

22.10 1/0 problems

If you are experiencing problems with I/O, use Table 22-9 to identify an appropriate remedy.

1/0 problems and remedies

Symptom Possible cause Possible remedy

No mA output and Power supply problem Check power supply and power-supply wiring.
no frequency output or loop See Section 22.11.

test failed

Fault condition present if fault
indicators are set to downscale or
internal zero

Check the fault indicator settings to verify
whether or not the transmitter is in a fault
condition. See Section 8.4.2 to check the mA
fault indicator or Section 8.5 to check the
frequency fault indicator.

If a fault condition is present, see Section 22.7.

mA output < 4 mA Process condition below value
configured for 4 mA

Verify process.
Verify or change the 4 mA value. See
Section 8.4.4.

Fault condition if fault indicator is set to
internal zero

Check the fault indicator settings to verify
whether or not the transmitter is in a fault
condition. See Section 8.4.2.

If a fault condition is present, check the active
alarm log. See Section 22.6.

Open in wiring

Verify all connections.

Bad mA receiving device

Check the mA receiving device or try another
mA receiving device. See Section 22.11.6.

Bad output circuit

Measure DC voltage across output to verify that
output is active.
Test output. See Section 16.4.4.
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I/0 problems and remedies continued

Symptom

Possible cause

Possible remedy

No frequency output

Process condition below cutoff

Verify or change the cutoff. See Section 8.4.4.

Fault condition if fault indicator is set to
downscale or internal zero

Check the fault indicator settings to verify
whether or not the transmitter is in a fault
condition. See Section 8.5.

If a fault condition is present, check the active
alarm log. See Section 22.6.

Slug flow

See Slug flow alarms in Section 22.7.3.

Flow in reverse direction from
configured flow direction parameter

Verify process.

Check flow direction parameter. See

Section 7.3.2.

Verify sensor orientation. Ensure that flow
direction arrow on sensor case matches process
flow.

Bad frequency receiving device

Check the frequency receiving device or try
another frequency receiving device. See
Section 22.11.6.

Output level not compatible with
receiving device

Verify that the output level and the required
receiving input level are compatible.

Bad output circuit

Test output. See Section 16.4.4.

Incorrect pulse width configuration

Verify pulse width setting. See Section 8.5.2.

Internal totalizer stopped and not
restarted

Restart internal totalizer.

Output is configured for passive power

Ensure output power is set to active. See
Section 8.5.

Constant mA output

Non-zero HART address (multi-drop
communications) (primary mA output
only)

Set HART address to zero. See Section 22.11.7.

Output is fixed in a test mode

Exit output from test mode. See Section 16.4.4.

Burst mode enabled (primary mA
output only)

Disable burst mode. See Section 13.4.

Zero calibration failure

See Section 22.17.

mA output consistently out of
range

Fault condition if fault indicator is set to
upscale or downscale

Check the fault indicator settings to verify
whether or not the transmitter is in a fault
condition. See Section 8.4.2.

If a fault condition is present, check the active
alarm log. See Section 22.6.

20 mA and 4 mA values not set
correctly

Check the 20 mA and 4 mA values. See
Section 22.14.

Consistently incorrect mA
measurement

Output not trimmed correctly

Trim the output. See Section 16.5.

Incorrect flow measurement unit
configured

Verify flow measurement unit configuration. See
Section 22.13.

Incorrect process variable configured

Verify process variable assigned to mA output.
See Section 8.4.3.

20 mA and 4 mA values not set
correctly

Check the 20 mA and 4 mA values. See
Section 22.14.

mA reading correct at low
currents but wrong at higher
currents

mA loop resistance may be too high

Verify mA output load resistance is below
maximum supported load.
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I/0 problems and remedies continued

Symptom

Possible cause

Possible remedy

Consistently incorrect
frequency measurement

Output not scaled correctly

Check frequency output scale and method. See
Section 22.15. Verify that voltage and resistance
match the frequency output load resistance
value chart.

Incorrect flow measurement unit
configured

Verify flow measurement unit configuration. See
Section 22.13.

Erratic frequency
measurement when flow is
stable

RF (radio frequency) interference from
environment

See Section 22.11.5.

Cannot connect to RS-485
terminals in service port
mode

Terminals not in service port mode

Terminals are accessible in service port mode
ONLY for a 10-second interval after power-up.
Cycle power and connect during this interval.

Leads reversed

Switch leads and try again.

Transmitter installed on multidrop
network

All Series 3000 devices on network default to
address=111 during 10-second service port
interval. Disconnect or power down other
devices, or use RS-485 communications.

Device is secured (custody transfer
only)

Change Series 3000 device to unsecured, or
use RS-485 communications.

Cannot connect to RS-485
terminals in RS-485 mode

Terminals not in RS-485 mode

For the first 10 seconds after power-up, the
terminals are in service port mode. If a service
port connection is made during this period, they
remain in service port mode. Wait until
10-second interval has expired, cycle power to
the device to reset the terminals if required, or
connect in service port mode.

Incorrect RS-485 configuration

After 10-second interval on power-up, the
transmitter switches to RS-485 mode. Default
settings are:

* Address=1

* Baud rate=9600

e Parity=odd

Use the display to check or change the RS-485
settings (see Section 13.3), then set parameters
appropriately in the remote device.

Leads reversed

Switch leads and try again.

22.11 Diagnosing wiring problems

Use the procedures in this section to check the transmitter installation for wiring problems.

22111

Checking the power supply wiring

To check the power supply wiring:

1. Verify that the correct external fuse is used. An incorrect fuse can limit current to the
transmitter and keep it from initializing.

2. Power down the transmitter. If the transmitter is in a hazardous area, wait five minutes.

3. Ensure that the power supply wires are connected to the correct terminals. See the installation

instructions.

4. Verify that the power supply wires are making good contact, and are not clamped to the wire

insulation.
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228

5. Use a voltmeter to test the voltage at the transmitter’s power-supply terminals. Verify that it is
within the specified limits (see Appendix A or Appendix B).

22.11.2 Checking the sensor-to-transmitter wiring
To check the sensor-to-transmitter wiring, verify that:

* The transmitter is connected to the sensor according to the wiring information provided in the
installation instructions.

*  The wires are making good contact with the terminals.
If the wires are incorrectly connected:

1. Power down the transmitter.

2. If the transmitter is in a hazardous area, wait five minutes.
3. Correct the wiring.
4

. Restore power to the transmitter.

22.11.3 Checking grounding

The Series 3000 device must be grounded. If you are using a T-Series sensor, it must be grounded. If
the core processor is installed separately, it must be grounded separately. See the installation
instructions.

22.11.4 Checking the HART communication loop
To check the HART communication loop (primary mA output only):
1. Verify that the loop wires are connected correctly for HART/analog wiring.
2. Remove analog loop wiring.
3. Install a 250 Q resistor across the primary mA output terminals.
4

. Check for voltage drop across the resistor (4—20 mA = 1-5 VDC). If voltage drop < 1 VDC,
add resistance to achieve voltage drop > 1 VDC.

5. Connect the Communicator directly across the resistor and attempt to communicate (poll).

22.11.5 Checking for RF interference

If you are experiencing RF (radio frequency) interference on your frequency output or discrete output,
use one of the following solutions:

* Eliminate the RF source. Possible causes include a source of radio communications, or a large
transformer, pump, motor, or anything else that can generate a strong electrical or
electromagnetic field, in the vicinity of the transmitter.

¢ Move the transmitter.
*  Use shielded cable for the frequency output.

- Terminate output cable shielding at the input device. If this is not possible, terminate the
output shielding at the cable gland or conduit fitting.

- Do not terminate shield inside the wiring compartment.

- 360° termination of shielding is not necessary.
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22.12

22.13

2214

22.15

22.16

22.11.6 Checking the output wiring and receiving device

If you receive an inaccurate frequency or mA reading, there may be a problem with the output wiring
or the receiving device.

*  Check the output level at the transmitter.
e Check the wiring between the transmitter and the receiving device.

* Try adifferent receiving device.

22.11.7 Checking the Loop Current Mode parameter

Depending on the setting of the Loop Current Mode parameter, the primary mA output may be fixed
at 4 mA. In this situation:

e The primary mA output will not report process variable data.
e  The primary mA output will not indicate fault conditions.
See Section 13.4.1.

Checking the sensor tubes

Corrosion, erosion, or damage to the sensor tubes can affect process measurement. To check for these
conditions, perform the meter verification procedure, if available (see Chapter 21). If the meter
verification procedure is not available, perform a visual inspection, or perform a density calibration
and check for a shift in the K1 and K2 values. Contact Micro Motion customer service.

Checking the flow measurement unit

Using an incorrect flow measurement unit can cause the transmitter to produce unexpected output
levels, with unpredictable effects on the process. Make sure that the configured flow measurement
unit is correct. Check the abbreviations; for example, g/min represents grams per minute, not gallons
per minute. See Section 7.3.2.

Checking the calibration span

A saturated mA output or incorrect mA measurement could indicate that an incorrect 4 mA or 20 mA
value has been configured for the mA output. Verify that these values are correct and change them if
necessary. See Section 8.4.4.

Checking the frequency output scale and method

A saturated frequency output or an incorrect frequency measurement could indicate a faulty frequency
output scale and/or method. Verify that the frequency output scale and method are correct and change
them if necessary. See Section 8.5.

Checking the characterization

A transmitter that is incorrectly characterized for its sensor might produce inaccurate output values. If
the flowmeter appears to be operating correctly but sends inaccurate output values, an incorrect
characterization could be the cause. See Section 7.3.3.
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22.17

22.18

230

Checking the calibration

Improper calibration can cause the transmitter to send unexpected output values. If the transmitter
appears to be operating correctly but sends inaccurate output values, an improper calibration may be
the cause.

Micro Motion calibrates every transmitter at the factory. Therefore, you should suspect improper
calibration only if the transmitter has been calibrated after it was shipped from the factory.

The calibration procedures in this manual are designed for calibration to a regulatory standard. To
calibrate for true accuracy, always use a measurement source that is more accurate than the flowmeter.

If there is significant discrepancy (>20%) between process data and the transmitter’s reported values,
do not attempt to recalibrate. Contact Micro Motion customer service for assistance.

Note: Micro Motion recommends using meter factors, rather than calibration, to prove the meter
against a regulatory standard or to correct measurement error. Contact Micro Motion before
calibrating your flowmeter. For information on meter performance verification, see Chapter 21.

Checking the test points

Some status alarms that indicate a sensor failure or overrange condition can be caused by problems
other than a failed sensor. You can diagnose sensor failure or overrange status alarms by checking the
flowmeter test points. These values describe the current operation of the sensor.

22.18.1 Obtaining the test points

To obtain current values for test points, use the Diagnostic Monitor, which is accessed from the View
menu. The Diagnostic Monitor displays:

e Tube frequency
e Left pickoff

* Right pickoff

*  Drive gain

e Live zero

Note: The Diagnostic Monitor is not the same as the Diagnostics menu. The Diagnostics menu,
accessed through the Maintenance option of the Management menu, allows you to read the values of
external inputs and set output levels for outputs. The Diagnostics menu and its use are described in
Chapter 16.

22.18.2 Evaluating the test points
Use the following guidelines to evaluate the test points:
* If the drive gain is unstable, refer to Section 22.18.3.

» If the value for the left or right pickoff does not equal the appropriate value from Table 22-10,
based on the sensor flow tube frequency, refer to Section 22.18.5.

» If the values for the left and right pickoffs equal the appropriate values from Table 22-10,
based on the sensor flow tube frequency, record your troubleshooting data and contact Micro
Motion customer service for assistance.
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Sensor pickoff values

Sensor model”

Pickoff value

ELITE Model CMF sensors

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

Model D, DL, and DT sensors

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

Model F025, FO050, F100 sensors

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

Model F200 sensors (compact case)

2.0 mV peak-to-peak per Hz based on sensor flow tube frequency

Model F200 sensors (standard case)

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

Model H025, H050, H100 sensors

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

Model H200 sensors

2.0 mV peak-to-peak per Hz based on sensor flow tube frequency

Model R025, R050, or R100 sensors

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

Model R200 sensors

2.0 mV peak-to-peak per Hz based on sensor flow tube frequency

Micro Motion T-Series sensors

0.5 mV peak-to-peak per Hz based on sensor flow tube frequency

CMF400 |.S. sensors

2.7 mV peak-to-peak per Hz based on sensor flow tube frequency

CMF400 sensors with booster amplifiers

3.4 mV peak-to-peak per Hz based on sensor flow tube frequency

(1) If your sensor is not listed, contact Micro Motion.

22.18.3 Excessive drive gain

Excessive drive gain can be caused by several problems. See Table 22-11.

Excessive drive gain causes and remedies

Cause

Possible remedy

Excessive slug flow

Eliminate slugs.

Change the sensor orientation.

Plugged flow tube

Purge the flow tubes.

Cavitation or flashing

Increase inlet or back pressure at the sensor.

If a pump is located upstream from the sensor, increase the distance

between the pump and sensor.

Overpressurized tubes

Contact Micro Motion.

Drive board or module failure, cracked flow tube, Contact Micro Motion.

or sensor imbalance

Mechanical binding at sensor

Ensure sensor is free to vibrate.

Open drive or left pickoff sensor coil

Contact Micro Motion.

Incorrect sensor characterization

Verify sensor configuration. See Section 22.16.

22.18.4 Erratic drive gain

Erratic drive gain can be caused by several problems. See Table 22-12.
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Diagnostics and Troubleshooting

Erratic drive gain causes and remedies

Cause Possible remedy

Wrong K1 characterization constant for sensor Re-enter the K1 characterization constant. See
Section 7.3.3.

Polarity of pick-off reversed or polarity of drive reversed Contact Micro Motion.

Slug flow Verify flow tubes are completely full of process fluid.

Foreign material caught in flow tubes Purge flow tubes.

22.18.5 Low pickoff voltage
Low pickoff voltage can be caused by several problems. See Table 22-13.

Low pickoff voltage causes and remedies

Cause Possible remedy

Faulty wiring runs between the sensor and core processor  Verify wiring. See Section 22.11.2.

Process flow rate beyond the limits of the sensor Verify that the process flow rate is not out of range of the
sensor.

Slug flow Verify flow tubes are completely full of process fluid.

No tube vibration in sensor Check for plugging.

Verify power to transmitter.

Ensure sensor is free to vibrate (no mechanical binding).

Verify wiring. See Section 22.11.2.

Test coils at sensor. See Section 22.20.

Moisture in the sensor electronics Eliminate the moisture in the sensor electronics.

The sensor is damaged Contact Micro Motion.

22.19 Checking the core processor
Two core processor procedures are available:

*  You can check the core processor LED. The core processor has an LED that indicates different
flowmeter conditions. See Table 22-14.

* Ifan A026 alarm is present, you can perform the core processor resistance test to check for a
damaged core processor.

22.19.1 Checking the core processor LED
To check the core processor LED:
1. Maintain power to the transmitter.

2. Remove the core processor lid. The core processor is instrinsically safe and can be opened in
all environments. Do not disconnect the 4-wire cable between the core processor and the
transmitter.

3. Check the core processor LED against the conditions described in Table 22-14 (standard core
processor) or Table 22-15 (enhanced core processor).

4. To return to normal operation, replace the lid.

Note: When reassembling the meter components, be sure to grease all O-rings.
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Standard core processor LED behavior, flowmeter conditions, and remedies

LED behavior

Condition

Possible remedy

1 flash per second
(ON 25%, OFF 75%)

Normal operation

No action required.

1 flash per second
(ON 75%, OFF 25%)

Slug flow

See Section 22.7.3.

Solid ON

Zero or calibration in
progress

If calibration is in progress, no action required. If no calibration is in
progress, contact Micro Motion.

Core processor
receiving between 11.5
and 5 volts

Check power supply to transmitter.

3 rapid flashes,
followed by pause

Sensor not recognized

Check wiring between transmitter and sensor. See Section 22.11.2.

Improper configuration

Check sensor characterization parameters. See Section 22.16.

Broken pin between
sensor and core
processor

Contact Micro Motion.

4 flashes per second

Fault condition

Check alarm status. See Section 22.6.

OFF

Core processor
receiving less than 5
volts

* Verify power supply wiring to core processor. See Section 22.11.2.

* If transmitter display is lit, transmitter is receiving power. Check
voltage across terminals 1 (VDC+) and 2 (VDC-) in core processor.
Normal reading is approximately 14 VDC. If reading is normal,
internal core processor failure is possible. Contact Micro Motion. If
reading is 0, internal transmitter failure is possible. Remove the wires
from core processor terminals 1 and 2, and check the voltage across
the wires. If the voltage reading is now ~14 VDC, the transmitter is
normal. If the voltage reading is not ~14 VDC, contact Micro Motion.
If reading is less than 1 VDC, verify power supply wiring to core
processor. Wires may be switched. See Section 22.11.2.

* If transmitter display is not lit, transmitter is not receiving power.
Check power supply. If power supply is operational, internal
transmitter or display failure is possible. Contact Micro Motion.

Core processor
internal failure

Contact Micro Motion.

Enhanced core processor LED behavior, flowmeter conditions, and remedies

LED behavior

Condition

Possible remedy

Solid green

Normal operation

No action required.

Flashing yellow

Zero in progress

If calibration is in progress, no action required. If no calibration is in
progress, contact Micro Motion.

Solid yellow

Low severity alarm

Check alarm status.

Solid red

High severity alarm

Check alarm status.

Flashing red (80% on,
20% off)

Tubes not full

If alarm A105 (slug flow) is active, see Slug flow alarms in
Section 22.7.3.

If alarm AO33 (tubes not full) is active, verify process. Check for air in
the flow tubes, tubes not filled, foreign material in tubes, or coating in
tubes.

Flashing red (50% on,
50% off)

Electronics failed

Contact Micro Motion.
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Diagnostics and Troubleshooting

Enhanced core processor LED behavior, flowmeter conditions, and remedies continued

LED behavior Condition Possible remedy

Flashing red (50% on,  Sensor failed Contact Micro Motion.

50% off, skips every

4th)

OFF Core processor * Verify power supply wiring to core processor.
receiving less than 5 * If transmitter display is lit, transmitter is receiving power. Check
volts voltage across terminals 1 (VDC+) and 2 (VDC-) in core processor.

If reading is less than 1 VDC, verify power supply wiring to core
processor. Wires may be switched. See Section 22.11. Otherwise,
contact Micro Motion.

* If transmitter display is not lit, transmitter is not receiving power.
Check power supply. See Section 22.11. If power supply is
operational, internal transmitter, display, or LED failure is possible.
Contact Micro Motion.

Core processor Contact Micro Motion.
internal failure

22.19.2 Core processor resistance test (standard core processor only)
Note: Perform this test only if an A026 alarm is present.

To perform the core processor resistance test:
1. Power down the transmitter.
2. Remove the core processor lid.
3. Disconnect the 4-wire cable between the core processor and the transmitter.
4

. Measure the resistance between core processor terminals 3 and 4 (RS-485/A and RS-485/B).
See Figure 22-6. Resistance should be 40 kQ to 50 kQ.

5. Measure the resistance between core processor terminals 2 and 3 (VDC- and RS-485/A).
Resistance should be 20 kQ to 25 kQ3.

6. Measure the resistance between core processor terminals 2 and 4 (VDC- and RS-485/B).
Resistance should be 20 kQ to 25 kQ2.

7. If any resistance measurements are lower than specified, the core processor may not be able to
communicate with a transmitter or a remote host. Contact Micro Motion customer service.

8. To return to normal operation:
a. Reconnect the 4-wire cable between the core processor and the transmitter.

b. Replace the core processor lid.

Note: When reassembling the meter components, be sure to grease all O-rings.
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Core processor resistance test
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22.20 Checking sensor coils and RTD

Problems with sensor coils can cause several alarms, including sensor failure and a variety of
out-of-range conditions. Testing the sensor coils involves testing the terminal pairs and testing for
shorts to case.
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22.20.1 Remote core processor with remote transmitter installation

If you have a remote core processor with remote transmitter installation:

1. Power down the transmitter.
2. If the transmitter is in a hazardous area, wait five minutes.
3. At the core processor:

Remove the end-cap.

Unplug the terminal blocks from the terminal board.

c. Using a digital multimeter (DMM), check the pickoff coils listed in Table 22-16 by
placing the DMM leads on the unplugged terminal blocks for each terminal pair. Record
the values.

Coils and test terminal pairs

00S€/00EE I9POIN — SuonedyIdads

Coil Test terminal pair
Drive coll Brown to red

Left pickoff coil (LPO) Green to white

Right pickoff coil (RPO) Blue to gray
Resistance temperature detector (RTD) Yellow to violet

Lead length compensator (LLC) (all sensors except CMF400 I.S. and T-Series) Yellow to orange
Composite RTD (T-Series sensors only)
Fixed resistor (CMF400 |.S. sensors only)

4. There should be no open circuits, i.e., no infinite resistance readings. The LPO and RPO
readings should be the same or very close (£5 Q). If there are any unusual readings, repeat the
coil resistance tests at the sensor junction box to eliminate the possibility of faulty cable. The
readings for each coil pair should match at both ends.

00.€/0SEE I9POIN — suonedydads
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5. Leave the core processor terminal blocks disconnected. At the sensor, remove the lid of the
junction box and test each sensor terminal for a short to case by placing one DMM lead on the
terminal and the other lead on the sensor case. With the DMM set to its highest range, there
should be infinite resistance on each lead. If there is any resistance at all, there is a short to
case.

6. Test terminal pairs as follows:

Brown against all other terminals except Red

e

Red against all other terminals except Brown
Green against all other terminals except White
White against all other terminals except Green
Blue against all other terminals except Gray
Gray against all other terminals except Blue

Orange against all other terminals except Yellow and Violet

=0 oo a0

Yellow against all other terminals except Orange and Violet

—

Violet against all other terminals except Yellow and Orange

Note: D600 sensors and CMF400 sensors with booster amplifiers have different terminal pairs.
Contact Micro Motion customer service for assistance.

There should be infinite resistance for each pair. If there is any resistance at all, there is a short
between terminals. See Table 22-17 for possible causes and solutions.

7. 1If the problem is not resolved, contact Micro Motion customer service for assistance.
8. To return to normal operation:

a. Plug the terminal blocks into the terminal board.

b. Replace the end-cap on the core processor housing.

c. Replace the lid on the sensor junction box.

Note: When reassembling the meter components, be sure to grease all O-rings.

Sensor and cable short to case possible causes and remedies

Possible cause Solution
Moisture inside the sensor junction box Make sure that the junction box is dry and no corrosion is present.
Liquid or moisture inside the sensor case Contact Micro Motion.

Internally shorted feedthrough (sealed passage  Contact Micro Motion.
for wiring from sensor to sensor junction box)

Faulty cable Replace cable.

Improper wire termination Verify wire terminations inside sensor junction box. See Micro
Motion’s 9-Wire Flowmeter Cable Preparation and Installation Guide
or the sensor manual.

22.20.2 4-wire remote installation
If you have a 4-wire remote installation:
1. Power down the transmitter.
2. If the transmitter is in a hazardous area, wait five minutes.

3. Remove the core processor lid.
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4. Disconnect the wires from the core processor terminals.

5. If you have a standard core processor — Loosen the captive screw (2.5 mm) in the center of the
core processor. Carefully remove the core processor from the sensor by grasping it and lifting
it straight up. Do not twist or rotate the core processor.

6. If you have an enhanced core processor — Loosen the two captive screws (2.5 mm) that hold
the core processor in the housing. Gently lift the core processor out of the housing, then
disconnect the sensor cable from the feedthrough pins by removing the snap clip and pulling
the plug straight out.

A CAUTION

If the core processor (feedthrough) pins are bent, broken, or damaged in any
way, the core processor will not operate.

To avoid damage to the core processor pins:

* Do not twist or rotate the core processor when lifting it.

* When replacing the core processor on the pins, be sure to align the guide pins
and mount the core processor carefully.

7. Using a digital multimeter (DMM), check the pickoff coil resistances by placing the DMM
leads on the pin pairs. Refer to Figure 22-7 (standard core processor) or Figure 22-8 (enhanced
core processor) to identify the pins and pin pairs. Record the values.

Sensor pins — Standard core processor

Right pickoff —

LLC / Composite RTD /
Fixed resistor"

Right pickoff +

Left pickoff —

RTD -

Left pickoff +

RTD +
Drive —

Drive +

(1) Functions as fixed resistor for the following sensors: F300, H300, FO25A, FO50A, F100A, CMF400 1.S., CMFS. Functions
as composite RTD for T-Series sensors. For all other sensors, functions as lead length compensator (LLC).
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Diagnostics and Troubleshooting

Sensor pins — Enhanced core processor

Drive — Drive +

LLC / Composite RTD /
Fixed resistor"

RTD +

Left pickoff — Right pickoff +

Left pickoff +

Right pickoff —

(1) Functions as fixed resistor for the following sensors: F300, H300, FO25A, FO50A, FI00A, CMF400 1.S., CMFS. Functions
as composite RTD for T-Series sensors. For all other sensors, functions as lead length compensator (LLC).

8. There should be no open circuits, i.e., no infinite resistance readings. The LPO and RPO
readings should be the same or very close (+5 Q).

9. Using the DMM, check between each pin and the sensor case. With the DMM set to its highest
range, there should be infinite resistance on each lead. If there is any resistance at all, there is a
short to case. See Table 22-17 for possible causes and solutions.

10. Test terminal pairs as follows:

a. Drive + against all other terminals except Drive —

b. Drive — against all other terminals except Drive +

c. Left pickoff + against all other terminals except Left pickoff —

d. Left pickoff — against all other terminals except Left pickoff +

e. Right pickoff + against all other terminals except Right pickoff —
f. Right pickoff — against all other terminals except Right pickoff +
g. RTD + against all other terminals except LLC + and RTD/LLC
h. LLC + against all other terminals except RTD + and RTD/LLC

[

RTD/LLC against all other terminals except LLC + and RTD +

Note: D600 sensors and CMF400 sensors with booster amplifiers have different terminal pairs.
Contact Micro Motion customer service for assistance.

There should be infinite resistance for each pair. If there is any resistance at all, there is a short
between terminals. See Table 22-17 for possible causes and solutions.

11. If the problem is not resolved, contact Micro Motion customer service for assistance.

To return to normal operation:
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. If you have a standard core processor:

a. Align the three guide pins on the bottom of the core processor with the corresponding
holes in the base of the core processor housing.

b. Carefully mount the core processor on the pins, taking care not to bend any pins.
If you have an enhanced core processor:

a. Plug the sensor cable onto the feedthrough pins.

b. Reinsert the snap clip to secure the sensor cable to the feedthrough.

c. Replace the core processor in the housing.

Tighten the captive screw(s) to 6 to 8 in-1bs (0,7 to 0,9 N-m) of torque.

4. Reconnect the wires to the core processor terminals.

5.

Replace the core processor lid.

Note: When reassembling the meter components, be sure to grease all O-rings.
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Specifications — Model 3300 and Model 3500

AA1

A.2

A3

A4

Housing and mounting
There are two housing and mounting options available for the Model 3300 or Model 3500.

A11 Panel-mount
e  With bezel mounting kit
* Front panel with bezel is rated IP65 (NEMA 4X)

A1.2 Rack-mount
¢  19-inch (486,2 mm) rack-mount meets DIN standard 41494 and IEC 297-3
*  Front panel is rated IP40

Interface/display

Screen
*  Backlit LCD, 128 x 128 pixel, bit map
e Adjustable contrast

* Non-glare chemical-resistant acrylic lens

Keypad membrane switch
* Large pushbuttons with tactile feedback
*  Software-defined function keys

*  Chemical-resistant polyester

Weight
Maximum 3.5 1b (1,6 kg), excluding prepared cables

Dimensions
Panel-mount: See Figures A-1 and A-2.
Rack-mount: See Figure A-3.

Core processor: See Figure A-4.
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Specifications — Model 3300 and Model 3500

Panel-mount dimensions for Model 3300 or Model 3500 with screw-type connectors

. . . inches
Dimensions in (mm)
61/2
(165)

| L Panel 81/2
~——— (216)
| | 7 3/4
( J (197)
€ J
Frame
Bezel /
6 _0 o o o o0 o o 0'II ‘
O N 41/2
¥ (122) { e
611/16
O 6 o o o/o o o o]0 \ (1\70)
6
(152) Approvals tag \
Intrinsic safety barrier
(Model 3500 only)
L 12

(12)
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Figure A-2  Panel-mount dimensions for Model 3300 or Model 3500 with 1/0 cables

inches

Dimensions in (mm)

61/2
(165)

Panel

e

Ll

Bezel

-

6
(152)
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8 3/4
(222)
Frame
i I
6 _O0 0 0 0 o0 0 0o O'I
55/16
. = (135)
1
611/16
T 6 6 0676 6 6 6|0 (170)
Minimum 4 1/4”
Approvals tag (108 mm) bend radius
1/2
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Specifications — Model 3300 and Model 3500

Rack-mount dimensions for Model 3300 or Model 3500

1U=1HE =1.750 inches (44,45 mm)
1 HP =1 TE = 0.200 inch (5,08 mm)

25HP (25 TE) ; 4 x M2.5x11

O0000000000

inches

Dimensions in (mm)

(3HE) O O 51/16
413/16 (128,5)
(122,5)

O0000000O0OOQ
)
) € Sooooossoon |

59/16
(142,2)
28 HP (28 TE)
19-inch (486,2 mm) rack conforms to DIN 41494, Part 5, and IEC 297-3.
Not included with Model 3300 or Model 3500.

Optional screw terminal

Rear rail for mounting connectors
that conform to DIN 41612 and IEC 603-2.
Not included with Model 3300 or Model 3500.

Intrinsic safety shield
(Model 3500 only)

O
o o o [3) o] o
o o0/ o o T ¢~
Approvals tag
1 611/16
(169,9) !
(254) 7 11/32
(186,7) —
7 29/32
=~ (200,6)
8 33/64
(216,2)
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Figure A-4  Core processor dimensions

, . . inches (111)
Dimensions in (mm)
—]

+ 511/16
(144)
2X 3
-l ‘ (76)
! 1]
"s= T
21/4
(57)
L4 |
}_{.E_LI_IL_{
AT\ U TR T
25/8
(67)
6H16 g P @I ‘
158 | I T
(158) (10) |
| .l 213/16
| (71)
l g
TS —al 1| To centerline of 2” pipe o,
=
o
213/16 S
- 71 = 5 3/4 »
41/2 Pole Mount )
~ (118 &
- W
49/16 21/ 1/2 —égNPT §
[, \116) [ 64 M20 X 1.5 3
Note: These di . / I 5 Wall Mount . a
ote: These dimensions apply only to the 23/8 o©
core processor component in remote core [~ (61)
processor with remote transmitter ~_111/16
installations. F‘\@ &l‘-"\l (43)
— ) ‘
35/16
(84)
\ 3/4—14 NPT
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A.5 Electrical connections

Electrical connections depend on the mounting option.

A.5.1 Panel-mount

Input and output connections

* Available as screw terminals (standard) or remote DIN-rail-mount screw terminals (optional)
with I/O cable

* Remote terminals attach to any of four rail types. I/O cable is available in lengths of 2, 5, and
10 feet (0,6, 1,5, and 3 meters)

e Terminals accept 24 to 16 AWG (0,25 to 1,5 mm?) wires

Power connection
Screw terminals accept 18 to 14 AWG (0,75 to 2,5 mm?) wires

A.5.2 Rack-mount

Input and output connections
*  Type D connectors per DIN standard 41612 (IEC 603-2)
* Available as solder tails (standard) or screw terminals (optional)

e Screw terminals accept 24 to 16 AWG (0,25 to 1,5 mm?) wires

Power connection
e Screw terminals are fixed to rack chassis

¢ Ground makes first and breaks last
e Terminals accept 18 to 14 AWG (0,75 to 2,5 mm?) wires

A.6 Inputs and outputs

A.6.1 Intrinsically safe input signals

One 4-wire Coriolis sensor signal input with ground (standard)

A.6.2 Non-intrinsically safe input signals

Frequency/pulse input
One 2-wire frequency/pulse input
* Frequency range: 0-20,000 Hz
*  Minimum pulse width: 25 psec
* Power: Sourcing or sinking
* Voltage: 0-0.8 VDC low state, 3-30 VDC high state

e Current: Nominal 5 mA pull-up
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Discrete inputs
Two discrete, momentary inputs
e Pulse width: 0.15 sec minimum
* Voltage: 0-0.8 VDC low state, 3-30 VDC high state, dry contacts

A.6.3 Non-intrinsically safe output signals

99UBWLIOLDd JUSWAINSES

Milliamp outputs
Two active 4-20 mA outputs
* Isolated to £50 VDC from all other outputs and earth ground
e Maximum load limit: 1000 Q
*  Output is linear with process from 3.8 to 20.5 mA, per NAMUR NE43 (June 1994)

Discrete outputs
Three discrete outputs
* Configurable for the application
* Polarity: Active high or active low, software selectable
* Power: Internal pull-up to 24 V
* Voltage: 24 VDC nominal
e Current: Sourcing at 5.6 mA when V_, = 3 VCD, sinking up to 500 mA at 30 VDC maximum
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Frequency/pulse output
One 2-wire frequency/pulse output
e Qutput is linear with flow rate to 12,500 Hz
* Configurable unit of measure
e Scalable to 10000 Hz
e Pulse width: 50% duty cycle above 500 Hz, configurable for frequencies below 500 Hz
* Power: Active or passive, software selectable
* Polarity: Active high or active low, software selectable

* Voltage: 24 VDC nominal, active; 30 VDC applied maximum, passive
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e Current: Sourcing, 10 mA at 3 VDC, active; sinking, 500 mA, active or passive

Fault output

When a fault is detected, outputs go to configured states. User can select high, low, last measured
value, or internal zero. Milliamp outputs conform to NAMUR NE43 (June 1994).

* High output limits can be configured from 21 to 24 mA for milliamp; 15,000 Hz for frequency
* Low output limits can be configured from 1 to 3.6 mA for milliamp; O Hz for frequency
* Last measured value is the last output for the process variable

* Internal zero drives the milliamp and frequency outputs for process variables to zero values

00.€/0SEE 19POIN — suonedldads
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A.7

248

A.6.4

Digital communications
One RS-485 port (standard)
- Supports Modbus RTU, Modbus ASCII, HART/RS-485, or printer
- User-configurable
HART superimposed on primary mA output
- Standard HART/Bell 202 communication parameters, not configurable

External adapters (not included) required for conversion to RS-232

Power supply options

A.7A1

Model 3300 controller

85 to 265 VAC

50/60 Hz, 15 VA

0.25 A max at 85 VAC; 0.12 A max at 265 VAC

IEC 127-3/4 fuse, 0.63 A time-delay

Complies with “low-voltage directive” 2006/95/EC per IEC 61010-1
Installation (Overvoltage) Category II, Pollution Degree 2

18 to 30 VDC

A.7.2

7 watts typical, 14 watts maximum
IEC 127-3/4 fuse, 1.6 A time-delay

Model 3500 transmitter

85 to 265 VAC

50/60 Hz, 30 VA

0.33 A max at 85 VAC; 0.15 A max at 265 VAC

IEC 127-3/4 fuse, 0.63 A time-delay

Complies with “low-voltage directive” 2006/95/EC per IEC 61010-1
Installation (Overvoltage) Category II, Pollution Degree 2

18 to 30 VDC

18 watts typical, 25 watts maximum
IEC 127-3/4 fuse; 1.6 A time-delay
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A.8

A9

A.10

A.11

A.12

Environmental limits
* Ambient temperature:
- Operating: —4 to +140 °F (=20 to +60 °C)
- Storage: —40 to +158 °F (40 to +70 °C)

Some darkening of display may occur above 131 °F (55 °C). Display responsiveness decreases
below —4 °F (=20 °C).

e Humidity: 5 to 95% relative humidity, non-condensing at 140 °F (60 °C)
*  Vibration: Meets IEC 68.2.6, endurance sweep, 5 to 2000 Hz, 50 sweep cycles at 1.0 g

Environmental effects

EMI effects
*  Meets EMC directive 89/336/EEC per EN 61326 Industrial
¢ Conforms to NAMUR NE21 (June 1997)

Ambient temperature effect
*  On analog outputs: + 0.005% of span per °C

Hazardous area classifications

A.10.1  ATEX

Model 3500 transmitter

Safe area only [EEx ib] IIB/IIC. The sensor outputs are intrinsically safe and can be connected to a
sensor in the Zone 1 area.

A.10.2 UL and CSA

Model 3300 controller

Class I, Div. 2, Groups A, B, C, D when installed in a suitable enclosure.

Model 3500 transmitter

Class I, Div. 2, Groups A, B, C, D when installed in a suitable enclosure. Provides nonincendive
sensor outputs for use in Class I, Div. 2, Groups A, B, C, D, or intrinsically safe sensor outputs for use
in Class I, Div. 1, Groups C and D; Class II, Div. 1, Groups E, F, and G.

Performance specifications

For performance specifications, refer to the sensor specifications.

Cleaning instructions
To clean the Model 3300 or Model 3500, use a clean dry cloth or dry air.
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B.1 Compartmentalized housing
* Compartment with threaded cover contains electronics
e Terminal compartment contains:
- Non-intrinsically safe compartment with input and output terminals

- Intrinsically safe compartment with interface/display, sensor wiring terminals
(Model 3700 only), and optional input and output terminals

* Mounting bracket and interface/display rotate to allow mounting in four different orientations
* Rated NEMA 4X (IP67)

B.2 Interface/display

Bunooysajqnou] pue saisoubelq

Screen
*  Backlit LCD, 128 x 128 pixel, bit map
e Adjustable contrast
* Non-glare tempered glass lens

¢  Suitable for hazardous area installation

Keypad membrane switch
* Large pushbuttons with tactile feedback
* Software-defined function keys

e Chemical-resistant polyester
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B.3 Weight
19 1b (8,6 kg)

B.4  Dimensions
See Figures B-1 through B-4.
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Model 3350 or Model 3700 dimensions — Face view

inches

Dimensions in (mm)

4 x 5/16-inch
(9 mm)
diameter _\

213/16
(71)

[

Mounting bracket can be
rotated 90° as needed

Display cover can be .
rotated 90° or 180° as (92)
needed (see Section 2.8) 6

Model 3350 or Model 3700 dimensions — Top view

inches

Dimensions in (mm)

e |

5 1/16-inch (129 mm)
clearance for removal
of circuit boards

|

—

Approvals tai
1 — PP 9 1156
(288)

61/8
(158) = 5} \ — 7

811/16
(221)

15 1/2
(394)
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Figure B-3  Model 3350 or Model 3700 dimensions — Conduit openings view

- 2x213/16
inches A1 (1)
(48)

Dimensions in

2x15/16
(24)

Case ground =

5 x 3/4-14 NPT G
or

5xM20x 1.5-6H

Mounting surface

o
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Core processor dimensions

inches
(mm)

Dimensions in

_— T
J
21/4
(57)
A
}_FI_I_I_IL_{
AT L U
25/8
(67)
1 1 L ren
6 3/16 A — -
(10)
i | , 213/16
(71)
| 'E.B___ EB I l To centerline of 2” pipe
213/16
- 71 - 5 3/4
41/2 Pole Mount
(114)
4916 012 1/2°-14 NPT
(116) (64) M20 X 1.5
. . Wall Mount
Note: These dimensions apply only to the 23/8
core processor component in remote core (61)
processor with remote transmitter _111/16
installations. (43)‘
35/16
(84)
\ 3/4"-14 NPT
=
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B.5  Electrical connections
Two color-coded wiring compartments:

*  Compartment with intrinsically safe terminal block has two 3/4-inch NPT or M20 x 1.5
conduit openings

* Compartment with non-intrinsically safe terminal block has three 3/4-inch NPT or M20 x 1.5
conduit openings

Input and output screw terminals accept 22 to 16 AWG (0,35 to 1,5 mm?) wires

99UBWLIOLDd JUSWAINSES

Power screw terminals accept 18 to 12 AWG (0,75 to 4.0 mm?) wires

B.6 Inputs and outputs

B.6.1 Intrinsically safe input signals

One 4-wire Coriolis sensor signal input with ground (standard)

B.6.2 Non-intrinsically safe input signals

Frequency/pulse input

One 2-wire frequency/pulse input

Bunooysajqnou] pue saisoubelq

* Frequency range: 0—20,000 Hz

*  Minimum pulse width: 25 psec

* Power: Sourcing or sinking

* Voltage: 0-0.8 VDC low state, 3-30 VDC high state

e Current: Nominal 5 mA pull-up

Discrete inputs
Two discrete, momentary inputs

e Pulse width: 0.15 sec minimum
*  Voltage: 0-0.8 VDC low state, 3-30 VDC high state, dry contacts

B.6.3 Non-intrinsically safe output signals
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Milliamp outputs
Two active 4-20 mA outputs
* Isolated to £50 VDC from all other outputs and earth ground
e  Maximum load limit: 1000 Q
e Qutput is linear with process from 3.8 to 20.5 mA, per NAMUR NE43 (June 1994)
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Discrete outputs

Three discrete outputs

Configurable for the application

Polarity: Active high or active low, software selectable

Power: Internal pull-up to 24 V

Voltage: 24 VDC nominal

Current: Sourcing at 5.6 mA when V_,, = 3 VCD; sinking up to 500 mA at 30 VDC maximum

Frequency/pulse output

One 2-wire frequency/pulse output

Output is linear with flow rate to 12,500 Hz

Configurable unit of measure

Scalable to 10000 Hz

Pulse width: 50% duty cycle above 500 Hz, configurable for frequencies below 500 Hz
Power: Active or passive, software selectable

Polarity: Active high or active low, software selectable

Voltage: 24 VDC nominal, active; 30 VDC applied maximum, passive

Current: Sourcing, 10 mA at 3 VDC, active; sinking, 500 mA, active or passive

Fault output

When a fault is detected, outputs go to configured states. User can select high, low, last measured
value, or internal zero. Milliamp outputs conform to NAMUR NE43 (June 1994).

B.6.4

High output limits can be configured from 21 to 24 mA for milliamp; 15,000 Hz for frequency
Low output limits can be configured from 1 to 3.6 mA for milliamp; 0 Hz for frequency
Last measured value is the last output for the process variable

Internal zero drives the milliamp and frequency outputs for process variables to zero values

Digital communications
One RS-485 port (standard)
- Supports Modbus RTU, Modbus ASCII, HART/RS-485, or printer
- User-configurable
HART superimposed on primary mA output
- Standard HART/Bell 202 communication parameters, not configurable

External adapters (not included) required for conversion to RS-232
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B.7

B.8

B.9

B.10

Power supply options

85 to 265 VAC
*  50/60 Hz, 30 VA
* 0.33 Amax at 85 VAC; 0.15 A max at 265 VAC
* [EC 127-3/4 fuse, 0.63 A time-delay
e Complies with “low-voltage directive” 2006/95/EC per IEC 61010-1
* Installation (Overvoltage) Category II, Pollution Degree 2

18 to 30 VDC
e 18 watts typical, 25 watts maximum
» IEC 127-3/4 fuse; 1.6 A time-delay

Environmental limits
* Ambient temperature:
- Operating: —4 to +140 °F (=20 to +60 °C)
- Storage: —40 to +158 °F (40 to +70 °C)

Some darkening of display may occur above 131 °F (55 °C). Display responsiveness decreases
below —4 °F (=20 °C).

e Humidity: 5 to 95% relative humidity, non-condensing at 140 °F (60 °C)
e Vibration: Meets IEC 68.2.6, endurance sweep, 5 to 2000 Hz, 50 sweep cyclesat 1.0 g

Environmental effects

EMI effects
*  Meets EMC directive 89/336/EEC per EN 61326 Industrial
¢ Conforms to NAMUR NE21 (June 1997)

Ambient temperature effect
*  On analog outputs + 0.005% of span per °C

Hazardous area classifications

B.10.1  ATEX

Zone 1, complying with ATEX Directive (94/9/EC) for group II category 2G and marked as
EEx de [ib] IIB/IIC T4.

B.10.2 UL and CSA

Class I, Div. 2, Groups A, B, C, and D. Provides nonincendive sensor outputs for use in Class I, Div.
2, Groups A, B, C, D, or intrinsically safe sensor outputs for use in Class I, Div. 1, Groups C and D;
Class II, Div. 1, Groups E, F, and G.
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B.11  Performance specifications
For performance specifications, refer to the sensor specifications.

B.12 Cleaning instructions
To clean the Model 3350 or Model 3700, use a clean damp cloth.

A WARNING

Using a dry cloth to clean the display cover of the Model 3350 or Model 3700
can cause static discharge, which could result in an explosion in an
explosive atmosphere.

To prevent an explosion, use a clean damp cloth to clean the display cover of the
Model 3350 or Model 3700 in an explosive atmosphere.
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C.1 Overview

The Model 3100 accessory features relay packs for interfacing with high-energy solenoids, pump
starters, or other devices.

C.2 Relay packs
The Model 3100 contains three relays with the following characteristics:
* Solid state, SPST
* Rated at 24-250 VAC, 40 mA-5 A; or 0-70 VDC, 5 A

* Energized by discrete outputs

C.3 Hazardous area classifications

C.3.1 ATEX

Zone 2, complying with ATEX Directive (94/9/EC) for Group II, Category 3G, according to
CENELEC standard prEN 50021:1998 and marked as:

e EExnVIIT4
« KEMA 97 ATEX 4940 X
*  Ambient temperature —20 to +60 °C (—4 to +140 °F)

C.3.2 UL and CSA
Class 1, Division 2, Groups A, B, C, and D
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D.1

D.2

D.3

About this appendix

This appendix explains how to install relay modules for the Series 3000 device. Relays are used to
connect the device’s discrete outputs to control devices.

Relay types
Two types of relay can be used with the Series 3000:

*  The Model 3100 relay module supplied by Micro Motion. The Model 3100 contains three
solid-state relays.

»  User-supplied relay or relay module compatible with the Series 3000 discrete outputs (see
Section D.5.1).

D.2.1 Power
The Model 3100 relay module is powered by the Series 3000 discrete outputs.

User-supplied relays can be powered by the Series 3000 discrete outputs if both of the following are
true:

* They are solid-state relays, and

* The relay input requirements are met by the discrete output characteristics (see Section D.5.1).

If either of these conditions is not true, user-supplied relays must be powered externally.

Hazardous area installations

If you are installing the relay or relay module in a hazardous area, review the information in this
section.

D.3.1 Model 3100 relays

ATEX

Model 3100 relay modules are suitable for installation in Zone 2, complying with ATEX Directive
(94/9/EC) for Group II, Category 3G, according to CENELEC standard prEN 50021:1998 and
marked as:

e EExnVIIT4
e KEMA 97 ATEX 4940 X
*  Ambient temperature —20 to +60 °C (—4 to +140 °F)
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Installing Relays

D.4

D.5

262

To comply with hazardous area requirements:

*  Model 3100 relay modules must be mounted into a suitable and classified enclosure that
provides ingress protection of at least IP4X according to EN 60529, taking into account the
environmental conditions into which the equipment will be installed.

* The external metal parts of the relay module (heat sinks) must be connected to the
potential-equalizing system within the hazardous area.

UL and CSA
Model 3100 relay modules are suitable for installation in Class I, Division 2, Groups A, B, C, and D.

Note: For CSA compliance, the relay module must be installed in a suitable enclosure where the final
combination is subject to acceptance by the Canadian Standards Association (CSA).

D.3.2 User-supplied relays

User-supplied relays to be used for Zone 2 applications must be certified as Category 3 equipment.

Replacing relays

You may not replace a defective relay separately. If an individual relay is defective, you must replace
the entire relay module.

This requirement applies to both the Model 3100 and to user-supplied relays, and to both hazardous
and non-hazardous areas.

Using relays with the Series 3000 device

A relay is used to connect the Series 3000 device’s discrete outputs to control devices.

D.5.1 Series 3000 discrete outputs

The Series 3000 has three discrete outputs, which can be configured for specific application
requirements. The outputs have the following characteristics:

* Polarity:
- Active high or active low
- Software selectable

e Current:

- Sourcing at 5.6 mA, V_, =3 VDC minimum

out

- Sinking up to 500 mA at 30 VDC supply maximum

Figure D-1 shows a diagram of a typical discrete output circuit.
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Figure D-1  Discrete output circuit
+24 V (Nom)
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D.6  Installing the Model 3100 relay module

Follow these steps to install a Model 3100 relay module.

Step 1 Mount relay module

| Out+

| Out-

Mount the supplied relay module to a DIN rail. The relay module accommodates various standard rail

types. See Figure D-2.
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Figure D-2  Relay module dimensions

; /
Dimensions in /f();l;ﬁ)s l——— 3(376)4 _— -
2 ‘
21/32 (50) ﬂ NN 27/32
(52) ) (56) 2 21/64
] | (59)
l L ‘ |
TS 32
TS 15
TS35x7.5 TS 35x 15

(203)

00| 00N ool )
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Connect discrete output terminals to relays

Follow the steps below to connect the transmitter/controller’s discrete output wiring terminals to one,
two, or three relays.

A WARNING

Shock Hazard.
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Improper installation of wiring, or installation with power supply on, can cause
electric shock or property damage.

For personal and system safety:

* Shut off power before installing wiring.
* Make sure the installation meets or exceeds local code requirements.
¢ |Install relays and wiring in accordance with the illustrations in these instructions.

* Install relays and wiring where ambient temperature remains between —4 and
+140°F (—20 and +60°C).

1. Use the following wire sizes:
e Model 3300 or Model 3500: 24 to 16 AWG (0,25 to 1,5 mm?)
e Model 3350 or Model 3700: 22 to 16 AWG (0,35 to 1,5 mm?)

2. Connect the wires between the transmitter/controller terminals and the relay terminals as
shown in Table D-1 and in the following diagrams:
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*  Model 3300 or Model 3500 with screw-type or solder-tail connectors: see Figure D-3
*  Model 3300 or Model 3500 with I/O cables: see Figure D-4
*  Model 3350 or Model 3700: see Figure D-5

Transmitter/controller terminals and Model 3100 terminals

o]
(1]
Transmitter/controller terminals g“
Model 3300 or Model 3500 Model 3350 or Model 3700 @
Screw-type or
I1/0 cables or /O solder-tail Terminal Model 3100
terminal block  terminals Gray terminal block function terminals
19 al4 20 Return al4
18 cl14 18 DO1 ci4
20 c16 17 DO2 c16
22 c18 16 DO3 c18
7
[}
=
(7]
w
o
(=}
o
=
(1)
=)
c
(7]
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Model 3300 or Model 3500 to Model 3100 - Screw-type or solder-tail connector

Wire size is 24 to 16 AWG (0,25 to 1,5 mm?) o j o
mc am
mc 6 am

K3 K2 K1 mc 8 am
mc 10 am
mc 12 am

MODEL 3300/3500
TERMINAL 14 omp—
CONNECTION
. mc 16 am
@ a4 18 am
Relay 3 Relay 2 Relay 1 g %2: mc 20 am
@ [Je4 mc 22 am
“ mc 24 am
£ TBA 25V [ad - 2 1A W ¥z . BT 250V I 081
mc 26 am
O=| = Q|| O0=0| -2 O||O0=0| [2—=2] & e 28 am
=] O O O O
Ic 1272 2] e 1272 i3 16C 127-2 & mc 30 am
mc 32 am
Model 3300 or Model 3500 input/output wiring terminals
See Figure 2-2
Model 3300 or Model 3500 to Model 3100 - I/0 cables
Wire size is 24 to 16 AWG (0,25 to 1,5 mm?) = :'E_‘
(S
— =y
K3 K2 K1 Zl; gu
o~
MODEL 3300/3500 = (1|
CONNERTION — | ey Mo
Relay 3 Relay 2 Relay 1 Py S| |
@ [Jfer= e (| N
@ [Jore — z (| oo
@ [je14 — | Kl
L] N
FB3OTmA 2w 3 w P ™ B A2 - FTOTBA 2V LAl . :I::Zla
O=0| el O||=0| T2 O||0=0| 22l =i | =
NS .
1E¢ 127-2 3»'?5 1EC 127-2 gﬁ 1E¢ 127-2 3?" ro jl\:
=1 ==
=l +

Model 3300 or Model 3500 input/output wiring
terminals
See Figure 2-2
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(7
Model 3350 or Model 3700 to Model 3100 3
e,
=
=
=
2
Model 3350 or Model 3700 input/output 1
wiring terminals 3 3 =
Gray terminal block 4 14 2
See Figure 2-2 5 15 5 w
Ol > 10 2
81— =1

7 17-

8 18

F3 T5A 250V

o]

(]

o D
Relay 3 Relay 2 Relay 1 ComEGTON <
| 5
Mo 7]
IS5 )
eliers =
Cdl 7y . ) o
] Wire size is 22 to 16 AWG (0,35 to 1,5 mm?) >
>

- ”
e m z ﬁ

Connect relay wiring to control devices
Follow the steps below to connect one, two, or three relays to a control device.
1. Wire size must be between 22 and 16 AWG (0,35 to 1,5 mm?).

2. Connect the wires between the relay module and the control device as shown in the diagrams:

(o]
» If the relay loads have an AC power supply, see Figure D-6. AC output terminals do not g'-
have polarity. %
» If the relay loads have a DC power supply, see Figure D-7. DC output terminals have
polarity.
»
o
=
(7}
w»
(=}
(=}
o
=
(1]
=]
c
(7]
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Model 3100 relay module to control devices — AC power

24 10 280 VAC One relay, two relays, or all three
(no polarity) relays may be connected

or other control device

v Primary control valve
/\

®
S | v Secondary control valve
un A or other control device
Relay 2 * |
|
sl m B
3 ’E!
5 Pump or other
1Q control device

1@ @]
[m ]
o e

Relay 3

K3
LW ]
=0
Y]

Model 3100 relay module to control devices — DC power

+ - One relay, two relays, or all three
1210 30 VDC relays may be connected

Primary control valve or
other control device

= i
Relay 1 Or=

Kt

Secondary control valve
or other control device

Relay 2

< Pump or other
L [OF control device

Relay 3
IEg
) =]
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D.7 Installing user-supplied relays

Follow these steps to install user-supplied relays.

Connect discrete output terminals to relays

Follow the steps below to connect the transmitter/controller’s discrete output wiring terminals to one,
two, or three relays.

A WARNING

Shock Hazard.

001€ |9POINl — Suoneoyioads

Improper installation of wiring, or installation with power supply on, can cause
electric shock or property damage.

For personal and system safety:

* Shut off power before installing wiring.
¢ Make sure the installation meets or exceeds local code requirements.
* Install relays and wiring in accordance with the illustrations in these instructions.

* Install relays and wiring where ambient temperature remains between —4 and
+140 °F (—20 and +60 °C).

X
o
)
<
5
7]
2
-
o
[=4
o
5

1. Use the following wire sizes:
¢ Model 3300 or Model 3500: 24 to 16 AWG (0,25 to 1,5 mm?)
e Model 3350 or Model 3700: 22 to 16 AWG (0,35 to 1,5 mm?)

2. Connect the wires between the transmitter/controller and the relay as shown in Table D-2 and
in the following diagrams:

*  Model 3300 or Model 3500 with screw-type or solder-tail connectors: see Figure D-8
e Model 3300 or Model 3500 with I/O cables: see Figure D-9

*  Model 3350 or Model 3700: see Figure D-10 gg..
=
Transmitter/controller terminals for user-supplied relays @
Transmitter/controller terminals
Model 3300 or Model 3500 Model 3350 or Model 3700
Screw-type or
I/O cables or /O  solder-tail
terminal block terminals Gray terminal block Terminal function
19 a4 20 Return
18 ci14 18 DO1
20 c16 17 DO2 @
22 c18 16 DO3 ]
w»
(=}
(=}
o
=
(1]
=]
c
(7]
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Model 3300 or Model 3500 to user-supplied relay — Screw-type or solder-tail connector

Model 3300 or Model 3500
input/output wiring terminals
See Figure 2-2

Externall ¢ 1210 30VDC
power e Maximum coil load:
[ | supply 500 mA/relay

500 mA
maximum

Wire size is 24 to 16 AWG
(0,25 to 1,5 mm?)

500 mA

maximum ._%?}

User-supplied relays

500 mA

maximum % g}

MR

Model 3300 or Model 3500 to user-supplied relay — 1/0 cable

= | [ External| ¢ 121030 VDC
Model 3300 or 2| QIES power e Maximum coil load:
M_osjel 3500_|nput/output ~(H —1 supply 500 mA/relay
wiring terminals ~— = - +
See Figure 2-2 —|=

o ~|= Wire size is 24 to 16 AWG

2|(E NE=+ (0,25 to 1,5 mm?)

)= == 500 mA

=S maximum h

K= % q) 1

5| 2=

“5 x(= 500 mA

o0 | — = maximum ¥ ¢ { User-supplied relays

<+ 0| o ¢ |

" | o= 500mA |

~(E <= maximum _%?) {

— |y t |
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Figure D-10 Model 3350 or Model 3700 to user-supplied relay

Model 3350 or Model 3700 input/output wiring terminals
Gray terminal block
See Figure 2-2

°

A . &
500 mA maximum w_j}__% r User-supplied relays
500 mA maximum ‘ % jL 1{
500 mA maximum (
1»—%—j r External e 121030 VDC
+ | power supply e Maximum coil load:
500 mA/relay
Wire size is 22 to 16 AWG (0,35 to 1,5 mm?)

Step 2 Connect relay wiring to control devices

The method used to connect the relay to the control device depends on the function the relay will
perform. For an illustration of typical wiring for a 2-stage batch application, see Figure D-11.

Figure D-11 User-supplied relay to control device: 2-stage batch application

Secondary control valve
or other control device

v Primary control valve
% > ;|' A or other control device
User-supplied relays g} -K /\
§> _{ Pump or other
T control device
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Default Values and Ranges

E.A Overview
This appendix provides information on the default values for most Series 3000 parameters. Where
appropriate, valid ranges are also defined.
These default values represent the platform configuration after a master reset. Depending on how the
platform was ordered, certain values may have been configured at the factory.
E.2 Most frequently used defaults and ranges
The table below contains the default values and ranges for the most frequently used Series 3000
settings.
Series 3000 default values and ranges
Type Setting Default Range Comments
Flow Flow direction Forward only
Flow damping 0.8 sec 0.0-51.2sec User-entered value is
corrected to nearest lower
value in list of preset values.

For gas applications, Micro

Motion recommends a value

of 2.56 seconds or higher.

Flow calibration factor 1.00005.13 For T-Series sensors, this
value represents the FCF and

FT factors concatenated. See

Section 7.3.3.

Mass flow units a/s
Mass flow cutoff 0.0000 g/s Recommended setting:

* Standard use — 0.2% of the
sensor’s rated maximum
flowrate

* Empty-full-empty batching —
2.5% of the sensor’s
maximum flowrate

Volume flow type Liquid

Volume flow units L/s

Volume flow cutoff 0.0000 I/s 0.0-xl/s X is obtained by multiplying
the flow calibration factor by

0.2, using units of I/s

Meter factors Mass factor 1.00000
Density factor 1.00000
Volume factor 1.00000
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Default Values and Ranges

Series 3000 default values and ranges continued

Type Setting Default Range Comments

Density Density damping 1.6 sec 0.0-51.2 sec User-entered value is
corrected to nearest value in
list of preset values

Density units glcm?®
Density cutoff 0.2 g/cm?® 0.0-0.5 g/lcm®
D1 0.00000
D2 1.00000
K1 1000.00
K2 50,000.00
FD 0.00000
Temp Coefficient 4.44
Slug flow low limit 0.0 g/cm?® 0.0 -10.0 g/lcm?®
Slug flow high limit 5.0 g/cm?® 0.0 —10.0 g/cm?®
Slug duration 0.0 sec 0.0 - 60.0 sec
Temperature Temperature damping 4.8 sec 0.0 - 38.4 sec User-entered value is
corrected to nearest lower
value in list of preset values
Temperature units degC
Temperature calibration factor 1.00000T0.0000
Frequency input Flow rate units kg/min
Scaling method Frequency = Flow
Frequency 1000.0000
Flow 999.9999 kg/min
K factor 1.0000
Discrete inputs  Polarity Active low
Discrete events  Type HI
Process variable Mass flow rate
HI PV value 0.0000
Discrete Polarity Active low
outputs Assignment None
Fault indication None
Milliamp output  Fault indication: Condition Downscale
1 Fault indication: Setting 2.0000 mA 1.0-3.6 mA
Fault indication: Last 0 sec 0.0 -60.0 sec
measured value timeout
Variable assignment Mass flow
Calibration span: 20.0 mA 200.0000 g/s
Calibration span: 4.0 mA —200.0000 g/s
Calibration span: Low flow 0.0000 g/s
cutoff
Damping seconds 0.0000
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Series 3000 default values and ranges continued

Type Setting Default Range Comments
Milliamp output  Fault indication: Condition Downscale
2 Fault indication: Setting 2.0000 mA 1.0-3.6 mA
Fault indication: Last 0 sec 0.0-60.0 sec
measured value timeout
Variable assignment Density
Calibration span: 20.0 mA 10.0000 g/cm?®
Calibration span: 4.0 mA 0.0000 g/cm?®
Damping seconds 0.0000
LRV Mass flow —200.000 g/s
Volume flow —0.200 I/s
Density 0.000 g/cm?®
Temperature —240.000 °C
Drive gain 0.000%
Gas standard volume flow —423.78 SCFM
External temperature —240.000 °C
External pressure 0.000 psi
URV Mass flow 200.000 g/s
Volume flow 0.200 I/s
Density 10.000 g/cm?®
Temperature 450.000 °C
Drive gain 100.000%
Gas standard volume flow 423.78 SCFM
External temperature 450.000 °C
External pressure 100.000 psi
Frequency Flow source Mass flow
output Scaling method Frequency = flow
Frequency 1,000.00 Hz 0.00091 —
10,000.00 Hz
Flow 16,666.66999 g/s
Max pulse width 277.2352 ms 0-277.2352 ms
Power Active
Polarity Active high
Fault indication Downscale
Last measured value timeout 0.0 sec 0.0 -60.0 sec
RS-485 Baud rate 9600
ﬂ?’\r;r?eptreortsocol Parity Odad
Data bits 8
Stop bits
Polling address 0
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Default Values and Ranges

Series 3000 default values and ranges continued

Type Setting Default Range Comments
RS-485 Baud rate 9600 Modbus RTU is the default
F\)Aac;glrorljeshgi L_J Parity Odd RS-485 protocol
protocol Data bits 8
Stop bits 1
Polling address 1
Byte order 3-4-1-2
RS-485 Baud rate 9600
protocol Data bits 7
Stop bits 1
Polling address 1
Byte order 3-4-1-2
RS-485 Baud rate 9600
Bﬁ;atl;nre;?c:tsocol Parity Odd
Data bits 7
Stop bits 1
Bell 202 HART polling address 0
parameters Burst mode Disabled
Burst command PV & Pct Range
Device Fault setting None
parameters HART QV Volume flow
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Appendix F

Series 3000 Menu Flowcharts

F.1

F.2

Figure F-1

Overview

This appendix provides flowcharts for the Series 3000 display menus.

Process monitor
Access to the process monitor depends on whether or not the discrete batch application is installed:

* Asshown in Figure F-1, when the discrete batch is not installed, the process monitor is the

default display. The five process monitor screens are accessed via the Left and Right cursor

control buttons. If no display variables are configured for a particular screen, that screen is
skipped.

* Asshown in Figure F-2, when the discrete batch application is installed, the default display is

the batch operation screen, and the process monitor is accessed through the View menu.

Process monitor: Discrete batch application not installed

L

Screen 1

Var
Var
Var
Var

Screen 2

Var
Var
Var
Var

Screen 3

Var
Var
Var
Var

Screen 4

Var
Var
Var
Var

Screen 5

Var
Var
Var
Var
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Series 3000 Menu Flowcharts

Process monitor: Discrete batch application installed

Well Performance Meas

Start Well Test
View Well Tests
Recalculate Well Test e e

B>

L
!

View Menu

v

‘ Process Monitoring ‘

Screen 1 Screen 2 Screen 3 Screen 4 Screen 5
Var Var Var Var Var
Var Var Var Var Var
Var Var Var Var Var
Var Var Var Var Var

F.3 Menu access
As shown in Figure F-3:
* To access the View menu system, press the VIEW function button.

* To access the Management menu system, press the Security button.

Menu access

Process monitor" Batch operation screen®

Screen x Preset Name

Total

Var

Var
Var Target

Var

to View menu to Management menu

(1) Displayed if the discrete batch application is not installed. See Figure F-1 for details.
(2) Displayed if the discrete batch application is installed. See Figure F-2 for details.
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F.4  View menu
The appearance of the View menu depends on the special applications that are installed:

*  Figure F-4 shows the View menu when neither the custody transfer application or the discrete
batch application is installed. The petroleum measurement and enhanced density applications
are optional.

*  Figure F-5 shows the View menu when the custody transfer application is installed and
configured for OIML compliance. The discrete batch, petroleum measurement, and enhanced
density applications are optional.

*  Figure F-6 shows the View menu when the discrete batch application is installed, or the
discrete batch and custody transfer applications are installed and custody transfer is configured
for NTEP compliance. The petroleum measurement and enhanced density applications are
optional.

View menu: Special applications — None, API only, or ED only

View Menu

l
[ [ \

Active Alarm Log ‘ ‘ Process Monitoring ‘ ‘ Process Totalizers ‘

!—1 { - \

Screen1 12 13 |4 |5 ‘ Process ‘ ‘ Inventory
’ | |
ar - Mass Total - Mass Inventory
Var
Var - Volume Total - Volume Inventory
- API Corr Volume Total" - API Cor Vol Inventory"

- ED Std Volume Total®

- ED Std Volume Inventory®
(<X >] - ED Net Mass Total®

- ED Net Mass Inventory®

- Freq Input Total

- Freq Input Inventory

[

[

[

|

Diagnostic Monitor ‘ ‘ Density Curves? ‘ LCD Options ‘ ‘ Applications List
| | | |

- Tube Frequency . Curve 1 name® - Contrast -1/0
- Left Pickoff . Curve 2 name® - LCD Backlight - Core processor version
- Right Pickoff ) -API®
- Drive Gain - Enhanced Density®
- Live Zero
- Temperature

(1) Displayed only if the petroleum measurement application is installed.
(2) Displayed only if the enhanced density application is installed.
(3) Only configured curves are listed.
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Series 3000 Menu Flowcharts

View menu: Special applications — Custody transfer (OIML)
(Discrete batching, API, and ED optional)

View Menu
|
Active Alarm Log ‘ ‘ Process Monitoring ‘ ‘ Preset Selections!" ‘ ‘ Batch Inventory!"
Screen1 |2 |3 5 Preset 1 name® Preset 1 name®

Preset 2 name®

Preset 2 name®

Var
Var
Var
< X >
I I
‘ Transfer Totalizer ‘ ‘ Transfer Log
I
I I I
Transfer ‘ ‘ Inventory ‘Transfer & Inventory - Current BOL

- Current BOL
- Mass Transfer
- Volume Transfer

- Current BOL
- Mass Inventory
- Volume Inventory

- Current BOL

- Mass Transfer

- Mass Inventory

- Volume Transfer
- Volume Inventory

API Transfer & Inventory®

‘ ‘ ED Transfer & Inventory®

- Current BOL
- API Corr Vol Transfer
- API Cor Vol Inventory

- Current BOL

- ED Net Mass Transfer
- ED Net Mass Inventory
- Volume Transfer

- Volume Inventory

- ED Concentration

- Select BOL to view

Diagnostic Monitor ‘ ‘ Density Curves® ‘ ‘

LCD Options

Applications List

- Tube Frequency
- Left Pickoff

- Curve 1 name®

6)

I
- Contrast
- LCD Backlight

-1/0
- Core processor version

- Curve 2 name'

- Right Pickoff =1

. Dlrive Gain - Enhanced Density®

- Live Zero - Weights & Measures®
- Temperature

(1) Displayed only if the discrete batch application is installed.

(2) Only configured presets are listed.

(3) Displayed only if the petroleum measurement application is installed and approved for custody transfer.
(4) Displayed only if the enhanced density application is installed and approved for custody transfer.

(5) Displayed only if the enhanced density application is installed.

(6) Only configured curves are listed.

(7) Displayed only if the petroleum measurement application is installed.

(8) If World Area is set to OIML, the custody transfer application version is displayed.
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View menu: Special applications — Discrete batch (no custody transfer) or discrete batch with 3
custody transfer (NTEP) (API and ED optional) &
o
=
View Menu g
(7
l I
[ [ [ | s
Active Alarm Log ‘ ‘ Process Monitoring ‘ ‘ Preset Selections ‘ ‘ Batch Inventory ‘ %
’_1 ‘ @
—
(=}
Screen1 |2 |3 |4 |5 Preset 1 name!" Preset 1 name!" ©
Preset 2 name'” Preset 2 name'"
Var
Var
Var
| \
‘ Process Totalizers ‘ ‘ Density Curves® ‘ -
[ o
Q0
[ | ‘ <
Process ‘ ‘ Inventory - Curve 1 name® 5
‘ ‘ - Curve 2 name g..
- Mass Total - Mass Inventory ] §
- Volume Total - Volume Inventory =
- API Corr Volume Total® - API Cor Volume Inventory® g
- ED Std Volume Total® - ED Std Volume Inventory®
- ED Net Mass Total® - ED Net Mass Inventory®
- Freq Input Total - Freq Input Inventory
{ [ |
‘ Diagnostic Monitor ‘ ‘ LCD Options ‘ ‘ Applications List ‘
- Tube Frequency - Contrast - 110
- Left Pickoff - LCD Backlight - Core processor version
- Right Pickoff - API®
- Drive Gain - Enhanced Density®
- Live Zero - Discrete Batch ()
- Temperature g._
(1) Only configured presets are listed. %

(2) Displayed only if the petroleum measurement application is installed.
(3) Displayed only if the enhanced density application is installed.
(4) Only configured curves are listed.

F.5 Management menus
The Management menu system is illustrated in Figures F-7 through F-13:

*  Figure F-7 shows the top level of the Management menu, plus the Security and Language
menus.

* Figures F-8 through F-12 show the Configuration menu. Note that the Digital Communication
menu structure changes according to the setting of the Protocol parameter.

*  Figure F-13 shows the Maintenance menu.
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Management menu - top level, Security menu, and Language menu

Management Menu

l

[ [

[

|

‘ Configuration ‘ ‘ Maintenance

Security

Language

See following pages See following pages

(1) Displayed only if the custody transfer application is
not installed.

(2) Displayed only if the custody transfer application is
installed.

(3) Displayed only if the custody transfer application is
configured for OIML.

(4) Displayed only if the discrete batching application
is installed.

(5) Displayed only if the petroleum measurement
application is installed.

(6) Displayed only if the enhanced density application
is installed.

\
Security
- Enable/disable
- Write Protect"
- Totalizer Reset!"

Passwords
- Maintenance
- Configuration

Weights & Measures®

- World Area

- Process Monitoring®

- Discrete Batch®®
.AP|(3)(5)

- Enhanced Density®'®

- Transmitter Checksum®
- Core Checksum®

- Switch Status

Alarm Log®
- Enable Alarm Password
- Alarm Log Password

Language
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Figure F-8  Gonfiguration menu
Management Menu
I
‘ Configuration ‘
[ I ——————————————— continued-—-———=————————-— >
‘ System ‘ ‘ Inputs ‘
I
I I I |
(Tag ‘ Core Processor ‘ Frequency Input Discrete Inputs External Inputs
(Time ( Flow Rate Units ( Discrete Input 1-2 ( Polling Variable 1-2
( Date ( Scaling Method ( Polarity ( Polling Control

( Alarm Severity
( Electronics Alarms
( Process Alarms
( Sensor Alarms
( Configuration Alarms

( Unit
(K-fa

( Frequency®
( Flow®
( Pulses/Unit®

s/Pulse®
ctor

Enable

Config Process Var
( Flow Variables
( Flow Damping
( Flow Direction
( Mass Units
( Mass Low Flow Cutoff
( Volume Flow Type
( Volume Unitst"
( Vol Low Flow Cutoff"
( Std Gas Volume Units®®
( Std Gas Volume Cutoff®
( Std Gas Density®
( Special Mass Units
( Special Volume Units'"
( Special Gas Std Units®
( Density
( Density Units
( Density Damping
( Density Cutoff
( Slug Low Limit
( Slug High Limit
( Slug Duration
( Temperature
( Temperature Units
( Temperature Damping

Discrete Inputs

( Start Zero

( Reset Mass Total

( Reset Volume Total

( Reset API Cor Vol Tot®

( Reset ED Std Vol Tot®

( Reset ED Net Mass Tot®
( Reset All Totals

( Start/Stop All Totals

( Polled Variable

( Pressure Compensation”’
( Pressure Units'”

( Flow Factor”

( Density Factor™

( Cal Pressure”

( Ext Temp Compensation®

Sensor Cal Data
( T-Series Setup®

Sensor Information
( Sensor Model No.
( Sensor Serial No.
( Sensor Material

( Sensor Flange
( Sensor Liner

,—Yes—l—No—I
(FCF ( Flow Cal
(FTG (D1-2
(FFQ (K1-2
(D14 (FD
(K1-4 ( Dens Temp Coeff
(FD ( Temp Cal Factor
(DT ( Temperature Slope
(DTG ( Temperature Offset
(DFQ1-DFQ2 ( Mass Factor
( Temperature Slope ( Density Factor
( Temperature Offset ( Volume Factor
( Mass Factor
( Density Factor
( Volume Factor

(1) Liquid volume; displayed only if Volume Flow Type = Liquid.
(2) Gas standard volume; displayed only if Volume Flow Type = Gas Standard.

(3) T-Series option displayed only if transmitter is not connected to sensor. The parameter list displayed depends on the

sensor type.
(4) Displayed only if the petroleum measurement application is installed.
(5) Displayed only if the enhanced density application is installed.
(6) Options displayed depend on Scaling Method.
(7) Displayed only if Polled Variable = Pressure.
(8) Displayed only if Polled Variable = Temperature.
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Configuration menu continued

Management Menu

‘ Configuration ‘

—————————— [ il F———————————continued———————————>
‘ Discrete Batch'" ‘ ‘ Measurements
[ ‘ { |
Flow Source Discrete Events AP|® Density Functions®
- Frequency Input - Discrete Event 1-5 - Table Type - Derived Variable
- Mass - Event Type - Temperature Units - DI Next Curve
- Volume - Process Variable - Density Units - Configure Curve
- HI PV Value® - Reference Temperature | |- Extrapolation Alarms
Control Options - LO PV Value? - Curve Fit Results
- Enable Batch
- Time Out

- No. of Stages

- No. of Decimals

- Reset on Start

- Count Up

- Enable End Warning
- Enable AOC

- Enable Overrun

- Lockout Target

- Maximum Target

- Ignore Source

- Alarms

- Configure Presets by

Configure Presets (1) Displayed only if the discrete batching application is installed.

- Preset 1-6 (2) Either or both are displayed, depending on Event Type.

- Enable Preset (3) Displayed only if the petroleum measurement application is installed.
-Name (4) Displayed only if the enhanced density application is installed.

- End Warning

- Target

- Overrun

Discrete Inputs
-End

- Inhibit Batch

- Inhibit Totalizer

- Reset

- Resume

- Start

- Stop

- Increment Preset
- Inhibit Flow
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Figure F-10 Configuration menu continued

Management Menu

‘ Configuration

________________________ I I ——continued—--»

Outputs ‘ Monitoring
[ I
| | | Screens 1-5
Discrete Outputs Milliamp Outputs Frequency Output - Variables 14
- Discrete Output 1-3 - Milliamp Output 1-2 - Flow Source
- Polarity - Fault Indication - Scaling Method Variables
- Assignment - Condition - Frequency® - Number of Decimals
- Fault Indication - Setting - Flow® - W&M Approval®
- Flow Switch Source" - Last Meas Val Timeout® - Pulses/Unit® - Label
- Flow Switch Setpoint" - Variable Assignment - Units/Pulse®
- Calibration Span - Max Pulse Width Update Period
-20 mA - Power
-4 mA - Polarity
- Low Flow Cutoff - Fault Indication
- Damping Seconds - Last Meas Val Timeout®
-4 mA Minimum
- 20 mA Maximum
+ Minimum Span

(1) Displayed only if Assignment = Flow Switch.

(2) One setting applies to both milliamp and frequency outputs.

(3) Options displayed depend on Scaling Method.

(4) Displayed only if the custody transfer application is installed and configured for OIML.

Figure F-11 Configuration menu continued

Management Menu

‘ Configuration ‘

‘ Digital Communication ‘

———-continued---->
Protocol=HART, Modbus RTU,

Modbus ASCII
Configure Bell-202 Device Setup Configure RS-485
- Polling Address - Fault Setting - Protocol
- Loop Current Mode - Description - HART
- Burst Mode - User Message - Modbus RTU
- Burst Command - HART QV - Modbus ASCII
- Burst Variable 1-4 - HART Device ID - Printer
- Transmitter Serial No - Configure Protocol
- Baud Rate
- Parity
- Data Bits
- Stop Bits
- Polling Address
- Byte Order
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o
.
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Configuration menu continued

Management Menu

‘ Configuration

‘ Digital Communication ‘

l

Protocol=Printer

Protocol=Printer
Discrete Batching

Protocol=Printer
Discrete Batching
Custody Transfer (NTEP)
|

Protocol=Printer
Custody Transfer (OIML)

]
Protocol=Printer
Discrete Batching

Custody Transfer (OIML/batch)
I

Configure RS-485
- Protocol (Printer)
- Configure Printer
- Printer Selection
- Pre Header Codes
- Header Line 1-2
- Footer
- Post Footer Codes
- Baud Rate
- Parity
- Data Bits
- Stop Bits
- Chars Per Second
- Print Buf Size
- Lines Per Page
- Disable Paper Check
- Discrete Inputs
- Print Screen
- None
- Discrete Input 1-2
- Discrete Event 1-5
- Screens to Print
- Process Monitor
- Monitor Screen 1-5
- Batch Ticket
- All Config Data
- Active Alarm Log
- Alarm History
- Alarm Event Log
- Audit Event Log
- Print Process Monitor
- Printer Test

Configure RS-485
- Protocol (Printer)
- Configure Printer
- Printer Selection
- Pre Header Codes
- Header Line 1-2
- Footer
- Post Footer Codes
- Baud Rate
- Parity
- Data Bits
- Stop Bits
- Chars Per Second
- Print Buf Size
- Lines Per Page
- Disable Paper Check
- Discrete Inputs
- Print Screen
- None
- Discrete Input 1-2
- Discrete Event 1-5
- Batch Timeout
- Batch End Warn
- Batch Overrun
- Batch in Progress
- Batch Pump
- Batch Primary Valve
- Screens to Print
- Process Monitor
- Monitor Screen 1-5
- Batch Ticket
- All Config Data
- Active Alarm Log
- Alarm History
- Alarm Event Log
- Audit Event Log
- Print Process Monitor
- Printer Test

Configure RS-485
- Protocol (Printer)
- Configure Printer
- Printer Selection
- Header Line 1-2
- Footer
- Baud Rate
- Parity
- Data Bits
- Stop Bits
- Chars Per Second
- Print Buf Size
- Lines Per Page
- Number Of Tickets
- Auto Print
- Disable Paper Check
- Format W&M Ticket
- Header Line 1-4
- Footer
- Batch Start No. (BOL)
- Discrete Inputs
- Print Screen
- None
- Discrete Input 1-2
- Discrete Event 1-5
- Batch Timeout
- Batch End Warn
- Batch Overrun
- Batch in Progress
- Batch Pump
- Batch Primary Valve
- Screens to Print
- Process Monitor
- Monitor Screen 1-5
- Batch Ticket
- All Config Data
- Active Alarm Log
- Alarm History
- Alarm Event Log
- Audit Event Log
- Print Process Monitor
- Printer Test

(1) Displayed only if the petroleum measurement application is
installed and approved for custody transfer.

(2) Displayed only if the enhanced density application is installed and
approved for custody transfer.
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Configure RS-485
- Protocol (Printer)
- Configure Printer
- Printer Selection
- Header Line 1-2
- Footer
- Baud Rate
- Parity
- Data Bits
- Stop Bits
- Chars Per Second
- Print Buf Size
- Lines Per Page
- Format W&M Ticket
- Header Line 1-4
- Transfer Ticket
- Transfer Start (BOL)
- Transfer Print Cond.
- Transfer Form Feed
- Alarm Occurred
- Num. Transfer Tickets
- Footer
- Discrete Inputs
- Transfer Print Screen
- None
- Discrete Input 1
- Discrete Input 2
- Transfer Screen To Print
- Transfer Totals
- Inventory
- Transfer & Inventory
- API Transfer & Invt"
- ED Transfer & Inv®?
- Print Screen
- None
- Discrete Input 1-2
- Discrete Event 1-5
- Screens to Print
- Process Monitor
- Monitor Screen 1-5
- Batch Ticket
- All Config Data
- Active Alarm Log
- Alarm History
- Alarm Event Log
- Audit Event Log
- Print Process Monitor
- Printer Test

Configure RS-485
- Protocol (Printer)
- Configure Printer
- Printer Selection
- Header Line 1-2
- Footer
- Baud Rate
- Parity
- Data Bits
- Stop Bits
- Chars Per Second
- Print Buf Size
- Lines Per Page
- Number Of Tickets
- Auto Print
- Format W&M Ticket
- Header Line 1-4
- Transfer Ticket
- Transfer Start (BOL)
- Transfer Print Cond.
- Transfer Form Feed
- Alarm Occurred
- Num. Transfer Tickets
- Footer
- Batch Start No. (BOL)
- Discrete Inputs
- Transfer Print Screen
- None
- Discrete Input 1
- Discrete Input 2
- Transfer Screen To Print
- Transfer Totals
- Inventory
- Transfer & Inventory
- API Transfer & Inv("
- ED Transfer & Inv®
- Print Screen
- None
- Discrete Input 1-2
- Discrete Event 1-5
- Batch Timeout
- Batch End Warn
- Batch Overrun
- Batch in Progress
- Batch Pump
- Batch Primary Valve
- Screens to Print
- Process Monitor
- Monitor Screen 1-5
- Batch Ticket
- All Config Data
- Active Alarm Log
- Alarm History
- Alarm Event Log
- Audit Event Log
- Print Process Monitor
- Printer Test




Series 3000 Menu Flowcharts

Figure F-13 Maintenance menu

Management Menu

‘ Maintenance

Active Alarm Log ‘ Process Inventory ‘ ‘ Calibration ‘ ‘ Diagnostics ‘ ‘ Meter Verification”
I I I I
Alarm History Mass Inventory Sensor Zero Read External Inputs Uncertainty Limit
Volume Inventory - Zero Time - Discrete Input 1-2 Counter
API Cor Vol Inventory® - Mass Flow Rate - Frequency Input Start Meter Verify
ED Std Vol Inventory® - Calibrate Zero - External Pressure® - Fault

Alarm Event Log

ED Net Mass Inventory®

Freq Input Inventory

‘ Batch Inventory"

Audit Trail®

‘ Preset 1-6

Current Event Number
View Event
Date Search

- Restore Factory Zero
- View Current Data
Density
- Low Density

- Density

- D1

- Calibrate Density
- High Density

- Density

-D2

- Calibrate Density
- Flowing Density
- View Current Data
mA Output Trim
- Milliamp Output 1-2
- Trim 4.0 mA
- Trim 20.0 mA
Batch AOC"
Temperature
- Low Temperature
- High Temperature
- View Current Data
Density Curve Trim®
- Curve x

- ED Trim Offset

- ED Trim Slope

- External Temperature®
Simulate Outputs

- Discrete Output 1-3

- Milliamp Output 1-2

- Frequency Output

- Hold Last Value

(1) Displayed only if the discrete batching application is installed.
(2) Displayed only if the custody transfer application is installed.

(3) Displayed only if the petroleum measurement application is installed.

(4) Displayed only if the enhanced density application is installed.
(5) Displayed only if polling for pressure is configured.

(6) Displayed only if polling for temperature is configured.

(7) Displayed only if the meter verification option is available.
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ProLink Il and Pocket ProLink

G.1

G.2

Overview

ProLink II is a Windows-based configuration and management tool for Micro Motion transmitters. It
provides access to most Series 3000 functions and data. Pocket ProLink is a version of ProLink II that
runs on a Pocket PC.

Note: Not all Series 3000 features and functions are available via ProLink II. For complete access,
use the Series 3000 display menus.

This appendix provides basic information for connecting and using ProLink II with your Series 3000
device. The following topics and procedures are discussed:

* Requirements — see Section G.2

*  Configuration upload/download — see Section G.3

*  Connecting to a Series 3000 device — see Section G.4

*  ProLink II menus for Series 3000 devices — see Section G.4

For more information on installing or using ProLink II, see the ProLink II manual. For more
information on installing or using Pocket ProLink, see the Pocket ProLink manual. Instructions in this
appendix will refer only to ProLink II.

Requirements
To use ProLink II with a Series 3000 device, the following are required:
e ProLink II v2.5 or later for most basic functions
e ProLink II v2.9 or later for the most recent Series 3000 enhancements
*  One of the following ProLink II installation kits:
- RS-232 to Bell 202 (HART) converter with tester and cables
- RS-232 to RS-485 (Modbus or HART) converter with tester and cables
- USB to Bell 202 (HART) converter with tester and cables
- USB to RS-485 (Modbus or HART) converter with tester and cables

Note: Windows drivers are required for correct operation of the USB converters. The drivers are
provided with the USB installation kits. Install the driver before connecting the converter or adapter.
If you do not, Windows will not recognize the device when it is plugged in.

Note: If you are using the enhanced core processor and you connect directly to the core processor’s
RS-485 terminals, instead of to the transmitter, ProLink Il v2.4 or later is required. This connection
type is sometimes used for troubleshooting.
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ProLink Il and Pocket ProLink

G.3

G.4

290

ProLink Il configuration upload/download

ProLink II provides a configuration upload/download function which allows you to save configuration
sets to your PC. This allows:

* Easy backup and restore of device configuration
* Easy replication of configuration sets

Micro Motion recommends that all Series 3000 configurations be downloaded to a PC as soon as the
configuration is complete.

To access the configuration upload/download function:
1. Connect ProLink II to your Series 3000 device as described in this chapter.
2. Open the File menu.
* To save a configuration file to a PC, use the Load from Xmtr to File option.

* Torestore or load a configuration file to a Series 3000 device, use the Send to Xmtr from
File option.

Connecting from a PC to a Series 3000 device
For a Series 3000 device, ProLink II supports the following connection types:
* HART/Bell 202
e HART/RS-485
*  Modbus/RS-485
* Service port (specialized Modbus/RS-485)

Notes: Due to the design of HART protocol, connections made using HART protocol are slower than
connections that use Modbus protocol. If you use HART protocol, you cannot open more than one
ProLink Il window at a time.

The RS-485 terminals are available in service port mode only for the first 10 seconds after power-up.
If a service port connection is made during that period, the terminals remain in service port mode
until power is cycled. If no connection is made during that period, they revert to standard
Modbus/RS-485 mode using the RS-485 parameters configured in the Series 3000 device.

To connect to the Series 3000 device:
1. Determine the connection type you will use.
2. Identify the terminals for that connection type:
e All Bell 202 connections use the primary mA output terminals.
* All RS-485 connections use the RS-485 terminals.

See Figure 2-2 for the location of the terminal blocks on the different Series 3000 devices. See
Figure 2-3 to identify the terminals.

3. Connect the appropriate signal converter to your PC’s serial or USB port, using adapters as
required.

4. Connect the two leads of the signal converter leads to the appropriate terminals, or to any point
on the network.
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ProLink Il and Pocket ProLink

5. Add resistance as required.

* For HART/Bell 202 connections, the signal converter must be connected across a
resistance of 250-600 Q. See the ProLink II manual for more information.

*  For RS-485 connections, additional resistance may or may not be required. See the
ProLink II manual for more information.
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6. Start ProLink II and click Connection > Connect to Device. In the Connect dialog box:

a. Select the protocol for your connection type. The ProLink II dialog box is updated to
reflect your choice.

b. Set other required parameters.
c. Click Connect.

7. If you are using an RS-485 connection, the RS-485 terminals may not be in the desired mode.
To change mode:

a. Power-cycle the device.

b. To connect in service port mode, click Connect within the 10-second interval after
power-up.

c. To connect in RS-485 mode, wait more than 10 seconds, then click Connect.

G.5 ProLink Il menu flowcharts

This section contains flowcharts for the ProLink II main menu and the configuration menu. These
flowcharts are based on:

e ProLink II v2.6

e Series 3000 device software rev7.0
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ProLink Il and Pocket ProLink

ProLink Il main menu

File View Connection ProLink Tools Plug-ins
| | | |
Load from Xmtr to File Connect to Device Gas Unit Configurator Data Logging'"
Save to Xmtr from File Disconnect
Meter Verification Enable/Disable
License Custody Transfer
Options
* ProLink Il Language
* Error Log On
Preferences
» Use External Temperature

» Enable Inventory Totals Reset
* Enable External Pressure Compensation
* Copper RTD

Configuration

Output Levels
Process Variables
Status

Alarm Log

Diagnostic Information
Calibration

Test

ED Totalizer Control
Totalizer Control

Core Processor Diagnostics
Finger Print

API Process Variables
ED Process Variables
PPI Variables

Batcher Control

Installed options

(1) For information about using Data Logger, refer to the ProLink Il manual.
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ProLink Il and Pocket ProLink

Figure G-2  ProLink Il configuration menu

ProLink >

Configuration

——————— Additional configuration options-—————-
Flow Density Temperature Pressure
* Flow direction * Density units » Temp units * Flow factor

* Flow damp

* Flow cal

* Mass flow cutoff

* Mass flow units

« Vol flow cutoff”

« Vol flow units™

« Vol flow type

« Std gas vol flow cutoff®®
- Std gas flow units®

- Std gas density®

Gas wizard®
« Mass factor
« Dens factor

« Vol factor

« Flow switch variable
* Flow switch setpoint

+ Density damping
* Slug high limit

* Slug low limit

* Slug duration

* Low density cutoff
* K1

* K2

*FD

* D1

+D2

» Temp coeff (DT)

» Temp cal factor
* Temp damping
» External temperature

* Dens factor

« Cal pressure

* Pressure units

« External pressure

T Series

*FTG
*FFQ
DTG
*DFQ1
*DFQ2
* K3
+D3

+ D4

* K4

Device

* Tag

* Date

* Descriptor

* Message

* Sensor type

*» Transmitter serial number
« Floating pt ordering

* Add comm resp delay

Restore factory configuration

Digital comm settings

* Fault setting

* HART address

* Loop current mode

* HART device ID

* Modbus address

» Enable write protection

Update rate
* Response time

Burst setup

* Enable burst
* Burst cmd
*Burstvar 1...4

Display

Screen 1
*Var1..4

Screen 2
*Var1..4

Screen 3
*Var1..4

Screen 4
*Var1..4

Screen 5
*Var1..4

Display precision

«Var

* Number of decimals

« Custody transfer approved

Display language

(1) Displayed only if Volume Flow Type = Liquid Volume.
(2) Displayed only if Volume Flow Type = Gas Standard Volume.
(3) Displayed only on systems with the enhanced core processor.

Configuration and Use Manual

293

o
=
o
c
5
=




ProLink Il and Pocket ProLink

ProLink Il configuration menu continued

ProLink >
Configuration
——————————— Additional configuration options- —————-———-»
Analog output Frequency Sensor simulation
Primary/secondary output « Tertiary variable » Enable/disable
*PV/SV is « Scaling method
* Lower range value * Freq factor Mass flow
» Upper range value * Rate factor » Wave form
* AO cutoff « Pulses per unit « Fixed value
* AO added damp « Units per pulse « Period
*LSL « Freq pulse width * Minimum
+ USL « Last measured value timeout * Maximum
* Min span « Freq output power
* AO fault action * Freq fault action Density
+ AO fault level * Freq fault level » Wave form
« Freq output polarity « Fixed value

* Last measured value timeout « Period

* Minimum

* Maximum

Temperature
Frequency input Discrete output Discrete input « Wave form

« Fixed value
* Scaling method Discrete output 1/2/3 Assignment « Period
* Freq factor + DO1/2/3 assignment « Minimum
* Rate factor * DO1/2/3 polarity Polarity « Maximum
* Pulses per unit » DO1/2/3 fault action « DI1 polarity
* Units per pulse « DI2 polarity
* K-factor
* Units

(1) Displayed only on systems with the enhanced core processor.
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Figure G-4  ProLink Il configuration menu continued

ProLink >

Configuration

System
Real-time clock

Security

» Enable security

» Maintenance password

+ Configuration password
« Enable alarm security!"
- Alarm password"

- Totalizer reset options'"

Weights and measures

* Approval

« Software rev

« Enable OIML CT approval for API®

« Enable OIML CT approval for ED®

* Enable OIML CT approval for process
monitor®

* Enable OIML CT approval for discrete
batcher®

Special units

« Base mass unit

* Base mass time

* Mass flow conv fact
* Mass flow text

* Mass total text

- Base vol unit®

- Base vol time®

« Vol flow conv fact®
- Vol flow text®

- Vol total text®

- Base gas vol unit®

« Base gas vol time'

« Gas vol flow conv fact®
« Gas vol flow text®

« Gas vol total text®

RS-485

* Protocol

* Baud rate
* Parity

* Stop bits

» Choose typical
HART settings

Discrete events

* Event name

» Event type

* Process variable
* Low setpoint (A)
* High setpoint (B)

Polled variables

Polled variable 1/2
« Polling control

« External tag

« Variable type

* Current value

Sensor

* Sensor s/n

» Sensor model
» Sensor matl

« Liner matl

* Flange

Variable mapping

*PVis
*SVis
*TVis
*QVis

Alarm

* Alarm
* Severity

(1) Available only if the custody transfer application is installed.
(2) Available only if Approval is set to OIML.

(3) Displayed only if Vol Flow Type is set to Liquid.

(4) Displayed only if Vol Flow Type is set to Gas Standard.
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ProLink Il configuration menu continued

ProLink >

Configuration

|| - Water reference density

API setup!”

* Table type
* Units

ED setup®

Global config

- Active curve

- Derived variable

- Reset all curve info

- Lock/unlock ED curves

Curve specific config

- Curve configured

- Curve name

- Reference temperature

- Water reference temperature

- Trim slope
- Trim offset

Extrapolation

- Alarm limit

- Enable density low

- Enable density high

- Enable temperature low
- Enable temperature high

Concentration
- Units
- Special unit string

Discrete batch®
Flow source

Control options

- Enable batch

- Count up

- Enable AOC

- Lockout target

- Auto print at batch end
- Reset on start

- Enable end warning

- Enable overrun

- Ignore source alarms
- No-flow timeout

- Number of stages

- Number of decimals

- Maximum target

- Alarm timeout

- Configure presets by

Configure presets
- Preset number

- Preset name

- Enable preset

- Open primary

- Open secondary
- Close primary

- End warning

- Density curve

- Overrun

- Preset target

ED curve®

Process fluid density at specified temperature
and concentration

- Curve being configured

- Curve fit max order

- Temperature isotherms

- Concentration points

- Curve data points

Curve fit results
- Accuracy

Process fluid density at reference temperature
and specified concentration

- Reference temperature

- Concentration points

- Curve data points

(1) Displayed only if the petroleum measurement application is installed.

(2) Displayed only if the discrete batch application is installed.
(3) Displayed only if the enhanced density application is installed.
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Printer

Printer

* Type

» Data bits

* Chars/sec

* Buffer size

* Disable paper out detection

Ticket

* Batch start number (BOL)

* No. of batch tickets

* Transfer start (BOL)

* Transfer type

* No. of transfer tickets

* Transfer type

» Use form feed

* Print with non-zero flow

» Alarm occurrence on transfer
ticket

Header and footer

* Pre header
eLine#1 ... #4
*Line feeds #1 ... #4
*Fontsize #1 ... #4
* Footer line

* Post footer

* Footer line feeds

* Footer font size

Print request configuration
* Process monitor with statistics
* Process monitor

* Monitor screen 1 ... 5

+ Batch ticket

« All configuration data

* Alarm history

* Active alarm log

* Audit trail event log

* Printer test

* Alarm event log




375 Field Communicator

1 jurjoid

H.1 Overview

This appendix provides basic information for connecting and using the 375 Field Communicator with
your Series 3000 device. The following topics and procedures are discussed:

* Requirements — see Section H.2
*  Connecting to a Series 3000 device — see Section H.3

¢ Communicator menus — see Section H.4

H.2 DD requirements

To use the 375 Field Communicator with a Series 3000 device, the following device description (DD)
must be loaded to your Communicator: Micro Motion 3000 Mass flo v7 DD v2
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This DD does not provide complete access to the Series 3000 features, functions, and data. For
complete access, use the Series 3000 display menus.

H.3  Connecting from the 375 Field Communicator to a Series 3000 device
To connect to the Series 3000 device:

1. Identify the primary mA output terminals on your Series 3000 platform.

o
See Figure 2-2 for the location of the terminal blocks on the different Series 3000 devices. See 3
Figure 2-3 to identify the terminals. s
2. Attach the leads from the Communicator to the primary mA output terminals. <=,'
3. Add resistance as required. g
4. Follow standard Communicator procedures to connect to the Series 3000 device.
H.4  Communicator menu flowcharts
This section contains flowcharts for most Communicator menus. These flowcharts are based on:
*  Micro Motion 3000 Mass flo v7 DD v2
* Series 3000 device software rev7.0
The flowcharts start from the Communicator Online menu.
g
g
<
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375 Field Communicator

Communicator Process Vars menu

On-Line Menu >
1 Process variables

T - —-Additional options--»

1 2
1 1
View fld dev vars View output vars
1 View basic vars 1 View PV-Analog 1
2 View external vars 2 View SV-Analog 2
3 View Fl vars 3 View TV-Freq/DO
4 View APl vars 4 View Qv
5 View ED vars 5 View discrete event
6 View batcher vars
1 Discrete event 1
1 Current ED curve 2 Discrete event 2
1 Mass flo 2 ED std vol flo 5— 3 Discrete event 3
2 Mass totl 3 ED std vol tofl 4 Discrete event 4
3 Mass inventory 4 ED std vol inv 5 Discrete event 5
| 1|4 Temp 5 ED net mass flo
5 Dens 6 ED net mass totl
6 Vol flo I-5— 7 ED net mass inv Value
7 Vol ,tOtl 8 ED net vol flo Type .
8 Vol inventory 9 ED net vol tol Setpo!nt A
ED net vol inv Setpoint B
ED dens at ref Status
e 1 Pressure ED dens (SGU)
2 Temp ED dens (Baume)
1 Fl flow rate ;
|3 12 Fl total 1 name unit
3 Flinv 2 Batch total
3 Batch target
4 Preset 1 inv
1 TC Dens L_6— 5 Preset 2 inv
2 TC vol 6 Preset 3 inv
3 TC vol totl T'Preset 4 inv
4 4 TC vol inv 8 Preset 5 inv
5TC avg temp 9 Preset 6 inv
6 TC avg dens
7 CTL
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375 Field Communicator

Figure H-2  Communicator Process Vars menu continued

On-Line Menu >
1 Process variables

2 ! 2 i
|
View status Totlizer contrl Batcher cntrl Custody trf tot reset
opt
1 Mass totl 1 None unit
2 Vol totl 2 Batch total
3 Start totalizer 3 Batch target
4 Stop totalizer 4 Batcher cntrl
5 Reset all totals
6 Reset mass total
7 Reset volume total 1 Start batch
2 Stop batch
3 End batch

4 Inhibit batch

5 Resume batch

6 Reset batch

7 Inhibit totalizer
8 Print batch ticket
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375 Field Communicator

Communicator Diag/Service menu

On-Line Menu >
2 Diag/Service

1 2 3 4
| | 1 |
Test/Status Calibration Perform diagnostic action Loop test
1 View status 1 Auto zero 1 Reset alarm log 1 Fix analog out 1
2 Self test 2 Density cal 2 Acknowledge all alarms 2 Fix analog out 2
3 Meter verification 3 Reset Power On time 3 Fix frequency out
- 4 Restore factory configuration 4 Fix discrete out 1
5 Reset all ED curve information 5 Fix discrete out 2
6 Enable write protect 6 Fix discrete out 3
7 Disable write protect
8 Restore factory zero
9 Exit
[ T T 1
5 6 7 8
| | | |
Trim outputs Read outputs Read inputs Test points
1 Trim Analog out 1 1 Pres freq 1 Read discrete in 1 Status words
2 Trim analog out 2 2 Read DO 1 2 Read DI 2 2 LPO
3 Scaled AO1 trim 3 Read DO 2 3 Fl freq 3 RPO
4 Scaled AO2 trim 4 Read DO 3 4 Tube
5 Drive

6 Board temperature
7 Meter temp. T-Series
8 Live zero flow
9 Input voltage
Actual target amplitude
Average sensor temp
Min sensor temp
Max sensor temp
Max electronics temp
Min electronics temp
Average electronics temp
Wire RTD
Meter RTD
Line RTD
Power cycle count
Power on time
Drive current
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375 Field Communicator

Figure H-4  Communicator Basic Setup menu

On-Line Menu >

3 Basic Setup
r T T |
1 2 4 6
] ] | 1
Tag PV unit 3 SV unit 5 Freq scaling
1 FO scale method
- Freq = flow
- Pulses/Unit
Anlog 1 | Anlog 2 |
nlog 1 range values nlog 2 range values . Units/Pulse
1PV URV 1PV URV T
2PV LRV 2 PV LRV 2 FO scaling
- TV freq factor
- TV rate factor
- TV pulses/unit

(1) Options displayed depend on FO Scale Method.
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375 Field Communicator

Communicator Detailed Setup menu

On-Line Menu >
4 Detailed Setup

1
I

Charize sensor

1 Sensor selection

2 Flow

3 Density

4 Temp cal factor

5 Pressure compensation
6 Meter factors

7 Polling setup

8 External temp

1 T-Series
2 Other 1 Mass factor

6— 2 Vol factor
3 Dens factor

1 FlowCal"

L2— 1 FCF® 1 Poll control
2FTG? 2 External device tag 1
3 FFQ@ —7— 3 Polled var 1

4 External device tag 2
5 Polled var 2

1D1
2 K1
3D2 o~ | 1 Enable ext temp

4 K2 2 Static temperature
5 Temp coeff(”
5DTG?

6 FD"

-3— 6 DFQ1?

7 DFQ2?®
8DT?®

9FD?®

.D3@

. K3®

. D4®@

. K4®

1 Enable pressure
2 Flow factor

L5— 3 Dens factor

4 Flowcal pressure
5 Static pressure

(1) All sensors except T-Series.
(2) T-Series sensors only.

302

r—————- Additional options——---- >
2
|
Config fld dev vars
1 Flow
2 Density
3 Temperature
4 Pressure
5 API
6 Batcher
1 Mass flow unit
2 Mass flow cutoff
3 Spcl mass units
L 4 Vol flow unit 1 Current preset
5 Vol flow cutoff 2 Batch flow source
6 Spcl vol units 3 Batch timeout
7 Flo direction 4 Reset on start
8 Flo damp 5 Counting up
6 Ignore alarms
6— 7 Alarm timeout
8 Preset 1 setup
9 Preset 2 setup
1 Density unit Preset 3 setup
2 Density damp Preset 4 setup
L, 3 Density cutoff Preset 5 setup
4 Slug low limit Preset 6 setup
5 Slug high limit
6 Slug duration
1 Enabled
2 Target
| 3| 1 Temp unit 3 Source units
2 Temp damp 4 ED curve
4— 1 Pressure unit
1 API setup
2 Enable API
L-5— 3 API 2440 CTL table (read-only)
4 API thermal exp (read-only)
5 API ref temp (read-only)
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375 Field Com

municator

Figure H-6 Communicator Detailed Setup menu continued

On-Line Menu >
4 Detailed Setup

3
1

4 HART

6 Fault ti

Config outputs
1 AO setup
2 FO output
3 DO setup

5 RS485 setup

output

meout

i Additional options———»

Config inputs

1 Discrete actions
2 Dl setup
3 Fl setup

1PVis

2 Range values

3 PV AO cutoff

4 PV AO added damp

5 AO1 fault setup

6 SVis

7 Range values

8 SV AO2 cutoff

9 SV AO added damp
AO2 fault setup

1 Var assignment
2 Poll addr

3 Num preambles
4 Burst mode

IS

1TVis

2 FO scale method‘"
3 TV freq factor

4 TV rate factor

5 Max pulse width

6 FO fault indicator
7 FO fault value

5 Burst option
6 Burst var 1
7 Burst var 2
8 Burst var 3
9 Burst var 4

1 Assign discretes

2 Read action assign (read-only)
] 3 Action assignments (read-only)
4 PrintScreen assign

1PVis
28Vis
3TVis
4 QVis

1—

1 RS485 protocol
2 RS485 baudrate
3 RS485 parity

1DO1is

2 DO1 polarity

3 DO1 fault indicator
4DO02is

5 DO2 polarity

6 DO2 fault indicator
7 D03 is

8 DOS polarity

9 DO3 fault indicator

—5— 4 RS485 stop bits

7 Printer setup

5 Modbus address
6 Comm fault indicator

1 Start sensor zero

2 Reset mass total

3 Reset volume total

4 Reset API ref vol

5 Reset all totals

6 Reset ED ref vol

7 Reset ED net mass

8 Reset ED net vol

9 Start/stop all totals
End batch
Inhibit batch
Inhibit batch tot
Reset batch
Resume batch
Start batch
Stop batch
Increment preset
Increment ED curve
Print screen

S

Process monitor
Batch ticket

All config data
Alarm history
Active alarm log
Audit trail

1 DI1 polarity
2 DI2 polarity

1 FI scale method""
2 Freq factor

L-3— 3 Rate factor

4 Fl unit

5 K factor

(1) Options displayed depend on FO or FI Scale Method.
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375 Field Communicator

304

Communicator Detailed Setup menu continued

On-Line Menu >
4 Detailed Setup

T
5
|

Device information

1 Tag

2 Descriptor

3 Message

4 Date

5 Device id

6 Final assembly num

7 Sensor s/n

8 Sensor model

9 Output option board
Construction materials

6 7

1 1
Config discrete event Config alarms
1 Discrete event 1 1 Write severity
2 Discrete event 2 2 Read severity (read-only)
3 Discrete event 3 3 Review severity
4 Discrete event 4 4 Acknowledge the selected alarm
5 Discrete event 5 5 Alarm history

6 Refresh alarm history

1 Discrete event var
2 Discrete event type

o 3 Setpoint A
Revision #s 4 Setpoint B
Real-time clock
| T
8 9
| |
Display setup Setup simulation mode Modbus data
1 Enable/disable 1 Simulation mode enable/disable 1 Read Modbus data value
2 Display variables 2 Simulate mass flow 2 Write Modbus data value
3 Display precision 3 Simulate temperature

_ |1 Update period
2 Display language

1 Screen 1, Line 1
2 Screen 1, Line 2

Screen 5, Line 4

1 Var code varx
L_3— 2 Precision varx

4 Simulate density

5 Mass flow simulation mode (read-only)

6 Mass flow fixed value (read-only)

7 Mass flow minimum amplitude (read-only)

8 Mass flow maximum amplitude (read-only)

9 Mass flow period of waveform (read-only)
Temperature simulation mode (read-only)
Temperature fixed value (read-only)
Temperature minimum amplitude (read-only)
Temperature maximum amplitude (read-only)
Temperature period of waveform (read-only)
Density simulation mode (read-only)

Density fixed value (read-only)

Density minimum amplitude (read-only)
Density maximum amplitude (read-only)
Density period of waveform (read-only)
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Appendix |
Sample Tickets

1.1 Overview
This appendix provides sample tickets for the following ticket types:
* Standard tickets
- Process monitor tickets — see Figure I-1
- Alarm tickets — see Figure I-2
- Configuration ticket and audit event log ticket — see Figure I-3
* Batch tickets — see Figure [-4
e Batch (NTEP) tickets
- Original tickets — see Figure 1-5
- Duplicate tickets — see Figure I-6
¢ Transfer (OIML) tickets
- No alarm banner — see Figure I-7
- Alarm banner — see Figure I-8
- Process variable approved — see Figure 1-9
¢ Batch (OIML) tickets
- Original tickets — see Figure I-10
- Duplicate tickets — see Figure I-11
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Sample Tickets

1.2

Standard tickets

Typical process monitor tickets

No custody transfer
With Stats

Custody transfer installed
Without Stats

HEADER 1
HEADER 2

M. RESET

29-SEP-2003 10:58:27
Mass Flow Rate

g/s

Current Value:0.000000
Average:-0.043297
Maximum:56:830570
Minimum:-0.145275

Mass Total

9

Current Value:628050.562500
Volume Flow Rate

1/s

Current Value:0.000000
Average:-0.000035
Maximum:0.046584
Minimum:-0.000107

Volume Total

1

Current Value:744.410522
Density

g/cm3

Current Value:1.219813
Average:1.219888839
Maximum:1.262375
Minimum:1.216220

FOOTER

Not A Legal Receipt

HEADER 1
HEADER 2

M. RESET

29-SEP-2003 10:58:27
Mass Flow Rate

g/s

Current Value:0.000000

Mass Total

9

Current Value:628050.562500
Volume Flow Rate

1/s

Current Value:0.000000
Volume Total

1

Current Value:744.410522
Density

g/cm3

Current Value:1.219813
FOOTER

Not A Legal Receipt
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Figure I-2  Typical alarm tickets

Active alarm log

Alarm history

HEADER 1
HEADER 2

M. RESET

29-SEP-2003 13:27:33
Active Alarm Log

Temp. Out-of-Range

INFO 17-JAN-07 14:14:53
Sensor RTD Error

INFO 17-JAN-07 14:14:53
Meter RTD Error

INFO 17-JAN-07 14:14:53
API: Temp Overrange
FAULT 17-JAN-07 14:14:53
FOOTER

Alarm event log

HEADER
HEADER

M. RESET
29-SEP-2003 13
Historical Alarm Log
Drive Overrange
Cnt 13
Post 29-SEP-3
Clr 29-SEP-3
Security Breach
Cnt 11
Post 29-SEP-3
Clr 29-SEP-3
Xmtr Initializing
Cnt 10
Post 29-SEP-3
Clr 29-SEP-3
FOOTER

:27:

13
13

11:
11:

13
13

33

127
127

02
03

127
127

HEADER 1
HEADER 2

M. RESET

28-MAR-2007 16:36:45
Alarm Event Log

Drive Overrang

Post: 28-MAR-07 16:36
Power Reset

Clr: 28-MAR-07 16:36
Power Reset

Post: 28-MAR-07 16:36
Security Breach

Post: 28-MAR-07 16:36
FOOTER

Configuration and Use Manual
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Sample Tickets

Configuration ticket and audit event log ticket

M.RESET HEADER 3
29-SEP-2003 1:05:03 HEADER 4
::Frequency Output:: M. RESET
0 29-SEP-2003 1:05:03
FO Active Audit Trail
1 001 4-JAN-2003 15:58:58
FO Polarity MAO1l Source
1 0
FO Flow Source 001 4-JAN-2003 15:58:58
0 MAO2 Source
FO Fault Frequency 0
15000.000000 001 4-JAN-2003 15:59:01
FO Frequency Factor FO Flow Source
1000.000000 5
Coe 001 4-JAN-2003 15:59:01:
FOOTER Flow Direction
2
FOOTER

For the tickets shown in Figure I-3, codes are used for all items which are selected from a selection
list. For example, FO Flow Source code O represents mass flow rate, and FO Flow Source code 5
represents volume flow rate.

Selection lists and codes are documented in the following manuals:

e Using Modbus Protocol with Micro Motion Transmitters, November 2004, P/N 3600219,
Rev. C (manual plus map)

*  Modbus Mapping Assignments for Micro Motion Transmitters, October 2004, P/N 20001741,
Rev. B (map only)

In the audit event log ticket:
* The first date and time represent the time at which the ticket print job was initiated.

*  All other dates and times represent the time at which the configuration parameter was
changed.
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1.3 Batch tickets

Typical batch tickets

Custody transfer application not installed

Custody transfer application installed,
discrete batch application not approved

HEADER 1
HEADER 2

M. RESET
29-SEP-2003 11:05:01
Preset 1
Units: g
Actual: 1324.5
Target: 1300.9 g

FOOTER

1.4 Batch (NTEP) tickets

Original tickets

Data secured

Not A Legal Receipt

HEADER 1
HEADER 2

M. RESET
15-MAR-2005 11:05:01
Preset 1
Units: g
Actual: 13245 ¢
Target: 1300.9 g

FOOTER
Not A Legal Receipt

Data unsecured

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Total:  1162.0591 ¢

Batch Count: (8)
FOOTER

Configuration and Use Manual

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Total: 13245 ¢

Batch Count: (9)

SECURITY BREACH
Not A Legal Receipt

FOOTER

309

1 jurjoid

101E2IUNWWOY Plold SLE

[72)
Q
3
8
)
o
)
=
o
o
(7]

sjage Aisjes



Sample Tickets

Duplicate tickets

Data secured

Data unsecured

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Total: 1162 0591 ¢

Batch Count:

DUPLICATE RECEIPT

FOOTER

310

Transfer (OIML) tickets

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Total: 13245 g

Batch Count:

DUPLICATE RECEIPT
SECURITY BREACH
Not A Legal Receipt

FOOTER

For the tickets shown in Figure I-7, there is no way to distinguish between the following:

No alarm occurred.

An alarm occurred (possibly a security breach), but the Alarm Occurred parameter was

disabled.

For the tickets shown in Figure I-8, the alarm may or may not be a security breach. The security

breach banner will appear on the Series 3000 display, if appropriate.
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Figure -7 No alarm banner

Transfer complete

Transfer incomplete

HEADER
HEADER

Transfer (BOL):
31 Complete

Mass Transfer

1
2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

* 0.906 kg*
Volume Transfer

* 0.3 US gal*
FOOTER

Configuration and Use Manual

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Transfer (BOL):
500 Not Complete

Mass Flow Rate
0.0513 g/s
Volume Flow Rate
0.0001 1/s
Mass Transfer
53434.1016 g

Volume Transfer
60.3386 1

FOOTER
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Sample Tickets

Alarm banner

Transfer complete

Transfer incomplete

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Transfer (BOL):
36 Complete

Mass Transfer
* 0.000 kg*
Mass Inventory
297.18 kg

Volume Transfer
* 0.0 US gal*
Volume Inventory

137.3086 US gal

Alarm occurred during the
Transfer.

FOOTER

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Transfer (BOL):
501 Not Complete

Mass Flow Rate
0.0513 g/s
Volume Flow Rate
0.0001 1/s
Mass Transfer
53434.1016 g
Volume Transfer
70.3386 1

Alarm occurred during the
Transfer.

FOOTER
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Figure I-9  Process variable approved

Approved variable: Mass total
Transfer complete

Approved variable: Volume total
Transfer incomplete

HEADER 1
HEADER 2

HEADER
HEADER
M. RESET

28-MAR-2007 16:42:01
Transfer (BOL):
2 Complete
Mass Flow Rate

0.0000 kg/s
Volume Flow Rate

0.0000 1/s

Mass Transfer
* 5.1050 kg*
Volume Transfer

5.1718 1

FOOTER

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
28-MAR-2007 16:41:43

Transfer (BOL):
2 Not Complete

Mass Flow Rate

0.1007 kg/s
Volume Flow Rate

0.1020 1/s
Mass Transfer

5.1050 kg
Volume Transfer

5.1718 1

FOOTER

1.6 Batch (OIML) tickets

Figure I-10  Original tickets

Data secured

Data unsecured

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Total:  1162.0591 g

Batch Count: (8)
FOOTER

Configuration and Use Manual

HEADER 1
HEADER 2

HEADER
HEADER

M. RESET
15-MAR-2005 10:57:23

Total: 13245 ¢

Batch Count: (9)

SECURITY BREACH
Not A Legal Receipt

FOOTER
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Sample Tickets

Duplicate tickets

Data secured

HEADER 1
HEADER 2

HEADER
HEADER 4
M. RESET

Total  1162.0591 g
DUPLICATE RECEIPT

FOOTER

314

Data unsecured

HEADER 1
HEADER 2

HEADER
HEADER 4
M. RESET

Total 13245

DUPLICATE RECEIPT
SECURITY BREACH
Not A Legal Receipt

FOOTER
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Label Maintenance and Replacement

J.1 Maintaining and replacing labels

Micro Motion product safety labels have been designed in accordance with the voluntary standard
ANSI 7535.4. If the labels illustrated below are illegible, damaged, or missing, promptly have new
ones installed.

Contact Micro Motion for replacement labels. Contact information is provided on the title page of this
manual.

J.2 Labels on the device
The Series 3000 platform may include the safety labels illustrated below.

Safety labels

A WARNING - EXPLOSION HAZARD
Do not disconnect or remove equipment connections
unless power has been turned off or the area is
known to be non-hazardous.

Label number 3300215 Substitution of components may impair suitability
for Class 1, Division 2.

A\ AVERTISSEMENT - RISQUE D'EXPLOSION

Avant de déconnecter ou retirer I'equipement, couper le courant
ou s'assurer que I'emplacemant est désigné non dangereux.
La substitution de composants peut rendre ce matériel

inacceptable pour les emplacements de Classe 1, Division 2.
\_ PN 3300215 Rev. A GD

4 A\ WARNING )

Explosion Hazard.
Substitution of components
may impair intrinsic safety.

A\ AVERTISSEMENT
Risque d'Explosion.

La substitution de composants
\_ Pn3ioosssrev. 8 | peut compromettre la sécurite intrinséque. J

Label number 3100436

( AWARNING )

Using a dry cloth to clean the display
cover can cause static discharge, which
could result in an explosion in an
explosive atmosphere.

Label number 3300709

To prevent an exEIosion, use a clean, damp
cloth to clean the display cover in an
\explosive atmosphere. y

Configuration and Use Manual 315
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Appendix K
Return Policy

K.1

K.2

K.3

Configuration and Use Manual

General guidelines

Micro Motion procedures must be followed when returning equipment. These procedures ensure legal
compliance with government transportation agencies and help provide a safe working environment for
Micro Motion employees. Failure to follow Micro Motion procedures will result in your equipment
being refused delivery.

Information on return procedures and forms is available on our web support system at
www.micromotion.com, or by phoning Micro Motion customer service.

New and unused equipment

Only equipment that has not been removed from the original shipping package will be considered new
and unused. New and unused equipment requires a completed Return Materials Authorization form.

Used equipment

All equipment that is not classified as new and unused is considered used. This equipment must be
completely decontaminated and cleaned before being returned.

Used equipment must be accompanied by a completed Return Materials Authorization form and a
Decontamination Statement for all process fluids that have been in contact with the equipment. If a
Decontamination Statement cannot be completed (e.g., for food-grade process fluids), you must
include a statement certifying decontamination and documenting all foreign substances that have
come in contact with the equipment.
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L.1 Overview
This appendix documents the change history of the Series 3000 MVD device software.

L.2 Software change history
Table L-1 describes the change history of the software. Operating instructions are English versions.

=

m

Series 3000 device software change history &

u

: 7}

Software Operating o

Date version Changes to software instructions <
10/2003 6.00 Initial release 20001266A
7/2005 6.10 Software expansion 20001266B

Independent reset of inventory totals
Added display of enhanced density curve fit result
Added support for Katakana language on the display

Added configurable pre-header and post-footer control codes for
printing

Software adjustment
Improved accuracy when batching on frequency input
Allow batch to be ended when flow is present
Clarified the behavior of certain Modbus calibration coils

xopu|

HART Tri-Loop and other communication improvements

HART support of concentration units

Clarified state of discrete outputs during device startup following a
power on condition.

Feature addition
Added support for FDW printer protocol
Added compliance with OIML custody transfer requirements
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NE 53 History

Series 3000 device software change history continued

Software Operating
Date version Changes to software instructions
3/2007 7.00 Software expansion 20001266C

Added flow switch to selection list for discrete output assignment

Added ability to configure discrete output fault indication
Added several HART and Modbus commands
Added ability to restore the factory configuration

Added ability to restore the factory zero value

Added alarm event log

Added ability to write protect configuration data

Added new items to selection list for mA output source assignment

Range values for mA output stored separately for each process
variable

Expanded custody transfer application for independent
implementation of NTEP and OIML compliance

Expanded custody transfer (OIML) features to include configurable
approval of discrete batcher, enhanced density, API, and process
monitor applications; added ability to mark OIML-approved process
variables with asterisks, added display of firmware checksum of core
processor and transmitter, added display of W&M version number,
expanded discrete output source selection to include PPI Display
Error, added configurable password protection of alarms menu

Added ability to configure the display update rate

Printer output expanded to include alarm event history

Expanded HART command 33 to include frequency input raw
frequency

Added ability to use discrete input to inhibit flow measurement by
discrete batcher

Added active enhanced density curve to selection list for process
monitor display variables

Added discrete events for Model 3300 controller

Added core processor ETO number to applications list on display

Added ability to configure Loop Current Mode

Added ability to configure text strings used to identify totals and
inventories

Added 304 Stainless Steel to selection of sensor material
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Series 3000 device software change history continued

Date

Software
version

Changes to software

Operating
instructions

Software adjustment

Clarified range checking when writing D1 and D2 values for T-Series
sensors

Clarified posting of Start Not Okay alarm

Allow discrete batch to be started when milliamp output is fixed

Allow batch target to be changed from batcher process screen when
no decimal point is displayed (precision set to zero)

Removed printing of character when power is cycled

Allow batch preset selection to be changed when device is secured for
custody transfer.

Clarified use of HART command 180 for Model 3300 controller for
writing output fault parameters

Clarified default derived variable when standard curves feature is
enabled

Expanded range of frequency input total and frequency input
inventory

Feature addition

Added configurable alarm severity

Added gas standard volume functionality

Added support for meter verification option

11/2009

8.00

Software expansion

Added Field Verification Zero process variable

Updated meter verification to add support for “continue measurement”
option, scheduling, and execution from a discrete input or discrete
event

Added user-configurable hysteresis to flow switch

Added ability to configure pre header and post footer printer codes
when the custody transfer application is enabled but the transmitter is
not secured

Software adjustment

20001266CA

Support for HART command 139 modified to include unit checking

Response to a Modbus write command to coil 34 modified so that an
A028 alarm is no longer generated

Feature addition

Added support for Marine Bunker Transfer Package (refer to the
manual entitled Series 3000 Transmitters: Marine Bunker Transfer
Package Supplement, available on the Micro Motion web site at
www.micromotion.com)

Configuration and Use Manual
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Numerics Application 2 g
20 mA value Applications list 148
configuration 67 ATEX 259, 261
troubleshooting 229 Model 3350 or Model 3700 257
375 Field Communicator 297 Model 3500 249
connecting to Series 3000 device 297 Audit trail 170
menu flowcharts 297 Auto print
requirements 297 batch (NTEP) tickets 125
4 mA value batch (OIML) tickets 131
configuration 67 batch tickets 122
troubleshooting 229 >
4-wire cable 10 B m
9-wire cable 10 Batch &
See Discrete batch application %
A Batch (NTEP) tickets 8
Active alarm log 209 See Tickets, batch (NTEP) =
from View menu 146 Batch (OIML) tickets
Active high 66 See Tickets, batch (OIML)
Active low 66 Batch alarms 220
Alarm event log 210 Batch AOC 85, 157
Alarm history 210 Batch inventories
Alarm log password 110, 168 See Inventories
Alarm severity 38, 208 Batch tickets
Alarms See Tickets, batch
active alarm log 146, 209 Bell 202
alarm categories 209 communications 19
alarm event log 210 parameters 102
alarm handling 208 signal converter 16
alarm history 210 wiring diagrams 20
alarm severity 208 wiring terminals 19
alarm types 208 BOL number
batch alarms 220 batch 163, 164
calibration alarms 221 transfer 164
configuration alarms 222 Burst mode 103
electronics alarms 212 Buttons
help 211 cursor control buttons 30
listed by category 212 in discrete batch operation mode 153
output saturation alarms 220 function buttons 28
process alarms 216 in discrete batch operation mode 151
sensor alarms 215 Security button 27
slug flow alarms 219
Ambient temperature effect C
Model 3300 or Model 3500 249 Cable glands 11
Model 3350 or Model 3700 257 Cable types 10
API Calibration 179, 181
See Petroleum measurement application alarms 221
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Index

batch AOC 85, 157 control options 86
density 197 flow source 85
sensor zero 134 presets 88
temperature 201 discrete events 79
troubleshooting 230 action 81
Calibration factors 53 event type 80
Calibration span 67 high and low values 81
Characterization 53 process variable 80
density calibration factors 54 setpoints 81
flow calibration parameters 55 discrete inputs
troubleshooting 229 assignment 56
Checksum, core processor 110 polarity 58
Checksum, transmitter 110 discrete outputs 63
Cleaning instructions assignment 64
Model 3300 or Model 3500 249 fault indication 65
Model 3350 or Model 3700 258 polarity 63
Coil, testing resistance 235 external inputs 59
Communication loop, troubleshooting 228 flow damping 42
Communication parameters flow direction 42
HART over Bell 202 104 frequency input 57
RS-485 mode 100 flow rate units 57
service port mode 100 K-factor 57
Communication tools scaling method 57
375 Field Communicator 3 frequency output 70
local display 3 flow source 70
Pocket ProLink 3 maximum pulse width 71
ProLink II 3 polarity 71
Configuration power 71
alarm severity 38 scaling method 70
Bell 202 parameters 102 HART over RS-485 99
burst mode 103 input parameters 39
core processor parameters 41 language 35
custody transfer application 105 low flow cutoff
cutoff mass flow 42
density 51 volume flow (gas standard) 43
mass flow 42 volume flow (liquid) 43
milliamp output 68 mass flow process variable 42
volume flow (gas standard) 43 mass flow units 42
volume flow (liquid) 43 measurement units
damping density 51
density 51 mass flow 42
flow 42 temperature 52
temperature 52 volume flow (gas standard) 43
date 38 volume flow (liquid) 43
default values and ranges 273 milliamp outputs 66
density damping 51 Modbus 99
density process variable 51 outputs 61
density units 51 passwords 34
device parameters 104 petroleum measurement application 75
digital communications 97 polling 59
discrete batch application 83 printer 101
batch control methods 90 process inventory reset methods 35
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process monitor
display variables 94
precision of displayed variables 94
process totalizer and process inventory
labels 94
process totalizer reset methods 35
process variables 42
quaternary variable 104
restoring a working configuration 224
RS-485 parameters 99
RS-485 protocol 99
security 34
sensor calibration data 53
sensor information 56
slug duration 51
slug high limit 51
slug low limit 51
standard gas density 43
system parameters 37
tag 38
temperature damping 52
temperature process variable 52
temperature units 52
ticket formatting and printing 117
batch (NTEP) tickets 123
batch (OIML) tickets 129
batch tickets 121
standard tickets 119
transfer (OIML) tickets 125
time 38
volume flow process variable 42
volume flow type 43
volume flow units (gas standard) 43
volume flow units (liquid) 43
when custody transfer application is enabled 170
write-protecting 34
Configuration files (ProLink II) 290
Connecting with ProLink II or Pocket ProLink
software 277
Control device, connecting to relay 267, 271
Control options 86
Controller 2
Core processor 2
dimensions 245, 254
enhanced 2
remote 10
standard 2
troubleshooting 232
Core processor checksum 110
Core processor inputs
enabling and disabling 42

Configuration and Use Manual

Core processor parameters
configuration 41
discrete inputs 56
process variables 42
sensor calibration data 53
sensor information 56
Core processor resistance test 234
Crossover frequency 72
CSA 259, 262
Model 3300 or Model 3500 249
Model 3350 or Model 3700 257
CTL 76
Cursor control buttons 30
in discrete batch operation mode 153
Custody transfer application 105
audit trail 170
configuration 105
device behavior 159
NTEP 106
BOL number 163
configuration 107
executing a transaction 163
process inventory values 164
ticket printing 163
transfer variable 107
OIML 106
alarm log password 110
application approval 108
BOL number 164
configuration 108
executing a transaction 164
process monitor approval 109
process variable approval 94, 109
ticket printing 166
transfer log 167
transfer variable 108
transfer variable approval 109
View menu 168
OIML/batch 106
alarm log password 110
application approval 108
BOL number 164
configuration 108
executing a transaction 165
process monitor approval 109
process variable approval 94, 109
ticket printing 166
transfer variable 108
transfer variable approval 109
View menu 168
operation mode 159
reconfiguring Series 3000 device 170
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Index

security switch 111
Model 3300 or Model 3500 panel-
mount 111
Model 3300 or Model 3500 rack-mount 112
Model 3350 or Model 3700 field-mount 113
weights and measures seal 115
Customer service, contacting 5
Cutoff
definition 53
density 51
interaction between milliamp output cutoff and
low flow cutoff 69
mass flow 42
milliamp outputs 67
volume flow (gas standard) 43
volume flow (liquid) 43

D
Damping
damping values 52
definition 52
density 51
flow 42
interaction between milliamp output damping and
other damping parameters 69
milliamp outputs 67
temperature 52
Data security 159
Default values 273
Density
calibration 197
calibration factors 54
cutoff 51
damping 51
process variable configuration 51
slug flow alarms 219
slug flow configuration parameters 51
units 51
Density curves
from View menu 148
See also Enhanced density application
Device parameters 104
Diagnostic monitor 148
Digital communications 15
configuration 97
fault indication 104
installation 15
protocols 15
wiring 13
Dimensions
core processor 245, 254
Model 3300 or Model 3500 241

326

Model 3350 or Model 3700 251
relay module 264
Discrete batch application 83
batch AOC 85, 157
batch control functions 91
batch events 150
cleaning or purging the tubes 157
configuration 83
control options 86
ending with flow 157
flow source 85
function buttons 151
operation mode 149
preset selections 147
presets 88
printing batch tickets 122
processing sequences 153
stages 88
tickets 85
Discrete events
configuration 79
action 81
event type 80
high and low values 81
setpoints 81
in batch control 90
printing
batch (NTEP) tickets 125
batch (OIML) tickets 131
batch tickets 122
standard tickets 120
process variable 80
Discrete inputs
configuration
assignment 56
polarity 58
in batch control 90
printing
batch (NTEP) tickets 125
batch (OIML) tickets 131
batch tickets 122
standard tickets 120
transfer (OIML) tickets 128
testing 139
Discrete outputs 262, 265
configuration 63
assignment 64
fault indication 65
polarity 63
discrete batch requirements 65
testing 139
troubleshooting 228
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voltage levels 63
Display

process monitor configuration 94

scientific notation 30

startup 25

update period 95

using 25
Documentation resources 4
Drive gain

erratic 231

excessive 231
Duty cycle 72

E
Electrical connections
Model 3300 or Model 3500 246
Model 3350 or Model 3700 255
EMI effects
Model 3300 or Model 3500 249
Model 3350 or Model 3700 257
End batch 91
Enhanced core processor 2
Enhanced density application 1
Environmental effects
Model 3300 or Model 3500 249
Model 3350 or Model 3700 257
Environmental limits
Model 3300 or Model 3500 249
Model 3350 or Model 3700 257
Erratic drive gain 231
Events
See Discrete events
Excessive drive gain 231
External inputs
configuration 59
testing 139
External temperature compensation 59
configuration 59
petroleum measurement application 78
wiring diagram 22
with HART Tri-Loop, wiring diagram 23

F

Factory zero 135

Fault indication
digital communications 104
discrete outputs 65
frequency output 71
milliamp outputs 66

Fault timeout 209

Field Verification Zero 110

Configuration and Use Manual

Field-mount
See Model 3350 or Model 3700
Flow calibration parameters 55
Flow direction 42
Flow source
discrete batch 85
frequency output 70
Flow switch 65
setpoint 65
Flow switch, hysteresis 65
Frequency input
cable length 8
configuration 57
flow rate units 57
K-factor 57
scaling method 57
testing 139
Frequency output
configuration 70
fault indication 71
flow source 70
maximum pulse width 71
polarity 71
power 71
scaling method 70
testing 140
troubleshooting 225, 228, 229
Function buttons 28
in discrete batch operation mode 151
FvZz
See Field Verification Zero

G
Gas standard volume flow 43, 48
Grounding
I/0 wiring 13
troubleshooting 228
GSV
See Gas standard volume flow

H

HART
loop current mode 103
polling address 100
RS-485 configuration 99
See also Bell 202

HART burst mode

See Burst mode 103
HART Communicator

See 375 Field Communicator
HART interface 289
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Index

HART Tri-Loop wiring diagram 23
with pressure compensation or external
temperature compensation 23
Hazardous area classifications
Model 3100 259
Model 3300 or Model 3500 249
Model 3350 or Model 3700 257
user-supplied relays 262
Help system 211
Housing
Model 3300 or Model 3500 241
Model 3350 or Model 3700 251
Hysteresis, flow switch 65

|
I/0 wiring 11
grounding 13
relays 13
terminal blocks and terminal locations 11
Increment preset 91
Ingress protection on Model 3300 8
Inhibit batch 91
Inhibit flow 91
Inhibit totalizer 91
Input parameters 39
Inputs
Model 3300 or Model 3500 246
Model 3350 or Model 3700 255
Installation
digital communications 15
digital communications wiring 13
display cover orientation (Model 3350 or Model
3700) 9
environmental requirements 8
frequency input cable length 8
grounding I/O wiring 13
I/0 wiring 11
Model 3100 263
relay 13,263
remote core processor 10
sensor wiring 10
supplemental information 7
user-supplied relay 269
Interface/display
Model 3300 or Model 3500 241
Model 3350 or Model 3700 251
Inventories 173
batch inventories 147, 174
managing 174
process inventories
configuring labels 94
configuring reset methods 35

328

displaying large values 164
with custody transfer (OIML) or custody
transfer (OIML/batch) 169
See also Totalizers
transfer inventories 169, 174
viewing 174

K
K-factor 57

L

Labels
maintaining and replacing safety labels 315
safety labels on Series 3000 device 315
terminal labels on Series 3000 device 11
used for process totalizers and process

inventories 95

Language used in Series 3000 device 35

LCD options 148

Legal security 159

Liquid volume flow 43

Loop current mode 103, 229

Low flow cutoff
mass flow 42
volume flow (gas standard) 43
volume flow (liquid) 43

Low pickoff voltage 232

M
mA outputs

See Milliamp outputs
Maintenance

cleaning instructions

Model 3300 or Model 3500 249
Model 3350 or Model 3700 258

density calibration 179

meter factors 179

meter validation 179

meter verification 179

safety labels 315

temperature calibration 179

zero calibration 179
Management menu 26

Security button 27
Marine Bunker Transfer Package 1
Mass flow

damping 42

low flow cutoff 42

process variable configuration 42

special units 49

units 42
Maximum pulse width 71, 72
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Measurement units
density 51
mass flow 42
special units 49
temperature 52
verifying correct configuration 229
volume flow (gas standard) 43
volume flow (liquid) 43
Measuring Instruments Directive 110
Menu system
flowcharts 277
Management menu 26
Management menu flowcharts 281
process monitor flowcharts 277
shortcuts 28
using 25
View menu 26
View menu flowcharts 279
Meter factors 55, 181, 196
Meter fingerprinting 206
Meter validation 179, 181, 196
Meter verification 179, 180, 183
execution 184
preparing for test 183
results 190
See also Smart Meter Verification
Meter verification, specification uncertainty
limit 184
Micro Motion customer service 5
MID
See Measuring Instruments Directive
Milliamp outputs
configuration 66
calibration span 67
cutoff 67
damping 67
fault indication 66
process variable 67
range 67
scale 67
testing 140
trimming 140
troubleshooting 225
calibration span 229
Modbus
configuration 99
polling address 100
Model 3300
frequency input cable length 8
ingress protection 8
installation 7
K-factor 57

Configuration and Use Manual

Quick Reference Guide 7
rack-mount
replacement for RFT9739 rack-mount 7
Model 3350
display cover orientation 9
frequency input cable length 8
installation 7
K-factor 57
Quick Reference Guide 7
Model 3500
installation 7
Quick Reference Guide 7
rack-mount
replacement for RFT9739 rack-mount 7
sensor wiring 10
Model 3700
display cover orientation 9
installation 7
Quick Reference Guide 7
sensor wiring 10
Mounting relays 263
MVD 2

N
Net Oil Computer 1
New equipment returns 317
NTEP
See Custody transfer application

0
OIML
See Custody transfer application
OIML/batch
See Custody transfer application
Operation mode
custody transfer application 159
discrete batch application 149
process monitor mode 144
View menu 145
Optional applications 1
applications list 148
Output, troubleshooting
frequency output 225
milliamp outputs 225
Outputs
configuration 61
Model 3300 or Model 3500 246
Model 3350 or Model 3700 255
output saturation alarms 220
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P

Panel-mount

See Model 3300 or Model 3500 panel-mount

Passwords
configuration 34
alarm log password 110
configuration password 34
maintenance password 34
types 34
Petroleum measurement application 75
definitions 76
external temperature compensation 78
parameters 76
reference tables 77
Pickoff voltage 232
Platform 2
Pocket ProLink 277, 289
Polarity
discrete inputs 58
discrete outputs 63
frequency output 71
Polling 59
Polling address
HART over Bell 202 102
HART over RS-485 100
Modbus 100
Power supply
for relay 261
specifications
Model 3300 or Model 3500 248
Model 3350 or Model 3700 257
Power supply, troubleshooting 227
Power-up 133
Preset selections 147
Presets 88
Pressure compensation 59
configuration 59
wiring diagram 22
with HART Tri-Loop, wiring diagram 23
Printer
configuration 101
test 102
Printing
auto print
batch (NTEP) tickets 125
batch (OIML) tickets 131
batch tickets 122
batch (NTEP) tickets 124
batch (OIML) tickets 131
batch tickets 85, 122
standard tickets 120
transfer (OIML) tickets 127
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Prior zero 135
Process inventories
See Inventories
Process monitor
approval for custody transfer 109
configuration
displayed variables 94
precision of displayed variables 94
process totalizer and process inventory
labels 94
from View menu 147
process variable approval 94, 168
Process monitor mode 144
Process totalizers
See Totalizers
Process variable
approval for custody transfer 109
assigned to frequency output 70
assigned to milliamp outputs 67
configuration 42
in discrete events 80
troubleshooting 203
ProLink IT 277, 289
configuration upload and download 290
connecting to Series 3000 device 290
menu flowcharts 291
requirements 289
saving configuration files 290
Protocol
on RS-485 terminals 99
printer 101
supported 15
Pulse width
definition 72
See also Maximum pulse width

Q
QRG
See Quick Reference Guide
Quaternary variable 104
Quick Reference Guide 7
Qv
See Quaternary variable 104

R
Rack-mount

See Model 3300 or Model 3500
Range

milliamp outputs 67
Receiving device, troubleshooting 229
Relay 13,261

connecting to control device 267, 271
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installation 263

mounting 263

power 261

replacing 262

types 261

user-supplied 262, 269
Relay packs 259
Remote core processor 10
Replacing relays 262
Reset batch 91
Resistance

testing coil 235

testing core processor 234
Restore factory configuration 224
Resume batch 91
Return policy 317
RF (radio frequency) interference 228
RFT9739 rack-mount transmitter, replacing 7
RS-485 16

parameters 99

signal converter 15

wiring diagrams 17

wiring terminals 16

S
Safety labels 315
Safety messages 1
Saving ProLink II configuration files 290
Scale, milliamp outputs 67
Scaling method
frequency input 57
frequency output 70
Scientific notation 30
Security
configuration 34
with custody transfer application 159
Security breach
clearing 170
identifying 159
Security button 27, 159
Security switch 111
Model 3300 or Model 3500 panel-mount 111
Model 3300 or Model 3500 rack-mount 112
Model 3350 or Model 3700 field-mount 113
Sensor 2
characterization 53
pickoff values 231
testing coil resistance 235
Sensor simulation mode 207
Sensor tubes 229
Sensor wiring 10
cable glands 11

Configuration and Use Manual

cable types 10
Sensor zero 134
Series 3000 2
software change history 319
Service port mode 100
Setpoint
discrete events 81
flow switch 65
Short to case test 235
Signal converter
Bell 202 16
RS-485 15,289
Simulation mode
See Sensor simulation mode
Slug flow
alarms 219
configuration parameters 51
Smart Meter Verification
execution 186
preparing for test 183
results 190
scheduling 195
Special units 49

Specification uncertainty limit 184

Specifications
Model 3100 259
Model 3300 241
Model 3350 251
Model 3500 241
Model 3700 251
Standard core processor 2
Standard density 48
Standard gas density 43
Standard tickets
See Tickets, standard
Start batch 91
Startup
device behavior 143
initial 133, 143
Startup procedures
milliamp output trim 140
sensor zero 134
testing inputs and outputs 138
Stop batch 91
System parameters
configuration 37

T

TEC 76

Temperature
calibration 201
damping 52
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process variable configuration 52 Totalizers
units 52 managing

Temperature compensation from Maintenance menu 174
See External temperature compensation from View menu 147, 174

Terminal blocks 11 process totalizers 176
Terminal labels 11 configuring labels 94
Terminology 2 configuring reset methods 35

controller 2

core processor 2
enhanced core processor 2
MVD 2

platform 2

sensor 2

Series 3000 2

standard core processor 2
transmitter 2

Test points 230
Testing

core processor resistance 234
discrete inputs 139

discrete outputs 139

external temperature value 139
frequency input 139
frequency output 140

inputs 138

meter verification 184
milliamp outputs 140

outputs 138

pressure value 139

printer 102

sensor coil resistance 235
short to case 235

Smart Meter Verification 186

Tickets

batch (NTEP) tickets
formatting 123
printing 124
batch (OIML) tickets
formatting 129
printing 131, 166
batch tickets 85
formatting 121
printing 122
sample tickets 305
standard tickets
formatting 119
printing 120
transfer (OIML) tickets 127
formatting 125
printing 127, 166
types 117

from View menu 147
with custody transfer (OIML) or custody
transfer (OIML/batch) 169
See also Inventories
transfer totalizers 169, 174
types 173
viewing 174
Transfer (OIML) tickets
See Tickets, transfer (OIML)
Transfer log
See Custody transfer application, OIML, transfer
log
Transfer variable
See Custody transfer application
Transmitter 2
default values 273
ranges 273
Transmitter checksum 110
Trimming the milliamp outputs 140
Troubleshooting 203
alarms 208
calibration 230
calibration span 229
characterization 229
communication loop 228
core processor 232
core processor resistance test 234
customer service telephone number 5
discrete outputs 228
erratic drive gain 231
excessive drive gain 231
frequency output 225, 228, 229
grounding 228
loop current mode 229
low pickoff voltage 232
mA output fixed 229
measurement range 229
measurement unit configuration 229
meter fingerprinting 206
milliamp outputs 225
power supply wiring 227
process variables 203
receiving device 229
RF (radio frequency) interference 228
sensor coil resistance 235
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sensor pickoff values 231 Weights and measures
sensor simulation mode 207 seal 115
sensor tubes 229 See Custody transfer application
sensor-to-transmitter wiring 228 Wiring
short to case 235 digital communications 13
test points 230 /0 11
wiring problems 227 sensor 10
Wiring diagrams
1] Bell 202 20
UL 259, 262 external temperature compensation 22
Model 3300 or Model 3500 249 external temperature compensation with HART
Model 3350 or Model 3700 257 Tri-Loop 23
Update period 95 HART multidrop 22
Used equipment returns 317 HART Tri-Loop 23
User-supplied relays 262, 269 HART/analog single-loop 21
pressure compensation 22
v pressure compensation with HART Tri-Loop 23
VCF 76 RS-485 17
View menu 26 Wiring problems 227
active alarm log 146 Write-protection
applications list 148 device configuration 34
batch inventories 147 with custody transfer application 159
density curves 148
diagnostic monitor 148 z
in process monitor mode 145 Zero 134
LCD options 148 factory zero 135
managing totalizers 147 prior zero 135
managing totalizers and inventories 174
preset selections 147
process monitoring 147
process totalizers 147
with custody transfer (OIML) or custody transfer
(OIML) batch 168
Volume flow
damping 42
gas standard 43, 48
low flow cutoff 43
special units 49
standard gas density 43
units 43
liquid 43
low flow cutoff 43
special units 49
units 43
process variable configuration 42
type 43
w
Weight
Model 3300 or Model 3500 241
Model 3350 or Model 3700 251
Configuration and Use Manual 333
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